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Copyright 

This documentation is protected by law. All rights, especially the right 
of duplication, circulation, and translation are reserved. 

No part of this publication may be reproduced in form of copies, 
microfilms or other processes, or transmitted into a language used 
for machines, especially data processing machines, without the 
express written consent of the publisher. 

All copyrights reserved. 

All other product names are trademarks of the corresponding 
manufacturers. Errors in and changes to the contents as well as 
program modifications reserved. 
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trademarks of MAGIX AG. 

This product uses MAGIX patented technology (USP 6,518,492). 
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respective manufacturer. 
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Preface 

Congratulations on your purchase of Samplitude Music Studio 14! 

Creating your own music or video soundtracks in a home studio has 
become more and more popular. But the wide variety of available 
equipment and software often confuses beginner and professional 
musicians alike. What to I really need? What's best value for money? 

Samplitude Music Studio 14 is the perfect solution: Fast and easy-to-
handle music production on your PC – from recording to mastering. 
Transform your PC into a complete sound studio. 

All you need to produce and arrange in high-quality is a conventional 
sound card. Additional studio equipment can easily be added.  

The following pages will introduce you in detail to the various 
functions and possibilities of Samplitude Music Studio 14. 

Have fun with Samplitude Music Studio 14.  

Your 

MAGIX team 
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Support 

If you experience any problems with your software, please get in 
touch with our support team: 
Support website:  http://support.magix.net. 
Here you can access the MAGIX Customer Service team as well as 
check out the following free offers: 
• FAQs (frequently asked questions) and general Tips and Tricks: 

You'll find the solution to most problems you may encounter when 
using the program here. Just in case you don't, there's also an email 
support form for your queries. 

• Email support form: You can use the special form to supply our 
support staff with information about your system. This information is 
used to quickly and competently solve whatever problem you may 
be experiencing. Simply fill it out and send it off! 

• Support forum: You are not alone. Other users may have 
experienced similar problems and might be able to help you. Our 
competent support staff can be found on a regular basis on the 
forum as well. 

• Download section: Advancements, optimizations and error fixing 
features, known as "patches", are also available as free downloads. 
Many problems that may occur are probably known to us already 
and can be fixed by installing the latest patch. Alongside the 
patches, you also find small assistant programs for checking and 
optimizing your system. 

• Links: In the link list you'll find the contact address of important 
hardware manufacturers. 

Please note: To be able to use the support you have to register your 
product using the serial number provided. This can be found on the 
CD case of your installation CD or on the inside of the DVD box. 

You can also reach our support team by telephone: 

UK:  
  

0905 118 0888 (25p/min) 
(open Monday to Friday 9:00 - 16:00 GMT) 

Denmark: 
   

077345695  
(open Monday to Friday 10:00 - 17:00 CET) 

Finland: 0942597819  
(open Monday to Friday 10:00 - 17:00 CET)  
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Norway: 
   

021543223    
(open Monday to Friday 10:00 - 17:00 CET) 

Sweden: 
  

0852507027  
(open Monday to Friday 10:00 - 17:00 CET)  

Email: 
 
    

info@magix.net 

Please have the following information at hand: 

• Program version 
• Configuration details (operating system, processor, memory, hard 

drive...) 
• Soundcard configuration (type, driver) 
• Information regarding other audio software installed 
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Getting started 

Package contents 

Program disc: This disc contains the Samplitude Music Studio 14 
installation manager. 

Printed manual: The printed manual contains all necessary 
information for a quick start into the program.  

Hint: The complete documentation is included in the Samplitude 
Music Studio 14 folder as a PDF file. You can read it on your screen 
or print it. You will need the "Adobe Acrobat Reader" application, 
which you can download for free from the Internet if it is not yet 
installed on your PC. 

Minimum System Requirements 

Computer: 

• Intel® Pentium® or AMD® Athlon® 700 MHz or higher, 256 MB RAM 
(512 MB recommended) 

• Free hard disk space: 3 GB 
• Graphics card: Resolution 1024x768 with 16-bit high-color 
• Full duplex 16-bit sound card or ASIO-enabled sound card 

(recommended) 
• DVD ROM drive 
• Microsoft® compatible mouse 
• Operating system: Microsoft® Windows® 2000 | XP | VistaTM 

Optional: 

• Burn CDs/DVDs with CD/DVD±R(W) recorder. 
• Access to and publication on www.magix.com and in MAGIX Online 

Services only with Internet connection and Microsoft® Internet 
ExplorerTM 6.0 or higher.  

• Sending emails possible with Internet access and existing Microsoft® 
OutlookTM or Microsoft® Outlook ExpressTM standard email software. 
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Seriennummer 

A serial number is included in each product. This serial number is not 
required for the installation of the software, but does enable usage of 
additional bonus services. Please store this number in a safe place. 

What can a serial number do? 

With a serial number your Samplitude Music Studio 14 is clearly 
assigned to you and only you. This way improved and more targeted 
customer service is made possible. Abuse of the software can be 
prevented with a serial number, which ensures that optimum the 
price/performance ratio continues to be offered by MAGIX. 

Where can the serial number be found? 

The serial number can be found on the reverse side of your CD/DVD 
case. If your product, for example, is packed in a DVD box, you'll find 
the serial number on the inside. 

For the versions that have been especially optimized for the Internet 
(e-versions) you'll get your serial number for activating the software 
directly after purchasing the product via email. 

When will you need the serial number? 

The serial number is required when you start or register Samplitude 
Music Studio 14 for the first time. 

Note: We explicitly recommend registering your product as you are 
only then entitled to use the MAGIX Premium Club (on page 20), get 
program updates, and contact the MAGIX Support (on page 15). 
Entering the serial number is also required for activating codecs. 

Installation 

Step 1: Insert the program disc into the drive. The installation 
program starts up automatically. If the disc doesn't run automatically: 

• Open the Windows Explorer and click the letter of the CD-ROM 
drive. 
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• Now double-click on "Start.exe" to start the installer. 

Step 2: To begin the installation of Samplitude Music Studio 14, click 
on "Install". The Samplitude Music Studio 14 installation program will 
appear. 

Hint: During installation you will be asked if, in case there are multiple 
users on your computer, you would like to set up an administrator. 
The option "Administrator only" restricts use of the program to the 
specified administrator only. The option "All users" allows all users of 
the computer to use the program. 

Simply follow the instructions on screen to complete the installation 
process and then click on "Continue". All files are now copied onto 
the hard drive. 

Step 3: Once the installation is complete, confirm the message by 
pressing "Finish". You can now start the program whenever you want 
from the Windows Start menu. 
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myGOYA 

In perfect unison: MAGIX products and Online Services 

 

Discover the possibilities offered by myGOYA, your free 
online operating system! 
Every MAGIX product offers a direct and easy-to-use 
gateway to the world of online multimedia. 

• Present your photos, videos, and musi

 www.magix.com

c directly in your Online Album 

®

t directly to your doorstep – 
quick, easy, and at the right price. 

nd many more online services on 
www.mygoya.com 

remium Club members have access to a wide 
range of services: 

News and info about the club and much more... 

 information about this topic on 
www.magix.com 

or in worldwide Internet communities. 
• Find professional templates & content for enhancing your personal 

projects. 
• Create your own personalized website in professional Flash  design – 

with photos, videos, music & impressive animations.  
• Order brilliant photo prints to be sen

Experience these a

MAGIX Premium Club 

Our exclusive club for all MAGIX customers who own a registered 
product. MAGIX P

• Free product updates and services 
• Exclusive club events and surprises 
• 

Membership is free. 

You can find more

Hint: You can register your product either directly from the program 
using the Help menu, or with your product registration number at 
www.magix.com. You can find your product registration number on 
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your program CD. Earlier network card numbers with the example 
format XY-58241-45, are, of course, still valid. 
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Introduction 

What is Samplitude Music Studio 14? 

Samplitude Music Studio 14 is a multitrack recording and editing 
application for all types of audio material featuring unlimited editing 
options. It's easy to use and follows three simple steps: 

1. Download and record 
You can download CD tracks, MP3 songs, WAV files, video 
soundtracks or sounds & samples from the hard disk, the CD ROM 
drive, or downloaded from the internet. You can even make your own 
recordings from a stereo system or  with a microphone. Everything 
you download or record is displayed as an object on the Arranger 
tracks.  

2. Arrange and Edit 
Basically all tracks stacked virtually above each other will be played 
simultaneously, and everything that follows horizontally will be played 
in subsequent order. However, you can mute the objects stacked 
above each other.  

Every object – that is, every sound, every song – can be cut up or 
have effects added. For example, if you want to shorten a song, 
move the object with your mouse to the length at which you would 
like the song to be – done! Want to freshen up your sound? Then 
open the equalizer and either select a preset that fits, or modify your 
sound "by hand”. 

Arranging and editing is fundamentally all about cutting, blending, 
adding and mixing effects, and placing audio material into the right 
positions and onto the right tracks. But it’s also about play and 
experimentation. If it fits, throw it in! Without experimentation there is 
no innovation. Samplitude Music Studio 14 allows you to experiment, 
and experiment wildly. There’s no risk of your audio material being 
damaged. All editing functions are "non-destructive”. 

3. Export and use 
Regardless what you're experimenting with, in the end something 
usable should come out of it. Samplitude Music Studio 14 has 
everything you need to do just that: 

• Homemade audio CDs which can be played from every standard CD 
player 
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• Unique MP3 collections, for example, as a source for your MP3 
player 

• Personal direct publications in the MAGIX web publishing area, the 
online forum for creative musicians, beginners, and professionals 

• and much more.  
• Our export principle: "What you hear is what you get", that is, what 

you export sounds exactly as it sounded in the arrangement on 
playback in Samplitude Music Studio 14. 

What�s new in Samplitude Music Studio 
14? 

100% Samplitude 
Music Studio is now 100% Samplitude. Benefit from the most 
advanced technology of the Samplitude® audio software that's been 
used for years in sound studios, and radio & TV stations around the 
world.  

Hybrid Audio Engine 
The Hybrid Audio Engine® of Samplitude Music Studio 14 offers a 
new dimension in professional music production: The combination of 
the Low Latency Engine and the classic Samplitude® playback 
engine enables minimum latency at maximum performance. The Low 
Latency Engine allows for very short reaction times while calculating 
track effects, and also permits monitoring at low latency during Live 
Recording. The classic playback engine saves resources and allows 
for integration of high-performance effects. 

VST MultiOut 
Samplitude Music Studio 14 now offers more outputs per VST 
instrument. You can access the VST instruments through the Track 
Editor. Clicking on the button right of  the "Plug-ins" activates and 
opens the DirectX/VST Plug-ins dialog with which you can compile a 
plug-in setup for this track. 

MIDI Multi Object Editing 
With the new MIDI Editor you can now edit several MIDI objects 
together in one editor. You can use a new button to toggle between 
MIDI objects. 

VSTi and effect automation 
You can now draw parameters of VST instruments or effects plug-ins 
directly into the track. This also works while recording. 

• First select a VST instrument or effect plug-in in the Track Editor 
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from which you would like to control the track (via the plug-in 
button). 

• Then right-click on the automation button in the Track Editor to 
specify the parameter you want to control. 

• Now use the pen tool to draw the desired curve into the track. 

Hint: You can also use the AUX busses for the effect automation. The 
principle: Create an AUX track via the menu Track > Track properties, 
add the track effect that will be controlled by the curve, an echo for 
instance, and then draw a volume curve into the AUX track using the 
pen tool. The curve of the AUX track thus controls the proportion of 
effects routed to the audio track. A "wave" therefore has to be drawn 
where the echo should "fly in". 

New Vita Instruments 
The sample synthesizer MAGIX Vita, specializing in the realistic 
playback of natural instruments, now has new sound programs. 
Newly added are the electric guitar power chords, clean electric 
guitar and soundtrack percussion. Acquiring authorization to access 
the Vita user interface is no longer required. The Vita Instruments can 
be accessed in the Media Pool via the "Synthesizer" button. 

Revolta 2 
Revolta 2 is an analog, varied and powerful-sounding, 12-voice 
synthesizer with highly advanced functions, sound matrix, noise 
generator, and a complete effect section with nine effect types. 

With this synthesizer you can create any electronic music you may 
imagine. The sound presets were created by sound designers for 
Access Virus and Rob Papens Albino, which makes Revolta 2 the 
Number 1 choice for beginners and professionals alike. 

Hardware controller support 
You can now use hardware controllers to control Samplitude Music 
Studio 14, e.g. Mackie Control. 

Total overview 
More overview for long arrangements: The new total overview allows 
you to display all tracks and objects at a single glance. 

magix.info 
Directly from within the program you'll be able to access the 
magix.info, the new knowledge base of MAGIX. Here you'll find 
answers to all the most frequently asked questions on MAGIX 
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products and multimedia. magix.info can be found in the "@Services" 
menu. 

The features 

Formats and interfaces 
Imports: Standard MIDI formats (MID, GM, GS, XG), sample formats 
(SF2), WAV (24 & 32-bit), WAV with codec, OGG Vorbis, MP3, CDA 
(Audio CD with preview), AIFF, MOV, AVI 

Exports: MID, WAV (24-Bit), WAV with Codec, OGG Vorbis, MP3 
(demo encoder with 20 free runs), CD-A (Audio-CD), AIFF, WMA, 
RealAudio (Helix), QuickTime 

Interfaces: VST(i), DirectX, ASIO, Rewire 

In addition: Save sounds & projects on DVD, extract and export video 
soundtracks, synchronize to SMPTE, MTC, MC (master & slave), 
song to email 

Catooh 
In the massive Catooh you will always find the matching sounds & 
pictures. The clearly archived library makes it child's play to find what 
you're looking for. Simply preview it and, if you like it, download it! 

Synthesizer 
Samplitude Music Studio 14 comes with the following synthesizers 
that you can play directly on your PC keyboard or with a MIDI 
keyboard. 

• Sample Tank: A sampler for acoustic or electronic instruments. 
• MAGIX Vita + Vital Instruments: Another sampler with astonishingly 

real-sounding "classic" instrument sounds. 
• Drum & Bass Machine: For bass and drum tracks in Drum 'n' Bass" 

sound 
• Beatbox: For computer beats and computer sounds 
• LiVid (Little Virtual Drummer): For "real" acoustic drum tracks. 
• Robota: For "mean" electronic sounds 
• MAGIX Revolta 2: A bass & lead synth 
• Atmos: For nature sounds or atmospheres like rain, thunder, or wind 

Effects and effect plug-ins 
Samplitude Music Studio 14 offers the following effects and effect 
plug-ins: 
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• Equalizer (graphic and parametric) 
• FFT filter 
• Echo 
• Reverb (MAGIX VariVerb) 
• Vocoder 
• AmpSim (simulates classic tube amps) 
• Vintage Effects Suite, consisting of chorus, flanger, analog delay, 

distortion, filters and the LowFi-Effects BitMachine (optionally as a 
free download) 

• Mastering Suite, featuring parametric equalizer, multiband 
compressor, stereo enhancer and audio meter 

• Compressor (various types, including Multiband Compressor 
Multimax, with many presets such as Limiter, DeEsser, Noise Gate, 
Expander or Leveler) 

• Tape Simulation (high-quality simulation of analog tape 
compression) 

• Stereo FX for editing the stereo bandwidth 
• Cleaning FX: DeHisser and DeNoiser (for reducing hiss and other 

artifacts) 
• Declipping (for eliminating digital clipping and blazing) 
• Timestretching/resampling/pitchshifting (for correcting pitch and 

time) 
• Elastic Audio (dynamic pitch correction) 

DirectX and VST Plug-ins 
Samplitude Music Studio 14 enables the direct use of DirectX and 
VST plug-ins for which a large variety is available in retail or directly 
online. Such plug-ins (audio effects or synthesizers from third party 
manufacturers) can significantly increase the functionality of 
Samplitude Music Studio 14. 

MIDI integration 
With Samplitude Music Studio 14 you can arrange, load, record, edit, 
and play MIDI data just as easily as audio data. You can combine 
wave sound files with MIDI files for controlling the sound chip on your 
sound card or VST instrument plug-ins or external synthesizers, and 
then arrange everything together. 

For MIDI recordings and editing you can use the comprehensive MIDI 
Editor with Piano Roll, Drum Editor, Velocity/Controller Editor and 
Event List. 

The recording of MIDI objects can be started directly from the 
Arranger by setting the recording mode in the track box to MIDI. 
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High-end 32-bit floating point 
All sound changes are executed in the 32-bit floating point method 
for especially differentiated and high-quality sounds. This technology 
is also used in professional studios. This way, an audio picture with 
especially high dynamics can be created. Digital overmodulation and 
clipping become virtually impossible. 

24-bit playout & native editing 
High-resolution 24 bits have now become the standard for audio 
cards and sound samples. Samplitude Music Studio 14 also supports 
playing of these files in the presence of the relevant hardware without 
having to calculate down to 16-bit in real time, as used to be the 
case. 

MAGIX Jam Session Automation 
The Auto Jam Session lets you create complete songs single-
handedly. The program simulates working with hardware "looping 
delays" like, for example, the Gibson Echoplex. The difference is that 
Samplitude Music Studio 14 creates an arrangement which can later 
be edited and compiled into a complete song.  

During an Auto Jam Session, everything you do is recorded. The 
most important thing with the Auto Jam Session is the fun factor – 
there should never be too much of it.  

Manager & Explorer 
A project-related manager set for managing objects, tracks, ranges, 
and markers allows the efficient administration, archiving, and 
management of all project contents and data directly from the 
working environment. Without the diversion of Windows features, and 
with elegant Drag&Drop in the program – including Search & Find. 

Track Editor 
The Track Editor to the left of the arrangement window enables 
access to all important parameters of the selected track. Record and 
monitoring status, volume, panorama, MIDI/audio in- and outputs, 
plug-ins, AUX sends and EQ settings are displayed in well-arranged 
sections and can also be edited in this view. You will instantly see all 
relevant settings of the corresponding track. 

You can open the Track Editor via the corresponding track button at 
the bottom of the VIP below the workspace selection button or via 
the menu "Window > Track Editor". 

MAGIX Remix Agent 
The Remix Agent is the ideal tool for producing DJ & Live Mixes. It 
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automatically recognizes the beat of MP3 or audio CDs and edits it 
as loops precisely according to the beat. Simply drag songs into the 
arranger: remixing has never been simpler! The recognized beats can 
be used to quickly form a base for a comprehensive remix. 

Track Freezing 
Entire tracks (including all track and object effects) can be frozen – 
meaning that tracks can be bounced and replaced by an object in the 
VIP, freeing up valuable computing power. If a track needs some 
extra work, “un-freezing” is a breeze.  

Batch processing 
Convert entire sample libraries, create pre-listen MP3s from 
enormous music collections, or clean-up all your session recordings 
in one go – automatically. 

ASIO driver support 
With the help of ASIO driver support, you can also use Samplitude 
Music Studio 14 as an external effects device. The signal is pushed 
through the realtime effects section by Samplitude Music Studio 14 
and then re-issued. All realtime effects from the mixer can be used 
directly: MAGIX AmpSimulation, MAGIX multiMAX, reverb, echo, 
compressor, 4 band equalizer and vocoder. Requirements: You will 
need an ASIO driver for your soundcard. 

User-friendlier interface 
The entire Samplitude Music Studio 14 user interface has been 
designed with presets to integrate smoothly with a variety of specific 
applications. For example, the presets for CD mastering, wave 
editing, multitrack recording and power user are included. These 
"beginner-friendly” presets offer clear and concise menus and 
toolbars in Samplitude Music Studio 14 that help implement such first 
projects.  

Task Assistant 
The Task Assistant uses short video clips to demonstrate the simple 
ease of use of the technically demanding effects and functions. 

In addition: 
• "BPM Tap": Create your own grooves with this intuitive tempo maker 

in the transport control 
• MAGIX Guitar Tuner: Tuner (not just for guitars) 
• Video Support for precise video dubbing 
• Download coupons for MAGIX soundpool samples 
• MAGIX Music Manager: Record, archive, and burn 
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• MAGIX Photo Manager incl. MAGIX Online Services 
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Tutorial 

In this chapter we will introduce the most important features of 
Samplitude Music Studio 14. You will learn how to create an 
arrangement with audio and MIDI as well as the powers of both 
formats. Furthermore you will receive information on essential parts of 
the program so that you can take advantage of all possibilities of 
Samplitude Music Studio 14. 

Creating a VIP 

First of all, create a new project by clicking on the "New multi track 
project (VIP)" button in the program's Start Wizard menu. If you 
already have Samplitude Music Studio 14 open, select "New Virtual 
Project (VIP)..." in the "File" menu. 

 www.magix.com
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Name your new project and select the file path here to which you 
wish to save the VIP. Now enter the settings and then confirm by 
pressing "OK": 

• 4 tracks (you can add tracks anytime via the Track menu) 
• Select "[0] Stereo Master" as the Mixer Setup. 
• Sample rate: 44100 Hz (for recording in CD quality) 

As a first test we will subsequently record two stereo tracks. Let us 
assume that you are using one audio source, e.g. a microphone or a 
musical instrument. Connect it to the input of your sound card with a 
suitable cable. 

 The first track in your virtual project (VIP) is already 
armed for recording. This is indicated by the red 
"R" in the track.  

 

Recording the first track 
1. Now right-click on the Record button of the transport console.  

 

In the dialog that will now appear you can enter all necessary settings 
for recording. 

 

www.magix.com

Hint: If the transport console is hidden, unhide it by clicking on the 
"Transport" button in the lower part of Samplitude Music Studio 14. 
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onitor it while recording. The level meter will display 
what enters at the sound card inputs. If it reaches the upper red 

2. Click on the "Monitor" button. This function lets you preview audio 
material and m

range, the input level is too high and clipping will occur. In this case 
you should reduce the input volume.  

 

3. Click on the "Record" button. Samplitude Music Studio 14 now 
starts recording and indicates this in the record window by displaying 
a counter.  

 

4. Now stop the recording at a suitable position by pressing the 
"Stop" button. 
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ou can now 
either use the recorded material or delete it. You can repeat the 

ou 

au

Samplitude Music Studio 14 will then stop recording. Y

recording without saving the first attempt on your hard drive. If y
want to use your recording, Samplitude Music Studio 14 will add the 

dio material to the first track as an object. 

 

Recording another track 

 
recording.  

Now we will record a second track. If your record dialog is still open, 
please close it. Now perform the following steps: 

1. Activate the Record button in the second track by clicking on the 
"R" button left of the second track. The track is now ready for

2. Right-click on the Record button in the transport console. You can 
now enter further record settings. As we now want to play the first 
track while the second is being recorded, you will have to activate 
"Play while recording". 
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3. Click on the "Record" button again.  

4. Now stop the recording at a suitable position by pressing the 
"Stop" button. 

Hint: "Playback while recording" requires that your sound card can 
play audio material while recording (full duplex mode). Some sound 
cards can either record or play, but can't do both at once. In such a 
case you should deactivate "Playback while recording". 

Integrate audio material 
Now add new, already available audio material. Audio material can be 
added to your virtual project from different sources and in different file 

es, sample CDs 

Ther terial: 

• In 
• Yo

in
• Au to be copied onto the hard drive individually. 

14 .". 

VIP and Wave projects 
h audio object you can see in the 

t made up of different 
objects. The tracks in the virtual project are for recording or loading 

tracks. You can conveniently record and 

formats. You can add audio CDs, WAV files, MP3 fil
(such as the MAGIX Sound  Essentials) as well as other audio files. 

e are several possibilities for loading audio ma

the menu bar click on "File > Load/import > Load audio file...".  
u can also drag audio files directly from the Windows Explorer® 

to the Samplitude Music Studio 14 arrangement.  
dio tracks first have 

To do this, click into the top menu bar of Samplitude Music Studio 
 on "File > Load/import > Load audio CD tracks..

You have now created your first arrangement from two of your own 
arrangements and a completed audio file. You can listen to the result 
anytime by clicking on the Start button in the transport control or 
pressing the Space bar on your keyboard.  

A wave object is created for eac
arranger. You can generally work in two project types:  

• Virtual Project (VIP): This is an arrangemen

audio material onto several 
create sound on different tracks. 

• Wave Project: This is the audio material of one object. 

Hint: If you delete an object in a virtual project, the audio material and 
the corresponding wave project on your hard drive will be retained. 

Switch to a wave project, for instance, your first recording: Mark the 
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menu bar of Samplitude Music Studio 14 on "Object", and select the 
corresponding object in the VIP by mouse-clicking, click into the top

option "Edit wave project...".  

 

If you have opened a wave pr of 
the audio material in enlarge ustic properties are 
directly visible in the wave form. This means that where there's 

audio material. Direct 

What is MIDI? 
A few words about MIDI: MIDI files do not contain the actual sounds 
like audio files, only the note control information which is first played 
by the synthesizer chip of the sound card. This has several 

1. 
2.

oject, you will see the wave display 
d view. The aco

something to see, there's something to hear. The higher the peak of 
the wave form, the higher the volume. Press the Space bar on your 
keyboard to play the wave project. 

In wave projects you can directly edit your 
editing of the material is particularly useful: Mark a range in the wave 
project with the mouse and then press the Del key. After editing the 
audio material you can close the wave project. You now have to 
decide whether you want to accept the changes or discard them. If 
you want to accept the changes, click on "Save project". The original 
audio file will now be overwritten. 

Working with MIDI 

advantages: 

MIDI files need a lot less memory than wave files. 
 MIDI files can be adapted to any beat (BPM) without affecting the 

sound. Only the playback tempo is changed. 
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3. IDI files to other pitches. 

 sufficient. 

4. you can use VST instruments 

The disadvantage of MIDI files: The actual sound is not yet set. Only 

mpletely different and better than standard sound cards. 

Audio + MIDI in one application 
s versions into "Audio Studio" and MIDI Studio" 

is now a thing of the past. Now there is only one Music Studio, thus 

  

 Similarly easy is the transposition of M
When doing so, a section in a song does not have to be saved in 
several different keys. The version in C major is perfectly
It can then be transposed to any key by simply clicking on the 
right mouse button. 

 In Samplitude Music Studio 14 
which play the notes contained in the MIDI files. 

during playback by the synthesizer chip of the sound card from 
external MIDI synthesizers/virtual instruments (VST instruments) will it 
be produced. High-quality sound cards or external synthesizers will 
sound co

The division of previou

integrating audio and MIDI into one program. 

Preparing a MIDI recording 
Prepare an empty track in your VIP for recording. Click on "R". Then 
click on "Track Editor" in the lower half of the Samplitude Music 
Studio 14 program screen to make track settings.

 

Use the small triangle to open up the MIDI section. Here you can now 
define the in- and outputs for your MIDI data on the selected track.   

• Input (In): Could be a MIDI keyboard here which you can use to 

 next to the word "Out" 
in the Track Editor and select "New instrument". 

enter MIDI notes that are then recorded by Samplitude Music Studio 
14.  

• Output (Out): Can be a virtual instrument (VST instrument) that plays 
the MIDI notes entered with the MIDI keyboard as sounds. To select 
a VST instrument, click on the small triangle

Hint: All global MIDI settings can be found in the System Settings 
dialog ("Y" key), sub menu "MIDI".  
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Via "Channel In" and "Channel Out" 

control an external synthesizer via a 
MIDI keyboard.  

For instance, if your MIDI keyboard is transmitting on MIDI channel 1, 
you should enter the value "1" in the "Channel In" menu. While 
recording Samplitude Music Studio 14 will then receive all notes 
transmitted on channel 1 by a MIDI keyboard.  

You can generally assign a specific MIDI channel to external MIDI 
synthesizers. For instance, if your external synthesizer is addressed 
via MIDI channel 4, you should also enter the value 4 in  the "Channel 
Out" menu of the Track Editor in order to be able to address the 
external synthesizer via this track. 

et the MIDI 
record mode in the transport control.  

in the Track Editor you can assign a 
special receive and send channel for 
every type of MIDI data. This is 
important, for instance, if you can to 

MIDI record modes 
There are several methods of recording MIDI. You can s

 

• Norma
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l: This Record Mode corresponds to that of the audio 
ct is 

ct. This 
 takes of a passage and then compare 

mixed together. 
n already existing object, 

corded MIDI data are mixed together. Existing 
ver, remain the same. 

ta is 

recording, that is, for each recording process, a new MIDI obje
created over the existing object. The old object remains inta
way you can record multiple
them in the Take Manager later on. 

• Overdub: The data is recorded into an already existing object, 
available and newly recorded MIDI data is 

• Multi-Overdub: The data is recorded into a
available and newly re
objects, howe

• Replace: The data is recorded to an existing object, any MIDI da
overwritten.  

After you have selected MIDI record mode, you can prepare the 
corresponding track by clicking on the "R" button for recording. Now 
start recording by clicking on the "Record" button in the transport 
control. 
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Edit Objects 

Individual objects are highlighted with a mouse-click. Multiple objects 
can be selected when the Shift key is pressed. You can also click and 
drag out a rectangle to select multiple objects. All objects contained 

ped object" 
is activated in the top menu bar, you can stretch the object with the 
right handl rt 
drum samp

At the top o fade handles that can 
be adjusted to fade an object in or out. The handle at the top center 

Many object edits require the objects to be selected first. 

therein will be selected ("rubber band selection"). 

All objects can be shortened or looped by moving the mouse to one 
of the lower corners of the object until it turns into a stretch symbol. 
You can now reduce the size of the object. If "Create loo

e. This way you can create entire rhythm tracks from sho
les by simply stretching the object apart. 

corners of every object there are tw

can be used to adjust the volume of the objects. The handles of 
audio and MIDI objects work the same way.  

 

Tip: Several objects can be combined with others to make up a 
group, t t of o avoid the objects being unintentionally moved ou
relation t on o each other. First mark the individual objects. Then click 
the "Group" symbol of the tool bar.  
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ontext menu from which you 
can also select the Object Editor. Here you can make all important 
settings for the corre
Editor you can add effects to audio objects and change the 
quantization on MIDI objects.  

Object editor 
Right-clicking on the object opens a c

sponding object. For instance, in the Object 

 

Tip The Object Editor can be permanently open::  It will adjust its 
setting depending on which object is currently selected.  

MID
You 
Edito ext menu and select 
the "MIDI Editor." The MIDI Editor displays the data of the MIDI 

• Matrix Editor (Piano Roll) 

tor (velocity, MIDI volume…) 
• List Editor (event list) 
• Score Editor 

s tools are available, for example, pencil or eraser. 

I Editor 
can use the MIDI Editor for editing MIDI data. To access the MIDI 
r, right-click on the object, open the cont

object. 

MIDI data can be edited in the MIDI Editor in five main areas: 

• Drum Editor (toggle between the Drum Editor and Piano Roll 
possible) 

• Controller Edi

Here variou

Fundamentally, changes, for example, moving or deleting notes, 
always refer to all selected MIDI events (red) with just a few 
exceptions. You can, for example, select a group of notes in the 
Piano Roll and then change the velocity of these note groups which 
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Working with the Matrix Editor 
The Matrix Editor is particularly useful for conveniently arranging MIDI 
notes (Piano Roll).  

 

In the Matrix Editor you can edit MIDI notes for controlling sound 
generators such as synthesizers, drum machines and virtual 
instruments (VST instruments). If a MIDI instrument is activated, you 
can play it via the keyboard at the left of the screen. Clicking on a key 
makes the synthesizer create the corresponding sound.  

Now select a pen and paint the notes into the score 
sheet. MIDI notes can also be prolonged by holding the 
left mouse button or double-clicking. The Eraser tool 
deletes notes from the note field.  

Tip: The tool for drawing the pattern is particularly interesting. Use 
the selection tool to select specific notes and then click Ctrl+P on 
your keyboard. The selected notes are played as a sound pattern. 
You can now easily sketch the sound pattern with only one click. 

Tip: Pressing the "left" and "right" arrow keys on your keyboard 
moves forwards and backwards in the notation. With the cursor 
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up/down keys you can adjust the note pitch step by step. 

Using the Controller Editor 

 

 

ditor. Clicking on the small 
button above opens a context menu. Here you can select 
a MIDI parameter and then sketch it with the pen tool in 
the Controller Editor.  

In the Controller Editor you can adjust MIDI parameters 
in the left part of the MIDI 

 

 already opened 
MIDI Editor you can include additional MIDI objects by clicking on 

such as velocity. A simple click 
Editor opens the Controller E

Multi Object Editing 
With the new MIDI Editor you can now edit several MIDI objects 
together in the MIDI Editor. Please select the MIDI objects in the 
arrangement in sequence by holding the Ctrl key and then clicking on 
the MIDI Editor button to open the MIDI Editor. In an

them while holding down the Shift key. 

You can access individual MIDI objects via the 
to the name. 

 
flip menu next 

Hint: Right-clicking on this position opens the Object Editor so that 
you can quickly toggle between the Object and MIDI Editor. 

From MIDI to Audio 
If you are not controlling an external MIDI synthesizer with your 
arrangement you can convert its sounds into audio tracks using the 
Samplitude Music Studio 14 record function. This is particularly 
recommended if you want to enrichen the sounds created with your 

rnal synthesizer should 

audio file that can be edited and exported together with the 

external synthesizer with audio effects, convert your project into MP3, 
or burn it onto disc. 

1. The audio output (Line-OUT) of your exte
be connected to the audio input (Line-IN) of your sound card.  

2. Set an audio track to "armed" by pressing "R".  
3. Start audio recording as usual. The MIDI data will be played and 

recorded simultaneously via the record function. The result is an 
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he result is an audio file that can be edited and 
exported together with the multimedia files. 
multimedia files. T

Tip: Do not delete MIDI trac  ks in the arrangement after you have
generated audio files from th  em, simply mute them with the "Mute"
button. You can then later change melodies composed via MIDI and 
record them as audio files again. 

Hint: If you prefer VST instruments as synthesizers it makes more 
sense to use the function Track Freeze (on page 298) from the 
context menu. 
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er 
and panorama movements. Furthermore, you can add effects and 
much more here. Adjust the volume of the tracks with the slider in the 
lower part of the mixer until you have a balanced result and every 
instrument in the song is sufficiently accounted for. You can also 
experiment with the effects on the individual tracks. 

With the Mixer (keyboard shortcut "M") you can adjust the volume 
and panorama of the recorded tracks as well as automate the fad
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You can considerably enhance your music productions with effects. 
cts adds bass and simply sounds better. 

Samplitude Music Studio 14 has plenty of effects. Experiment around 
with the various effects in Samplitude Music Studio 14 and learn how 
to use them.  

Clever use of effe

 

Of
In the top menu line of Samplitude Music Studio 14 you can directly 
access "Realtime Effects" and "Offline Effects": Offline effects alter 
the audio files in the Wave Project resulting in imminent changes to 

Un
rea  
are be modified, 
varied, without altering your original audio material.  

fline effects and realtime effects 

the initial audio file.  

like offline (destructive) effects, virtual effects are not added in 
ltime to the wave projects to which the objects refer. Such effects
 recalculated every time they are played and can 

Hint: To add an effect to an audio object you first have to select it 
with a mouse-click.  

Ca
Yo io objects, 
tracks and in the master. When played, effects are first calculated in 

ffects 
are

Fir while 
other objects in the same track remain the same. For instance, if you 
have saved a groove consisting of several audio objects on one track, 

Th ects 
loc ter 
eff

Effects in audio objects: Right-click on an object to open the context 

lculating audio effects 
u can add audio effects in three different levels: aud

the audio objects. Track effects are then added. The master e
 added last. 

st start with the object effects to distort individual objects 

you can edit the last object of the groove with a distorter. 

en use track effects, for example to add reverb, to all obj
ated on one track. Finish off your song with powerful mas
ects that have an effect on the entire song. 
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ss 
the
via

menu and add an object effect. In the context menu you can acce
 object effects directly. Object effects can be selected and edited 
 the Object Editor. 

 

 

channel. 

Effects in tracks: To adjust track 
effects in the Mixer, open the Mixer by 

 
bol 

of an effect slot in the corresponding 

clicking on "Mixer" in the lower part of 
Samplitude Music Studio 14. In the
"Ins" section click on the arrow sym
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Effects in the Master: Open the Mixer 
to add master effects. You will find the 

the desired 
master effects. 
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master section at the right edge of the 
Mixer. Here you can install 

Hint: Track effects and master effects 
are always realtime effects. 
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k on 

Burn CD 

If your VIP is finished, you can burn it onto disc. To do this, clic
the button with the CD symbol. The CD burning dialog now opens. 

 

Now click on the "Burn CD" button: 
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esktop overview 

VIP window 

Program d

 

1 M  
Music Studio 14 directly under the title bar. A keyboard shortcut 

cated to every menu entry.  

2 Toolbar: Toolbars are made up of buttons which carry out specific 
commands with a mouse
below the project windo he individual 
button bars can be found  
on the individual toolbars yboard shortcut 

rview. 

3 Grid/Marker bar: The grid/marker bar is positioned above the first 
tra he marker bar where 
the displays the grid 
list elected unit 
of es.  

enu bar: You'll find menus in the main window of Samplitude

can be allo

 click. They can be found above and 
. More information on tw
 in the button overview. More information
 can be found in the ke

ove

ck in the VIP. In the upper half, you'll find t
 markers and playback cursors. The lower half 
 which displays the project time depending on the s
measurement. You can also open various rang
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Pro ible in 
the ed depends on the position of 
the

There are many commands for moving (scrolling) the visible clip 
an e 
me tcut keys. 

5 Tra  of a VIP track. It 
o  

mo ters. More 
 on the individual controls of the track box can be 

found in the track box overview. 

6 Track Editor:  The left borde bles 
access to all important param elected track. Record 
and monitoring status, v m
outputs, plug-ins, AUX send ed in 
well-arranged sections and c w. 

7 Setup/Zoom/Position bu
manage each of the four diff t 
clip displayed in the VIP wind , 
"End", "Mouse", and "Mixer" configured with a right-
click. 

8 Status display: The status d  of 
the VIP window. For longer a
displayed whose width show

Furthermore, CPU load infor y, 
buffer, etc. is updated and di  
display can also be open  
menu. 

 

Transport control 

Shortcut:  Ctrl + S

4 ject window/Clip: A "clip" refers to part of the project vis
 project window. The part display
 section and the zoom setting. 

d customizing its size (zooming). These can be opened via th
nu view, the grid/marker bar, and the shor

ck box: The track box is the front range
c ntains various controls which range from mixer functions and

nitoring commands to other track parame
information

r of the arrangement window ena
eters of the s

olu e, panorama, MIDI/audio in- and 
s and EQ settings are display
an also be edited directly in this vie

ttons: This part of the work area helps 
erent setup and zoom settings projec
ow. Similarly, the "Pos.", "Len."

 fields can be 

isplay appears at the bottom border
ctions or calculations a bar is 
s the current state of operation. 

mation on the processor load, latenc
splayed constantly. The status

ed via the "Window > Status display" 

hift + T 

 

The transport control window contains the most important 
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commands for playback, recording, and positioning. 

Play / Stop / Fast forward / Rewind buttons: This way, the 
positioning can be controlled like a cassette player. 

h
para nning in stereo master mode. Here you can, 

o vice, and 
rub

h g 
para r 
exam u can also start a mono or stereo 

o

co , that 
is, tr tton in the Track info to the left. The 

o n the 
"R" b

Time lays the current playback position. The unit of 
as

Rang sing 
the arrow symbol you can open previously used ranges. 

L/E  Here, the length and end position of a range is 
w -click. 

 button opens the marker manager for further 
marker editing. More information can be found in the chapter called 

f one 
position has been saved, the marker will appear bright. Another click 

Recording modes: Here you can set up the appropriate recording 

selected, playback of existing objects is deactivated while recording, 

Rig t-clicking on the Play button: This opens the playback 
meters window for ru

am ngst others, specify the sample rate, playback de
sc bing/varipitch options. 

Rig t-clicking on the Record button: This opens the recordin
meters window. Here you can adjust the recording settings, fo
ple, "Play while recording", yo

rec rding straight from here. 

Re rd button: This starts the recording for all activated tracks
acks with a red "R" bu

rec rding devices have to be set up before by right-clicking o
utton. 

 display: Disp
me urement can be selected by clicking on the small triangle. 

e buttons: You can save ranges with buttons "1" and "2". U

time display:
sho n and can be edited with a double

"Marker" button: This

"The Manager". 

Marker buttons 1...12: The current play position can be saved at any 
one of the 12 marker buttons with a simple mouse click. I

on the same marker moves the play position to the corresponding 
marker. Right-clicking deletes the saved marker again, making it 
available again to be allocated. 

mode. 

Recording without playback (play monitoring): If this option is 
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. 

sing the "Punch" buttons. 

"Sync" button: This button opens the dialog with the synchronization 
settings. Further information can be found in the "MIDI in Samplitude 
Music Studio 14 -> Synchronization" chapter. 

"Punch" button: This button shifts Samplitude Music Studio 14 into 
Punch mode. This means that a recording can be started "on the fly" 
using the record button during playback at any time, also multiple 
times back-to-back. Punch In and Out markers are then placed 
automatically. A punch recording is ended by pressing the record 
button, playback is not interrupted. 
"In" button: This button sets the starting point for a Punch recording. 

"Out" button: This button sets the end point for a Punch recording. 

If Punch In and Punch Out markers are set, the Punch recording can 
be started using the Record button. While the Record button is 
flashing, playback occurs until the Punch In Marker has been 
reached. When reached, the Record button turns red. It now records 
until it reaches the Punch Out marker, then Samplitude Music Studio 
14 changes back to Playback mode again. 

Additional Punch In/Out markers can be set by holding down the Alt-
key. 

"Loop" button: Use this to switch into Loop mode, that is, a specific 
range is played repeatedly. 

MIDI record modes: The following MIDI record modes are available: 
Normal, Overdub, Multi-Overdub and Replace. These decide which of 

the cursor remains at the beginning of the recording

Standard mode (record while playing): This is the typical recording 
mode for multi-track productions. This adds further tracks to already 
available audio material while playing. 

Punch Marker mode: This setting starts a recording process which 
can be started and stopped at any time during playback. This setting 
corresponds to u

Auto JamSession: Opens the "Auto JamSession" window. 

"Rec M" button: This button activates Samplitude Music Studio 14 
record monitoring, i.e. you will see the incoming signal in the peak 
meters of all tracks with "R" activated. Right-clicking on the "Rec M" 
button lets you select from the various monitoring modes. 
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 VIP. 

Tempo section: In the tempo section of the transport control you can 
adjust the playback speed and the tempo of the entire arrangement. 

ur choice with 
timestretching. In addition, you can fade in the bar grid with the 

ome click with the "CLICK" 
" button opens the metronome 

settings button. 

The buttons beneath it can be used to start playback forwards and 
e used to improve 

control over audio passages, like editing out crackles or other errors 

the newly recorded MIDI files will be added to the

All objects in the VIP are adapted to the speed of yo

"SNAP" button and switch on the metron
button. Right-clicking on the "Click

Scrub control: With the Scrub Control wheel, the playback speed 
can be adjusted. This can be used to find audio passages. 

backwards at a slower speed. This too can b

later. 

Track Editor 

 

1 Track number display and track name: Right-clicking on the 
track name opens the "Track Settings" dialog. 

 the exception of the one 

5 

6 
ting of an object. 

tput signal 

2 "S" button: Switches off all tracks with
selected. 

3 s the track. 
4 "Rec" button: Activates the track for the recording. 

The loudspeaker symbol: Switches on playback of the incoming 
signals when the "Rec" button is 

"M" button: Mute

active, if "Manual monitoring" is 
selected in the system options. 
The Lock button: Lets you protect objects in the track and 
prevents unintended moving or dele

7 Peak Meter: Both LED displays show the input and ou
for the track. 
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them. Save your 
personal track effect settings in the program directory in "FX 

hes the track to MIDI recording and opens 
the MIDI section of the Track Editor. 

Automation 

8 Volume input field and volume control 
9 "FX": Here you can access the track effects of the activated 

track. You can copy, insert, reset, save, or load 

Presets > Track FX". Of course you can also create new 
subfolders here. 

10 "MIDI" button: Switc

11 The Panorama button: Controls the position within the mix. 

 

A:  Rig

 

menu 
Plug-in: Select the plug-in you would 
like to automate here. 
Param: Select the paramete

ht-clicking opens the context 

r you would 
like to automate here. 

 

MIDI: 

 

1 Arrow: Opens and closes the dialog box. 
2 In device: Opens the MIDI Input device menu. 

e menu. 

7 Bank MSB: Set the device-specific control change messages 

9 Transpose: You can transpose the notes of the respective 
e. 

3 Out device: Opens the MIDI Output devic
4 Channel in: Set the MIDI Input channel here. 
5 Channel out: Set the MIDI Output channel here. 
6 Program: This button is used in MIDI mode for program 

selection of the MIDI instrument. 

for controlling your external instrument here. 
 

8 LSB: Sets the device-specific control change messages for 
fine-tuning your external instrument here. 

MIDI input or output up or down her
10 Drum map: Here you can select a drum map for allocating 

MIDI notes to the device-specific sound. 
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2 The "Out" slot specifies the audio 

example, be a sound card output 
or (in MIDI mode) a VST instrument. 

3 Plug-ins: Here you can activate the 
us track 

effects as well as an additional 

dialog with which you can compile 
a plug-in setup for this track. 

4 Aux: Here you can specify the AUX 

select the desired effects in the 
AUX return channel in the Mixer 

5 EQ: Contains the parametric EQ for  

1 The "In" slot specifies the audio 
input device, for example, your 
sound card. 

output device. This can, for 

sound rack containing vario

compressor. 
In the first slot you can also select 
a MAGIX Synth that is to be 
controlled from the track. Clicking 
on the button to the right of the 
field beside "Plug-ins" activates and 
opens the DirectX/VST Plug-ins 

send feed for which you can then 

view. 

this track. Right-clicking opens a 
convenient input window. 

6 Comments: Track info section for 
quickly adding notes on tracks. 

 

Track box 
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k for recording. 
5  Loudspeaker symbol: Switches on playback of the incoming 

 track and 
prevents unintended moving or deleting of an object. 

ight-clicking on the track names opens the 

can switch on the panorama 
automation. 

11  Volume and panorama controls 
 

Workspaces 

The purpose of workspaces is to sort menu entries and toolbars in 
such a manner that you have a good overview of the functions of 
Samplitude Music Studio 14. Workspaces bundle commands with 
regard to certain tasks such as mastering, editing or recording. 

Besides hiding menu entries (Options > Program Preferences > Edit 
keyboard shortcuts and menus > Hide menu) and redesigning 

orkspace, open the 
context menu by right-clicking on the workspace bar and selecting 

. You will now be asked to enter a name for your 

1  Peak Meter: Both LED displays show the input and output 
signal for the track. 

2  "S" button: Mutes all tracks except the selected one. 
3 "M"-Button: Mutes the track. 
4  "R" button: Arms the trac

signals when the "R" button is active, if "manual monitoring" is 
set up in the system options. 

6 The Lock button: Lets you protect objects in the

7  Track name: R
"Track settings" dialog. 

8 "FX": Opens the effects/routing dialog with which you can 
configure and edit multiple effect groups. Right-clicking opens 
the context menu which contains all the available track effects 
for the object. 

9  "Vol." button: This button switches on the volume automation 
curve. This way level adjustments in the track can be controlled 
via an automation curve and drawn by moving the channel 
fader. 

10  "Pan": With this button you 

toolbars (right mouse-click on the toolbar), you can also save your 
settings as a preset. 

You will see the selection box for the workspace at the bottom left 
corner of the VIP window. Some workspaces are already predefined. 
"Power user" displays all toolbars and commands, and is a good 
starting point for defining customized workspaces. 

Creating a new workspace: To create a new w

"New workspace"
workspace. The new workspace contains all settings of the previously 
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ther 
adjustments are automatically saved in the workspace. Manual saving 

ace. You can activate or deactivate 
each bar individually, or add/remove individual symbols. You can also 
hide menu items in "Edit menu". Simply select the corresponding 
menu item from the keyboard shortcuts and then press the button 

ide menu item". 

activated workspace as well as your current changes. All fur

is not required. 

Adjusting the workspace: Open the context menu and click on "Edit 
workspace". Here you can select which toolbar you want to have 
displayed in your new worksp

"Show menu item" or "H
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le into a VIP Object 
Method 1: Loading a File into a VIP 

le. The file is inserted at the beginning of the selected 
range as an object. The range also denotes the track into which the 

dio 
file in Explorer that you would like to use, and then simply drag it over 

Virtual project. 
• Create a new Virtual project with File>New Multi Track Project 

 the Wave project into the Virtual project 
by clicking the left mouse button into the range and dragging the 
range into a VIP track. 

sition the mouse button 
was released. 

udio material in an Object 
• Select any object. 

 
option is available from the context sensitive menu when clicking the 

 

Prerequisite for this is the selection of the correct Mouse Mode: 

Functional overview 

Working with Objects in the VIP 

Loading an audio fi

Mark a range in the VIP and load the WAV file with File>Open 
Project>Audio Fi

WAV file is inserted. 

Method 2: Drag & Drop from Windows Explorer 

Open Windows-Explorer and arrange the Explorer and Samplitude 
Music Studio 14 windows so that both are at hand. Access the au

into Samplitude Music Studio 14 while holding down the mouse 
button. 

Load ranges from Wave Projects into the VIP 
• Open a Wave Project.  
• Mark a range, which is to be incorporated into a 

(Shortcut: ‘e’) or with the corresponding button in the toolbar.  
• Tile the open windows by pressing the ‘Enter’ key. 
• Drag the selected range in

• A new object is created in the VIP at the po

Accessing a

• In the menu Object, select ”Destructive Editing”. (The same menu

right mouse button on the object.)  
• This opens the corresponding Wave project window. The marked 

range represents the audio material that is used in the VIP object.

Selecting an Object with the Mouse 
Clicking the left mouse button selects the desired object. 
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 object is 
selected by clicking on the lower half of the object. 

Clicking the mouse button outside of the object confines unselects 

Moving and duplicating objects 

rizontally (in the timeline) while 
holding the left mouse button. As soon as you let go of the left mouse 

If several objects have been selected in different tracks, the selected 

If the Shift key is pressed when moving the Objects, the time position 
is retained and you can only change the track. 

If the Ctrl key is pressed while moving the object selection, a copy of 
on is created. In this case, the copy of the original 

object selection is placed at the destination. The original objects 

handles of a selected object can be used to alter 
the object borders. The mouse can be used to change the object 

co

be  of the corresponding Wave project. 

be

Fa
Th sed to set the object 

th

Th

Object Mode, Object & Curve Mode, and Universal Tool Mode all 
offer this functionality. In the Universal Tool Mode, the

The five handles on the outline of the objects identify any selection of 
objects. While the mouse button is held clicked, the outline of the 
object is also displayed. 

any object selection. 

Once one or several objects have been selected, they can be shifted 
vertically (by track number)  and ho

button the object will be placed at the current position. 

group can be moved vertically only so far that all objects remain 
within the tracks. 

the object selecti

maintain their position. 

Changing Object Borders in Virtual Projects 
The lower object 

beginning or end. The object length can only be changed within the 
nfines of the physical Wave project window. 

This means that the beginning of the object can not be extended 
yond the beginning or end

Conversely, the end of the object can not be extended beyond the 
ginning or end of the corresponding Wave project. 

de-In / Fade-Out and Object Volume 
e object handle in the upper middle can be u

volume. The exact volume level in dB during the change is visible in 
e pop up window at the object.  

e upper left and right-hand handles of the object change the fade-
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in

Si ack of the 

up out having to fear data loss. 

Th
Ed

O
A el) can only play back one object at a time. 

 is moved over another object, the previous object is 
partially or completely taken out of the playback list much like one 

overed object will not be audible. By moving the covering 
object out of the way, the covered section or the complete object can 

in. To create a crossfade between two objects 
h other, the Crossfade Editor in the menu 

The object editor is a very practical tool for editing the most important 

To  half of an object.  

Im
nu
playing tempo, there is a Pitchshift/Timestrech effect. 

Click on OK to save the settings. This closes the object editor. The 
ow only affect the object when it is being played. Of 

course, you can also edit the EQ in the mixer. There are an infinite 

 and fade-out settings of the object. 

nce these changes are applied in real-time, during playb
project, the original audio material is left intact. This allows easy set 

 of fades and volume levels with

e curve types when fading in and out can be set in the Crossfade 
itor. 

verlapping Objects 
track (chann

If one object

sheet of paper covers another partially or completely. The invisible 
part of a c

be made audible aga
that are intersecting eac
Edit can be used. 

Object-Editor 

settings for objects.  

 open the object editor, double click the bottom

portant settings such as length, position and volume can be edited 
merically in the object editor. To adjust the pitch tone or the 

settings will n

amount of effects combinations to utilise. 

There’s no need to close the new version of the object editor. You 
can jump between different objects in the VIP – the open object 
editor will automatically adjust to the currently selected object. 

Ranges 

Ranges are selected sections of the arrangement that can be set for 
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mitations like 
markers. Ranges that you search for are displayed inverted. By 

n. 

editing or re-opening later on. When creating ranges you are not 
bound to object borders, individual tracks or any other li

switching on the "Grid" function in the "Project options" you can set 
the step size of the selectio

Detailed information on the project options can be found in the menu 
reference in the "Options" menu -> Project options". 

Selecting a range 

mouse button. Move the mouse pointer 
within the object while pressing the mouse button. Now you can see 
an inverted rectangle between the starting point and the current 

you let go of the mouse button, the range is 
selected. The play cursor always automatically remains at the 

nd the range onto other tracks, click on the top half of the 
selected object again and drag the mouse down vertically while 

To select a range, move the mouse pointer to the top half of an 
object and press the left 

mouse position. Once 

beginning of the range, even if you can't see it at this moment in time. 
To expa

keeping the mouse button held. 

 

You can also select a range by dragging the mouse across the 
timeline. It will then be displayed in green. Double-clicking on this 

range in the selected track, a further double-

a different range, click elsewhere in the project 

timeline area selects a 
click selects the range over all tracks, the next double-click then 
reverts back to the simple timeline selection. In the timeline selection 
you can also position the play cursor outside the range. The range 
will remain intact. This way you can start playback in front of or within 
a loop. Range borders can also be changed during playback. The 
play range can be deleted by dragging to size 0. 

Leaving a range 
If you wish to select 
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Enter the keyboard shortcut: "Shift + Backspace". By clicking on this 

by clicking on the button with the left 
arrow in the transport control. 

command repeatedly you can restore the last five ranges. You can 
execute the same function 

 

Change range border 
In the timeline selection you can change the range edges by 
positioning the mouse over the range border. The mouse pointer 

area and keep the mouse button pressed. Now, while 
keeping the mouse button pressed, leave the range in the direction of 

y + arrow keys. 

turns into a double-arrow. Now you can change the range edges by 
dragging horizontally. 

If you wish to change a border of an already existing track range 
(start, end, top edge, or bottom edge), left-click inside the range of 
the existing 

the border you wish to change. As soon as you have crossed the 
border of the existing range, the range border will follow the 
movements of the mouse pointer. Once you have newly defined the 
range border, you can let go of the mouse button. The start of the 
range of a track can be changed with the arrow keys of the keyboard, 
while the range end can be changed with Shift ke

Horizontal movement of a range 
Left-click within the existing range while holding down the Shift key, 
keep the mouse button held and move the range horizontally. 

Saving and opening ranges / Special range commands 
Selected ranges can be saved using the "Range" menu or by 
pressing "Alt" and one of the function keys "F2-F10" and opened 
again with "Ctrl+F2-F10".  

"Alt + F4", however, shouldn't be used as it is a Windows command 
that closes the current screen. Similarly "Alt+F9" should not be used 
either as it is used for 4-Point Cut editing in Samplitude Music Studio 
14. In Samplitude Music Studio 14 you can redefine this keyboard 
shortcut whenever you like via "Options" > "Program settings" > 
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"Shortcuts" and "Edit menu". 

You can also save and rename ranges without any restrictions using 
Alt+F11. 

These and further special functions for defining, changing, and using 
ranges can be found in the "Range" menu. Beneath this you'll find a 
range editor dialog for the exact numerical input of ranges and the 
Range Manager (on page 251) for quick and easy viewing of and 
jumping to ranges. 

More information on ranges can be found in the menu reference point 
under "Range". 

Examples for working with ranges 
Example 1: You wish to move multiple neighboring objects to a new 
position. Instead of selecting each object separately while holding 
down the Ctrl key, you can select a range that contains all objects. 

wish to completely remove a section of a song from 

nd 

you can’t normally see the wave window. In 

You can select them using the function from the "Object" menu -> 
Select objects -> Select objects under the play cursor / range". 

Example 2: You 
the VIP window. This may be, for example, a verse of a song that 
should be cut out in order to reduce the overall length of the track. 
You can select the verse in question by dragging out a range a
activating all tracks with a double-click. Then select "Edit" > "More" 
> "Delete with time/ripple" to remove the verse. 

Example 3: You wish to play a selected range as a loop. Here you 
can modify the range borders. Before making your cuts final, you can 
preview the possible result. 

Working in wave projects 

A wave project contains the audio files. Objects in VIP refer to these 
audio files.  

Access to the wave project is through the respective wave window.  

When a VIP is open, 
order to view it as an icon, activate the ”wave project as icon” option 
in the menu window. To hide it again, select ”Hide wave project”. 
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e Music Studio 14 can 
administer many wave projects on screen simultaneously. 

Samplitude Music Studio 14 now offers real non-destructive (virtual) 

Selecting ”Destructive Edit” confines the wave project to destructive 

rrently working 
in. The wave project in the image above is thus in destructive mode.  

Position marker 

pecial line at the top edge of a project as named 
orange bars. Markers can be placed during playback as well as 

• Markers in wave projects are saved in the audio file (*.wav) as so-

• ve projects can also be viewed and set in the VIP 

• y number of markers. The first ten can be 

 to "10". You can save these by pressing 
"Shift" + "Number key". By pressing the corresponding number key 

• With the menu point "Range > Remember marker > Other"  you can 

In the title bar of the wave window is the name of the wave project, 
the bit resolution, the length of the sample and the subsequent 
memory required. To activate a wave project, the appropriate window 
must be clicked with the mouse. Samplitud

Virtual wave editing 

wave editing. Basically, wave project edits are saved in a virtual 
domain as long as editing is being processed. This saves an 
enormous amount of time when editing waves! 

In order to start non-destructive wave editing, deactivate the settings 
in the Options > project properties > Destructive wave editing mode”.  

When you select ”Wave Editing”, the wave project will by default be 
set to non-destructive editing mode. 

wave editing mode  

One can always see in the title bar of the wave window what wave 
editing mode (destructive or non-destructive) one is cu

Using markers 

Position markers serve as reminders for position points. They are 
visible as in a s

during recording. 

called audio markers and are available in this form in other 
applications as well. 
Markers in wa
object (VIP display options). 
A project can contain an
accessed directly using the number keys and receive the 
corresponding names "1"

you can jump back to the marker once again. 
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• To delete a marker, click on it and press the Del key. Markers can be 
moved by grabbing them and dragging them to where you want to 
go, the mouse pointer changes into a double arrow <->. 

• If you right-click within a marker line, a context menu will appear 
from which you have access to all important commands. 

• You can manage and name markers in the Marker Manager (Tools 
menu or Marker context menu). 

• To stretch a range between any two markers, click on the first 
marker. Then click on the second marker while holding down the 
Shift key. This selects a new range. 

• To quickly move between the marker positions, use the shortcuts, 
see Keyboard Shortcuts (menu "Range > Move play cursor > Marker 
left/right"). 

CD Markers 

CD markers are triangular markers for various CD burn functions. 
There are 

• CD Track Markers 
• CD Subindex Markers 
• CD Pause Markers 

MIDI Markers 

• Beat markers for tempo changes at a specific position in the project 
• Signature markers for changes of the beat type from the marker 

position onwards (e.g. from 4/4 beat 3/4 beat)  
• Beat marker (option "Lock musical position (bar)"). Beat markers 

assign a certain musical position to a certain part. This way, the bar 
frame/grid and MIDI events can be easily synchronized with existing 
audio material. 

Volume 

The volume levels of objects and tracks/channels can be changed at 
various stages. 

Wave Project Level 
The volume level changes are applied to the audio material with 
Effects>Normalize>Normalize File or with Fade In/Out. 

The audio data is changed. The computer usage is not affected 

define and name other markers.  
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during playback. 

Object Level 

n be performed by changing the upper handles of the object 
or with Effects>Amplitude/Normalize>Normalize Object. 

erformed in 

Th
vo ume fader in the Mixer or the 

Th  are performed in 

O

(k

as
(if ctive soundcard). 

Pl
sa

be
pa
nu

Record 

H
Th
so
or to record, the A/D Converter gathers, in determined 

its
kH ral thousand 

Every object can have an independent setting for its volume level. 
This ca

The audio data is not changed. The calculations are p
real-time during playback. 

Track Level 
e volume of every track can be changed dynamically with the 
lume automation curve and the vol

VIP. 

e audio data is not changed. The calculations
real-time during playback. 

utput Mode 

You can setup the output mode in the Playback parameter dialog 
ey P). 

With the sample rate option you can choose a different sample rate 
 playback. With Device you can select the desired playback device 

 you have more then one a

ease note that some soundcards are not be able to playback all 
mple rates.  

Note: Different recording and replay devices for individual tracks can 
 selected in the ”Track information” dialogue rather than the Play 
rameter window. Track information opens a click on the track 
mber.  

ard drive Recording 
e device used to digitize audio signals is already included on the 
und card and is called an Analogue Digital Converter (A-to-D, ATD 
 A/D). In order 

time lapses, samples of the signal that has to be digitized, measuring 
 frequency. The rate is called ”sample rate” and normally lies in the 
z ranges. KHz means a vibrating frequency of seve
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by
of

Th
si
re

kH

R
Fi
ca
eq

M st be amplified before the 

se fy signals, but the results 

am

A
lin
so

lin
C
re
Sound card mini-stereo catch sockets. You must have the 

If 
sp ket for recording. In this case, 

pr
the phones input. The disadvantage is that phones outputs are 

ly not very good. With cassette recordings, always use the 

ch ts directly to the Sound 

do

times per second. The higher the rate, the more samples are taken 
 the A/D Converter and the more natural the digital transformation 
 the sound will be. 

e precision with which the A/D Converter measures the analogue 
gnal is determined by the sample resolution. Here, too, the finer the 
solution, the better the digital transformation. 

CD-quality audio recordings are recorded with a sample rate of 44.1 
z and a 16 bit resolution. 

ecording Source 
rst of all, the Recording Source must be connected to the Sound 
rd. There are several ways to do this, depending on your 
uipment. 

icrophone: Microphone signals must fir
soundcard modifier can record them. Most soundcards have 

parate microphone inputs that pre-ampli
are rarely of a professional 

Quality. Connection to an external mixer or external microphone 
plifier produces far better results. 

mplifier: If, for example, you possess a guitar amplifier that has a 
e-out output, you can connect it with the line-in input of the 
undcard. 

stereo system: The stereo system’s amplifier usually has separate 
e-out. If instead, you see ”Aux-out-Sockets,” you should use these. 
onnect them with the Input of the Sound card (usually shown in 
d). Normally, a hi-fidelity (hi-fi) amplifier has chinch sockets, and the 

corresponding cable to connect these properly. 

the amplifier doesn’t have separate outputs (other than the loud 
eakers), you can use the phones soc

you need a cable with two mini-stereo headphone connectors. This 
ocess has an advantage: you can control the signal level through 

normal
Tape-Decks Line-Out. Often with record transfers you have no other 

oice. Never connect a record player’s outpu
card, because the phono signal must be pre-amplified first. If you 

n’t have a pre-amplifier, the only way to do this is via the phones 
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D
or

R
so

rding 
Dialogue. 

 recording 

co an reduce the incoming signal only by using the 

D

of the resolution 

sh

Th
th  maximum setting 

Di
W
th

AD
of
sa
St
co

For this to occur correctly, you must first set the sample rate of the 
 Recording Dialogue. Click on the Dev. Button 

C
So

N
yo

output or an external amplifier 

Adjusting the Signal 
igital recordings through the Sound card need optimal control in 
der to obtain the best sound quality. 

Once the recording source is connected to the Sound card, open the 
ecording Dialogue with the Record Button and start the recording 
urce. 

You can check the control on the LED displays in the Reco

If the level is too high, reduce the incoming signal. If the
source is connected through the amplifier or tape deck’s Line-Out 

nnectors, you c
Sound card’s Mixer Window. This is located in the Recording 

ialogue under the Level Control tab. 

If you reduce the input sensibility with the Sliding Regulator (fader), 
you also reduce, in many sound cards, the precision 
with which the analogue signal is digitized. This is why these controls 

ould be kept at the loudest possible setting! 

e standard for optimal adjusting is naturally the loudest section of 
e material. This should be turned to the

gital Transfer 
ith the Recording Function, digital audio data can be transferred to 
e hard drive through a digital interface (e.g. S/PDIF or ADAT). 

AT or DAT Recorders normally produce data with a sampling rate 
 48 kHz. For a CD Project with 44.1 kHz you must convert the 
mpling rate. This is carried out in real time by Samplitude Music 
udio 14. The digital signal is read at 48 kHz but is automatically 
nverted and inserted into the project as an audio file at 44.1 kHz. 

incoming signal in the
in the Recording Dialogue. In the following Dialogue, Sound card 

haracteristics, set the audio recording formats supported by the 
und card. 

ow, connect the digital output of your recorder to the digital input of 
ur Sound card – and start recording! 
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24
Audio files in Samplitude Music Studio 14 can not only be recorded in 
16 bit quality, but also in far superior 24 bit resolution. Simply click 
the ”device” button in the recording dialogue, and select the ”24 bit” 
option under ”soundcard properties”. 24 bit recordings require a high 
quality audiocard with 20 or 24 bit converters, as well as a 24 bit-
compatible NME drive. 24 bit audio material can also be transmitted 
via audiocards with SPDIF digital interfaces. 

We have had positive experiences with the 24 bit audiocards 
produced by Marian, RME, SEKD and Terratec. 

The high resolution audio files are stored and edited in the 32 bit 
”floating point” file format by Samplitude Music Studio 14. This 
ensures the full 24 bit quality independent of the gauge. The 
dynamics may increase to over 140 dB, while the recording’s 
jamming transmission sinks, according to the type of audiocard, to 
110 dB and more. Thanks to floating point processing, there is no 
need to worry about internal editing being distorted. Floating point 
processing only starts to distort at around 1,500 dB above zero – in 
contrast to a 16 bit signal that distorts immediately once the zero dB 
line has been traversed. 

Even in cases whereby audio material is intended for burning onto a 
16 bit CD, it is worth selecting 24 bit recording because all effects 
calculations are made in a higher quality and therefore no ”rounding” 
mistakes can be detected in the audible 16 bit range. 

24 bit recordings (via storage as 32 bit float files) take up twice as 
much storage space on the harddisk as 16 bit recordings. But with 
current harddisk storage capacities, it works out as a good 
compromise when one considers the increase in quality. 

High resolution audio files can be imported and exported as 24 bit 
WAV files, enabling trouble-free file exchange with other high quality 
audio systems. 

Further Recording Dialog possibilities 
The recording dialog also offers 

• a string instrument tuner for creating the best sound possible before 
recording. Deviations from the standard pitch are graphically 
displayed. 

• the option of laying track markers (either manually or automatically) 
while recording a CD.  

• the possibility of directly incorporating a variety of audio formats e.g. 

 bit audio support 
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Please read the “Recording Options” section of the “Playback Menu” 

to save fixed-disk space. 

chapter to learn about all of the Recording dialog options. 
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Tips & Tricks 

. 
• A range can be selected from one exact marker position to the next 

by clicking on the marker above the waveform. Next, hold the Shift 

use click a range can be moved horizontally. 
• Shift + Ctrl + Cursor keys will flip a range to the right or left. This is a 

Pressing 
Shift + Tab will open a dialog window in which you can set the 

volume curve you can 
create and delete volume handles. Activate the volume automation 

 you to lock objects to prevent for 
example accidental movement. This is especially useful for multi 

resents (for example: 4) in the Section Free Bar 
Snap. Next, click on the button Get Range in the section Free Bar 
Snap to retrieve the length of the selected range. The BPM display in 

 Snap section now displays the BPM of the audio 
section. 

seful functions depending on the window component you 
clicked on. Among them are objects, Record and Mute buttons, and 

A few tricks that help make working with Samplitude Music Studio 14 
easy: 

Working in Projects 
• The ‘a’ key will select the complete sample as a range. 
• With the keys Home and End you can set the play cursor to the 

beginning or end; all selected ranges will disappear

key and click on the second marker. 
• Using the Shift + mo

great way of testing a loop at a different position. 
• Objects in Virtual projects can be displayed in two different modes. 

By pressing the Tab key you alternate between the modes. 

parameters of the display modes. 
• Using Ctrl + mouse click on an object copies the object. 
• Double-clicking the mouse button on the 

curve with the V-button in each track of the VIP! 
• Change the function of the mouse buttons in VIPs with the menu 

Preferences>Mouse Mode or use one of the Mouse Mode buttons in 
the Mouse Mode toolbar! 

• The function Lock Objects allows

track recording when the individual tracks need to stay in sync with 
each other. 

• To determine the tempo of a selected range (BPM), open the Snap 
Definition dialog (Shift + ‘r’) and select the number of beats the 
selected range rep

the Fixed Bar

• Try the right mouse button on various components of the VIP 
window! A context sensitive pop-up menu is displayed, which 
features u

the scrollbars. 
• The Delete key deletes markers when the Play Cursor (real-time 

cursor) is located exactly on the marker. The same key deletes any 
selected objects and deletes ranges that are selected. 
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ct is 
separated on the range borders, which results in three objects. If the 

adds smooth crossfades at the 
separation points. These crossfades can later be edited for further 

 the lower 
left-hand corner of the Virtual project window. Use the Shift + left 

ed with the Shift + left 
mouse click to store a complete window configuration set. This 

lected by holding the Ctrl key and 
individually clicking on the desired object. 

r window to the Samplitude Music Studio 14 window. A 
special menu option is available to open the Explorer from within 

isplay the VIP Display Mode dialog. This 
dialog allows you to change the VIP Display aspects such as the VIP 

• When pressing the Return key, all open windows are tiled on the 
Samplitude Music Studio 14 screen. This is a good starting point 
when using drag & drop functionality to move ranges and objects 
between individual project windows. 

• Use the menu option Edit>Edit Tracks to manipulate complete 
tracks. This includes adding new tracks, inserting tracks and 
rearranging tracks. 

Mixer 
• Clicking the right mouse button on a Mixer effect control knob or 

element opens the associated effect dialog. 
• A double click on the middle of a control knob or element returns it 

to the passive default setting. Another double click resets the 
element to the previous position. 

• The key t separates a selected object at the position of the Play 
Cursor. If a range is selected within the object, the obje

Auto Crossfade mode is active while the separation takes place, 
Samplitude Music Studio 14 

refinement. Use the Crossfade Editor to change the crossfade 
aspects. 

• Multiple zoom levels can be saved to the four Z buttons in

mouse click to store a zoom level to a specific preset button. When 
clicking on a previously assigned preset button, the zoom level is 
recalled. The S preset buttons can be us

includes the scroll position of the window and the Mute/Solo 
assignments for the tracks. This offers four Mute/Solo groups that 
can be quickly recalled. 

• Multiple objects can be se

• Holding the Shift key and clicking the mouse button behind the last 
object you want to select can select objects between two points. 

• WAV, HDP, and RAP Projects, as well as stored objects can be 
opened with the Windows Explorer by dragging them from the 
Explore

Samplitude Music Studio 14 with Tools> Explore the HDP Directory. 
The default folder opened in Explorer is the same as the HD-Project 
setting in the System dialog (Shortcut: ‘y’). 

• Shift + Tab can be used to d

window behavior when an object or range is moved toward the 
confines of the currently displayed window borders (VIP Border 
Scroll). 
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• Clicking on the left or right outer limits of a control knob changes the 

indow, multiple channels can be soloed 
simultaneously. When holding the Shift key and clicking on a Solo 

 is soloed. 
• The Master Normalization function in the Mixer window can be used 

to instantaneously adjust the output level to 0 dB, no matter how 
loud or soft the master output signal is. 

Performance 
If errors occur during playback, you have the following options: 

• Increase the VIP and HD buffer in the "System" dialog ("Y" key). 
• Zoom out to project full view (button "A" at position bar") 
• Deactivate the "Autoscroll" function in the "Playback parameters" 

dialog (key "P"). 
• Reduce the number of displayed image elements of the VIP window 

in the dialog "Object display in virtual projects" (Shift + Tab). 
• Bounce several tracks by Mixdown and mute the original tracks. 
• Reduce the used realtime effects in the object editor or mixer. 
• Do not use plug-ins as they increase the CPU load. 
• In Windows NT the playback performance of the hard disk system is 

particularly good if the corresponding files are played for the first 
time. So, if a VIP with many tracks is not played perfectly, save it, 
close all windows (key "h") and open the VIP agein. Now the NT file 
system performance is optimum again. 

• It often helps to run two copies of Samplitude Music Studio 14 at the 
same time (simply start it twice from the Desktop). This allows you to 
work on an extensive effect processing, a longer recording, the
creation of a CD, or any other unattended procedure, while working 

 and stopped with 

d with the 0 key on the numeric keypad, the 
cursor will stop at the current playback position. Continuing to hold 

setting in individual increments. 
• In the Mixer w

button, all previously soloed channels are un-soloed and the single 
channel

 

on another aspect of a second VIP or project. When working on dual 
processor systems in Windows NT, both instances use the full 
capacity of one of the processors. Even under Windows 95 this 
technique can be used to work more effectively. Make sure you 
disable the option Check Space Bar for Playback… in the System 
dialog (Shortcut: ‘y’) to prevent the program in the background to 
stop any process. 

Recording/Playback 
• The Recording window can be displayed by pressing the shortcut 

key r. The recording can be started with the key r
the key s when the Recording window is displayed and active. 

• The playback can be started and stopped with the Spacebar. When 
stopping, the Play Cursor returns to the original position. If the 
playback is stoppe



 

Functional overview 73  

 

www.magix.com

the 0 key, while moving the mouse (Scrubbing) can alter the exact 
position. 
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of high-quality effects and 
effect plug-ins ("MAGIX plug-ins") as well as interfaces for external 

ins and DirectX plug-ins. 

hey 
used? 

ifference between the effect types. The 
following effects occur in Samplitude Music Studio 14: 

 effects are also referred to as "non-
destructive" or "virtual" effects. They are added to the original sound 

ard drive. 

iginal file is changed or a copy is created on the hard 
drive for working in. 

These effects are independent effects modules, i.e. they are provided 
ic Studio 

14 we distinguish between three types of effect plug-ins: "MAGIX 
tX plug-ins" and "VST plug-ins". 

The place of use is a further criteria for effects. The following are 

e accessed via the Object Editor or the 
Realtime Effects menu) 

• Track Effects (can be accessed via the trackbox plug-in selection 

n be installed identically for several tracks, or individually. 
• Surround effects (accessible via the Insert selection box of the 

 for editing surround material. 
• Master effects (can be accessed via the Master section of the 

Effects and effect plug-ins 

Samplitude Music Studio 14 contains lots 

VST plug-

What effects are there and how are t

In general there is a d

Realtime effects: These

while it is played. This means that the original file remains unchanged 
on the h

Offline effects: These effects are also called "destructive effects". 
They are added to the audio file before it is played. This means that 
either the or

by third party vendors or programmers. In Samplitude Mus

Plug-ins", "Direc

integrated into Samplitude Music Studio 14: 

• Object Effects (can b

• Wave Effects (can be accessed via the Offline Effects menu) 

button or the trackbox plugin) 
• Mixer channel effects (can be accessed via the Insert section of the 

Mixer): These realtime effects affect track effects the same way as 
complete tracks. 

• AUX effects: (accessible via the Track Editor and Track Box): These 
effects ca

corresponding surround bus channel, Track Editor and Track Box): 
These effects serve
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Most of the effects modules - equalizers, compressors, reverb, echo, 

. All 
effects and effect plug-ins that are NOT offline effects, and can be 

ed via the Offline Effects menu, are explained in the following 
sections of this chapter. The other effects that, amongst other things, 

gram directory). 

If a preset is not located in this directory, it still can be loaded via the 
 the 

ll need to browse for it. 

Effects that are added/launched from within the Mixer or Object 
Editor are pre-configured with the values assigned to the Virtual 

y to apply the settings of the last 
destructive effect, a corresponding entry can be found in the Options 

ult parameters for 
destructive editing. 

Noise Level: Set the Dehisser’s input threshold as precisely as 

of the hissing produces artefacts and should be 
avoided. High settings produce dull results. Useful signals (e.g. the 

Mixer): These effects are for editing the master sound. 

etc. - can be used in several of the above versions. However, they 
are only described at one position within this documentation

activat

can also be activated via the chapter "Offline Effects", are described 
in more detail in the "Offline Effects menu" chapter. 

Saving Effect Parameters (Preset 
Mechanism) 

The effect dialogs contain Preset selection boxes. These presets are 
saved and recalled to/from the 'FX-preset' directory (a sub-directory 
of the main Samplitude Music Studio 14 pro

'Load Setup' function, but it will not automatically appear in
selection box, so you'

Project. If the Virtual Project is to adopt particular changes made to 
the settings in the effect dialog, you will need to click on the OK 
button to transfer them to the VIP. 

You also have the possibilit

box. If there is no destructive application of the effect, the parameters 
selected in the list entries will be applied to the defa

Dehisser 

The Dehisser eliminates regular ”white” noise, typically produced by 
analogue tape recordings, microphones, pre-amplifiers, or 
converters. 

possible. Low settings result in incomplete deletion of the hissing. An 
incomplete deletion 
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Audiotype: Lets you set the audio material that is to be edited; the 

Noise Reduction: Here you can set the attenuation of the hissing in 

 Hiss: To test your results, you can listen to the filtered-
away part of the music prior to downloading or burning onto a CD. 
(Remember this is for test purposes only.) 

Quality: The processing quality can be set in two stages. You can 
use this to precisely adjust the values in the dialog for standard 
quality adjustment without skipping playback, and can then select a 
higher quality for final burning. 

Adaptive: The value for the noise level parameter is set automatically 
by determining the hiss contained in the signal. If the noise level value 
is changed, its effect is then relative, i.e. the resulting value is 
determined from the automation as well as the noise level fader 
settings. 

One advantage is that you no longer have to set the noise level value 
manually and that this value can also be adjusted later if the noise 
share fluctuates, for example, if you use music tracks with differing 
hiss levels within one project. 

If the noise level is constant, a better result may be obtained manually 
(Adaptive off). However, the noise level value must then be set 
precisely. 

blow of a wind instrument) that are similar to hissing are also filtered 
away. If the level of the hissing is low, the setting is no problem. 

algorithm is adjusted accordingly. 

decibels. Often it makes sense to reduce the hissing by only 3 to 6 
dB in order to keep the audio material sounding natural. 

Removed
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Sound FX (object editor, mixer channels, 
mixmaster) 

Sound FX features an Effects rack with the following virtual effects 
devices: 

 

Equalizer 
The 10-track equalizer divides the frequency spectrum into 10 areas 
(tracks) and supplies them with separated volume controls, which 
allows you to achieve many impressive effects, from the simple rising 

vel, it can cause 
ster volume using the master 

of the bass, to total sound transformation. If you raise the low 
frequencies too much throughout the whole le
distortions. In this case, lower the ma
volume control on the main screen. 

Thumb controls: All of the 10 frequency areas can be raised or 
decreased separately by the 10 volume controls. 

Link Bands: Using this switch you can match the frequency areas in 
a flexible way to avoid the overemphasizing of single frequency areas 
that sound artificial. 
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have selected a preset for the effect and later you change 

nd effect into the neutral starting position 
where no processing power is used and where no effect is calculated 
in the sound. 

assages 
become louder. Compression is often used to make the material 

The processing is realized ”in advance” as occurs in high-quality 

d of the compressor can be intuitively 
altered with movement of the mouse.,  

t the entry threshold, under the 
compression. 

 is reduced or raised. 

 and later you change 
it manually, you can compare the original-preset-sound with the new 

s using the A/B-switch. 

where no processing power is used and where no effect is calculated 

A/B: If you 
it manually, you can compare the original-preset-sound with the new 
adjustments using the A/B-switch. 

Reset: Reset inserts the sou

Touch-screen (right EQ-Section): This is the ”sensor-field” of the EQ: 
Use your mouse to draw a curve that will be transferred immediately 
into the corresponding EQ control adjustment. 

Compressor 
The compressor is essentially an automated dynamic volume control. 
Tune dynamics are limited, loud passages stay loud, low p

more powerful. The degree of compression is adjusted by the ratio 
control, and the ”Threshold” determines the entry threshold. Rise and 
decrease of time can be influenced by Attack and Release. 

studio equipment. This means that there won’t be any overdriven 
peaks or other artefacts, as the algorithm can never be ”surprised” by 
the peak levels. 

Sensor-Field: The sensor-fiel

Ratio: The parameter controls compression intensity. 

Threshold: Here you can adjus

Attack: Here you can adjust the time in which the algorithm responds 
on the rising level. Short attack times can produce a ”pumping” 
sound, as the volume

Release: Here you can adjust the time in which the algorithm 
responds to decreasing levels. 

A/B: If you have selected a preset for the effect

adjustment

Reset: Reset places the sound effect into the neutral starting position 
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ound. 

ly-developed real-time effect that 
simulates tube amp sound properties. It is especially suitable for 

Amp Model: Here you can select from a range of amplifiers whose 
sound can be simulated. 

Speaker Model: Here you can select from a range of speakers whose 
sound can be simulated. 

EQ-Section: A 3 band equalizer for setting the bass, mid-tones and 
treble. 

 following automatic 

s distortion in typical analog amplifier fashion. 

ly with ‘room size’, ‘time’ and ‘colour’ and mixed into the 

 it sounds as if the audio 

 i.e. the fading 

in the s

Load/Save: Here you can store the current adjustments as an effect 
file in order to use them for other projects. 

AmpSim 
The Ampsimulator is a new

guitar sounds, but also for the organ or recordings of vocals. 

Bright: The Bright button is for a particularly sharp sound display, 
that can be jarring when used with the
controllers:  

Distortion: Create

Volume: Controls the entire volume of the amplifier module. 

Echo / Reverb 
Reverb 

Reverb supplies a high-quality reverberation which can be defined 
more close
original sound with ‘mix’. 

You can choose between various reverb styles in the presets. 

Room size: This control button controls a room simulator which 
calculates the reverb effect in dependency on the room size. If the 
control is turned completely to the left,
object has been recorded in a tiny room, turned completely to the 
right, one can listen to the object as if it had been recorded in a 
cathedral.  

Time: Here the length of the ‘reverb trail’ is determined,
phase of the sound. 
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rsa.  

Echo: The echo effect is defined more closely with ‘delay’ and 

ividual echos can be 
determined; the more you turn the control to the left, the faster will 

Feedback: Here the number of echos can be adjusted. Turned 
, there is no echo at all, turned completely to the 

mix master) 

Colour: Here it is possible to control the type of reverb – rather dull 
than high-pitched or vice ve

Mix: This control determines the mixing ratio between the unedited 
original sound (‘dry’ signal) and the reverb portion (‘wet’ signal).  

Echo 

‘feedback’ and calculated into the original sound by means of ‘mix’. 

Delay: Here the period of time between the ind

the echos follow each other.  

completely to the left
right there are virtually endless repetitions. 

Parametric Equalizer (mixer channels, 

 

This dialogue contains a 4-Band parametric equalizer. You can adjust 
the sound of your sample activating filters on three independent 
frequency bands. This allows you to raise the bass and treble in a 



 

Effects and effect plug-ins 81  

 

www.magix.com

r, you will first have to highlight an area of the current project 
or the entire project with the a-key (wave-projects). 

ludes one equalizer per 
channel that works in real time and does not modify the saved audio-

n-destructive manipulation process). 

Q: Here you can set the frequency-spectrum of each filter between 
10

Gain: These switches control the activity and intensity of each filter. If 
 system 

resources. 

Volume: This button controls the general volume should the filters 

Setup A/B/C: Here you can switch between three various setups so 

broad spectrum as well as making very specific corrections in the 
dynamic frequency spectrum. 

Howeve

Don‘t forget that the mixer (m-key) also inc

material! (No

Frequency: Adjust the middle frequencies of the different filters 
between 10 Hz and 24 kHz using these switches. As your choice is 
completely unrestricted, you can also set various filters to the same 
frequencies in order to obtain more pronounced effects. 

 Hz and 10 kHz. 

the switch is set to 0, the filter will be inactivated, saving

produce an extreme increase or decrease of the individual levels. 

that an acoustic comparison between the various settings can be 
performed, for example, during the preview function (Play/Stop 
button). 
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zer 

nal 

e basic sound of the mix by increasing and 
it more “depth” (lower center 

lso decrease the 
 frequency response to 

d in 
hic. The frequency is spread out horizontally, the increase or 

 frequency, vertically. The blue bullets 1-4 
ave bands. You can move them around with the 

The parametric equalizer consists of four filter bands with which you 
can mainly form the sound of the music track. Each band is a filter 
with a typical “bell shape”. Within a certain frequency range around 
an adjustable middle frequency you can increase or reduce the sig
level gain. The width of this frequency range is called bandwidth. The 
bandwidth is defined by the Q value. The higher the Q value, the 
narrower and steeper the filter curve. 

You can influence th
decreasing the broadband so as to give 
200-600 Hz) or more “air” (Highs 10Khz). You can a
narrowband width (high Q-value) in the
remove, for example, disruptive frequencies. 

Graphic: The resulting frequency path of the equalizer is displaye
the grap
decrease of the respective
symbolize the four w
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y response. 

utput level of 
the equalizer. The adjacent master gain controller can be used to 

Edit: The “Edit” button opens the fine-tuning for the four bands: 

Parameter selection: With the buttons on the right you can select the 
parameter that can be adjusted with four faders of each band. 
Furthermore, there are number keys to enter every parameter of the 
bands. 

Gain dB: These controllers allow you to raise or lower the filter. 
Setting the controller to 0 deactivates the filter and doesn’t use CPU 
power.  

Freq. Hz: The center frequency of the individual filters can be set 
between 10 Hz and 24 kHz with the frequency controllers. Freely 
choosing the frequency enables multiple filters to be set to the same 
frequency in order to have a greater effect. 

Q (Bandwidth): Here you can set the bandwidth of the individual 
filters to between 10 Hz and 10 kHz. 

There is still a peculiarity among bands 1 and 4: Their filter curve can 
be changed from a normal “Peaking” EQ filter to “shelving” (this is the 
basic setting) and high (band 1) or high-cut (band 4). When using the 
“shelving” filter, a soft increase or decrease in all frequencies 
happens above or below the filter frequency, the Q parameter does 
not have a function here. With a low-cut or high-cut filter, all 
frequencies below (low-cut) or above (high-cut) the set frequency are 

mouse until you find your desired frequenc

Peakmeter: With the peakmeter you can control the o

balance the level with the EQ. 

filtered out. 
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io material 
in the stereo panorama. Whenever a stereo recording sounds 

-width can p ovide 

Stereo FX 
The Stereo-FX-Enhancer allows you to reposition your aud

undifferentiated, the extension of the basic stereo r
a more transparent sound. 

 

Basic stereo width controller: Here you can adjust the width of the 
basic stereo panorama from mono (leftmost side), over unchanged (in 
the centre) to maximum width (”Wide”, rightmost side). When setting 

orama to smaller values, the sound level may rise. In 
an extreme case – it means that if the left and right channels contain 

dio materi l 
”mono” – the sound lev

sing e ba
mono sound compatib
that have been manip  such a manner will sound hollow 
during mono playback. 

r: Adjust 
 dampin

indicated in dB values under the controllers. This allows you to 
n orig ally 

inside the stereo panora

Stereo-meter (correlati
phase position of the
orientation of your signal inside the stereo panorama and the effects 
caused by the Stereo-Enhancer.  

In order to achieve the best possible mono-compatibility, the graphic 
should resemble a diagonal line. If not, some frequency areas may 
eliminate each other when the stereo signal is played back on a 
mono player. 

Karaoke Preset: THis preset opens a special karaoke effect that 
more or less eliminates vocals during playback by deleting middle-
range frequencies typical for the human voice when singing. This 

the stereo pan

identical au a and the Basic stereo width controller is set to 
el increase can be as much as 3 dB. 

While increa th sic stereo width (values exceeding 100) the 
ility gets worse. This means, that recordings 
ulated in

Volume fade
panorama. The

the volume for each channel and the stereo 
g for the left and the right channel will be 

reposition a in centred recording to the right or to the left 
ma.  

on indicator): This is a graphic display of the 
 audio signal. Here you can check the 
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meone else to take over the singing.   

Multimax 
The MultiMax is a compressor with three independent frequency 
bands. The dynamic processing takes place separately for each 
band. 

The main advantage of a multi-band compressor over a ”normal” 
compressor is that warping and other bothersome side-effects are 
reduced drastically by the dynamic processing. This means, for 
example, that a single peak level in the bass section will not drag the 
level of the whole signal down. 

Otherwise, the multi-band technology enables precise treatment of 
individual frequency bands. 

allows so

 

Frequency Band Settings: Made directly in the graphic display. 
Simply click on the dividing lines to shift them. 

expander: Too high compression will result in audible noise 
(usually defined as a pumping sound). Particularly radio recordings 

(interval between the quietest and loudest part). The Expander 

Bass/Mid/High: Regulates the degree of compression for each 
frequency band.  

Limiter: The MultiMax contains a limiter that harmonizes levels so 
that, for example, too high a level is automatically reduced, and quiet 
passages remain unaffected. 

Presets 
Two further special functions can be called up by using the presets in 
MultiMAX. 

Dynamic 

are recorded with very high compression rates to increase the 
perceived volume. Unfortunately compression reduces the dynamics 

enhances the dynamics of the recording. 

Cassette NR-B decoder: Samplitude Music Studio 14 simulates 
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tirely below a 
certain noise level. This lets you create, for example, song transitions 

-free. 

Leveler: This function brings the entire material up to a uniform 

een different songs, also use the 
function “Volume adjustment” function in the effects menu. 

ts remove overemphasized “s” sounds 
in speech recordings. ezialpresets dienen zur Entfernung von 

decoding of Dolby B + C noise suppression if no Dolby player is 
available. Cassettes recorded with Dolby B or C sound more muffled 
and slurry if played back without corresponding Dolby. 

Noise Gate: This Cleaning function suppressed noise en

that are entirely noise

volume automatically. The volume control handle is made void. Larger 
volume differences can therefore be adapted within a song. To 
balance volume differences betw

De-Esser: These special prese

überbetonten Zischlauten in Sprachaufnahmen. 

Tip: The limiter can also be used independently of the MultiMax. 

Digital Audiometer 

ter, which provides separate control method displays for 
every channel for 10 wave bands. This device is used for orientation, 

On the lower border of the MAGIX Mastering Suite there is a digital 
audiome

for example, for selective equalizer editing. 
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Vintage Effects Suite 

Analog Delay 

 

is delay offers creative playing along with common delay effects. 
nalog" in this case means, for instance, that you can change the 
lay times while playing without the risk of typical, scratching 
tefacts developing. Instead, the times are softly faded out, similar to 
e old tape echo machines that used the tape spee

Th
"A
de
ar
th d to change the 

An
tim
sl
ba
de

You can use these characteristics to your advantage, creating for 

means that you can not digitally overdrive the delay. Even in a 

delay and where the system also had a certain sluggishness.  

alog Delay emulates the tape echo units of old, where the delay 
e was determined by the tape speed and speed changes were 

ow and affected the pitch. („Feedback"). The feedback has a two-
nd filter that can be used to create dark, high or mid repetitions 
pending on the settings.  

example ‘out-there’ dub/reggae-style delays that become less 
defined with each repetition and are slightly warbled. Here "Analog" 
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etition the signal can not be distorted indefinitely but 
compressed by an increasingly slight degree and distorted similar to 

Analog delay parameter 
Analog Delay has the following parameters: 

Delay Type 

Delay Type (L + R): Left and right delay times can be controlled 
separately (see below). You can choose a note value for the control 
pots to snap to. Even and syncopated note values from 1/2 to 1/32 
are available. Note that the delay times are always in relation to the 
project’s current tempo. 

'looped' rep

a tape. 

Link button (lock symbol): Press this button to control the “Delay 
Type” pots for both channels simultaneously. 

Mix: Adjusts the ration between the original signal and echo. 

 drastic warbling. 

tting at the 9-11 o’clock position. 

Modulation 

Speed: The tape warble speed. Low values result in very light 
fluctuations, high values result in

Depth: The warble intensity. When this control is turned all the way to 
the left, there is no pitch modulation. For a subtle ‘analog’ feel, we 
recommend a se

Filter 

"Low" This control progressively reduces the bass 
frequencies as it is turned to the right, making the 
signal sound ‘thinner’. 

"High"  All the way to the right, the control only attenuates the 
treble very lightly; turned to the left, the delay 
repetitions become progressively less treble. 

Width: This controls the stereo width of the delay repetitions. When 
to the right, a further effect is achieved: the panning 

Drive: When this control is turned all the way to the left, the delayed 

Feedback 

you turn “Width” 
of the delays increases. This is commonly referred to as a ‘ping-
pong’ delay. 



 

Effects and effect plug-ins 89  

signal is repeated only once. Turned all the way to the right, the 
feedback is seemingly endless and the repetitions continue for a long 
time.  

 

www.magix.com

u send a "loud" signal to the 
delay, the feedback will sound longer than at a lower level as 

ession "brings it up" to a certain level. If you are used to 
"purely digital" delays you may require a short adjustment period. 

Flanger 

The actual strength of the effect is dependent on the material as the 
feedback loop - as explained earlier - is addressed via compression 
and uses a "tape saturation" effect. If yo

compr

However, will most probably sound "livelier". 

 

The "flanger" effect is similar to the chorus, although it has a different 
history: It was developed by coincidence: someone (according to a 

er brief delay of the second signal compared to 
the first resulted in cancellations within the frequency spectrum, 

creates "peaks" and "lows" in the spectrum that look familiar to the 

legend it was actually John Lennon) briefly slowed down one of the 
reels of two tape machines that were linked together.  
The result: the rath

leading to a so-called comb filter effect (the sum of both signals 
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 up, a familiar flanging 
effect is produced – the sound characteristics of a jet engine warming 

“Normal”: Flanging. 

“Dual”: Two parts, panned left and right.  

alternatingly panned left and right. 

: Like “Quad”, but the “Depth” control also sets the 
 right. 

teeth of a comb).  

Flanging is basically a chorus effect that modulates a shorter delay 
time (under 10 ms). Flangers do not strive to double or disembody a 
sound like a chorus but aim to manipulate its frequency range.  

When the “Feedback” parameter is turned

up. 

Flanger parameters 
Speed: Modulation speed. 

Depth: The overall amount of modulation. 

Feedback: The volume of the internal feedback loop. 

Mode:  

“Quad”: Four parts, 

“Quad Pan”
intensity of the signal’s pan movements between left and
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"Filter" is a modulation effect like Chorus and Flanger. However, it 
controls the frequency range and modulation source instead of the 
pitch. Therefore it has different filter types and modulation times. 
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The filter is ly effective for synth sounds (‘filter sweeps’ on 
ospheres) and for creatively manipulating drum loops 

Filter parameters 

n or dotted). Like in the Analog Delay, the tempo 
information is automatically provided by the arrangement.  

 final position of the controller: 

particular
pads and atm
(such as for variations, fills etc.). It can also be used on guitars to 
produce the well-known ‘wah’ effect. Either with tempo modulation or 
a special mode, modulation via the current signal strength above the 
cut-in frequency of the filter. 

Speed: The modulation speed is set by note values ranging from 1/1 
to 1/16 (eve

 A peculiarity of the
Tempo synchronization stops and modulation is controlled via the 
signal level. 
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i.e. the modulation 
increases the filter frequency.. 

lation depth, that is, the 
amount by which the speed control (or envelope mode, as described 

al y to the left and “Depth” all the way to the right. 

Fi

Lo

Freq: This is the base frequency for modulating the filter. This 
generally takes place above this frequency, 

Depth: This control determines the modu

above) increases the base frequency. For extreme effects, turn “Freq” 
l the wa

lter Modes 

w-pass  A filter with a slope of 24 dB/octave and a small amount of re
treble frequencies above the base frequency (cut-off frequen
steeply. This is great for filter sweeps on synth p

and-pass 
ads and dru

B  Only the frequencies around the base frequency are passe
(24 dB slope with resonance). Use this mode to create w
guitars. 

Band  Two parallel filters (–36 dB) with linked base frequencies cr
in the frequency spectrum. This allows you to create interelimination 

(„Notch-Filter") example, guitar chords. This sounds similar to a

High-pass 

 phaser. 

 This mode achieves the opposite effect to the lo
below the base frequency are filtered steep

w pass filter
ly. If you ‘thin out

track (for example, a drum track) with a tempo-based modul
ull-range fresound very effective when contrasted with the f q

(for example, if the filter is turned off for the next

 

 object). 
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Chorus 

 

Chorus creates a ‘floating’ sound typically associated with guitars 
and synth pads. It can acoustically ‘thicken’ an instrument, making it 

which first 
increases and then decreases, thus also changing the sound pitch. If 

ilarly short if you were to double a guitar track for 

sound fuller or creating the illusion that several instruments are 
playing.   

The Chorus sound is created by using the so-called doubler effect. 
You probably have noticed this phenomenon daily life: The sound of 
an approaching ambulance sounds higher than when it is moving 
away. This effect is a result of the speed of the sound 

there were a second siren at your location, an oscillation would 
develop between both sounds (just like when two instruments are out 
of tune). 

Chorus also splits the signal in at least two: direct sound and effects 
part. The double effect is created by a short signal delay of the effect.  

This delay is within the range of 10-30 ms (as in this one), this means 
that it is short enough to be perceived as an "echo".  The times 
would also be sim
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rifting. 

 control the floating effect: 

ce vibrato-like qualities but can also 
result in an ‘under-water’ effect. 

rmines how strongly the speed 
affects the pitch modulation.  

 the balance between the direct signal and the effects 
signal.  

Mode: You can choose between four operating modes of the Chorus 
effect:  

“Normal” is a combination of the direct signal and the detuned delay 
signal.  

“Normal, low cut” is designed for bass-heavy signals such as bass 
guitar. The bottom end of the signal stays clear and well-defined, the 
effect is only audible for the mid and treble frequencies.  

“Dual” makes the source sound more lively than a single ‘part’. The 
sound is spread over the stereo panorama, which makes this mode 
seem ‘wider’. This makes the character of the sound livelier than with 
a single voice only. It is also distributed over the stereo panorama so 
that this mode sounds "broader". 

“Quad, low cut” is ideal for creating sounds such as deep synth pads 
with tight bass frequencies. 

instance. A short delay in the mix already sounds "doubled" but is not 
authentic. This is where the above-mentioned "out-of-tune" effect 
comes in: the pitch of the effect signal is slightly modulated by gently 
"drifting" forward and backward in the delay curve. The result is a 
floating effect where the speed is influenced by d

Chorus parameters 
You can enter the following parameters to

Speed: Modulation speed. Low speeds create an even, continuous 
development. High speeds produ

Depth: Modulation depth. This dete

Mix: This sets

Tip: Like on the stomp boxes our vintage effects are modeled on, 
there is a ‘footswitch’ below the pedal’s logo that can be clicked to 
turn the effect on or off for A/B comparisons. All the effects of the 
Vintage Effects Suite have been designed like this. 
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Distortion 

  

The distortion pedal is a “high gain” distorter for crunch and lead 
guitar sounds. If you like typically “British” amp sounds and want to 
quickly record a guitar track with little effort, this pedal is for you. 

An entire valve pre-amp circuit has been modeled, including the 
typical EQ curve. The amplification is “valve-typical”, i.e. it doesn’t 

There are only three parameters on this effect; however, these 

• Low: the “bass” controller. This allows you to set the share of 

start quickly but is harmonic and soft. Even at full power the pedal 
still reacts softly to a guitar and its settings (e.g. pick-up choice and 
tone controller). For instance, you can influence the distortion even 
more by using the volume knob on the guitar. 

interact with each other and can thus generate quite a variable 
sound: 

basses, even after the distortion. The type of prefiltering is important 
for guitar amps in particular, and is characteristic for the basic 
sound. You should set the bass controller depending on the basic 
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 of the guitar and the sound you are aiming for (“powerful” or 
“cutting”). 

• High: Mainly controls the share of highs before and after the 
 not using an external guitar speaker as a 

monitor, we recommend setting the controller to the middle position 
sharp” highs 

. This controls the amplification used to 
operate the “virtual valve circuit” (max. 60dB). As the level increases, 

rovides the usual “weight” for power rock chords and more. 
The further you turn this controller to the right, the more the mids of 

“high-gain” lead sound is 
better heard. 

sound

distortion. If you are

or even moving it slightly to the right. This way the “
disappear, which all guitar amps generate without the suitable 
loudspeaker. At the same time the mids stand out more, which gives 
the sound more “kick”. On the other hand you can further emphasize 
the highs if you want the sound to be more neutral. 

• Drive: The level of distortion

the valve goes into overdrive and generates typical distortions. For a 
slightly distorted sound (“Crunch”) it is surely sufficient to set the 
controller to 10-11 hours at maximum. Furthermore the modeled 
circuit p

the signalmove to the fore so that the 

You can also use the distortion effect in combination with the amp 
simulation. 

B  (only available as a download after registration) itMachine

  

Audio material can always be edited into high quality with Samplitude 
Music Studio 14. Nevertheless, there are situations when, for 
example, a more imperfect lo-fi sound would perfectly suit a drum 
loop or a synthesizer sound. 

Remember, for example, the first hardware samplers from the 80s 
that usually only ran in 8- or 12-bit resolution and at low sample 
rates. With the BitMachine, changing the sound with such an 
„antique“ device is no problem. 
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ing an oscillator (LFO) or the input 
signal. 

ection 
The filter in the BitMachine is a digital model of one of the most well-

 in question is the 
‘Chamberlin 2-pole’ filter, which was used in old Oberheim 

al. They 
can also be used in quite creative ways in the BitMachine and must 

oothen out existing artifacts.  

de, that is, it lets through 
terial according to setting, and 

dampens the highs and medium areas. 

With this dial, you can specify the cut-off frequency of the filter. 

With this, the signal in the area around the cut-off frequency can be 
strongly elevated („resonance“: to just below the self-oscillation). 
Sharp, cutting sounds are now made possible. The effect becomes 
even clearer when you vary the cut-off frequency. 

drive: 

Both of the individual filters of the connections mentioned above have 
the ability to overmodulate themselves internally. With the „drive“ dial, 
you can regulate the amount of overmodulation. The more you turn 
up this dial, the more the signal is overmodulated. In this case, the 

You can use the BitMachine to bring back to life the times when 
minimalist and scratchy sound chips in home computers were 
commonplace. 

The BitMachine opens up a gateway to „acoustic time travel“ where 
you can encounter bit and sample rate reduction and downstream 
filters based on analog models. 

Furthermore, the effect has a modulation section with which you can 
control individual parameters us

We have designed a range of „typical“ presets to demonstrate the 
time travel abilities of the BitMachine. These can be opened at the 
top right of the interface. 

"Filter" s

known filters in music electronics. The filter

synthesizers. These types of filters sound exceptionally music

not be called upon solely to sm

The filter works in the so-called high-cut mo
deep frequency (or medium) ma

freq: 

Filtering starts above this frequency. 

reso: 
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parameters of the internal workings of the filter interact with one 
another. This way, for example, increasing drive weakens the 
resonance, but, at the same time, the signal gets more volume, more 
bass and becomes acoustically fuller.  

Note: The two smaller dials from this section are explained under 
Modulation. 

"Modulation" section 
You can automate your effects via the settings in the modulation 
section. 

Here, you’ll find the so-called low frequency oscillator (LFO), which 
resonates with adjustable speed. You can influence the speed and 
type of resonance. 

To influence the resonance, use the two small dials in both the 
reduction and filter areas. These four dials display modulation targets.  

ample rate at its default setting. 
s middle position to either side. 

T e modulation for the dial v rate: The 
LFO now controls these parameters mple 
rate reduction resonates at this modulation. 

You can use this technique on other dials as well. You just have to 
make sure that the main dial isn’t turned up to full, because, if this 
were the case, the modulation wouldn’t have any effect. The 
modulation is always added to the set value. 

‘sample rate’) to the right 
(+50). You’ve now assigned a modulation to both parameters with 

 inversion of the 
modulation, you’re, effectively, turning down the control signal. 

tion 

 
• Square wave (that is, only 0 or 1, no intermediate level) 

Example: You’ve left the dial for the s
Change the small dial beneath from it

h alue is added to the sample 
 proportionately and the sa

Example: Turn the small dial beneath the ‘bits’ dial fully to the left 
(Value: -50) and the one beside it (beneath 

the LFO. They are not changed uniformly, but rather opposite to one 
another: A negative setting is nothing more than an

Waveforms of the modulation sec

We’ve already explained this example with the help of sine oscillation. 
The LFO can be in: 

• Sine form
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 (in Hz).  

Modulation with the „Envelope f

In the modulation section, you’ll find a fourth button, the audio input 
signal. If this mode is active, the signal itself can be called upon to 
extract “modulation tension”: a so-called envelope follower 
continuously scans the volume of the input signal. 

• Random value (an internal randomizer will be queried at the set 
speed) 

Oscillator speed 

The LFO speed is specified with the „speed“ dial. If the „sync“ button 
is active, the LFO adapts to the song speed, and the dial locks 
musical values into place (for example, ¼ note). With it, rhythmic 
paths of the sound distortion are made possible. You can also switch 
off this synchronization and set the speed manually

ollower“ 

Note: The BitMachine doesn’t recognize the type of audio signal 
automatically. For this reason, you should roughly set the input 
sensitivity with the „gain“ dial. To do this, use the control LED: With 
accurate detection of the signal dynamics, assigning the four small 
dials to modulation lows is easier and you can use the full control 
range.  

In envelope mode, the „speed“ dial is used to control the response 
speed of the envelope (the display now switches to milliseconds). 
Lower times result in a faster response, higher times make the 
envelope rise (and fall) slower. You should experiment with the signal 
according to its complexity. The presets provided can only point in a 

he resolution of the audio material. Turning the dial 
to the left results in 16-bit quantization, and thereby CD quality. The 
further it is turned to the ri al dynamic 
becomes. In extreme cases (1-bit), there are only „on“ or „off“ states.  

In the intermediate levels, you’ll notice an increase in the background 

nly 48 dB. Quieter points in the 
material sound noisy and very quiet points sound „capped“. This 

rough direction. 

"Reduction" section 
Bits 

This dial controls t

ght, the lesser the sign

noise and a decrease in the dynamics. For example, 8-bit 
quantization will exhibit dynamics of o
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 to the left, until it starts 
crackling or ‘groaning’. 
effect is amplified the more you turn the dial

Sample rate 

The audio material is ‘down-calculated’ with this dial, that is, the 
internal sample rate is reduced. Here, a new separation ratio between 
old and new rates is created. In relation to this ratio, a sample from 
the data stream will be „dropped“ at the various points. 

Note: The two smaller dials from this section are explained under 
Modulation. 

Tape Simulation 
Tape simulation lets you add an “analog touch” to your recordings by 
reproducing the typical aspects of an analog tape recording. Many 
studios today still use 1" and 2" tape machines that are believed to 
have a “warm” and “saturated” sound, which is in contrast to the 
rather neutral and analytical digital technology.  

 numerous factors that are decisive for the sound of tape-
supported recordings. Some of these are: 

• Distortions that occur when the tape is forced into the saturation 

• Changes in the frequency curve as the signal is edited at the 
ion, all machines more or less 

have distinctive frequency spectrum peaks, particularly in the bass 

 effect of the tone coloring is. 
You simultaneously gain more “loudness”. 

eq low/hi: Adjust the frequency curve (spectral balance controller). 
er you would like to have an output signal with 

a heav ebles. The 
pre-filtering during “recording” and the equalization are adjusted.  

There are

range 

recording and playback end. In addit

range (so-called “head bumps”) 
• Treble loss due to self-deletion as a result of the HF current (“bias”, 

pre-magnetization) and intermodulation between the signal and the 
HF signal. 

drive: Specifies the input signal. You can specify when the “virtual 
tape” is saturated and how strong the

You can choose wheth
y bass or whether it should rather include more tr

However, please observe that the frequency curve of the simulation 
will not be neutral even if the “eq low/hi” controller is set to the 
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s. 

 occur during tape simulation can quickly 
l d t terial 
including many highs. The differences can be heard more easily in a 

Trac  mixer 
channels) 

 

neutral position: A frequency-selective amplification always occur

Using the distortions that
ea o a state of “acoustic fatigue”, particularly with ma

1:1 comparison when the tape section is deactivated. In most cases 
minor editing using the simulation is sufficient to create a slight 
“analog touch”. 

k Dynamics (track effects,

Samplitude Music Studio 14 provides two different dynamics 
modules: one that can be opened via the "Offline Effects" menu and
which is talked about in further detail in the corresponding chapter, 
and a second one that is only available via the track effects and in the 
Mixer. 

 

Use this Editor to edit the dynamics of a sample. All functions can be 
previewed in realtime. 

The graphics display shows the corresponding resulting dynamics 
curv  t

Compressor: The dynamics of a piece are limited, loud sequences 

e o improve the overview. 

The following functions are available: 
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uiet sequences are retained. Compression is often 
u ed to s. The 
level of  the ratio controller, the activation 
threshold is determined by the threshold. You can also influence the 

nly the loudest passages are limited (above the threshold). 
Quiet passages remain unedited. Limiters are used to reduce the 

g the master dynamics. 
be increased using 

>L  preset sets a threshold of -0.2 dB when using the 

le is corresponds with 
normalization in one single step. 

sed, loud sequences 
become even quieter. Dynamics 

expansion is often used for recording speech with a high noise level. 
be raised which the 

ing algorithm 

G sages (below the Threshold Level) are dampened 
ely suppressed during 

se  (ratio > 5), in order to raise the most 
quiet passages and prevent background noise. 

ols the strength of the corresponding 
effect, 1.0 means that there is no effect. 

low or above 

Attack: Sets how quickly the algorithm takes to react to increasing 

 to react to falling 

Gate level: This parameter specifies which levels should be set to 0. 

are dampened, q
s  add power to audio material or to increase the loudnes

compression is adjusted by

attack and release. 

Limiter: O

occurrence of big level peaks without reducin
After the Limiter process, the master level can 
normalization without having to worry about overmodulation. The 

imiter< setup
Limiter as a Peak Limiter in the master range of the Mixer. 

Limiter 100%: Performs the same editing as the Limiter; however, the 
vel is immediately raised to 0 dB – th

Expander: The dynamics of a piece are increa
remain quiet, quiet sequences 

The expansion causes the level of the speech to 
noise is suppressed. Please note that a powerful denois
is also provided. 

ate: Very quiet pas
or set to zero. This way, hissing can be effectiv
pauses between individual takes. Using the Gate function also makes 

nse at high compression levels

Ratio: This parameter contr

Threshold: Here, the volume threshold can be set, be
the one which applies the effect. 

sound levels. 

Release: Sets how quickly the algorithm takes
sound levels. 
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rack effects) 

 different dynamics 

Effects" menu and which shall be talked about in further detail in the 
corresponding chapter, and a second one that is only available via 

Track delay/reverb (t

Samplitude Music Studio 14 provides two
echo/reverb modules: one that can be opened via the "Offline 

the track effects and in the Mixer. 

 

Use this Editor to calculate an echo effect into a sample. To avoid 
overmodulating the sample, there should be a certain volume control 
reserve, that is, the sample data should not be allowed reach the 

Echo Delay / Rev. Time: This button displays the delay between the 

e echo leads (logically) to a 
change in the echo delay. 

Reverb properties: Here the values for the size of the simulated room 
 can be specified numerically as well as by 

using the scroll bars. 

ndividual 
echoes can be entered as a percent. A number close to 100% results 
in slower sounding echoes, a value under 40% has quick sounding 

maximum/minimum. This can be accessed, if required, using the 
normalization function (some 70%). 

individual echoes/original signal and the first echo in seconds. You 
should note that the delay is dependent on the sample rate, that is, a 
change in the sample rate after creating th

and the reverb coloration

Wet/Dry Balance %: Here the dampening between the i
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 the Elastic Audio Editor 
Elastic Audio is a specialized editor with which the pitch of audio 

ged. Resampling and pitch-shifting algorithms 
 a basic frequency recognition 

 to change around considerably the pitches of 

Pitch-shifting algorithms are able to change a melody in the pitch 

n be used based on existing 
material. 

nition of the basic frequency in monophonic audio material. 
• Automatic and manual correction of the basic frequency process in 

• Manual correction of the pitch of notes from monophonic audio 

delays. 

Elastic Audio 

General information on

material can be chan
that can be automated as well as
enable the user
monophonic audio material.  

without influencing the tempo. Samplitude Music Studio 14 provides 
various pitch-shifting algorithms that ca

Elastic Audio has the following capabilities 

• Recog

monophonic audio material. 

material. 
• Changing melodies in monophonic audio material.  
• Harmonizer for creating additional voices 

Note on time-stretching: Time-stretching cannot be automated, but 
can continue to be used statically when using Elastic Audio. 
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eristi ting window. To customize 
espondi h of the audio material 

urse, be to the functionality is 
reliminary terial. This is basically 

 tonal, monoph  vocals, solo instruments 

nction s
e he 

slice 
dium pitches of 

ermin
set progression of the pitch curve inside the slice the 
borders of the slice o  

e an 
, but still keeping the 

small changes in the basic frequency (vibrato). 

The pitch charact c is shown in the edi
the pitch corr ngly, the original pitc

known. Fundamental must, of co
therefore a p  pitch analysis of the ma
only for onic material like solo
and speech. 

The analysis fu tarts automatically when the editor is opened. 
 up more time with longer objects. After tThe analysis can tak

analysis is complete, the objects are split up into individual 
he recognized pitches. The meobjects according to t

a slice object det e its position in the graphic, independent of the 
 object. On 

bjects, two handles are created on the pitch
curve. These handles can be moved in order to produc
increasing or decreasing pitch characteristic

The “Tune” function for automatic pitch correction can be found 
beside the Draw pitch function. 

Axes labelling and legends 
Y-axis: Pitches in notes. The notes can be deselected on the 
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racteristic (result of the analysis) 

Red line: Harmonizer voices. 

 in the editor itself, but 
rather by splitting and moving the objects in the VIP.  

keyboard. They won’t be used in the automatic pitch correction or in 
quantized drawing. The corresponding guidelines for scales can be 
used by selecting the basic tone and scales in the box “Edit slice 
object”. 

Orange line: New pitch characteristic (editable) 

Grey line: Original pitch cha

Fundamentals of the Elastic Audio Editor 
Opening the Elastic Audio Editor 

Select the object that should be edited in the Editor. The Elastic 
Audio Editor for a selected object is opened via Menu Effects -> 
Audio. 

Interaction between Elastic Audio Editor and objects 

Temporal corrections to notes are not run
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Description of all control elements 

Edit PROJECT OBJECT box 

These options and parameters always effect the whole object loaded 
into the editor, and therefore all the slices.  

Algorithm: You can choose between the modes: monophonic voice 
(preset), standard, smooth and beat marker slicing. 

For more information on the algo
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rithms, read the corresponding 
 processor! 

to a 

m may 
s typical 

for the character of instruments or the human voice. With instruments 
they mainly result from the geometry of the resonance body. With 
humans the formants are created by the anatomy of the vocal tract.  

With most algorithms the formants are also influenced by changing 
the pitch. With the Monophone Voice algorithm you can change the 
position of the formants independent of the pitch. Acoustically this 
corresponds with stretching or compressing the above-mentioned 
geometries, which can lead to interesting effects. 

paragraph on the time

Curve smoothing: This parameter brings about the smoothing of the 
given pitch curve using a time constant (in ms). When smoothing to a 
large extent, jump-like pitch-shifts change from a “kick” 
glissando. 

Formant control: Selecting the Monophone Voice algorith
result in so-called formants. Formants are sound component

 

HARMONIZER box 
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e chord that make up the parallel voices 
tion is made between major and minor. 

The settings of the keyboard are taken into account unless the option 

Create voices: This button generates voices. 

Harmonic adjustment: Usually parallel voices are generated taking 
the keyboard and Humanize settings into account. However, if this 
option is deactivated, the voices are always kept exactly parallel to 
the orange curve. 

Chord: Here you can set th
of the Harmonizer. A distinc

lead voice has been activated. 

Humanize: At a low setting this causes high quantization of the 
parallel voices. This makes the effect sound very artificial. If you 
select a very high humanize value, the pitches of the individual voices 
will vary and the cue will be shifted so that you get the impression of 
an amateur ensemble. 

  

Edit SLICE OBJECT box 

Options for automatic pitch correction 

Basic tone: Basic tone of the scale. In the chromatic scale this 

Pitch characteristic tune!: This button quantizes (“levels out”) the 
pitch characteristic of selected slices. 

With quantization smoothing you can determine the “Strength” of 
quantization: Lower values are quantized the most. As a 
consequence, the small pitch fluctuations that always occur in natural 
sound sources, like, for example, Vibrato, disappear (“Cher effect”).  

Reset: Resetting the selected slices. The orange curve is 

setting is still not taken into account. 

Scale: Type of scale. Major/minor or modes 
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ver the grey curve and the slice is reset to the original 
tch. 

superimposed o
medium pi

Playback control 

  

Reset All: Recalculates and resets the pitch curves of the loaded 
material. 

Stop/Play: Stops/Starts the playback of the arrangement.  

Play solo: Only the object loaded into the editor is played. 

Bypass: Switches the effect on or off. 

Tools in the Elastic Audio easy Editor 
You can use various tools when editing slices and the pitch curve. 
The two tools can be freely assigned to each mouse button. The tool 
assigned to the left mouse button is displayed in blue and the right 
mouse button in red. Click with the corresponding mouse button on 
the desired console button. An exception is the zoom tool with which 
can be assigned to both mouse keys. 

 

Selection tool (arrow) 

 
You can now move the slice objects up and down. 

This modifies the pitch of slice objects as a whole. Slice objects and 
andles can also be selected. Multiple selection is possible with 

 lasso. 

w function 

curve h
the Ctrl or Shift keys, as is the stretching of a slice object

Free-hand dra

 
You can freely draw the pitch curve using the draw tool. 

If you press the Shift key as well, a straight line will be drawn between 
the start position on drawing and the current mouse p
the Ctrl key is pressed, the slice objects are combined when drawing. 

osition. When 

Drawing with quantization 
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This is the tool used for quantized drawing. 

traight line using the Shift key and compiling slice objects 
 also possible in quantized draw mode. 

 

Quantized means that the line is horizontally free but the curve snaps 
onto the grid of the tones of the selected scale under "Tune". 

Drawing a s
with the Ctrl key is

Rubber-band tool 
Use the rubber-band tool to bend the pitch curves between 

rve handles remain 
the same. In combination with moving the curve handles at the slice 

ove the pitch characteristic and attain 

Cut tool 

two neighboring handles. 

Here the middle of the curve is moved while the cu

object edges you can also m
micro-tone structures (vibrato). 

 www.magix.com

 objects (according to the notes). 

If automati

This can be used to split audio material manually into slice 

c recognition is not sufficient. Slice objects can be 
Ctrl + the drawing pens. connected to one another with 

Eraser 

 
Use the eraser to reset the output value of the orange curve. 

The pitch characteristic then corresponds to the original again and 

Magnifying glass zoom tool 

the curve corresponds to the recognized curve. 

 mouse button zooms out. 

Left-clicking and 

Zoom tool: Left mouse button "Zoom" zooms in and the right 

dragging can stretch out a range which can then be 
zoomed entirely. 

Navigation tool 
With the navigation too

 
l, the visible clip can be moved 

vertically and horizontally. 

o easy Editor 
Pitch correction (intonation correction) with monophonic audio 
material 

 
  

Applications of the Elastic Audi

Getting started (for all subsequent editing): 
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diting the 
orange curve or the pitch of the slice objects. 

w). 
• Move vertically with the mouse.  

• Select the slice objects with the Selection tool (arrow). 
cale in the Edit slice objects group and, if required, 

els off pitch 
characteristics inside a slice. 

• Select the slice objects with the Selection tool (arrow). 

• Select the slices with the Selection tool (arrow). 

tch modulations. 

Creating "Plastic voices" (Removing vibrato by strong quantization 

• Set the parameter Quantization smoothing to 0. 

 to a pitch 
• Select the slice(s) with the Selection tool (arrow). 
• Select the draw tool for quantized drawing. 

• Load objects into the Elastic Audio easy Editor. 
• Set the desired selection state. All slices are selected directly after 

the analysis. 
• Select suitable algorithms – you should test here to see if 

"monophonic voice" (see above) is the suitable algorithm. 
• Now, the pitch can be edited with the mouse tools by e

Manual correction of the whole pitch of a pitch slice 
• Select the slice with the Selection tool (arro

Automatic correction of the pitch characteristic 

• Select the s
unselect the tones which are not to be quantized in the keyboard by 
clicking on them. 

• Press the "Tone pitch characteristics" button 
• With the parameter "Quantization smoothing" you can reduce the 

"strength" of the quantization. 

In principle, this editing process more or less lev

Correction of the increase or decrease in the pitch. 

• Click and drag the pitch curve by moving the two handles at each 
end of the slice objects or on the orange lines.  

Free redefinition of the pitch / Creation of frequency modulations 
like warblers and vibrato. 

• Select the drawing tool (quantized or unquantized). 
• Draw in the pi

of the micro pitch characteristic) 

• Press the "Tone pitch characteristics" button 
• If required, switch off format correction when using the "Monophone 

voice" algorithm.  

Creating "Robot voices" – quantizing
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• With artifacts: Increase the quantization smoothing parameter. 

Creation of parallel voices 

rameter and press "Create 
voices" to generate the voices again. 

Pitch-sliced-objects and VIP objects 

the level of the vowels. 

 
cut apart with the scissor tool and merged together with the rubber 
band gripper  Ctrl key held down. 

The Blue Lin range pitch for each object and 
results approximately from the average value of the pitches in the 

The possibility exists of resetting the corrections for selected slices. 

Sliced objects can be selected and unselected. With Ctrl+a all slices 
are selected; clicking on the “empty space” unselects them. 

al frequency analysis correction 
General options 

• Runtime stereophonics, 
• False analysis, 
• Voiceless vowels (sibilants...), 

• Set desired chord. 
• If necessary, change the Humanize pa

In the basic-frequency analysis the objects in pitch-slices are taken to 
pieces that ideally correspond to one note in the melody in unison 
music or one syllable in speech. In speech the pitches correspond to 

After the analysis all the slices are shown selected (blue) 

The sub-division into slices can be corrected manually. The slices are

tool with the

e represents the mid-

slice. 

In selected pitch-sliced objects the functions can be applied that are 
to be found in the “Editing sliced-object” group: the correction of the 
pitch sequence and the mid-range pitch. 

Selecting sliced objects 

Fundament

The fundamental frequency analysis and the related fundamental 
frequency-dependent pitch-slice-analysis may fail or cause errors for 
the following reasons: 

• Reverbed material, 
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the user with the opportunity of 

Symptoms: 
Sound: The pitch varies strongly for a short period and does not 
correspond to the set value or characteristic. 

When using the monophonic voice algorithm, additional strongly 
distorted noises arise. The algorithm, which depends on the 
fundamental frequency recognition itself, fails. 

Graphics in the Editor: The curve exhibits a short strong jump and 
behaves in a very jerky manner. 

Solutions: 
• With the help of the eraser you can try superimposing the original 

curve at these points. 
• If you set high values for the curve smoothing parameter, short 

"hiccups" can be reduced in severity or prevented completely. 

Correction of slice borders 

So that the automatic or manual correction of the mid pitches of 
slices provides correct results, the slice borders have to match well 
with the note borders. 

The slice borders can be manually 
changed by connecting two slices to one 
another with the pen 

Ctrl +

In the last two cases, analysis cannot return a result as the 
fundamental frequency is not available. 

MAGIX Elastic Audio provides 
achieving good results using many "manual" options whereby the 
fundamental frequency analysis does not or cannot deliver any 
results. 

Error in the fundamental frequency analysis 

or  

and using the cutting tool to cut through 
at the correct position.  

 

Keyboard commands and mouse-wheel assignments 
Navigation via mouse-wheel  
Horizontal scrolling: mouse-wheel 
Vertical scrolling: Alt + mouse-wheel 
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g: Shift+ mouse-wheel 
l: Ctrl + mouse-wheel 

Zoom hor. + vert. Ctrl + Shift + mouse-wheel 

Space bar 

-8 
Ctrl + Shift + 1-8 
Shift + Alt +P 
Ctrl + Cursor up 
Ctrl + Cursor 
Cursor left 
Cursor right 
Home 
End 
Ctrl + Cursor 
Ctrl + Cursor 
Shift + R 
Ctrl + NUMPAD 4,5,6
Alt + NUMPAD 4,5,6 
NUMPAD 4,5,6 

Play Solo/Stop 
Play/Stop 

Select tool for left-hand mouse button 
Select tool for right-hand mouse button 
Show/hide pitch curve 
Enlarge wave form 
Enlarge wave form 
Play cursor to the left 
Play cursor to the right 
Jump to object start 
Jump to object end 
Zoom in 
Zoom out 
Alter scaling mood (Frequency for chamber 
note a). 
Saves zoom snapshots 1,2,3 
Loads zoom snapshots 1,2,3 
without any vertical zoom 
zoom snapshots 1,2,3 with vertical zoom 

 

Installation of VST plug-ins 

Install every VST instrument according to the instructions of the 
manufacturer. VST instruments and VST effects are not entered into 
the Windows registry, but must be saved in a certain directory. 

Vertical zoomin
Zoom horizonta

Ctrl + space bar 

Ctrl + A 
A 
Ctrl + Z  
Ctrl + 1

Select all 
Up-date view 
Undo 
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r system, use the already existing 
folder. You will, however, have to enter this foreign path in the system 
settings ("Y" key) in the "Effects > VST / DirectX / ReWire" subdialog 
(entering multiple paths is also possible). Simply enter one path after 
the other, all paths will be taken into consideration. Samplitude Music 
Studio 14 will automatically find newly installed plug-ins contained 
within the selected folders. 

Samplitude Music Studio 14 searches for installed VST instruments in 
the "VST Plug-ins" program subfolder. You can install your VST 
instruments either in this folder or use any other path. If you already 
have VST plug-ins installed on you

 

The first time the program is opened, a search for existing 
instruments and plug-ins is executed when the track settings are 
opened. Here, not only are all the plug-ins imported, but they are also 
checked for their usability within the program. This search is only 
necessary once, the next time it is opened, the track settings will be 
opened immediately. 

Tip: For problems with your current configuration, you can reset all 
paths and installed instruments or plug-ins. 

Effect Calculations 

When working withSamplitude Music Studio 14, audio material 
manipulation can be performed on five levels. The signal flows 
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2. Manipulations on the object level in Virtual projects (Real-time 

5.

W lume, panorama, and filter manipulations, the 

w
or vice versa. Even when working with a multiple of effects, the input 

 Delay 
(Echo), Resampling and Timestretching, or Pitch Shifting. 

se that remove or reduce 
noise (De-hisser and Noise Reduction) are dependent on the input 

u have found an optimal setting for the parameters, you 
should not apply other changes to effect blocks that precede these 

Samplitude Music Studio 14 as an 

With the help of ASIO driver support, you can also use Samplitude 

re-issued. All real-time effects from the mixer can be used 
directly: MAGIX AmpSimulation , MAGIX multiMAX, reverb, echo, 

undcard. 

ialog (Y key), select the “ASIO Software Monitoring 
with Track Effects“ option from the “Record options“ card. 

through these five levels in sequence: 

1. Wave Editing (Destructive Editing), 

Processing), 
3. Volume and panorama automation, including track volume fader in 

the Mixer or VIP (Real-time Processing), 
4. Real-time effects in the Mixer tracks (Real-time Processing), 

 Real-time effects in the Mix Master section (Real-time Processing). 

hen working with vo
sequence is not important. For example, it is of no significance 

hether you first apply a filter function and then change the volume 

signal level is unimportant. Among them are the Reverb, the

However, all Dynamics functions and tho

signal level and in some cases on the frequency response of the input 
signal. If yo

types of effects. 

external effects device 

Music Studio 14 as an external effects device. The signal is pushed 
through the real-time effects section by Samplitude Music Studio 14 
and then 

compressor, 4 band equalizer and vocoder. Requirements: You need 
an ASIO driver for your so

Here’s how it works: 

• In the system d

• Connect your instrument (e.g a guitar amp) to the soundcard. 
• Select one or more real-time effects for the track activated for 

recording. 
• Play it. The sound now has the selected effects added to it. 
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Samplitude Music Studio 14 provides lots of comprehensive 

 manually. The created 
automation data are visible as controller movements in the 

automation possibilities at track level. You can enter automation 
movements in realtime or draw them

corresponding plug-in or as a curve in the automation track. For each 
track you have an indefinite number of automation curves at your 
disposal. The volume automation curve is set to 0 dB at the middle of 
the track and +6dB at the top of the track. 

 

Dynamic automation of volume, panorama and plug-in control 
elements is available in every track. 

Automation � Context menu 

 "Automation" category. 
To open automation, right-click on the "Vol" button in the track box 
or on button "A" in the

 

 The first entry indicates which parameter you have automated, e.g. 
Effect 0 Volume or Effect 1 Pan. By checking the corresponding 
entry you can activate the corresponding automation curve. If you 
haven't activated an element, No effect (Track) will be displayed. 

Editing curves 
Creating 
The curve generator will create a volume curve for you that is beat-
based and pulses according to eighth, quarter, half or full notes. As 
an option for the beat-based envelope curve calculation you can 
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enter a minimum and maximum value or define delay values. 

As an alternative you can also let the curve generator write an 
envelope curve scan. 

Invert 
This command inverts the activated automation curves. 

Thinning out 
This function thins out the activated automation curve by reducing 
the number of automation events. While recording, the automation 
events are placed in very short intervals. The command "Thin out" 
reduces the number of curve points. The course of the automation is 
then displayed and reproduced even more accurately.  

Copy/Paste/Delete 
The activated automation curve can be copied, pasted into other 
tracks and deleted. 

Inactive 
Use this command to deactivate the selected automation curve. This 
means it remains intact, but no longer affects the corresponding 
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Delete all curves 

With this option you can deactivate the display of the automation 

ation (default setting) 
If you select this display option only the track automation will be 

selected curves of the 
corresponding track. This helps keep track if several automation 

Display unselected curves (can be activated) 

ntext menu lists the ranges that are 
available in event of automation of the corresponding track of an 

parameter. 

This command deletes all automation curves of the corresponding 
track. 

Automation mode 
Specify the Automation mode (on page 120) here. 

Do not display automation. 

curves for all tracks. 

Display track autom

displayed. 

Display selected curves only 
With this option you can only view the 

curves have been created. 

Display unselected curves (cannot be activated) – Default setting 
The unselected curves are shaded and can no longer be activated 
with the mouse.  

The unselected curves are also shaded, but can now be activated 
with the mouse. 

The last section of the co

object automation parameter. 
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Automation modes 

 

With the automation modes you can define how automation data 
should be saved or displayed. You can set the automation mode for 
each track. You can select the different automation modes by right-
clicking on the automation button in the mixer channel. Clicking this 
button only once will toggle between the last activated mode and 
read mode. With the option Transfer to all tracks you can apply the 
currently selected automation mode to all tracks/channels. 

Off mode 
All automation functions are deactivated on Off Mode, all already 
written automation sequences are ignored. 

Read Mode 
All recorded automation parameters are played in Read Mode. 

Touch Mode 
In Touch Mode automation data is only recorded as long as you 
touch the selected control element with the mouse or touch it from 
your external controller. Automation recording is stopped when you 
release the corresponding key. Once released the control element will 
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move back to the po
can set the fader 
Automation in Setting

VST plug-in/V eter dialog 

All parameters you w
activated in the param

This allows you to dir
the parameter during 

You can open the p  
Plug-in menu. 

Plug-in/instru

The easiest way to also write automation in Read Mode is via the key 
combination Ctrl+Alt+ e
way you can easily re  
as you hold these k can also automate the 
selected parameters in Read Mode. 

Draw Panorama mode 

To sketch an automa  MIDI controller, select 
Panorama Draw mode in the symbol list. 

sition previously recorded at this position. You 
return time in the dialog MIDI Controller/FX 
s > Time constant for user entry. 

ST param

ould like to automate can also be selected and 
eter dialog of the VST plug-in.  

ectly record automations with the controllers of 
playback. 

arameter dialog from the plug-in panel via the

ment screen 

Switch/Fad r in the instrument  interface. This 
cord an automation at any point in time. As long
ey combinations you 

tion parameter curve or a

 

You can now draw  
track using the n to

Edit automati

Alongside the normal  delete curve point), a special  

the automation curve straight into the chosen
ol for the selected parameters. pe

on curves 

mouse (create or

 
Curve Edit mode 
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or Object/Curve Mode 

is provided. 

In Curve Edit mode you can delete curve points after having selected 
them by pressing the "Del" button. If you move individual points using 
the "Alt" key, the bordering can be lifted using the neighboring points 
to the right. 

Detailed information on the curve modes can be found in the "Screen 
elements -> Symbol lists -> Mouse Mode list" chapter. 

Move automation curve with audio/MIDI 
data 

You most likely have to change the position of your audio material on 

o the objects. This can be done using the "Connect 
curves with objects" mouse mode. To use it, click on the 

the time axis every so often. If your created automation curve should 
also be moved to the new position, the automation curves have to be 
connected t

eponymous button in the mouse mode toolbar. 

 

 www.magix.com

You can now move or copy objects together with your curve points. 

Note: If you only wish to move or copy the curve points, follow the 
instructions above and simply delete the objects once moved/copied. 
The curves remain intact. 

To copy the curve points simply use Curve Edit mode and drag out a 
rectangle by moving the mouse from right to left over a curve while 
holding down the mouse button, then copy the curve points with "Ctrl 
+ C" and insert them into a different track with "Ctrl + V". 
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Overview 

owever, it is by far more flexible than an analog 
mixer. 

Mixer 

You can open the Samplitude Music Studio 14 mixer via "Window > 
Mixer". It strongly resembles a hardware mixer. As a result of the 
digital environment, h
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dited in realtime. 
This includes track and master effects, panorama and level settings, 
All settings made in the mixer are processed and e

device allocations for individual tracks/busses as well as device 
allocations for the master section. 

 

Operating the Mixer 

Every VIP track has its corresponding Mixer track. However, you can 
hide any VIP or Mixer track in the Track manager. 

Alternative mixer skins 
In System Audio (keyboard shortcut: "Y") in "Design > Skins" you can 
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select an alternative for the Mixer skin. A further option for changing 
ystem menu in the Mixer window 

(the symbol at the top left corner of the Mixer window). 

• End: Opens the assigned sub-window of an element, e.g. the EQ 

x. 

er with the mouse and keyboard 

C
se

Sh
su
m

Sh ink selection 

C control element can be temporarily 
and operating the 

en

D nt to its preset 

ch

 value displays, below the faders or on the left 

Right-clicking on value displays, below faders or on the right 

the Mixer skins is to click on the S

Using the keyboard 
• Cursor keys: Select the active Mixer element (fader, button or switch) 
• Page up/Page down: Changes the value of the active Mixer element 
• Home: Resets the Mixer element to its preset (passive) initial value. 

When pressing Home again, the element is reset to the last value 
which allows for a simpler comparison between the changed and 
initial preset states. 

window for one of the EQ buttons. This corresponds with right-
clicking on a button. 

• Return: Enables the numeric entry for a marked window bo

Operating the Mix
Left-click: A control element is selected. 

trl & Left click: Several control elements can be selected (multi-
lection). 

ift & Left click on buttons: Permits changing of special functions 
ch as mute single track or solo single track although they are 
embers of an active group. 

ift & Left-click on buttons or faders: Reverses the l
(negative selection) 

trl & Left-click: A single 
positioned within a group by pressing the “Alt” key 
element. 

Double-click on numbers: Opens the entry box to allow manual 
try of numeric values. 

ouble-clicking on buttons: Resets the control eleme
(initial) value. Double-clicking again sets the value back to the 

anged value. 

Left-clicking on
button corners decreases the values. If the key is kept depressed, 
the value is automatically reduced until the key is again released or 
the end of the scale has been reached. (Keyboard: Page down). 
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atically increased until the key is again released or the 
end of the scale has been reached. (Keyboard: Page up) 

The level faders can be adjusted very precisely. If you click on these, 

direction. The steps of the settings 
become smaller as the mouse button is moved further away from the 
selected fader. 

The step size of the fader movement also becomes smaller if you 

s. After clicking on a knob 
you can either move the mouse around the knob this is the standard 

 up and down similar to moving the faders. You 
ng the “Shift” 

C

th
ob

Ea
in
corresponding arrow symbol. 

button corners increases the values. If the key is kept depressed, the 
value is autom

Right-clicking on buttons (e.g. Compressor) opens the 
corresponding window. (Keyboard: “End”) 

keep the mouse button pressed, move the mouse pointer away from 
the fader to the left or right. You can then adjust the settings by 
moving the mouse in a vertical 

keep the “Shift” key depressed while moving a fader key. 

There are two ways to change knob setting

method - or move it
can reduce the step size of the value settings by keepi
key depressed. 

hannel strips 

Each track in the VIP is sent through a specific mixer channel, that is, 
e sound settings of the respective mixer channel are applied to the 
jects on the track. 

ch channel strip provides the following setting options. Each 
dividual section can be opened and closed by clicking on the 
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Gain: Controls the ratio of signal input to signal output 
of each channel.
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verse the 

cts the corresponding channel with the one to 
the right of it. All settings and adjustments affect both channel strips. 

unction to record fade movements of the 
volume/panorama/AUX faders as Vol/Pan/Surround or AUX curves 

o button switches off all tracks with the exception of the 
selected one. Right-clicking enables the selection of the output 

REC

Mut
sele

Volu he level of the tracks. 

Beside the panorama dial, you'll also find a switch to re
phase. 

Link: This button conne

Automation: Use this f

during playback. Curves that already exist are shown in the mixer by 
movements of the AUX bars, panorama faders, and volume faders. 

Solo: The sol

device for the track. 

: Arms the track and starts recording. 

e: The mute button mutes the track. Right-clicking enables the 
ction of the output device for the track. 

me Fader: Controls t

Monit to activate the oring: Click on the loudspeaker button 
monitoring function. This means that audio material is always passed 
through the inputs of the sound card and forwarded to the outputs. 

If the "Hybrid Engine" is set up for monitoring, all mixer channel 
effects for the feeds can be used. This requires working ASIO drivers 
for the sound card. This way, Samplitude Music Studio 14 can be 
used as a live effect device. 

Further information on monitoring can be found in the chapter 
"System Settings" > "Global audio options" > "Monitoring settings". 

Track name: You can enter the name of the VIP track here. A mouse-
click opens the track settings dialog where you can change the track 

w e and edit any number of effect sequences. 
This lets you specify the sequence in which the effects are used. 

name, among other things. 

FX: This key activates each track's VST or DirectX extra effects from 
hich you can configur

Find out more about this in the "Effects and Effect Plug-ins" chapter 
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> "Order of Effect Calculations". 

Right-clicking on the button opens the control dialog. This lets you 
add or delete effects and makes the individual track effect settings 
dialogs accessible. You can copy, insert, reset, save, or load your 
personal track effect settings. Specify your custom track effect 
settings in the program directory in "FX Presets > Track FX". Of 
course, you can also create new subfolders as well as "instruments" 
or "Mid Side Processing". 

Out: Sets the audio output for the channel. This can either be a 
submix bus in the mixer or a wave out device. 

Master section 

The master section can be found to the right beside the channel 
strips. 
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Master Plug-ins: This function lets you set 
r out 

signal. Right-click on the control button to 

DeHissing dialog 
with a right-click. 

Vocoder: Here you'll find the Vocoder for the 

click opens the dialog. 

ulti-band Dyn: A right mouse-click opens 
the entire multi-band dynamics section. 

iter for the master signal 
opens with a right-click. 

Master Equalizer: This Equalizer affects the 

Stereo Enhancer (StE): This Stereo Enhancer 
reo picture of the entire 

signal. 

serves to temporarily check mono 
compatibility. 

 

VST or DirectX plug-ins for the maste

show the plug-in dialog. If you wish to quickly 
switch the plug-in effects on or off, click the 
control button. 

DeHisser: The effect master "DeHissing" 
helps you reduce existing distortions which 
often exhibit themselves as high-frequency 
hisses. You can open the 

FFT EQ: A right mouse-click opens the FFT 
filter dialog. 

entire signal. A right mouse-click opens the 
dialog. 

RoomSim: Here you'll find the Room 
Simulator for the entire signal. A right mouse-

M

Dyn. /Limiter: The lim

sum signal. 

lets you modify the ste

Mono: This button plays the entire signal in 
mono. It 

Normalize (N): This is the master normalization. If you click on this 
button, the output faders are customized in such a way that the 
loudest sections reach 0 dB. 

This function requires that the loudest sections in the VIP be found 
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made changes, please use the Peak Reset 
button. This deletes the peak display. Clicking on the numerical 

FX: Opens the effects/routing dialog with which you can configure 
and edit multiple effect groups. This lets you specify the sequence in 
which the effects are used. Find out more about this in the "Effects 
and Effect Plug-ins" chapter > "Order of Effect Calculations". 

and played. After clicking on the Normalize button, the program sets 
the peak value of the entire signal to 0 dB. To display the maximum 
values after having 

display of the peak value when stopped sets the play cursor to the 
VIP position of this value. 

Link: This key connects both faders. Please use this function if you 
wish to change the left and right faders simultaneously. 

Faders: Both of these faders adjust the left or right master signal. 
Double-clicking on a fader resets the fader to 0 dB. 

Mix to File: The entire VIP is calculated into a file with all the settings. 
You can find out more about this in the "Tools" menu > "Track 
Bouncing". 

On: This function allows you to mix the entire signal every time a 
stereo WAV file is played. It comes in hand when you want to se the 
processed output signal of the mixer, e.g. when monitoring. 

Make sure that the "On" button is deactivated if you don't wish to mix 
the master signal into a new file. Otherwise, the system creates a 
wave file every time the file is played. 

Hint: You don't have to use the Mix-in-file function to record dynamic 
mixer movements during playback. It is usually better to control 
effects movements via the AUX busses, to record volume and 
panorama curves, and to then use the mixdown function. 

Device / Master Out: Here the playback device for the entire signal 
can be entered, which can then be set in the System/Audio dialog 
under "Audio devices". 

Some further buttons for adjusting the global settings of the Mixer 

Global Settings 
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Start Track: If the VIP has many tracks, only a section of the 

f the Mixer. 

You can recall the previously saved section by clicking again on the 

window and Mixer handling can be found at the right side of the 
Mixer window. 

This includes (clockwise from bottom left): 

corresponding Mixer channels are generally displayed in the Mixer 
window. The visible section can be moved using the scroll bar at the 
bottom o

Hold the “Shift” key down and click on one of the “Start Track” 
buttons to save the current view (a left-click is sufficient the first time). 

“Start Track” button. 

Preset: Through clicking on the preset menu you can select various 
mixer setups. 

In the menu reference "Options Menu", please read the section 
"Project properties > Mixer Setup" 

Setup: A Click on the "Setup"-button opens the mixer setup dialog.  

Show-Functions: Right of the Master Volume Fader, individual 
 be switched on and off. Particularly 

r Section, Input Pad, AUX Section, Inserts, EQ 

 as 
volume and panorama. Automation has to be enabled on at least one 

sections of the Mixer Window can
single Tracks, Maste
and Visualization Display. 

+ Buttons:Additionally, the category "Aux" contains a function with 
which the amount of Aux routes and Insert slots can be in- and 
decreased. 

Solo/Mute: All solo and mute functions can be globally activated and 
deactivated using this button. 

BypassFX: Bypasses all Mixer effects for comparing the settings. 

AutoRec: This display indicates recording of automation data such

track. 

Play/Stop: Playback of the VIP can be started and stopped using this 
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Group selected controls: Those two buttons are used to to group 
elements of the Mixer and ungroup the when they are not needed 
anymore. Should you be wanting to create a group, select the 

 then press "Ungroup Controls". 

n be saved. 

ll Mixer settings to the default settings for 
stereo tracks (when working with Stereo Wave Projects). 

s of the channel strips to their default 

zer settings. 

button. A right-click opens the transport controller. 

desired elements holding down the Ctrl key and then click on the 
button "Group Controls". To ungroup, choose one of the Elements in 
the group and

Snapshots:The Snapshot Function is particularly useful to compare 
various Setups with each other. You can easily switch between the 
Setups. The naming of the Snapshots is possible through double-
clicking the name field. The two buttons on the bottom of the last 
name field enable you to save and load Snapshots. 

A right-click on a Snapshot opens a context menu from which 
Snapshots can be saved, loaded and deleted as well as switched 
between the banks of snapshots. Through that, up to 32 Mixer 
Snapshots ca

In this menu, Mixer Settings can as well be stored to a separate file. 

When loading a snapshot, the current Mixer settings are temporarily 
saved and can be restored by clicking on “Load last Mixer”. This also 
allows for A-B comparison between the snapshot and the current 
settings. 

Reset (Mono): Resets all Mixer settings to the default settings for 
mono tracks (when using mono or LR Wave Projects). 

Reset (Stereo): Resets a

Reset Aux: Resets all Aux share
values (= no Aux share). 

Reset EQ: Resets all equali

Reset Peaks: Resets the LED peak meters (peak hold display). 

Reset FX: Resets all effect parameters to the default settings so that 
effects can no longer be processed. 
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al of the desired Mixer channel is sent to 
the AUX bus ("AUX Send") where effects are added. The fader of the 
AUX bus represents "AUX Return". This means: the higher the volume 
of the AUX bus, the more effects in the mix will be audible. 

Busses and Routing 

AUX busses 
An AUX bus is a collecting bus combining all signals of the 
corresponding AUX Sends of the individual channels. AUX busses are 
usually used for controlling realtime effects via the volume curve. For 
this purpose part of the sign

Hint: The AUX tracks contained in the VIP tracks are usually not 
objects. They only provide dynamic effects to other tracks. 

Working method 
• An AUX/a Submix Bus can be created in the Mixer at any time. To 

insert a Submix Bus after all channels, for instance, right-click on the 
number of the last channel, shown in the mixer. In the appearing 
context menu, select "Insert Tracks -> new Submix Bus". If the 
output of several previous channels is now routed through this Bus, 
the Volume of all of these can be controlled centrally through the 
new Bus. In case you have created a AUX-Bus with "Insert Tracks -> 
New AUX Bus", you can the signals of the previously created AUX-
Sections into the the newly created AUX-Bus. AUX-Busses are also 
the target for AUX-Sends with a lower channel number. 

• Right-clicking the number of a channel gives the possibility to select 

. 
• Submix or AUX busses are always stereo busses. 

ama automation, and AUX Send. You can 
align your output to output devices or submix busses with a higher 

• Automation of volume and panning for AUX and submix busses are 
e as for all other channels. 

between the properties "AUX-Bus", "Submix Bus" or even both for 
the according channel strip

• Submix busses can be fed from tracks with a lower channel number 
just as a physical output device. 

• Submix and AUX busses can be used for all channel effects, 
including volume, panor

channel number the same way as any other channel. 

the sam

Submix busses 
A submix bus combines several tracks. It controls the volume, 
panorama and effect settings of all tracks that are “routed” to the 
submix bus. For example, all drum tracks (Hi-hat track, bass drum 
track, etc.) can be combined to one submix bus so that the entire 
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then be controlled via the volume controller of the 
submix bus. 
drum kit can 

Effect Routing 
The sequence of all realtime effects can be adjusted individually for 
each track. You can therefore individually specify the sequence in 
which the effects are used. 

Find out more about this in the "Effects and Effect Plug-ins" chapter 
> "Order of Effect Calculations". 

Embedding external effects devices 

In order to include external effects devices you require an audio 
interface with several in- and outputs, whereas one input/output pair 
is reserved for the external effects device. 

Routing the signal: 
• You can loop in the signal either as an effect or insert. 
• Insert send: Route the channel output directly to the physical output 

of the card that is to feed your external device. 
• Insert return: Select a Mixer channel that is to act as an insert return 

channel. In the input section of the channel select the sound card 
input connected to the output of the device you want to loop in.  

• External send effect: CreateS an AUX bus is to be fed from 
ls of the corresponding AUX send. The output of the 

o a physical output of the sound card. 
Connect the output of the effects machine to the desired input of the 

 card input is connected to the Mixer channel 

Tips and tricks 

aster Normalization the Mixer has a feature which allows you 
to quickly set the output level to 0 dB. If the limiter in the master 

ping. 
• Clicking on the displayed top peak level numbers of the master sets 

ontrolled with the 
function "Play over cut". 

different channe
AUX bus has to be routed t

sound card. The sound
by selecting the corresponding input section of the sound card of the 
AUX Return channel. 

• With M

section is active, the output level is also monitored thus preventing 
level clip

the cursor to the VIP peak position. This can be c

• The Mixer function "Mix in file" (to the right below the Mixer) writes 
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parameters are changed during playback, the sound that was 
 can be recorded. If you use the live input of Samplitude 

u have to rename this file 
or save it under a different name. 

the master output of the Mixer to a WAV file (or HD wave project). If 

changed live
Music Studio 14, all Mixer effects can be used in the mix file while 
recording. Warning: the mix file is overwritten at every play start. 
Therefore, if you want to keep the result, yo
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mplitude Music 

What is MIDI? 

A few words about MIDI: MIDI files do not contain the actual sounds 
like audio files, only the note control information which is first played 
by the synthesizer chip of the sound card. This has several 
advantages: 

1. MIDI files need a lot less memory than wave files. 
2. MIDI files can be adapted to any beat (BPM) without affecting the 

sound. Only the playback tempo is changed. 
3. Similarly easy is the transposition of MIDI files to other pitches. 

When doing so, a section in a song does not have to be saved in 
several different keys. The version in C major is perfectly sufficient. 
It can then be transposed to any key by simply clicking on the 
right mouse button. 

4. In Samplitude Music Studio 14 you can use VST instruments 
which play the notes contained in the MIDI files. 

The disadvantage of MIDI files: The actual sound is not yet set. Only 
during playback by the synthesizer chip of the sound card from 
external MIDI synthesizers/virtual instruments (VST instruments) will it 
be produced. High-quality sound cards or external synthesizers will 
sound completely different and better than standard sound cards. 

Connect external equipment 

Interface Connection 
Please consult your soundcard or MIDI interface manual for 
information on its correct connection. The most common ways to 
add MIDI functionality to computers are: 

• Multi-port MIDI interfaces, including separate devices. 
• Sound card with built-in MIDI interface. 
• via a General MIDI module or keyboards’ integrated interface, usually 

labeled as “To Host”. 

MIDI Cabling 
MIDI Inputs/Outputs: If your computer has an internal or external 
MIDI port, or has a MIDI-capable soundcard installed, connect your 

MIDI in Sa
Studio 14 
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t” to the computer’s “MIDI In” (on the 

If your MIDI keyboard can generate its own sounds, connect the 
 computer 

(or the MIDI device) offers more than one MIDI output, connect any 
nly has one MIDI 

output, you need to connect the second tone generator’s MIDI In to 
port. A third device can be connected to 

delivers a copy of the signals coming into the device’s MIDI In. It is 
 computer’s 

rather than chaining too many devices, one 
iming problems may occur in the chain if a lot of MIDI 

commands are sent in a short space of time. This is due to the slight 

of MIDI expanders.  

 connected to the 
sound generator. This behavior, however, is not what you want to 

enario, the keyboard is used as the computer’s input device, 

card or any other 
connected sound module. 

le using your 
keyboard as the input device, its own sounds would play alongside 

’s manual for information on how to do this. Don’t 
worry about “breaking” the link between the keyboard and its internal 

MIDI keyboard’s “MIDI Ou
interface, soundcard etc.).  

computer’s “MIDI Out” to the keyboard’s “MIDI In”. If your

other tone generators to these. If the computer o

the keyboard’s MIDI Thru 
the second’s MIDI Thru, and so on. The MIDI Thru  port always 

preferable, however, to use a direct connection from a
MIDI Out to a device, 
after another. T

delays introduced by each MIDI In to MIDI Thru transaction. If your 
computer also features several MIDI inputs, they can be used for the 
connection 

MIDI Local Off: If your keyboard features an internal sound source, it 
is important that you stop the keyboard from generating sounds 
directly from its own keyboard. If you buy a new keyboard that is to 
be used without a sequencer,  and connect it straight to an amplifier, 
you would expect the device to make a sound when you press its 
keys—in other words, the keyboard is internally

happen when using your keyboard with Samplitude Music Studio 14. 
In this sc
and Samplitude Music Studio 14 is sending (i.e. playing) MIDI 
information to any connected tone generators, be they the 
keyboard’s own sound generator, a sound

If you wanted to control and record another sound modu

those of the other tone generator— which is why the keyboard must 
be separated from its own internal sound generator. This function is 
known as “Local OFF”, and is set directly on your keyboard. Refer to 
your keyboard

sound generator—Samplitude Music Studio 14 will act as the 
“missing link” in this scenario. 
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If you use VST instruments, you won't have to convert these MIDI 

e processed there. 

he exported track. 

file that can be edited, 
which can, as usual, be exported together with the multimedia files. 

Convert MIDI objects into audio files 

objects into audio data before exporting your entire arrangement as it 
creates the sound on your computer and can b

If you still wish to do so (for example, to free up processing power on 
your PC), switch the desired MIDI track to "Solo" and export the 
arrangement. Then add the exported file back into your arrangement 
and delete the MIDI objects in t

All MIDI objects which open external synthesizers via a MIDI interface 
will have to be converted into audio objects if you want them to be 
exported as well. They only contain control information for sound 
reproduction. 

For this to happen, the output of the MIDI synthesizer (for example, 
the sound card) must be connected to the input of the sound card. 
The MIDI data can then be played and recorded simultaneously via 
the record function. The result is an audio 
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MIDI settings 

window 
rtcut: “Y”) “MIDI” submenu.  

All global MIDI settings can be found in the System/Options 
(keyboard sho

 

Please read the chapter "System settings --> MIDI Settings". 

MIDI: Import, Record, Edit 

Recording MIDI tracks 

To do so, open the "Track settings" dialog by right- clicking on the 
field that contains the track name (Track info box). In the "MIDI" 

l sequencer is connected. As the 

tivate the "MIDI" radio button in the 
"Recording" section. 

As with the routing settings of audio tracks you can tell the program 
which MIDI input is to be used. 

section of the track settings, select your "MIDI recording device" (the 
MIDI input device you use, for example, MIDI IN of your sound card), 
to which your keyboard or externa
"Playback device" or MIDI output device, select the MIDI playback 
device you use (for example, MIDI OUT of your sound card or a VST 
instrument. In the same dialog, ac

Note: You can activate the MIDI section of the Track Editor ("Menu 
Window > Track Editor") by clicking on the "MIDI" button in the track 
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box.  Now right-click on the "Rec" key to select the MIDI input device 
as well as the instrument outputs of each selected playback device 
from the context menu. You should also check the instrument 
outputs if the MIDI signal in the level display can be seen, but no 
sound can be heard, and adapt this to the MIDI outputs device (VST 
instrument). 

 

The following MIDI Record Modes are available: Normal, Overdub, 
Multi-Overdub, and Replace. These decide which of the newly 
recorded MIDI files will be added to the VIP. 

ord Modes in the transport 
control. Click on the arrow on the left beside the "Close" button in the 
transport control to display this section. 

Normal: This Record Mode corresponds to that of the audio 
ss, a new MIDI object is 

mains intact. This 
way you can record multiple takes of a passage and then compare 
them in the Take Manager later on. 

: The data is recorded into an already existing object, 

however, remain the same. This mode makes sense, for 
for recording MIDI controller changes subsequently over 

Replace: The data is recorded to an existing object, any MIDI data is 

You can specify the settings for MIDI Rec

Alternately, you can select the MIDI recording modes from "MIDI 
Record Mode" in the "MIDI" menu. 

recording, that is, for each recording proce
created over the existing object. The old object re

Overdub: The data is recorded into an already existing object, 
available and newly recorded MIDI data is mixed together. If you 
record over several objects, these are combined into a single new 
object. 

Multi-Overdub
available and newly recorded MIDI data are mixed together. Existing 
objects, 
instance, 
several objects. 
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eral existing objects are combined into a single 

ecting the mode, make sure that the recording is activated 
for the track. The record button, which is set to standby, changes to 

at this MIDI track should record MIDI data. 

key "R". 
After recording you will be asked whether you want to keep or delete 

 appear as 
a "MIDI take" in the VIP. 

Already existing MIDI files can be imported into a Samplitude Music 

Menu: File/Open/MIDI (*.MID) … 

MIDI files are generally imported like a WAV file, irrespective of 
y are imported in a VIP window or a MIDI project window. 

tion, select a range in 
the desired track or drag the file from the internal explorer or 

ctly into the track position via drag & drop. 

overwritten. Sev
object. 

After sel

violet to signal th

Now you can now start the MIDI recording using the shortcut 

the recording. At the same time, and within this dialog, you have the 
chance to change the Record Mode for the recorded MIDI data. After 
confirming this with "OK", your newly recorded material will

Importing MIDI data 

Studio 14 project as objects. However, you can also load a MIDI file 
as a separate object, the same way as a WAV, HDP or RAP project. 

Shortcut: Shift + M 
Mouse: Drag & drop from file browser or Windows Explorer. 

If you import MIDI files, please note that only type 0 or 1 MIDI data is 
compatible with the import function. Each file should end with *.MID 
so that it can be recognized as a valid format. 

whether the
For a VIP you can specify at which position you want to insert the 
new MIDI object. Set the play cursor at this posi

Windows Explorer dire



 

MIDI in Samplitude Music Studio 14 143  

 

www.magix.com

Hint: The following dialog is automatically displayed if a VIP os 
already open as an active window. If you want to open the MIDI file in 
a separate MIDI project window without inserting the content into a 
VIP, please ensure that no VIP project window is active. Samplitude 
Music Studio 14 will also display the MIDI import dialog if only one 
range of a MIDI project window is dragged into a VIP track. 

 

The Import dialog contains status information on the MIDI file you 

Ea

w
ne

f 

ade handles for fading in or out, and a volume 
handle that scales the MIDI velocity. MIDI objects refer to the MIDI 

want to load: 

ch standard MIDI file also contains temp information. Samplitude 
sic Studio 14Mu  displays this information in a separate section of the 

dialog. At this position of the import you can decide whether you 
ant to adjust the VIP tempo to the tempo of the imported MIDI file. If 
cessary, a tempo marker is displayed in the VIP. 

If you select the option "All MIDI channels in rack", Samplitude 
Music Studio 14 inserts the MIDI object into the currently selected 

 trac

to one t

VIP k. The created MIDI object then contains all MIDI channels o
the MIDI file. 

Editing MIDI objects 
Editing MIDI objects in Samplitude Music Studio 14 follows the same 
principle as editing audio objects: MIDI objects can be copied, split 
and trimmed, have f
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re not saved 
on the hard drive as a MIDI file but are saved as a project file instead. 

Editor and Score Editor. 

MIDI Object Editor 

ect Editor 
Shortcut: Ctrl+O 

object editor you can easily edit the parameters for the MIDI objects. 

data you have recorded while playing or importing, but a

You can edit MIDI object in the MIDI object editor as well as in the 
different MIDI editors Piano Roll, Drum Editor, Controller Editor, Listen 

“Object” menu / Obj

Mouse: Shift+double click 

With the MIDI Object Editors, which is designed similar to the audio 

Here you can adjust sound, length, volume and program changes 
individually for each MIDI object.  
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16 
channels and up to 16 MIDI SMF tracks (initial track number in 

this object you can edit the notes in the 
corresponding MIDI Editor in all channels or only in a selected 

A Samplitude Music Studio 14 MIDI  object may contain up to 

imported standard MIDI file). For instance, you can use a single 
object to control a multi output VST instrument via several MIDI 
channels. Within 

channel. You can use the max mode of the Object Editor to get an 
overview of which MIDI tracks or channels are within one MIDI 
Object. that, for example, may have been created from a General 
MIDI file (“Max” checkbox). 

 

If there is only a single track in the MIDI Object, the settings are only 
available for this MIDI track. 

bject Editor to quantize MIDI data in the MIDI 
Object. Please note that these settings affect the MIDI Object in real-

 Editor. 

The velocity fader is comparable to the volume fader in the Wave 

value in the Object Editor scales the volume of the notes in the MIDI 
Object from its physical maximum or minimum values (0 to 127), and 

You can use the MIDI O

time and not destructively. so that you don't see these changes in the 
MIDI Key or Drum

Important functions and settings in the MIDI Object Editor: 

Velocity 

Object Editor. Normally, each MIDI note has a velocity value which 
determines how “hard” the note is played. Changing the velocity 
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fore included in the actual velocity note values. Changing the 
fader is identical to changing the middle handle of the MIDI Object in 
the VIP track. 

Position/Length 

gth using the length handle at the 
bottom left and right of the Object. 

s as global settings in the 

for all 
of the project. Crossfades between MIDI and audio 

a fade effect to a MIDI Object, the changes are 
the affected notes. 
bject by using the 

 

displayed in 
 

Mode only): Mutes the channel of the MIDI 
Object. 

he MIDI data of a channel to a different 
channel. 

is there

This sets the starting position of the MIDI Object as well as the length 
of the Object. The settings correspond to moving the Object in the 
VIP track or changing the len

Crossfades (Max Mode) 
You can set/get the global fade setting
menus of the Fade In/Fade Range setting. 

The Crossfade Editor allows you to make global settings for MIDI 
crossfades. However, this corresponds with the basic setting 
crossfades 
Objects are possible. Create a crossfade between two Objects and 
press the “Set” key to save the crossfade. If the crossfade is set, you 
can use it for other Objects anytime by clicking on the “Get” key. 

Fade In/Out (“Max Mode”) 
These settings determine the Fade In and Fade Out effects of an 
Object. If you add 
interpreted as a change to the velocity values of 
The fade lengths can be changed directly in the O
upper left and right Object handles. In Max Mode the Object Editor
provides a selection of different curves. 

Object-Name 
Enter the name of the Object. 

MIDI Real-time Effects 
All 16 possible MIDI channels are displayed in Max Mode. If the MIDI 
Object does not contain data for a channel, this is 
grey.Only settings for one MIDI channel can be found in the preset,
reduced mode. 

MIDI IN Channel (Max 

MIDI OUT channel: Routes t

Transp.: Transposes all MIDI notes of this channel. 
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d here are always 
transmitted if the Object is played back. Use these settings if different 

This is a virtual quick quantization without further options, while the 
 settings changed in the MIDI Editor immediately affect 

want to split a multi-track MIDI file into separate VIP 
tracks but still would like to change all MIDI Objects as a group. You 

Mute Controllers 
ates MIDI controller 

ed for all channels simultaneously. 

Changes the background color of the MIDI Object. 

Bar definitions 

e to 
increase the quality of the MIDI notes and data. For example, you can 

MIDI Editor 

Program and Bank change: The values entere

Objects of a MIDI track are to use different programs of a synthesizer. 

Quantization 

quantization
the notes and adjust their starting positions. 

Track selection 
Use this if you 

should take into account that this function is only activated if several 
MIDI Objects are active in the VIP. Selecting several Objects with the 
Object lasso or individually using Shift+Mouse-click can also achieve 
this. 

Deactiv

Mute SysEx 
Prevents control via SysEx data 

Bypass effects 
Deactivates all real-time effects for this MIDI Object. 

Link all channels 
The settings are chang

Background color 

Reload Object 
It may be necessary to reload the MIDI data from the file from which 
the Object has at some point been created. Note: All previous 
changes are overwritten. 

This allows you to make your own bar settings for the MIDI Object. 
The settings can differ from the rest of the Project or other MIDI 
Objects. The four values in the settings window (Numerator, 
Denominator, tempo and PPQ) can help you if you would lik

specify a different resolution (PPQ) to enable a finer quantization. 
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. 

Opens the MIDI Editor (Piano Roll), where you can easily set, edit and 
quantize MIDI events. 

Play/Stop 
Starts and stops playback from the current position
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ditor features five main areas for editing: 

ample, velocity, MIDI volume…) 
• List Editor (event list) 

 example, pencil or eraser. Exact 
values for each MIDI event can also be set in the edit fields via the 

ed MIDI events (red) with just a few 
exceptions. Changes to the selection in a range always apply to every 

Notation display in Piano Roll and Controller Editor (with velocity 
curves) 
Notes which are not selected within the Editor are displayed in blue. 
The intensity of the color symbolizes the velocity: the velocity 
increases while getting darker/stronger in color. 

Selected notes: Multiple selected notes are displayed in red. Here 
too, a more intense color symbolizes increased velocity. 

Current event: Appears in bright red with a red border. The properties 
of the currently selected events are displayed in the edit fields above 
the Piano Roll. If an event is selected with the mouse, it turns into the 
current event. 

Display of filtered events: To get a better overview of the events of a 
MIDI object, you can filter specific events for the display. 

Example: The MIDI object as notes in the MIDI channels 1, 2, and 5. 
You can now make all notes in channels 2 and 5 accessible for the 
selection and editing tools via the selection of the MIDI channels in 

MIDI Editor 

Notation display, movement, zoom 

The MIDI E

• Matrix Editor (Piano Roll) 
• Drum Editor (toggle between the Drum Editor and Piano Roll 

possible) 
• Controller Editor (for ex

• Score Editor 

Here various tools are available, for

Piano Roll. 

Fundamentally, changes, for example, moving or deleting notes, 
always refer to all select

other range as well. You can, for example, select a group of notes in 
the Piano Roll and then change the velocity of these note groups 
which modifies all selected notes simultaneously. 
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the channel filter by selecting the two channels from the menu. All 
tes in channel 1 are displayed in gray in the 

Piano Roll and the List Editor. 

The List Editor provides additional display filters that only function 
within the list. The display filters are initiated with the settings of the 
playback filters (mute settings), but the filters can be set 
independently of one another. 

Display of muted events: MIDI object settings (in the MIDI Object 
Editor, "Ctrl+O") can be used to mute notes and filter other MIDI 
events. This type of "muted" event is displayed lighter or paler in the 
Piano Roll and List Editor. 

Events in front of or behind the beginning/end of the object 
(recognizable by the blue lines in the Editor or when the display is 
active and transparent as grayed-out ranges) appear similarly pale as 
non-muted events within the object borders. 

Events above and below the current picture section: Two small red 
displays above and below the vertical scroll bar to the right-hand side 
of the MIDI Editor screen show in red if there are notes outside the 
screen's display. 

Moving and zooming 

Mouse wheel: Scroll horizontally 

MIDI Edi

unselected filtered no

Events in the filtered channels can be completely hidden using the 
"Hide filtered MIDI data" in the Options menu. 

The vertical and horizontal view or zoom are adjusted with the Scroll 
bars just like in the project window. 

Shift+mouse wheel: Zoom vertically 
Shift+Ctrl+mouse wheel: Scroll vertically 
Ctrl+mouse wheel: Zoom horizontally 

Synchronized MIDI Editor and VIP screen 
view 

If you change the horizontal display or zoom using the scroll bars, 
holding the Shift key changes the corresponding VIP window. 

Play/Play Solo 
“Play Solo” only plays the MIDI Object that is currently opened in the 

tor (corresponding with the filter settings in the “Options” 



 

MIDI Editor 151  

 

www.magix.com

m

E

Yo eously in the MIDI 
Editor. All MIDI objects selected in the arranger are added to the MIDI 

 on the MIDI Editor button in the Arranger. 

dy-opened MIDI Editor you can include additional MIDI 
objects by clicking on them while holding down the Shift key. 

e 
track). New MIDI events will always be inserted into the active track – 

tool the active object and the current note line 
automatically reset. 

e top right. In the selection fields all objects contained in 
the MIDI editor will be listed. 

enu). “Play” plays the entire arrangement. 

MIDI Editor multi-object editing (MO-
diting) 

u can also load several MIDI objects simultan

Editor by clicking

In an alrea

In MO editing there is always an active objects (and with it, an activ

In Score mode the current note line will also be taken in 
consideration. When selecting notes or MIDI events or when clicking 
using the pen 

The active object as well as the active track can be displayed and 
altered at th

The Current object area can be highlighted using the button behind 
the object selection field. Areas lying outside the current object will be 
grayed-out and the notes of other objects will be paler, but still 
selectable. 

 

In MO editing you can activate a display filter for the current track. 
Data from other tracks are then grayed out or made invisible. 

 

In Score mode of the velocity editor only the velocity values for the 
current note line will be displayed. 

using blue note lines. 
In representing notes, the note system of the active track will be 
highlighted 
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Using the MIDI Editor: Selecting events 

• Set current event, deselect all other events: Double-click on event 

pitch: Double-click on the assigned key on 
the left keyboard 

• Select next or preceding note: Cursor left, right 

 selection options in the Piano Roll 
In order to directly select all notes of a certain pitch, double-click on a 

is pitch in the Piano Roll Editor or in the keyboard. 

hift and double-clicking on a free area selects all notes (all 
pitches) from the click position onwards. 

• Select event: Left-click on event 
• Add/Remove event to/from selection: Ctrl + left-click on event 
• Change/Set current event within multiple selection: Left-click on 

selected event 

• Selection of events within a line or range: Click while holding down 
Shift-key 

• Selection of all notes of a 

• Selection of all notes: Ctrl+A (functions for pitches selected with a 
key on notes with this pitch) 

Selection of MIDI events (Piano Roll, Drum Editor, Controller 
Editor, List Editor, Score Editor) 
Special

free section with th
Hold down the <Alt> key to select notes with this pitch only from this 
click position. 

Holding S

Note: If you press <Ctrl> as well during any of these selection 
methods, the new selection is added to the current one (i. e. the 
previous selection is not canceled). 
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Editing tools 

 mouse 
button. 

Left-clicking draws a note. The beginning and the length are 
determined according to the current quantization settings (Toolbar 
Editor). 

tings. 

 pitch of the first note is also maintained for all 

oves drawn notes. 

There are several editing possibilities for notes within the Piano Roll; 
so-called Mouse Modes. The same functions for editing notes (except 
delete) apply in all modes, so that these modes only differ by their 
reaction to clicking in empty spaces. 

Selection (1) 
Lasso: You can draw a selection frame by holding down the

A click in an empty space removes a selection. 

Draw Pencil (2) 

Drum Pencil (3) 
A sequence of notes is drawn. The length of the notes and the note 
intervals are determined by the current quantization set

When holding Alt: The
notes drawn subsequently. Moving the mouse backwards (to the left) 
while depressing the mouse button rem
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Velocity change (5) 
e mouse key and drag the mouse vertically, the velocity 

values of the selected events are increased or decreased relatively to 
each other: The velocity values are changed absolutely, i.e. all 
changed events have the same velocity values after editing. In the 
graphic velocity display mode you can change several velocity values 

elected note deletes all selected notes. Dragging the 
mouse deletes all notes underneath the eraser. 

R ght Mouse Button: Zoom out 

Left mouse button + drag: The sketched area is always zoomed. The 
y 

(Z). After releasing the key the mouse mode is active again. 

otes (8)  
Glues the note with the next note of the same pitch. 

s" menu. 

s when left-clicking and remove 
already inserted notes with a right-click, without having to change 

Pattern Pencil (4) 
Draws a freely definable note pattern (Ctrl+P). 

When holding Alt: The pitch of the first note is also maintained for all 
notes drawn subsequently. Moving the mouse backward (to the left) 
deletes just added notes again. 

If you hold th

at once by clicking + dragging the mouse over the notes. 

Delete (6) 
Clicking on a s

Magnifying glass (7) 
Left mouse button:Zoom in 

i

zoom mode can be temporarily accessed by holding a special ke

Glue n

Split notes (9)  
A notation bar is split in the matrix at the next grid position by 
clicking. 

Mute (M) 
Individual notes or selected note groups can be deactivated or 
activated by clicking on them. Also available as a command in the 
"MIDI Function

Hints: 
• You can freely define the shortcut for switching the mouse mode 

(tool). The Delete mode can be activated anytime by 
clicking/dragging with the right mouse button. For instance, you can 
use the pen to insert new note
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tools. 
• Notes reated in Draw mode contain the MIDI channel and velocity 

of the Edit boxes of the "New" section above the Piano roll. 

Editing notes with the mouse 

 on the part of the note, the following options will be 
available: 

• Change note start time: (grab note bar at the beginning), note end 

ngth) 
• Ctrl + scale note length (for multi-selection hold "Ctrl" and drag 

ference note longer/shorter – changes the note length 

old "Shift" key in move mode) 

MIDI func
The c m DI Functions menu always refers to all 
selected notes. If no notes have been selected, all functions are 

Remove overlaps (polyphonic): Notes may be shortened so that 
there no longer are any overlaps. Chords (simultaneously played 
notes) are recognized and not corrected, i. e. chords are not split up. 

Remove overlaps (monophonic): Notes may be shortened so that 
there no longer are any overlaps. Forces monophonic voice. 

Mute notes (Mute): Mutes and unmutes notes or selected note 
groups with a click. 

Quantize: Small irregularities when playing to record can be 
smoothened with the quantization function. In contrast, the "swing" 

c

• You can select the previous/next note with the cursor left/cursor 
right keys. With the cursor up/down keys you can adjust the note 
pitch step by step. 

If you move the mouse over a note, the mouse cursor will change 
and, depending

remains 
• Change note length (Grab note length at end) 
• Shift + set fixed note length (for multi-selection hold shift key and 

drag current reference note longer/shorter – all notes will have the 
same le

current re
relatively, i.e. the reference note will become twice as long and thus 
all other notes will be double length) 

• Move note freely (pitch and start time is changed) 
• Move note horizontally only, retain pitch (in free move mode, hold 

"Alt") 
• Move notes vertically, keep position (h

tions 
mands in the MIo

applied to all notes. 

Legato: Notes may be prolonged to be played in legato: 
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sounding sequences groovier. 

Clicking on "Quantize" shifts all selected notes to a customizable 
quantization grid. All notes are quantized without previous selection. 

1/4, 1/8, 1/16 and 1/32 notes can be selected as starting time (grid). 
(Uneven quantization values such as triplets can be created with "n-
tole" (see table). 

Quantization options (menu options in the MIDI Editor): "Strength" in 
 grid point 
uantization 

grid point, "0" does not mean movement = quantization off. 

"Swing" activates "triplet" play mode. Specifies the division for 

 window, events in the window are quantized, 
those outside remain at their position. 

ht of the grid point are 
quantized - no window -> Quantization off. 

number of sections set as n-
toles. You can enter any number you like, as well as the previously 

 numbers. 

hen created or edited. In this case 
the quantization values are also taken into account. For instance, the 

 corresponding positions within the quantization 

function makes mechanically 

%: "100" moves the event precisely to the quantization
"50" at the center between the current position and the q

uneven grid points before 50. 

"50-50 division": The uneven 1/8 note is exactly half way between the 
even eighths ("even play" mode) 67..." triplet play, 3-2 division 

"Window": Quantization

100 - Window covers the total range from the grid points of the 
quantization grid. 

50 - The window covers half of the quantization interval. Events with 
gaps of 1/4 of the grid width left and rig

"Offset": The entire quantization grid is moved: -100 is a half grid shift 
to the left (earlier), +100 is a corresponding shift to the right (later) 

"N-toles": The grid is divided by the 

defined

"Reset": Restores the default values. If snap is activated, the notes 
"snap" to the quantization values w

notes snap to the
window. 

Editing selected events (Edit fields): The properties of each event in 
the Piano Roll, Controller and List Editor can be edited by clicking on 
the edit tools below the edit buttons. The following buttons are 
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• Byte 1 (or pitch) 

To edit, click and drag the displayed value. Hold the left key and drag 
r down to increase or decrease the value. 

available for each note: 

• Channel 

• Byte2 (or velocity, attack) 
• (Start-)time in bars:beats:ticks 
• Length in bars:beats:ticks 

The display of the ticks has a resolution of 384 PPQ (i.e. 384 ticks 
correspond with a quarter note). 

the mouse up o

Hint: The value steps are greater if you press the Ctrl key. 

You can also edit the value numerically via the keyboard. Simply 

 multi-
selecting events: 

You can make permanent changes by simultaneously holding the 
r confirming entry with Shift + 

mouse-click on figure. 

A few special characteristics have to be observed when

You can relatively change the values by dragging the mouse, using 
the mouse wheel or entering numeric values and then confirming by 
pressing enter (for pitch and attack rate). 

shift key when dragging & dropping o
Enter. 

Controller Editor 

Open: The Controller Editor is located below the Piano Roll and can 
be hidden. It can display and edit up to 4 MIDI controller types or 
velocity values simultaneously. 

It is opened by clicking either on the - Button below the 
keyboard or with the shortcut "ALT + V". 

The values of existing events are displayed as colored bars in the 
Controller Editor, whereby darker and higher bars symbolize higher 
values. The bars are located vertically directly below the notes. 
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Shift+Drag: Set all bars to the same value. 

Alt: Draw freehand (envelope) 

orrect the curve while drawing. 

Selection 
Combo tool, also used for value changes as well as freehand and line 
drawing. Select the controller bar by clicking and dragging or single-
clicking in the range within a bar. 

Click on the bar end: The controller value can be adjusted by 
dragging vertically. 

Ctrl+Drag: Scale (relative value change) 

Shift: Draw curve (envelope) 

Freehand drawing: Click and drag to draw a controller curve, click 
and drag backwards to c

Just one click: Creates a single controller event. 

Shift + Click: Draw line 

Hint: If you edit velocity, no new notes are generated; only existing 
velocity values are modified. 

Draw lines: Click and drag to draw a controller ramp. 

Just one click: Creates a single controller event. 

Hint: If you edit velocity, no new notes are generated; only existing 
velocity values are modified. 

Multi-view 
T e fou  display or hide the view of all 
possible controller curves. Clicking on the menu area of the buttons 
opens a menu which allows you to choose a MIDI Controller for this 

 mouse. Clicking in the lower two thirds of the column 
selects the corresponding note, which is subsequently displayed in 

h r multi-buttons are used to

controller slot. 

Selecting and processing notes: By clicking in the upper Range of a 
controller column, the controller value can be changed immediately 
by dragging the
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The size of the controller editor can be determined by the dragging 

Especially in multi-phonic events the columns are located above each 
 respective note. To edit only 

notes of a certain pitch, e.g. all C1 notes in the Controller Editor, click 

re simply view options of the Controller 
Editor. Multiple note selection by double-clicking is not possible. 

 
located on top of each other and then select the required note using 

Besides directly changing the velocity values of a selected note you 
can change several velocity values at once by clicking in a free space 

, you can easily create a crescendo or decrescendo effect. 

the Editor in red. 

Tips:  

the mouse to the top edge (directly below the horizontal scroll bar). 

Several controller events can be shifted simultaneously. First select all 
values you want to move (hold Ctrl if necessary, to select different 
controller types together). You can now move the selection in the 
time box by entering a value and confirming with Enter, or by 
dragging the mouse.  

Use the display filter function for velocity values. 

other, making it difficult to select the

on the respective key on the keyboard. The key and the background 
of the selected pitch are highlighted. Only notes of this pitch are 
displayed in the Controller Editor. 

Notes of different pitches, e.g. all C1, D1 and A1 notes can be 
displayed with Ctrl+Click (or Shift+Click for the area between the 
clicks, respectively). These a

A further possibility is to selectively edit controller bars located on top 
of each other, which is based on the fact that the bar of the currently 
selected note is selected/edited using the mouse. Therefore, first 
click on the note within the Piano Roll, or click on the columns

the cursor keys. Then change the controller value by clicking in the 
upper third of the red (current) area of the column. 

and dragging the mouse over several velocity values while holding 
down the key. You can then also create sequences by moving the 
mouse in a curve. A previous (multi-)selection is ignored. For 
example
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List Editor (midi event list) 

Open List Editor 

The MIDI Editor has an integrated display of all events in list format. 

Double-clicking on a Sysex entry of the list opens a simple Editor for 
viewing and editing the Sysex information. 

but can be displayed by checking the box below the Editor). 

 the List Editor by using the 
 values of the edit fields in the upper 

frame of the Piano Roll always apply.
fields ea

This List Editor can be opened with the button above the keyboard or 
by using the “Alt+L” keyboard shortcut. 

When the List Editor is opened and activated for editing it has a 
narrow red border. This is to make clear that certain functions, e.g. 
select next/previous event (cursor keys) or the “Select all” command, 
refer only to the List. 

Working with the List Editor 

The List Editor does not only display Note Events, but also MIDI 
Controller and Sysex data. This controller and the data can be hidden 
and can even be filtered during playback (“mute”). 

A note always has a Note On and Note Off event. These are always 
selected and edited in pairs (Note Off events are not displayed by 
default, 

New events can be created directly in
“Insert Button”. The current

 Therefore, before editing these 
se ensure that no event in the Piano Roll is selected. pl
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mine the 
insert position by setting the play cursor. 
Tip: If no current event has been selected, you can deter

 

For editing certain events only, the List Editor has a view filter for 

this could be a note of a 
 

display only events of this type, e.g. of the selected pitch. All other 

e 10 control change 
events (volume) of MIDI channel 6. 

MIDI Editor tips & tricks 

. 

Duplicating: If the grid is activated (“Options” menu Quantization grid 
active), the selected notes are copied and inserted from the next grid 
point following the selection. They are otherwise inserted immediately 
after the selection. 

Drum Editor 

After opening the MIDI Editor (double-click on the MIDI object), open 

each column. These are small checkboxes above the List Editor 
columns. 

Select a representative format. For example, 
certain pitch. Then click on the display filter of a specific column to

events are now hidden. 

View Filters can be combined. For example, you can use the “Select 
all” command (Ctrl+A) to select and edit all Typ

You can copy & paste MIDI data within the Editor and between 
different MIDI Objects. MIDI data is always inserted at the current 
position of the play cursor
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nts. 

its "Options" menu and select the "Drum Editor" entry. Instead of the
piano keys to the left, you now see a list of drum instrume

 

Note: If a drum map is active in a track (recognizable by the cross 
beneath "Drum" in the trackbox), the Drum Editor is loaded 
automatically when the MIDI Editor is loaded. 

Drum Editor: In the trackboxes of the Drum Editor you can 
individually adjust MIDI channel, grid, quantization length, display 
width in cell mode and velocity scaling for each drum instrument. 

Velocity scaling: The velocity value of each note is multiplied ny the V 

 the Drum Editor opens, Cell Mode activates by 
ult. This is solely a view mode which permits an alternative view 

of the MIDI events. 
• Notes are displayed as cells, that is, the note length is not displayed, 

but rather a specific display width can be set. In Cell Mode of the 

value/100 entered here and adjusted to the MIDI velocity between 1 
and 127. Scaling is audible but is not visualized further. 

• Cell Mode: When
defa

 

Drum Editor, the display width for each instrument can be set 
individually in each trackbox. (In Cell Mode of the Piano Roll, the 
length value sets the width). 

• Cell Mode serves to improve the overview especially when editing 
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ositions, and velocity. 

iting events, just like in the 
piano roll: 

en into account when the events 
are drawn. 

to create a new pattern, 
you have to select it first in "Selection Mode" and press the keys 

Velocity Tool (5): This mode allows you to mark events and change 
values of all selected events in relation to each other. 

Absolute values are entered when you hold the Shift key, i.e. all 
changed me velocity value. 

If this button is active, the bar height is used when displaying the 
velocity value of the note. In all mouse modes (except for "Delete") 
the velocity can be changed by directly clicking on a note without 
have to switch to the Controller Editor. 

Drum Maps 
Drum Maps specify individual instruments, for example, Bass, Drum, 

MIDI drums and permits a structured and efficient workflow. This is 
because the display can be limited to the most important 
information, starting note p

Mouse modes 
The following modes are available for ed

Selection mode (1): You can use this mode to select drum events, 
move or change the length of one or several events simultaneously. 

Draw Pencil (2): In this mode you can draw drum events. If 
quantization is also activated, they snap to the grid immediately when 
you enter them. 

Drum Pencil (3): This mode also entails a draw function. However, 
the quantization length is also tak

Pattern Pencil (4): This mode allows you to draw entire Drum 
Patterns (or melody patterns). If you want 

Ctrl+P simultaneously (or go to menu "Edit" in the MIDI/Drum Editor > 
Create pattern from selection"). If you have created a preset pattern, 
you can start drawing at any position. The lowest note in the pattern 
is then the pitch you are drawing. 

the velocity 

 events receive the sa

Eraser (6): This tool lets you delete events with a single mouse-click. 

Zoom mode/magnifying glass (7): Sketch a rectangle to zoom in. 
The left mouse button is used to zoom in, the right one is used to 
zoom out. 

Velocity 
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 individual output notes, MIDI channel, and 

The Drum Map can be set in the track info (should the track be set to 
MIDI recording), via the "Drum" field and via the Drum Editor itself by 
clicking on the "Map" field. 

This means that when you play the drum event, the sound you wish 
 be heard (for example, instead of a bass drum, you 

p Editor 
This editor lets you route each played note to a different one and give 

in
ch

P  incoming MIDI note. 

In is where you can find the name of the drum 

Grid: If desired, you can set up a grid for the starting point of the 

nt 
here. Furthermore, you can select swing, window, and near 

ation settings can be found in the menu "Options > 

drum instrument can have its own quantization. To make the 

HiHat, Snare, etc. An
velocity scaling can be set for each of these instruments. To split the 
drum names a "General MIDI" map is used by default. 

It may be the case that your synthesizer (regardless if real or virtual) 
uses a different mapping setup. 

to hear may not
get a High Tom). In this case you will have to re-sort your mapping 
setup. 

Drum Ma

them their own individual names. It's also possible to assign each 
dividual instrument its own quantization and a new (MIDI) output 
annel. 

itch: This is the

strument: Here 
instrument, for example, "Bassdrum 1". 

drum event. 

Length: In this field you can set the grid for the note length. 

Output note: This is the note value to which the drum instrument (the 
incoming MIDI note in the "Pitch" field) should be routed or mapped. 

Channel: You can set up an individual channel for each instrume

quantization for each instrument in the Drum Editor. 

Quantization 
The global quantiz
Quantization options". Press "Q" to trigger global quantization. Each 

necessary settings, select the arrow next to the track name of the 
instrument you want to edit and open the quantization options. 
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The Score Editor displays the MIDI data of a MIDI object as a score 
ets" the available MIDI data into  realtime. If you move 
IDI data, such changes are immediately reflected in 

n the MIDI notes. You will therefore always have a 
I object should 

lly 

e Score Editor 
otes or the pen 

notes. In this chapter you will 

, it is better to make MIDI changes 

nto the MIDI Editor window. If the MIDI 
the linear score view by pressing 

sheet. It "interpr
or change the M
the score image. If you insert a new note in the Score Editor, a 
corresponding MIDI Note On event is created immediately. Therefore, 
do not view the Score Editor as a score painting program but more 
as an interpreter for MIDI data. 

For instance, it is not possible to insert or delete rest symbols 
directly. Samplitude Music Studio 14 automatically "registers" rests in 
the gaps betwee
valid score sheet and "complete" bars, even if the MID
only contain a single MIDI note: the necessary rests are automatica
inserted into the bars. 

The common controllers of the MIDI Editor in th
operate as usual, e.g. the eraser is used for deleting n
for creating, copying and inserting new 
learn how you can edit your MIDI objects within the regular score. 
While the Event Editor contains specific editing options for certain 
details (dynamics, note length)
directly in the score sheet as it guarantees a better overview. 

ening the Score Editor Op
The Score Editor is integrated i
Editor is opened, you can activate 
the "Score Editor (linear)" button. 

Score Editor (linear) butto
 

n 

N n adjust the play cursor directly in the score by 

pl
border and right-clicking the right border of the range. 

Score Editor Modes 
ude Music Studio 14 offers two alternatives for viewing the 

e mode.  

The linear note display can be combined with the matrix display 
which offers ideal MIDI Editing options, as the detail in depth of the 
matrix editor and overview can be supplemented by several score 

avigation : You ca
holding shift and clicking the desired position. You can set the 

ayback range by holding the shift key and left-clicking the left 

Samplit
score: linear display and pag
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 the score in the score sheet and perform 

Linear view 

systems. You can select
fine adjustments in the piano roll. Selection and zooms in all editor 
views (linear score, piano roll, event list, velocity editor) are always 
synchronized. 

Score Editor (linear) button 

For detailed editing of the MIDI data in the score you should 
preferably select linear view mode as both matrix and velocity display 
are available. All parameters such as pitch, note length, and velocity 
are displayed. 

Please note: Only the notes of the currently active system are 
displayed in the Velocity Editor if notes and velocity are parallel. The 
red bar mark indicates the currently active system. 

 

Notation view in Linear mode (move bar betwee and matrix) n score 

The horizontal zoom above the scroll bar zoom  the matrix s parallel to
view. 

In linear mode details can no longer be displayed correctly if you 
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oom out horizontally as the note symbols overlap. It may then be 
uce the size of the notation symbols (+- buttons on 

). Despite the no longer correctly displ tails, zooming 
vide you with a good overview ularly in large 

cores. Samplitude Music Studio 14 can adjust the notation symbols 
ally. To do this, please select "Automatic zoom" in the 

plays the notes just like on a al score sheet, 
rint preview. Here you ect notes and 

staves and delete them, although you cannot 
use or pen. 

z
necessary to red
the right ayed de
out can still pro , partic
s
automatic
Score menu. 

Page view 
This page mode dis  music
which also serves as a p  can sel
allocate them to voices/

omove them with the m

Score Editor page mode 
 

Page view is not only useful for preparing a scor sheet (e.g. for titles, 
but also for editing longer sequences. The stave break 

 you to display considerably more bars an with the linear 

iew mode: Use the vertical scroll bar to scroll from 
 page. 

e 
borders), 
allows  th
display. 

Scrolling in full v
page to

 

Page mode as print preview: You should first change the page 
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of your 
pends 

on the page format. You will then see your score exactly as it will be 

format (in the Score Properties dialog) to the paper format 
printer before setting up the page for printing as the display de

printed. 

The score 
The automatic conversion of MIDI data into score is usually sufficient 
for editing MIDI data as efficiency is required here instead of a 
perfect, ready-to-print display. However, it may still be necessary to 
adjust some of the display options while editing. The display options 
can be found in the MIDI Score Properties dialog, which you can 
open by clicking on the "Print" button. 

 
Opens the Score sheet settings dialog for notation and 
page properties. 

This is also where the presets are stored. These are pre-programmed 
standard settings for certain instruments or instrumentation such as 
strings or orchestra. Selecting a preset improves the score display 
and its readability. 

 

Treble clef view (preset) 

 

Switch notation display by selecting the piano clef preset. 

Further explanations of the notation system can be found below. 

Editing MIDI data in the score sheet 
Selection 
As usual you can select notes by clicking them. You can select a 
group of notes (e.g. a chord) by sketching a frame over them while 
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itch, velocity, and length can be changed for one or 
several selected notes. If you have selected one or several notes the 
data of the current note will appear in the info bar above the score 
view. Changing a parameter may have a comparable effect on all 

e when moving is determined by the selected 
quantization raster in the MIDI Editor. 

Insert new notes 
You can also insert new notes in the score editor by using the pen. 

ith the pen, hold down the mouse key 
and, if necessary, correct the position and pitch. If you let go of the 

 
the lower part of a piano system, first click on the lower staff in the 
system on the left.  

Only notes are inserted that correspond with the current pitch. Non-
scale notes or chromatic intermediate steps are skipped. When you 
enter conventional music material with the mouse, diatonic insert 
mode increases the chances of hitting the correct note. If a new 
prefix is to be added to the note, you can move the note 
chromatically with the arrow key. This way an inserted F in C-Major 
can be transformed into an F# by pressing the "Page Up" key.  

Delete notes 
You can delete notes by 

• selecting them and pressing the "Del" key or 
• by clicking on them with the eraser (or the right mouse button). 

holding down the mouse key. Select multiple single notes by pressing 
the Ctrl key. 

Note parameters 
The parameters p

selected notes, just like in the Matrix Editor. 

Move and transpose 
To move notes, first select and then drag them to the desired 
position. Here the info box can help you keep track of the pitch or 
position. The step siz

Copy 
Select the desired notes and copy them by holding down the Ctrl key 
and dragging the mouse. Alternatively you can also use the copy 
function of the Edit menu. 

Click on the desired position w

mouse key, Samplitude Music Studio 14 will add a new note of the 
same length as the selected length quantization value. You can only 
insert new notes into the active stave. For instance, to insert a note in
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Delete notation symbol 
Notation symbols such as clef and pitch cannot be selected as they 
are meta information for the notation display and no MIDI Events have 
been allocated to them. They can also be deleted by clicking on them 
with the eraser (or the right mouse button). 

Adjusting and optimizing the score. 
Samplitude Music Studio 14 automatically generates a notation 
display from the MIDI events contained in the MIDI object. This is 
always correct as regards pitch and position. However, this does not 
mean that the notation can be optimally read as displaying note 
lengths also plays an important role in this context. In this case the 
notation permits more interpretation flexibility so that the user usually 

a  would 

ver, it is not readable. Why 

of a note, its length and pitch, which has to be taken into account 
 

always are slightly shorter than sixteenth notes. If this were to be 

in the example above. The MIDI events also do not contain 
information on whether the gap between two notes is a real rest, its 
harmonic correlations (pitch), and the characteristics of the dynamic 

f notation always 
dio 14 

Note allocation in multiple staves 

Insert notation symbols 
Clef symbols can be inserted at the current cursor position by 
pressing the corresponding clef symbol in the active system. 

has to intervene. The illustration shows a typical example of how poor 
readable transformation of a sixteenth note piano sequence

look in notation.  

This representation may be correct; howe
is that? The MIDI events contain very precise information on the start 

during playback. It may influence the groove of a song if the notes

displayed correctly in the notation, the score would be unreadable as 

sequences. This is why automatic processing o
differs from what would be ideal. Samplitude Music Stu
includes an number of automatically and manually controllable 
functions for making it easier to read the notation. The reworked 
version of the the above score illustration shows how big the 
difference can be. 

The term "Stave" refers to an individual line within a stave as well as 
all staves of a score. In cases where it is important to be able to 
differentiate a score and a staff from one another, we use the term 
"Stave" for the score and "staff" for a single system. 

What is meant by a "Stave" can often be interpreted from this 
relation, for example, in a two-handed piano piece, "upper" or "lower" 



 

MIDI Editor 171  

systems are referenced. 

Samplitude Music Studio 14 provides multiple systems, for example, 
for piano notation or entire scores, which can be comprised of up to 
16 individual systems. 

To manually assign notes to a system, click on  

 

to move the selected notes one line on a stave higher and 
correspondingly on 

 

to move them one line lower. This results in the note being connected 
to the line (independently of the MIDI channel or pitch). This manually 
set allocation can be undone by clicking on  

 
"Automatic staff allocation"  

 

www.magix.com

When transcribing a MIDI piano recording, splitting the notes into a 
two-line piano system using the split point is recommended. The 
points where individual notes are placed incorrectly in a line can be 
corrected easily by assigning the notes manually with a click to the 
desired stave. 

The automatic allocation of the score to a specific line is flexible: 
either the MIDI channel of the note event, the pitch or even a 
combination of the two can make up the criteria. This permits simpler 

 stave. Let's assume 
the notes for the right hand are on channel 1 and the notes for the 

n channel 2. In this case you should set up two staves 
 

with the "Piano" preset. For the first staff, set the MIDI channel 

and faster distribution of MIDI notes in the score line.  

Example: It's often the case that, with some standard MIDI files, the 
notes of a lower system of a particular piano piece have a different 
MIDI channel to that of the notes of the upper

left hand are o
for the stave in the note stave settings. The easiest way to do this is

allocation to "Ch. 1" in the "Channel" selection box and "Ch. 2" for 
the second staff. Deactivate allocation according to pitch by setting 
the split point to 0 (see MIDI Score Settings dialog). 
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The rules for allocation are as follows: 

If the (preset) option "Automatic stave allocation" is set for the note, 
the staves will be played through until the MIDI channel corresponds 
with it and the pitch is over or equal to the split point. 

Note: It may happen that some notes are not shown at all as they are 
not yet allocated to a stave. 

Multi-voice notation 
Up to two independent voices can be annotated for each staff. The 
voices differ in the direction of the note stems: the first voice is 
always with the stem pointing upwards, the second with the stem 
pointing downwards. Rests are displayed individually for each voice. 

Multi-voice notation can simplify the score considerably and enable 
multiple instruments or parts to be displayed in one staff together.  

 

You can set the voice by selecting the notes and clicking on the 
button or menu command "Assign first voice" or "Assign second 
voice". 
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Here, the stem direction of the notes, and therefore the voice itself, 
are set. 

This assignment can be undone by clicking on 

"Automatic staff assignment for notes". 

tave 

cal when 

For automatic voice assignment, the note's MIDI channel has to be 
analyzed. 

To do this set up a MIDI channel for the second voice in the "S
properties" dialog. This can be set individually for each staff. All notes 
of a stave whose MIDI channel has not yet been assigned to a 
second voice, are added to the first voice. 

Voice assignment via the MIDI channel can be practi
displaying standard MIDI files with multi-voice piano pieces if the 
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vo to the first and second MIDI channels 
and the voices of the left hand are set to MIDI channels three and 

ices of the right hand are set 

four. In this case, apply the following settings: 

 

Note: If there is no MIDI channel selected for voice assignment, only 
one voice will be annotated (if manual voice assignment does not 
occur). 

MIDI Score Settings dialog 

Open Score Settings dialog for stave and page properties 
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page format settings can be set. None of the 
settings have any influence on the MIDI data itself, but rather only on 
Here, note stave and 

the display of the score. 

 

Note: The affected stave settings are always applied to all MIDI 
objects situated on the current track. The page format settings are 
global and valid for every VIP. 

Stave settings 
 

Samplitude Music Studio 14 provides MIDI files with up to 16 staves 
(for 

instruments that transpose, for example, a saxophone), and display 

Name") can be set as well as 
the MIDI channel for automatic stave/voice assignment. 

Similarly, the split point serves automatic stave assignment: Notes 
above the split point are added to the upper stave, while those under 
the split point are added to the stave beneath it (as long as the MIDI 

All settings for the stave an display parameters/options can be
accessed via this dialog page. Here you can enter the clef.  

on one track. For each staff, the clef, display transposition 

quantization can be specified individually. 

Furthermore, an instrument's prefix ("
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ally using the arrow buttons 
(up/down). In the lower range the display options of the active staff 
are shown. 

Note display: Interpretation options 

Simplify note lengths (Interpretation) 

d to a note whose value is considerably 
longer than the "real MIDI note". This is practical when working with 

The active staff is recognizable via the index marked in red. The list of 
16 staves can be scrolled vertic

Optionally, all changes to settings, display options, clef, and display 
quantization are always transferred equally to all staves. 

None of the options have any influence on the MIDI files or playback. 

Displays rests and slurred notes in such a way that the score is as 
legible as possible without influencing playback. 

Automatic staccato articulations 

A staccato symbol is adde

simplified length display. 

 

Option: "Simplify note lengths (interpretation)" selected.  

Additional option: "Automatic staccato articulations". 

Hide note overlaps: 

Prevents the overlapping of sequential notes which, for example, 
arises as a result of playing legato: 

Recognize triplets 

Activate this option if triplets are present in the MIDI object. 
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Please note: The display quantization value always has to be one 
step finer than the smallest discernible triplet value. To recognize one 
eighth triplets, display quantization has to be set to at least one 
sixteenth (or to 1/64 for 1/32 triplets). 

Strict measure/pulse division: 

ger than a beat subgroup (pulse). 
Longer notes are displayed as multiple slurred notes. This can 

Larger beam groups: 

 flam notes as long as a base note is present. 

Notation symbols 

There are no note or rest values lon

simplify the legibility of the score. 

Beam groups are partially compiled across beat subgroups. This can 
simplify the legibility of the score. 

Recognize grace notes 

Note values which are much shorter than the display quantization 
value are annotated as

Clef 

 

There are four clefs available in Samplitude Music Studio 14: violin, 
bass, tenor, and alto clef. Samplitude Music Studio 14 differentiates 
between base clef and clef change. The base clef can be set up for 
every stave in "Score settings" (and applies to all MIDI objects on the 

cursor at the desired insert point and click on the 

ginning of the tenth beat) the 

current track). A clef inserted from the tool bar, will be interpreted as 
a clef change. Clef changes are possible any number of times in a 
song and also within beats. 

Insert: Activate the staff into which the clef should be inserted (by 
clicking on the staff signature to the left). 

Position the play 
desired clef in the symbol bar. Move the playback cursor to the 
desired insert position and click on the desired clef in the symbol bar. 
The clef will be inserted musically, not graphically, that is, with a clef 
change at position 10:01:000 (the be
clef symbol at the end of the ninth beat will be displayed according to 
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Clef changes can also be deleted by clicking on clef symbol with the 

ers of the VIP project. 

eraser (or the right mouse button). 

Beat signature 
The metric and beat signature symbols are created automatically 
from the tempo mark

Beat changes are possible at every full beat border. In addition, you 
might want to create a beat count measure marker with the new 
signature (for example, 6/8) at the desired position. If there are no 
beat count measure changes, it's enough to set the bar type of the 
piece (for example, 3/4) in the transport control. 

Accidental 

 

Samplitude Music Studio 14 sets the sharps and flats according to 
the clef description you selected. It is often the case, however, that 
enharmonic change can considerably optimize the legibility of certain 

Enharmonic change 

passages. In this case you can act manually. To change one or more 
selected notes enharmonically, click on the corresponding button. 
The function transforms flats into sharps and vice versa. 
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P
You can select the page format independent of the printer settings so 
that it always has the same note layout regardless of workplace and 

f the printers installed in Windows. 

age format settings 

independent o

 

In the score–page format setting, texts for tempo description, 
composer, and an additional text can be entered. Similarly, you can 
choose which layout elements should appear on the page 
(checkboxes for beat numbers, page numbers, and texts). 

 only need to specify the page size, orientation, and page 
borders. 

• Note size: Here you can scale the size of the note symbols/the 
printout. This is actually irrelevant for working with the monitor's 
display as you can zoom whenever you want anyway. However, the 
size of the notes does influence at which position a line or page 
break occurs. 

• Set a value smaller than 100% to get more beats/staves onto one 
piece of paper. 

• Set higher values than 100% in order to keep larger note symbols on 
the printout. 

Print notes 
Activate the print process in the Score > Print Notes menu or via the 

Printing score 
Samplitude Music Studio 14 automatically creates the layout of the 
score and caters for optimal division of staves and staves on the 
page. You
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Print button. Furthermore, a prin
appears differently for each printer
printer there are various options, f  
you wish to print and the number 
set up the same paper format for  
otherwise the printout may be scal  

The following won't be printed, it's

• The lines which highlight the page
• Mouse pointers 
• The color display of the currently eas. 

ter dialog window appears which 
 or printer driver. Depending on the 
or example, the selection of pages
of copies. Make sure that you have 
the printer as for the page mode,

ed and the page ratio changed.

 only visible on the monitor. 

 borders on the monitor 

selected notes and playback ar

When printing a file (e.g. as a PD r) F file with a special printer drive
please note that you have to a  ctivate the option "Save fonts in
document" in the printer driver so   that the notation symbols will be
displayed correctly in the document. 

Quantize 

Irregularities when importing can be corrected using the quantization 
function. Clicking on "Q" shifts all selected notes to a customizable 
quantization grid. All notes are quantized without previous selection. 
As a quantization value for the length display of the individual MIDI 
events, note values of whole notes up to 1/64, and n-tuplet and 
dotted values can be selected. Quantization options (Options menu in 
the MIDI Editor): 

• Strength of the quantization in % (Strength 0... 100): 
• "100" moves the event precisely onto the quantization snap point, 
• "50" moves it into the middle between the current position and 

quantization snap point, 
• "0" means there is no movement > Quantization off 

Swingin % (Strength 0...100) 
Starts swinging, groovy playback (for example, triplet). Specifies the 
division for uneven grid points. 

• 50 ... "50-50 division": The uneven 1/8 note is exactly half way 
between the even eighths ("even play" mode) 

• 67... triplet play, 3-2 division 
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the window are quantized, those 
outside remain at their position. 

rs half of the quantization interval. Events with 
gaps of ¼ of the grid width left and right of the grid point are 
quantized. 

o window -> Quantization off 

s a half grid shift to the left (earlier), +100 is a corresponding 
shift to the right (later) 

N-Tuplet (off, 3, 5, 7, 9) 
antization values (for example, 8T, 

e note that you can only work either with the 
swing setting or n-tuplets. 

MIDI Editor shortcuts 

Window in % (Strength 0... 100) 
Quantization window, events in 

• 100: Window covers the total range from the grid points of the 
quantization grid. 

• 50: The window cove

• 0: N

Offset 
• Value range: -100...+100 
• Offset moves the entire quantization grid: 
• -100 i

The grid is split into n-tuplet qu
16T). You can enter any number you like, as well as the previously 
defined numbers. Pleas

Reset 
Restores the default values. 

Apart from few exceptions such as "Space" for stop/playback the 
keyboard shortcuts can be defined freely with the keyboard shortcut, 
menu and mouse editor. For some basic functions such as scrolling 
and zooming, all keyboard shortcuts from the VIP are applied. You 
can explicitly define shortcuts for all commands that are available in 
the MIDI Editor menu. 

Hint: The mouse wheel settings are also applied from the VIP, as is 
the switch for the temporary zoom mode (special) which is predefined 
with the Z key 

Playback/Stop Space bar 
Close MIDI Editor (apply changes) Return 
Close MIDI Editor (discard changes) Esc 
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Ctrl+I 
Export MIDI Ctrl+E 

Ctrl+C 

Ctrl+Back, Ctrl+Del 
Select next event Arrow right 

Arrow left 
 

Options 

Quantization grid active Ctrl+G 
antization grid Alt+G 

Quantization options Alt+Q 
MIDI Object Editor editor Ctrl+O 

Split note mode 9 
Mute notes (Mute) mode M 

File 
Import MIDI 

 
Edit 
Undo Ctrl+Z 
Redo Ctrl+Y 
Cut Ctrl+X 
Copy tracks 
Insert Ctrl+V 
Duplicate Ctrl+D 
Select all Ctrl+A 
Create pattern from selection Ctrl+P 
Delete selected MIDI data Back, Del 
Delete all MIDI data 

Select previous event 

MIDI functions 
Legato Ctrl+L 
Quantize notes Ctrl+Q 
 

Scroll mode F 
Show Event list  Alt+L 
Show Velocity/Controller Editor Alt+V 
Play clicked notes Alt+P 

Show qu

Audition Panic-End played edit notes Ctrl+F 
 
Mouse mode 
Selection 1 
Draw 2 
Drum (-draw) 3 
Pattern (-draw) 4 
Change velocity  5 
Delete 6 
Magnifying glass 7 
Glue note mode 8 



 

 182 MIDI Editor  

www.magix.com

Alt + Arrow down 
 value Alt + Arrow up 

Velocity/controller selection Ctrl+1 

Select next event Arrow right 
Select previous event Arrow left 
Event pitch higher Arrow up 
Event pitch lower Arrow down 
Select next grid quantization value 
Select previous grid quantization
Select next length quantization value Alt + Arrow right 
Select previous length quantization value Alt + Arrow left 
Move play cursor forward Page down 
Move play cursor forward (fast) Ctrl + Page down 
Move play cursor backward  Page up 
Move play cursor backward (fast)  Ctrl + Page up 

Velocity/controller draw freehand Ctrl+2 
Velocity/controller draw freehand Ctrl+3 
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ject according to VSTi standards (for example, 
Sample Tank) and can be controlled via the internal MIDI functions 

ting options. The maximum number of instruments is limited 
by the performance power of your processor. You can increase this 

Samplitude Music Studio 14 provides the option of integrating 
software instruments as well as MAGIX Synths (for example Roboto 
Pro) into a virtual pro

and editors. All instruments as well as their multiple outputs are 
seamlessly integrated into the Audio Engine with all of their effects 
and rou

number by using the integrated freeze function. 

 

ftware Instrument Robota Pro So

In

In
m
in

w

stallation of instruments and path 
ettings s

stall every VST instrument according to the instructions of the 
anufacturer. Samplitude Music Studio 14 searches for installed VST 
struments in the "VST Plug-ins" program subfolder. You can install 

your VST instruments either in this folder or use any other path to an 
already existing folder, for example, to another host application. You 

ill, however, have to enter this foreign path in the stave settings ("Y" 



 184 Software/VST instruments  

 www.magix.com

ke s > VST / DirectX / ReWire" subdialog (entering 
multiple paths is also possible). Simply enter one path after the other, 
all paths will be taken into consideration. Samplitude Music Studio 14 

newly installed plug-ins contained within the 
selected folders. 

y) in the "Effect

will automatically find 

 

The first time the program is opened, a search for existing 
instruments and plug-ins is executed when the track settings are 

ot only are all the plug-ins imported, but they are also opened. Here, n
checked for their usability within the program. This search is only 
necessary once, the next time it is opened, the track settings will be 
opened immediately. 

Tip: For problems with your current configuration, you can reset all 
paths and installed instruments or plug-ins. To do this, delete the 
"VST Plug-ins.ini" file in the Samplitude Music Studio 14 folder. All 
paths will have to be newly entered. Plug-ins which were removed 
from the program prior to this will still be shown. 

Load instruments 

These are managed in Samplitude Music Studio 14 under "Track 
menu -> VST Instrument Editor". You can also assign an instrument 
to each track – the instrument is selected as a MIDI playback device. 



 

Software/VST instruments 185  

 

www.magix.com

idual outputs are shown directly in 
the first VSTi Plug-in/Insert slot of the track box and mixer track and 
Selected instruments or their indiv

can also be muted (left-click) and opened (right-click) from there. 

 

• Load an instrument by selecting a "New instrument" in the project 
window as a track output. This can happen at various points: 

e" button -> MIDI -> New 
instrument) 

• "Out" slot -> MIDI -> New instrument in the Audio section of the 

and can be opened again at any later date by right-clicking on 
the VSTi slot in which the instrument name is displayed. Alternately, 

ord 
button on the track -> Instrument output -> VSTi Editor. 

-in) does not have its own interface, the parameter dialog will 
open. This display mode is limited to just a few control elements and 

layed. 

• Playback device menu (right-click on "Mut

• Plug-ins slot -> VSTi in the Track Editor 
• Insert effect slot of the mixer -> VSTi: You will only find this option in 

the top Insert slot of the individual mixer channels. 
• "Out" slot -> New instrument in the MIDI section of the Track Editor. 

Track Editor. 

Adjust instrument parameters 

The instruments editor (panel) is then opened when an instrument is 
loaded 

the VSTi Editor can also be opened by right-clicking on the rec

The graphical interface opens by default. If the selected instrument 
(or plug

can only be opened via the menu of the instrument window. Use this 
mode if you find the panel of the plug-in too unclear or if it takes up 
too much space on the screen. In this dialog eight freely selectable 
parameters of the instrument are clearly and numerically disp
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t 
parameters, the "Auto" checkbox is also of importance. Once 

 fader. 

is saved for each plug-in so that the next 
time you use the same plug-in in a different project, the same 

nel and parameter dialog 
The instruments editor (panel) is opened when an instrument is 

Editor can also be opened by right-clicking on the record button on 

The graphical interface opens by default. If the selected instrument 

t the parameter values. 

Bypass: Deactivates the instrument and mutes it. Note that some 

ocated in the Insert slot. In such cases, the instrument should 
be removed completely from the Insert if it is no longer required. 

Bar controls can be used to adjust the parameter values. 

Alongside the combi-boxes for the selection of all instrumen

activated, the automatic processes of the selected parameters are 
started. The automation curve is shown in the project track and can 
be edited. The parameter can be automated using the

Activate automation parameters by checking the "Auto" control box. 

The parameter selection 

parameters are used. This way you have the advantage that every 
frequently used parameter of the corresponding instrument is 
available immediately after it has been opened. 

Instrument pa

loaded and can be opened again at any later time by right-clicking on 
the VSTi slot displaying the instrument name. Alternatively, the VSTi 

the track -> Instrument output -> VSTi Editor. 

(or plug-in) does not have its own interface, the parameter dialog will 
open. This display mode is limited to just a few control elements and 
can only be opened via the menu of the instrument window. Use this 
mode if you find the panel of the plug-in too unclear or if it takes up 
too much space on the screen. In this dialog eight freely selectable 
parameters of the instrument are clearly and numerically displayed. 
Bar controls can be used to adjus

The parameter selection is saved for each plug-in so that the next 
time you use the same plug-in in a different project, the same 
parameters are used. This way you have the advantage that every 
frequently used parameter of the corresponding instrument is 
available immediately after it has been opened. 

Dialog menu 
Further options can be found in the menu of the Instrument window: 

instruments use up processing power if bypass is switched on but 
are still l
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 on if you wish to be able to 

al Audio Options ("Y" key, Audio setup tab) dialog. 

hes/banks: Here you can save an instrument's 

 a random value. For synthesizers, this option can 
lead to surprising results and provides interesting results for the 
sound design thanks to the random generation of a new sound. Here 

note, however, that parameters can only be set when 
they are accessible via the interface. With some very complex virtual 

meters, very extreme sounds 
can be generated. This may lead to no sound being produced at all 

Play and monitor instruments live 

In
en s would be a MIDI keyboard. Of course 

ha

Fo playing you will in any case require an 

ho

• 
• 

 Driver system) 

• 
• Software Monitoring or Hybrid Engine (Options > System/Global 

Monitoring: This option must be switched
hear the instrument when it is being played or recorded. If you wish 
to always have monitoring active when the track's REC button is 
pressed, please select the "Tape Monitoring" option in the 
System/Glob

Loading/Save patc
settings and sounds. The standard formats for this are: *.fxp for 
patches or *.fxb for whole banks. Some instruments have their own 
patch/bank format, settings are then loaded and saved directly via 
the instrument's interface. 

Set parameters randomly: Use this function to set all parameters of 
an instrument to

you should 

synthesizers, like, for example, modular systems, some parameters 
may not be modifiable using this option. Please note that thanks to 
the random placement of various para

or extremely loud volumes and frequency ranges being reached. For 
this reason you should keep an eye on the preview volume when 
experimenting with this function. 

Monitoring 
 order to play virtual software instruments you require a device to 
ter the data. Typically thi

you can also use any other PC that transmits MIDI data or a 
rdware synthesizer. 

r direct monitoring while 
audio interface with ASIO drivers. Simply playing instruments, 

wever, is also possible with MME or WDM drivers. 

For live monitoring you also have to make the following settings: 
ASIO drivers (System/Options > System/Devices > Global audio 
options > Playback devices >

• Activate global record monitoring in the Transport Control ("Rec M" 
button) 
Activate the track monitoring button (loudspeaker symbol) 
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audio options > Audio setup) 

Tip: You can also select monitoring mode by right-clicking on the 
Record Monitoring button on the Transport Control. 

Latency: Please not that a system-dependent delay between 
pressing the key and the instrument sound occurs when you play 
virtual software instruments. This so-called latency time is mainly 
determined by the buffer size set for the ASIO drivers. For playing in 
an acceptable manner we recommend a buffer size of 1024 samples 

curs when an instrument is played, playback latency of 
an already recorded MIDI track over a virtual instrument is 

As software instruments are fully integrated into the audio engine of 
ignals can be routed, mixed and equipped with 

plug-ins any way you like. There may be some restrictions when 
playing, but all functions are fully available during playback. 

max. This corresponds with 23ms at 44.1 kHz. For many users, 
however, a latency of 3ms, i.e. 128 samples, is optimum. Please note 
that the CPU load also increases at a lower buffer size. The "live" 
delay only oc

compensated later. 

the program, the s

Hint: Please note that "Track FX Monitoring Mode" or "Mixer FX 
Monitoring/Hybrid Engine" have to be acvtivated. 

Recording and playback of an instrument 
An instrument is recorded much in the same way as a normal MIDI 
track. Make sure that the MIDI recording is active in the desired track 
and then press the record button in the transport control. The 
recording begins immediately. 

When playing already recorded MIDI tracks, track monitoring should 
be switched off. 

Route MIDI instrument inputs 

Nearly all software instruments require MIDI data in order to be heard. 
To route the MIDI input onto a specific track which contains the MIDI 
data, click on the VSTi button in the Track Editor of the 
corresponding track and select the instrument from the "Out" slot 
which you wish to activate. Already loaded instruments are 



 

Software/VST instruments 189  

 

www.magix.com

Instruments with multi-channel outputs 

The number of available individual outputs generally depends on the 
instrument where it also can be adjusted. Outputs can be available in 
stereo and mono versions. 

Two examples of typical handling of individual outputs: 

Addressing an instrument on a MIDI channel and distributing 
sounds over several tracks 
This approach, for example, is ideal for all drum samplers if you want 

d 
program (part) on a specified MIDI channel. This also has the 

often 
have separate audio outputs. Please remember to route the individual 

mentioned in this list. 

To open a completely new instance of an instrument which works 
independently of already existing instruments within the project, 
select its name from the "New instrument" submenu. 

to address an entire drum set, but prefer to mix and edit the drum 
sounds individually. 

Addressing an instriment on several MIDI channels 
Several MIDI tracks are typically used for so-called multi-timbral 
synthesizers which can play several sounds on different MIDI 
channels simultaneously, whereby each addresses a specific soun

advantage that such instruments only require one instance of the 
plug-in for several sounds. Multi-timbral software instruments 

parts to the desired outputs within the VST instrument (panel). 

Routing of VST instruments using the 
VSTi manager. 

There are many flexible methods for signal routing of instruments. 

As described in the previous paragraph, an instrument can be fed 
from several MIDI tracks, and the outputs of an instrument can also 
be sent to several tracks. 
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strument outputs 
Instrument outputs can be easily routed in the VSTi Manager. To do 

ack". 

Routing in

this, open the VST instrument to view the individual outputs and 
right-click on the "Output to tr

Now search for the track which should be fed the corresponding 
individual output. The assigned output then appears in the plug-in 
slot of the target track. 

Alternatively, you can also route directly to the track box of the 

strument available 

rent 

Remove 
the instrument output by removing the check in front of the 

 output" submenu. 

se the entire routing options of the 

arranger: 

To play the output of an already loaded (or installed) instrument on a 
specific track, right-click on the record button of the track, go to 
"Instrument Outputs" and select the output of an in
in the project you want to sound on this track by adding a check. 
Several outputs of an instrument can also be used simultaneously in 
one track. You can even combine the outputs of several diffe
instruments into one track. 

Deactivating the instrument outputs works the same way. 

corresponding output in the "Instrument

Please note that you can also u
Mix Engine. You can route any track containing the return of any 
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ack and select the instrument from the "Out" slot 
which you wish to activate. Already loaded instruments are 

Multiple 
instances of the same VST plug-in can be noted from the count 

ct are responsible for the sound, are not present 
in the track, you will still hear the selected track solo. The program 

MIDI data to all allocated 
tracks. 

If an instrument has presets, these are displayed in the “Program 
 (if MIDI mode is activated). 

This flip menu can be used to easily “step through” the presets of 
 selected using the 

e 
program all the time. 

ower for playback, which at 
some point can be quite considerable and is required during every 

instrument to any bus, AUX bus or Master. 

Route MIDI instrument inputs 
Nearly all software instruments require MIDI data in order to be heard. 
To route the MIDI input onto a specific track which contains the MIDI 
data, click on the VSTi button in the Track Editor of the 
corresponding tr

mentioned in this list. 

To open a completely new instance of an instrument which works 
independently of already existing instruments within the project, 
select its name from the "New instrument" submenu. 

(index) in front of the name of software instruments. 

Solo playback of VSTi instrument outputs 
To preview solo instrument outputs, switch the track to which signals 
are added by the corresponding instrument to solo. Even if the MIDI 
objects, which in effe

automatically recognizes from which MIDI track the output is fed and 
lets the instrument continue to receive 

Preset management 

Slot” (“Prg”) with their internal name

your instrument. These presets can also be
“Program” menu of the instrument window. 

If your MIDI input device can send “Program change” commands, you 
can also directly select programs of this instrument. The program slot 
is automatically updated in the track, so you have an overview of th

Freezing instruments (Freeze) 

Software instruments require CPU p

playback. Therefore, please use the Freeze function to release the 
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short 
processing time, all MIDI and audio Objects are replaced by a single, 

is track is no longer addressed by MIDI 
files of this track and can even be deactivated, provided that it is not 

t was 'frozen”. The track is now 
returned to the state in which it was 'frozen', but again requires the 

is project, a new Freeze Object is processed and included in 
the original project. 

t hold 
Objects. The MIDI data that has been routed to the track or to the 

To edit Freeze data you cannot only use the Track Freeze Edit 
 are is no MIDI data available on this track that 

Note: As long as the instrument is not entirely unloaded from the 
system. 

considerable amounts of 

CPU power for VSTi tracks temporarily. You retain full control over 
the MIDI Objects of this track, which can be restored (“de-frozen”) at 
any time. 

To “freeze” an instrument, select the “Track Freeze” option in the 
track menu (keyboard combination: Ctrl+Shift+F). After a 

resource-friendly 32bit stereo audio Object, which is now played 
back instead of the original Object and the instrument. The existing 
automation data and track effects are already included in this Freeze 
Object. 

The actual instrument of th

used by other MIDI tracks. 

Select “Track Unfreeze” (Ctrl+Shift+U) to change the original MIDI 
data at a later point in time tha

initial CPU power for processing the instrument. 

Alternatively, you can use the feature “Edit Track Freeze”. In this case 
a new single-track VIP is opened with the original track. This track 
cannot be played together with your arrangement. As soon as you 
save th

Freeze also works with single outputs in different tracks than the main 
output track (Instrument outputs 1+2). You can also freeze these 
tracks if they do not contain MIDI information and do no

individual output of the instrument automatically creates an audio file 
that is now played instead of the original instrument. In order to 
prevent double playback of the data, deactivate the single output of 
the instrument manually in the frozen track. 

Function as there
could be edited. Therefore, “unfreeze” the track and edit the MIDI 
data of the send track. You can then refreeze the track. 

track it remains loaded into the RAM memory of the 
Samplers or instruments that require 
memory also require this when their Insert Tracks have been frozen. 
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 that use several 
synthesizers and play these in unison) by opening several 

s in 
the MIDI Editor that match the respective instruments. 

• nstruments use sound sets according to the General MIDI 

g to the GM standard. Please import the entire MIDI file to a 
single track including all channels. Please ensure that virtual 

ents can also receive program change commands that are 

re-compatible client applications (like, 
for example, Propellerheads Reason) can be integrated into 

 be loaded as 
instruments into a MIDI slot. All ReWire client applications appear as 

d should 
be closed before exiting Samplitude. Some client applications can be 

tion can then be accessed like a software 
instrument via MIDI, the audio output signal of the ReWire client can 

chronous to the time position of Samplitude. 

Tips on handling virtual instruments 

• You can realize so-called stack sounds (i.e. sounds

instruments and activating monitoring for all channels. 
• To program beats, you can create and save individual drum map

• If an instrument can limit the amount of voices, you can use this 
option to save CPU power if you do not require the full number of 
voices. 
Some i
standard. You can use these instruments for playing back MIDI files 
accordin

instrum
also saved in such a file, so that the correct sounds are played 
during playback. 

ReWire 

If this option is activated, ReWi

Samplitude Music Studio 14 as synthesizers.  

Activate ReWire functionality in the program settings ("Y" key). 
Afterwards, installed ReWire applications can

individual sections in the selection menu of the plug-in slot of the 
track and are loaded as software instruments (VSTi). The client 
application should always be launched after Samplitude an

opened automatically by right-clicking on their name in the MIDI slot 
(red) – just as you can open the plug-in window for VST instruments 
by right-clicking. 

The ReWire applica

be routed to the Samplitude Music Studio 14 tracks. (-> more details 
on loading the software instruments). The client application runs, 
starts, and stops syn

ReWire supports up to 4096 MIDI busses. A ReWire client only 
registers the MIDI busses that are actually available with the host 
(Samplitude Music Studio 14). You can therefore select the bus within 
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the track in the MIDI channel menu (e.g. the receiving instrument for 
Reason): 

The "classic" MIDI channel of MIDI 
notes and events is not important, 
it is replaced by the ReWire MIDI 
bus system. For each track a MIDI 

 

object is able to control a ReWire 
MIDI BUS. This means that all 

Multi-timbral MIDI objects, like 
those created in the MIDI file 
import, cannot be played correctly 
with ReWire. You can, however, 
access the ReWire client across 

ually. You 
can do this by starting your client application as you would normally. 

events of a MIDI object apply to 
the track for this ReWire bus, 
independent of the channel 
number the events originally had. 

multiple tracks on various ReWire 
MIDI busses. 

Only a few ReWire clients support the direct opening of the client 
application via the host application (Samplitude Music Studio 14). In 
this case, you will have to start the client application man

 www.magix.com

It then automatically recognizes the host and starts in a special client 
mode. 
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anged on the tracks together 
with the other objects. 

l folder which is 
copied to your hard disk on installation. To open it, click on the synth 
button. 

You can find all available s  

Object synths and track s
In Samplitude Music Stu types of 
software synthesizers. 

Object synths: These s  objects in 
Samplitude Music Studio e 
moved onto any track wit er 
settings. Object synths a ox, 
Atmos, Vita, LiViD, Robota

Track synths: These synth ts 
in Samplitude Music Stud cts. They 
correspond to functional external hardware synthesizers or VSTi plug-
ins, which are similarly con  
are dependent on the track, that is, the corresponding track synth is 
specified in the MIDI track s 
can also be selected in ita, 
SampleTank, and Revolta are.  

P ogrammi
Depending on the plug-in, various functions to create and control 
sound c n e read the 
following chapters pertaining to the individual synthesizers in this 
regard.  

ramming, playback can be started and stopped at 
any time with the space bar while the operating console is open. If 
the synth plug-in has its own play button (e.g. the beat box), it will 

Synth Objects 

Samplitude Music Studio 14 supplies several synthesizer plug-ins to 
create your own drum pattern, bass or melody lines. The synthesizers 
produce ‘synth objects’ which are arr

DF 

Opening the synthesizers 
The software synthesizers can be found in a specia

ynthesizer plug-ins in the selection box.

ynths 
dio 14 there are two different 

ynths build individual synth
14. A corresponding synth object can b
hout anything changing on the synthesiz
re the Drum & Bass machine, BeatB
, SilverSynth, and CopperSynth. 

s do not build any individual synth objec
io 14, rather "normal" MIDI obje

trolled by MIDI. Like all MIDI objects, they

settings. Correspondingly, the track synth
 the Track Editor and modified. V

belong to this type of softw

r ng the synth object 

a be applied via the operating console. Pleas

To monitor prog
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start the plug-in solo, without playing the other tracks of the 
arrangement as well. 

Arranging the synth object 

 www.magix.com

Once you have finished programming the melodies or rhythms of the 
e and arrange the 

synth objects on the tracks. They can be stretched or compressed, 
faded in and out, turned down or up etc. with the help of handles: 
These steps are the same for all objects.  

The operating console of every synth object can be reopened at a 
later stage by double clicking or via the synth button if you would like 
to reprogram the object. In addition, you can drag as many other 
synth objects of the same software synthesizer as you like onto the 
tracks and program them separately. 

Drum & Bass machine 2.0 

The Drum & Bass machine is a dual synthesizer, uniting both distinct 
styles of Drum’n’Bass in one piece of equipment: fast beat crashes 
and rumbling bass lines. With the Drum & Bass machine you need no 
special skills to create authentic sounds for your Drum’n’Bass songs. 

synth object, you can close the operating consol

A tip: The typical speed for Drum’n’Bass is usually around 160-180 
BPM. The Drum & Bass machine also fits in perfectly with other 
music styles, e.g. BigBeat (120 BPM) or Trip-Hop (80-90 BPM). 

Set-up 

 

The top half of the synthesizer controls the rhythm section, the 
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. Between the two, on the left 
side you will see a symbol, where both sections can be turned on 

, for example, turn off the bass section, 
so that you take only the drum section break beat into the 

ic Studio 14 arrangement mixdown 
will then only include the drum section in the mixdown file. 

The volume control is on the right border, controlling the volume for 
y and stop buttons allow you to listen to your 

Drum’n’Bass creations up front in Samplitude Music Studio 14. 

The ‘Drum‘n’Bass’ label covers a menu containing functions to load 

for 
the programming of the velocity row. 

The rhythm section (top half) 

You set up the new sequence in the top (‘Steps’) row. The blue cells 
 the individual sections (‘notes’) for the subdivision of the 

loop. 

A left mouse click on one of the blue cells allows you to select one of 
sible symbols. Each symbol represents a different note or 

other way of playing the note. Every time you click on one of the blue 

ition and creativity when programming your 
beats. It is not absolutely necessary to know the exact meaning of 

ividual symbol in order to create cool and authentic beats. 

1: Play drum loop from beginning 

2: Play drum loop from the second note 

3: Play drum loop from the third note 

bottom half controls the bass section

and off individually. You can

arrangement. The Samplitude Mus

both sections. The pla

and save ‘Drum’n’Bass’ patterns (Load Machine State/Save Machine 
State) and functions to delete or generate patterns (Clear All/Random 
All). The submenu ‘Velocity Presets’ contains some help functions 

Here you can easily create complex and authentic jungle break beat 
sounds. In a professional recording studio, jungle backbeats are 
created by dividing any given drum loop into several small ‘bits’ and 
putting them back together in a different order. This lengthy process 
is significantly simplified by the Drum & Bass machine. You just 
design your own new play sequence.  

indicate

six pos

cells, the next symbol is chosen. 

Rely on your own intu

each ind

Summary symbol description: 
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from the fourth note 

ws you to delete the step cells 
individually. The ‘Clear’ button on the right deletes all step cells; the 

ndom Rhythm’ 
button generates a random sequence. You can then alter the rhythm 

p sound. 
If you select a different drum loop, it will be loaded and played as 

med by you. 

n set the note to be played twice quickly in 
succession instead of only once, allowing you to program rolls and 

e mouse (left mouse-click increases value, right mouse-
click decreases value). Use the three buttons under the  ‘Velocity’ 

ill affect the sound of your loop. 
If you select ‘Volume’, the velocity value alters the volume for this cell 

se of the velocity values. 

tom half) 
The bass section allows you to create the right bass lines for your 

• By clicking on a cell with the left mouse button, you open a pop-up 
 select the notes.  

• By clicking with the right mouse button, you delete a cell.  

 Octave 3 a high tone. You can only 
set the octave values if there is a note in the row above. 

• As in the rhythm section, there are also buttons for ‘Clear’, ‘Random 

4: Play drum loop 

Backward symbol: Play backwards from this point 

Stop symbol: Stops play 

The right mouse button allo

drum loop is played in its original sequence. The ‘Ra

as you wish. 

By clicking on the blue field in the bottom part of the rhythm section 
you open a pop-up menu where you can select the drum loo

program

In the "Flame" row you ca

fill-ins. 

The ‘Velocity’ row allows you to set intensity values between 0 and 
16 with th

row to determine how these values w

(16 = loud, 0 = quiet). If you select ‘Filter’, the velocity value alters the 
filter strength for this cell (16 = sharp, 0 = muffled). The ‘None’ button 
blocks u

The bass section (bot

rhythm quickly. As in the rhythm row, there are two-step rows.  

• With the first ‘Notes’ row, you determine the sequence of the notes, 
i.e. the sound sequence.  

window, where you can

• If you click on an empty cell with the right mouse button, you will see 
a ‘Stop’ symbol. This function is similar to that in the rhythm section: 
it stops the bass sound play at this point. 

• In the ‘Octave’ row you can determine the bass octave sound. 
Octave 1 creates a deep tone,
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n field at the top border of the bass section. 
The red selection field allows you to set the bass sound. 

also find two sliding controls for 
sound adjustment. You can use the ‘Vibrato’ control to make the 

e control is pushed all the way to 
the right, the swing will be stronger; all the way to the left will have 

 the way to the right makes the sound fade 
out quickly (after approx. ¼ second); all the way to the left means 

Notes’ and a red selectio

• Underneath the step rows, you will 

bass tone ‘swing’ at its pitch. If th

no effect on the pitch. 
• With the ‘Delay’ controller you can set a time for the sound to 

completely fade out. All

ongoing sound. 

Beatbox 4.0 

 

The BeatBox is a high quality drum computer plug-in. It can be used 
to generate completely new rhythms and drum grooves.  

Programming 
Each line of the Drum Matrix corresponds with a percussion 
instrument, e.g. bass drum or hi-hat. Each column corresponds with 

6th note is preset) 

se. A note in the lowest line (bass drum) at bar 
positions 1, 5, 9, and 13 creates a straight bass drum rhythm to 

a bar unit (a 1

The drum sounds are played as soon as you click into the Drum 
Matrix with the mou
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ssion instruments. 

open a list of available drum kits. A 
drum kit is a collection of percussion instruments with matching 

s, e.g. rock kit or electronic drums à la TR 808. By changing 
the drum kit you can add an entirely different sound to the rhythm 

op from the Media Pool. 

 mean that you are restricted to drum sounds. Any WAV 
file can be dragged & dropped into the drum kit from the Media Pool 

samples or your own recorded wave files. 

Track Effects 
To the right of the Drum Matrix you can find the track effects. This 
lets you specify the settings for each active drum instrument. The 

Play: Here playback of the current rhythm pattern starts in solo. Only 

art position must occur above the transport functions.  

Record: Here the realtime recording function of the BeatBox starts. 
Up to 16 r 
keys 1...0 on the 
number pad. A drum sound is played for each key and the 
corresponding note is activated in the Drum Matrix. 

ocity: This button randomly changes the Velocity 

which you can add more great percu

Drum kit 
Click on the drum kit button to 

sound

you have already created. 

New drum or effect sounds can by added to the current drum kit by 
drag & dr

This does not

and can thus form part of the rhythm. Try it with the rap voice 

active instrument is selected by clicking on the drum kit, which then 
highlights the instrument. 

Buttons 

the BeatBox can be heard, any other tracks which may be in the 
Arranger will not be heard. If the entire arrangement is to be played, 
the play st

Stop: Ends playback or recording process. 

drum sounds can now be imported using the compute
above the letter keys on your keyboard or 1...6 

Random Rhythm: This button creates a random rhythm for the 
selected instrument. 

Random Vel
(volume) of the individual beats. This way, a rhythm can be made 
much more lively than when the volume is set to the same for all 
beats. 



 

Synth Objects 201  

 

www.magix.com

Pitch: The pitch of the current drum instrument can be set here. You 
ample, by downpitching the bass 

drum. 

an: Here the stereo panorama of the current drum instrument can 
be set. Add the sa ple, Snare) to two tracks, 
one panned to the left, the other to the right. Rhythms, which 
alternately use both tracks, now sound much more interesting. 

m frequency can be heard, including resonating 
histling sounds, which we already know from analog synthesizers. 

Cut-off: This fader sets the filter frequency. The sound of the drum 
beat is in eased a
are dampened which

Distortion: This fad
This can be used 
distortion sound effe

Shuffle: This fader changes the timing of the BeatBox. If the fader is 
e right, the eighth of a rhythm is played more and more 

like a triplet. If that sounds a bit too abstract – simply try it out, ideally 

er to set the volume of individual drum 
notes. If multiple notes are selected, they will be edited together. 

Bars 1-2-4: With this button you can set the length of a loop of the 
BeatBox in bars. You can choose from 1 bar, 2 bars, and 4 bars. 

Auto Draw: If more than one bar has been activated as a loop length, 
hat the drum notes which are set 

de

more refined constructions) and "free". In this case, the timing is set 

Volumes: Here you can set the volume of the current instrument. 

can access great effects, for ex

P
me instrument (for exam

Reso: You can set the filter resonance here. The higher the value, the 
ore clearly the filter 

w

cr t the set frequency position. Frequencies above it 
 creates the typical filter sound. 

er controls a distortion of the current drum sound. 
to create really "dirty" sounds as well as for 
cts. 

turned to th

with a pure 1/16 Hi-Hat figure; you'll soon see what the shuffle fader 
is capable of. 

Note Velocity: Use this fad

the Auto Draw mode makes sure t
automatically in the first beat are set in the subsequent beats. This 
also makes it easy to create a continuous beat, even with a loop 
length of four bars. Notes set in the bars further back are not affected 
by the Auto Draw function, which, for example, makes faint variations 

tectable only in the fourth bar. 

Quant: Here you can set the tempo of the BeatBox. You can choose 
from 1/8 notes (only for very simple rhythms), 1/16 (default), 1/32 (for 
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by ss of the mouse click – ideal for the more lively design 
of fixed rhythms by moving individual notes here and there. 

The black keyboard keys are in between, i. e. the "A" key for #C (C 
sharp). 

Playing BeatBox on the MIDI keyboard 

selected! The sounds 
e left can be accessed with the keys of the 

ecorded from now on and will be taken into 
account when playing the synth object in the arrangement. 

The recorded effect automation can be deleted via the Options menu

 the exactne

Playing BeatBox on your computer keyboard 
The lower octave is on the keys: < z x c v b n m ; the upper octave is 
on the keys: q w e r t y u i. 

There is not a lot you need to take note of here. You can start playing 
away once the proper MIDI driver has been 
listed in the column on th
C0 octave. 

Effect automation 
The new version "BeatBox 4.0" enables the automation of all 
BeatBox effects. Click on "Automation" at any time during playback. 
All effect settings will be r

 
of the BeatBox. 

Atmos 

Upon registration of Samplitude Music Studio 14 you will receive the 
Atmos synthesizer as a free download. 
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comprehensive tool which can be used to easily create 
realistic nature sounds in no time. From thunder and lightning to 
Atmos is a 

animal sounds and traffic noise, Atmos helps you design natural-
sounding atmospheric noises for your projects. 

 

• At the upper border window
Here, you can select a de

 select the upper category "Scenario". 
sired nature sounds category (for  example, 

"Thunder and Lightning"). 

ader controls the behavior of the sound – depending 
on controller element. For example, with "Thunder" you can set how 

aster volume of the synthesizer can be set. Furthermore, 
the setting "Randomize" can also be found there. This way you can 

MAGIX Vita Synthesizer specializes on realistic playback of "real" 

techniques and volumes are used, combined, and played again at the 

• In the middle of the window appears a collection of control elements 
with which the desired "Ambience" can be designed. Each element 
has its own description (for example, "Thunder") and two faders 
"Volume" and "Intensity".  

• The "Intensity" f

often thunder and lightning should sound; with "Rain", the strength 
of the rain can be regulated (if moved to the far left, light rain can be 
heard, while if moved to the far right, a downpour with loud 
splashing noises is audible). 

• At the bottom right border you will find a master volume fader with 
which the m

change the settings of the control elements by yourself. 

Vita 

instruments for which it uses sampling technology. This means that 
short samples of real instruments in different pitches, playing 
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ia the Output menu at the top of the 
MIDI Editor. 

The VITA synthesizer is controlled via the MIDI objects. If you load 
Vita via the Media Pool, a preset MIDI object will appear first. You can 
then load different Vita sounds v

You can adjust the sounds of Vita via the instrument menu of 
the trackbox. 

 

 

The Vita interface 

 

1. Layer selection/Peak meter: The Vita sounds, also known as 
layers, can be selected here using the arrows. Right-clicking on the 
display opens the layer menu. 

2. Main parameter: Here the volume, panorama position, pitch 
characteristics ("transpose") and the fundamental frequency ("master 
tune") can be set. 
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e the 
decrease in volume takes on a section set with S(ustain) at the 

 time it takes for the 
sound to ring out. 

3. AMP: This is the volume envelope. Here you can influence the 
temporal progression of a track's volume. A(ttack) stands for the 
volume increase at the start, D(ecay) for the length of tim

maximum volume. R(elease) is the length of

 

4. FILTER: Here you can switch on a filter which influences the 
ff" 

regulates the filter frequency, "Resonance" controls the strength of 
of the filter frequency. "Velocity" specifies how 

5. DELAY: Here you can switch on an echo effect, "Time" controls 

. 

lationship between the created 
volume and MIDI velocity is proportional. Since some MIDI keyboards 
produce a velocity which is too hard for loud sounds or the other way 

an be balanced out with the "MIDI Input 
Curve". With "dynamic" and "dynamic curve" the dynamics of the 

9. Voices: Here you can control the amount of voices played 

sound. With FILTER TYPE, you can select a filter type. "Cut-o

the amplification 
strongly beat should influence the filter frequency, while the volume 
can be balanced using the "Gain" controller. The filter envelope 
(ADSR slider) influences the filter frequency depending on the time. 

the delay time, "Level" controls the strength of the echo sound. 

6. REVERB: Here you can switch on a reverb effect, "Time" controls 
the delay time, "Level" controls the strength of the echo sound

7. VALUE DISPLAY: The value display shows the exact value of the 
parameter which was just modified. 

8. DYNAMIC RANGE: Usually, the re

around, this behavior c

sound can be influenced, that is, the relationship between the 
quietest and loudest sounds. 

simultaneously. If notes are no longer played during fast passages, 
you can increase the amount of voices here (performance will not be 
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MAGIX LiViD helps you to turn your ideas into songs. Enter a few 
basic details and LiViD will play a full drum track, complete with intro, 

es, fills, bridges etc.; the entire song structure is laid 
out for your convenience. Brilliant stereo drum samples recorded by 

io musicians and a freely adjustable “Humanize“ 

LiViD features four styles (Pop, Rock, Funk, Latin), each of which is 

 = triplet rhythm). 

Hi-hat: Sets the hi-hat sound to “soft” (fully closed) or “hard” (half-

SampleTank 2 MX (SE) 

What is SampleTank 2 MX (SE) 
SampleTank 2 MX (SE) is a polyphonic, multi-timbral sample 

as good). 

10. Keyboard: Here you can preview the Vita sounds. This only works 
during playback or recording. 

LiViD - Little Virtual Drummer 

verses, chorus

professional stud
function create an authentic drum feel with perfect sound quality. 

subdivided into four further substyles, as well as six song sections for 
each substyle (Intro, Verse, Bridge, Chorus, Outro, Fill-in). 

Scramble: A random sequence of four one-bar patterns is generated 
internally for each style/substyle/song section. “Scramble” generates 
a new pattern order. 

Shuffle: Shifts the second and fourth 16th note of a beat back by a 
freely definable amount (100%

Humanize: Randomly shifts all events backwards or forwards or 
leaves them unaffected. Note: these shifts are very subtle and not 
always immediately perceptible! 

Snare: Sets the snare stick style to “normal”, “side stick” (stick hits 
the rim while resting on the skin) or “rim shot” (sticks hits the rim and 
skin simultaneously). Exception: the snare’s quietest velocity level ( 
the ‘ghost notes’) is always “normal”. 

open). Exception: completely opened hi-hat (Pop, Type1, Verse). 

Ride: Sets the ride cymbal sound to “ride” (cymbal is hit on the rim) 
or “ride bell” (cymbal is hit on the bell at the center). 
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workstation with multi-effects units and propriet
combined into a unique plug-in instrument. SampleTank 2 MX (SE) 
uses samples as oscillator waveforms, but the synth engine is much 
more flexible than conventional hardware samplers. This makes 
SampleTank 2 MX (SE) a more complex worksta l 
sampler, with 32-bit floating-point processing, h 
superior quality. 

nds are included with 
the software, and as such are immediately at your disposal. 

 
straight from within your MAGIX program. 

ary sound banks, all 

tion than a traditiona
 providing you wit

SampleTank 2 MX (SE) lets you browse through hundreds of the 
highest-quality natural and synthesized. With one click, select a 
sound in a flash and have it ready for you to play in a fraction of the 
usual time. Many professional high-quality sou

6 sounds (deLuxe version: 10) are included and ready for use: 
Superb pianos, guitars, basses, strings, orchestral sounds, drums 
and other percussion instruments made with the finest samples and 
accurately programmed. SampleTank 2 MX (SE) offers the widest 
selection of high quality playable sounds with a variety you cannot 
find anywhere else! 

Furthermore, you can purchase new instruments from the Catooh

SampleTank 2 MX (SE) will be automatically integrated into your 
MAGIX software. A suitable audio card (with low latency drivers) and 
a master MIDI keyboard are strongly recommended in order to play it 
like a hardware musical instrument. 
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xplanation of the user interfa  E ce

 

Loading sounds and controlling instruments 
The available instruments are displayed at the center of the 
SampleTank 2 MX (SE) interface in the browser window. The 
scrollable list of instruments shows 6/10 instruments (classic/deLuxe) 
and also displays the number of available instruments you can 

ply double-click 
on it. It will be loaded onto PART 1 (if it's the first to be loaded). 

All the SampleTank 2 MX (SE) parameters on the interface will now 
d parts. The MIX window allows you to load 

simultaneously load into SampleTank 2 MX (SE) module (16 parts). 

The browser list of folders and instruments reflects the same folder 
and instrument structure of the hard disk folder where your sounds 
are located. This folder is called “root” and is stored in the 
SampleTank 2 MX (SE) preferences (which you can access and 
change by clicking the PREF button). 

Folders are indicated with a white triangle. To open a folder, click on 
its name in the list or on the triangle. Opened folders display the list 
of available instruments. To close a folder, re-click on its name or on 
the triangle. 

To load an instrument in SampleTank 2 MX (SE) sim

reflect those of the loade
up to 6/10 SampleTank 2 MX (SE) instruments per module, every 
instrument will be loaded into a PART. To select the PART where you 
want to load an instrument simply click on the PART number or in the 
middle of the part window. 
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 can UNDO this 
operation with the UNDO button). 

sily select the 
MIDI channel that this PART belongs to. Assigning the same MIDI 

ore than one PART will have all the PARTs responding to 

ive you 
immediate control over your mix of instruments. Here you have 
several controls at your disposal: 

e VOLUME and PAN of each specific PART (by 
clicking and dragging the mouse on the VOL and PAN number). 

 mouse on the OUT 
value. 

Once a PART is selected, the instrument will be loaded into that 
PART. If it already contains an instrument, the newly loaded 
instrument will replace the previous one (you

Every PART responds to a MIDI channel (CH). By clicking and 
dragging on the CH number of each PART you can ea

channel to m
the same MIDI channel for building sounds with layers of up to 16 
parts. 

You can now play the instrument using a master keyboard connected 
to the sequencer, a MIDI sequence in the track or by playing the 
SampleTank 2 MX (SE) mini-keyboard. MIDI activity in the PART is 
indicated by an LED which lights when MIDI data is received.  

Once an instrument is loaded into a PART, the image of the LIBRARY 
to which the instrument belongs, will appear on the right side of the 
interface. Clicking on the LIBRARY image will display further 
information such as instrument data, copyright and MACRO controls 
(if these are included with the instrument).  

The MIX window 
All the controls included in the MIX window are designed to g

• You can change the MIDI channel associated to that PART. 
• You can SOLO and MUTE instruments. 
• You can see the amount of RAM that the instrument is using (MB). 

By clicking on the MB button at the top you can also display the 
entire amount of RAM used by all the loaded instruments. 

• You can set the maximum polyphony for each specific instrument (by 
clicking and dragging the mouse on the POLY number). 

• You can EMPTY the PART with the EMPTY button. 

You can control th

• You can control which STEREO OUT is used for playing a PART (the 
max number of stereo outputs is set in PREFERENCES by clicking 
the PREF button) by clicking and dragging the

• You can see the output level of the instrument playing in the LEVEL 
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Effects 
ore pre-defined effects will be loaded and displayed in the 

X (SE) instrument can be programmed with 5 
effects. The effects are displayed in the effects slots. The first effect 

FECT option. 

ach effect's parameters, click on the desired 

Unused knobs will be shaded in gray. Above each effect knob you 
to its function. Below the effect knob 

is its current value. 

hted and the effect is active. All active effects are inserted 
in the instrument chain according to a patch order from top to 

BYPASS button. You can also LOCK effects into 
SLOTS preventing them from changing when a new instrument is 

display. 

One or m
EFFECTS section of the SampleTank 2 MX (SE) interface.  

Each SampleTank 2 M

slot always contains an EQ compressor. The other 5 effect slots can 
contain one of 32 DSP effects. 

To view the list of available effects once you've loaded an instrument, 
click on the arrow at the right in each of the 5 effects slot. A pop-up 
menu will appear displaying all the 32 DSP effects which are available 
in SampleTank 2 MX (SE) in your MAGIX software. 

Now move the selection with the mouse and click on an effect to load 
it. The selected effect name will now show in the effects slot. To 
empty an effects slot, simply select the NO EF

To view and change e
effect's slot. A frame will appear around the slot indicating that that 
effect is selected. Only the selected effect will be shown on the 
interface at any time. Effect knobs are labeled corresponding to the 
effect's parameters. 

can read a label corresponding 

To activate an effect, click on its ON button to the right. The button 
is highlig

bottom of the effect window. To deactivate an effect, click on the 
ON button again. The button will revert to 'normal'. 

You can BYPASS all effects at once (that is, hear the sound dry) by 
clicking on the 

loaded. This way you can prevent instrument effect settings 
overriding your own settings. 

You can also save multiple or single effect settings and load these 
settings with the SAVE MULTI, SAVE and LOAD buttons. The effect 
settings are saved as .STFX file. A dialog window will appear when 
you click one of these buttons asking whether the files should be 
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roduction.  

und production technique, the 

At each beat position, the playing positions can 
be set by clicking a button. In Event mode, the instruments are 

sing hi-hat 
to phat bass drums.  

be frequency and ring-
modulated. The depth of the modulation can be controlled via an 

(Crush) and 
sampling rate reduction (downsmple). 

saved or not. 

Robota 

The Robota is a four-part drum computer with virtual analog and 
sample-based sound production. Virtual analog sound production 
means that the sounds are synthesized in real-time, i.e. produced 
with a synthesizer – therefore recreating the typical analog sounds of 
the classical drum computers, such as the Roland Tr-808 and Tr-
909, or more recent devices such as the Korg Electribe or the Jomox 
x-cousin. Sample sound production uses drum sound recordings (or 
even other recordings) as the basis for sound p

After selecting the elementary so
sounds of each of the 4 parts (or instruments) can be edited using 
modulators.  

The step sequencer programmed with incident lighting helps Robota 
to play. 4 beats in sixteenths (or 2 beats in thirty-seconds) are 
processed as a loop. 

distributed within the beat pattern. In Snapshot mode you can adjust 
additional instrument sound settings.  

Sound synthesis 
The four instruments of the Robota are built identically. Each 
instrument can create all kinds of drum sounds –  from his

During elementary sound production, you can choose between an 
oscillator with selectable wave shape (sine, triangle or saw tooth) or a 
sample. In addition, you can add a noise generator can be added. 
The oscillator has a pitch envelope (pitch env.) and a volume 
envelope (attack/decay). It can also 

envelope parameter (Fm/rng dcy). There’s also a “Lo-Fi” section 
consisting of distortion (Rectify), bit rate reduction 

Temporal control via an envelope (lofi dcy) will get the best out of the 
Lo-Fi effects. A multi-mode filter (low-pass/band-pass filter/high-
pass) with 12/24 dB steep-side. A comb filter can be inserted. The 
filter frequency can be likewise modulated via an envelope. For extra 
pressure, an adjustable compressor (compressor, comp resp) is 
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included, as well as tube amplifier simulation (tube).  

Parameter (1) To simplify matters, not all 
parameters can be changed on a sound - 
only those that are meaningful for the 
selected drum sound may be changed 
(snare, kick, high etc.). There are four 
selected variable parameters co-
ordinated exactly with the selected preset 
sound.  
Oscillator Waveform (2): The 
fundamental waveform of the Oscillators 

mpl" you can use the 
to select a sample, i.e. a 

is selected here. You can choose from  
sinus/triangle/sawtooth/sample. If you 
have selected "S
rotary knob 
previously recorded drum sound. These 
samples are saved in the folder 

 

/Synth/robota/samples/. If select custom 
samples, they will appear in the selection 
list. 
(3):For each part you can regulate: Filter 
Cutoff, Resonance, Tube, Volume and 
Panorama (on page 213). 

With select choose the instrument for editing in the step 
sequencer.  
“M” mutes the instrument, “S” makes it solo    

 www.magix.com

 The Loudspeaker button allows you to hear a preview. 

Master Section 

Volume regulates the total volume of the Robota. Distortion adds an 
adjustable tube distortion to make the sound “dirtier” and more 
powerful. The peak meter helps control the output level – when it 
enters the red area, reduce the total volume.  
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f the Robota synthesis Schematic illustration o

 

Here you will find a detailed circuit diagram of a Robota voice with a 
description of all control parameters.  

Pitch Envelope (pitch env) 

Controls the pitch envelope level. 
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ping the wave shape. A sine wave 
(shape = 0) can be reshaped up to a square curve (shape = max). 

The fundamental wave form of the oscillators is selected here. You 

se
pr saved in the 

ap
w

N

A

the set value, the softer the 
attack of the sound. The attack rate is also applied to the LoFi and 

Decay 

y curve. The greater the value, the slower the 
instrument will decay. 

Tune 

Tunes the instrument. 

Oscillator Shape (osc shape) 

The shaper adds additional frequency shares to the basic sound of 
the oscillator by artificially resha

Oscillator Waveform 

can choose from sine/triangle/sawtooth/sample. If "Sample" is 
lected, you can use the controller to select a sample, i.e. a 
eviously recorded drum sound. These samples are 

folder /Synth/robota/samples/. If you select custom samples, they will 
pear in the selection list. If you are playing your own samples, they 

ill appear in the selection list. 

oise 

djust the ratio between the oscillator sound and the noise generator. 

Attack 

Adjusts the attack time. The greater 

filter envelope curves. 

Adjusts the deca

FM/Ringmodulation frequency (Fm/rng frq) 

The fundamental frequency of the frequency or ring modulation.  

FM Level (fm lvl) 

At a low frequency FM first adds vibration to the sound, at high 
frequencies and low levels it creates bell-like sounds, as the level 
increases metal sounds, and finally noise. 
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n level (rng lvl) 

ates typical auxiliary frequencies. 

odulation decay (Fm/rng dcy) 

Time Only the 
begi

ectify 

Crush 

Bit rate gher 
settings.

D wn sample (dwnsmple) 

ts for making 
the sound "dirty". Only the beginning of the drum sound of the lo-fi 

s (BP) – Sound portions above and below 
the cut-off frequency are filtered out. Low cut - All sound portions 

Filter resonance which increases the sound portions at the cut-off 

Ring modulatio

Ring modulation cre

FM/Ring m

 
nn

constant of by-product of FM/ring modulation. 
ing of the drum sound is affected by the modulation.  

R

Distorts the audio signal 

reduction. Digital artefacts become audible with hi
   

o

Sample rate reduction. Ideal for creating the "old school sound" of 
older digital drum machines. As it is increased, the result becomes 
darker. 

Lo-Fi decay (lofi dcy) 

Time constant of the by-product of the three lo-fi effec

effects is affected if the decay is low. For instance, this makes the 
kick of a kick drum sound more interesting. 

Filter modes (flt mode)  

Filter mode: High cut – sound portions above the cut-off frequency 
are filtered out. Band pas

below the cut-off frequency are filtered out. This mode is set as a 
preset and can not be changed. 

Filter frequency (flt freq) 

The cut-off frequency of the filter. 

Filter resonance (flt reso) 
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illator. 

Regulates how much and in which direction the filter envelope curve 

es. 

ode is 
set as a preset and can not be changed. 

Comb filter (comb filt on) 

You can activate a comb filter, a feedback delay that creates 
resonance-like sounds comparable to a plucked string. The delay 
time and feedback levels are permanently linked fo the filter 
parameters (frequency and resonance). This comb filter is set as a 
preset and can not be changed. 

Compressor 

Controls the compressor strength. This lets you increase the "power" 
of the drum sound. 

Compressor response (comp resp) 

Controls the compressor time. The lower the value, the faster the 
compressor follows the volume. 

Tube 

Controls the level of the tube amp simulation. It "saturates" the 

frequency of the filter. If the resonance is high, the filter itself can also 
be used as an osc

Filter modulation -/+ (flt mod -+) 

moves the filter frequency in which direction. 

Filter-Modulation decay (flt mod dcy) 

Decay time of the filter curve. Smaller values with high resonance 
create a "zapping" sound of the filter, greater values create the typical 
sweep sound. 

Filter modulation velocity (flt mod vel) 

Specifies how much the filter modulation depth depends on the 
velocity. If this value is increased, louder beats will generate higher 
filter curves than quieter on

24 dB 

The filter can operate with a slope of 12 dB or 24 dB. This m
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rmth to the sound if the 
ttings makes the sound 

"dirtier". 

output signal of the voice and adds wa
settings are moderate. Increasing the se

Volume/Pan 

Controls the volume and panorama position of the drum instruments. 

Sequencer 

  

Incident lighting is used to control the drum patterns just like in all 
 

f 16 individual step buttons with LEDs corresponding to the 
appropriate partitioning of a beat:  

16th se displayed). A button lights 
t e instrument at this point in the beat 

(= step).  

A left click turns on the step, a further left click deletes the step 
again.  

classical drum computers and groove boxes. The step sequencer
consists o

s or 32nds (a half beat is in each ca
up o indicate the releasing of th

A pattern can be a maximum of 4 beats long. The length 
can be modified using the fader on the button bar. 

 

 

The beat to be edited can be selected with the applicable “edit” 
button. The “Follow” button specifies whether the Step  of a beat is in 
time. 

„1>2-4" Auto Draw: If more than 1 beat is activated as the loop 
length, the Auto Draw mode ensures that the drum notes set in the 
first beat is set automatically for the following beats. This makes it 
very simple to produce a continuous beat from a loop length of 4 
beats. Notes set in the rear beats are not affected by the Auto Draw 
function.  

How to program a drum pattern: 
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• Select the pattern length with the fader. 
 

• select “Event” mode. 

• If you edit during playback, turn off “Follow”. Select the beat with 
the “Edit” buttons.  

 

  • Use “Select” to choose an instrument to edit.  

 • Use the “Clear bar” button to delete all steps in 
the selected instrument. 

 

 

• Turn on the appropriate step buttons, and use 
the “Velocity” controller to adjust the beat 
velocity.  

• Repeat the procedure with the other instruments  

Snapshots 

In addition, you can automate programming of the editable sound 
parameter of a drum sound via so-called "snapshots". You can 
thereby save the sound parameters of a drum instrument on the step 
buttons of the sequencers. 

Automating the Drum Instrument with Snapshots.: 

 www.magix.com

 

• Put the Edit mode to “Snap”.  
• If you edit during playback, turn off “Follow”. Select the beat with the 

 
ument and edit the sound. You can control the sound 

“Edit” buttons. 
• Select an instr

of an instrument even when playback has stopped by using the 
loudspeaker button. 

• Save the sound as a Snapshot to one of the step buttons. 
• Change the sound of an instrument and save the settings to other 

step button 

Warning: The parameters are not changed abruptly but are faded 
internally instead, in order to avoid crackling. If two snapshots with 
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extreme parameter differences are too close together, the drum 
sounds will sound differently when the pattern is played. 

 

• Using the arrow keys, you can jump between the 
individual snapshots during stopped playback.   

• Press “on” to activate snapshot automation.  

Groove Control 

The secret behind “groove” beats lies in delay. That is, individual 
beats are either anticipated or delayed according to patterns. For 
example house beats use the “shuffle” whereby straight 1/16s are 
delayed at certain times. 

 

In the Robota there are Groove Velocity and Groove Swing presets. 
Groove Velocity presets contain for each step of a beat a certain 
offset to increase or reduce the original beat velocity. Groove Swing 

 regulator.   

presets contain for each step a time alignment that is either 
anticipated or delayed. The result is a livelier-sounding sequence. The 
strength of the effect can be adjusted with the %

Setups, Drumkits, Presets and Patterns 
A single instrument sound is 
saved as a Preset.   

  

Presets containing all four 
instruments are saved as 

 Drumkits.  

 
All note information plus the 
snapshots are saved as a 
Pattern.  
Together (Drumkit + Pattern) 

 

ad/Save 

they are know as a Setup.  

Lo

Pr
continuous rotary regulators next to the display area. For storing, 

esets, drumkits, patterns and setups can be selected with the 
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cl  “Savick on the e” button. Then specify a new name in the input 
field. To store, press “Enter”.  

Note: A drumkit stores only the names of the presets, not the actual 
parameters. If you want to store your own drum sounds that were 
created by changing existing presets, you must first store them as 
new presets and then as a new drumkit! The same applies to the 
setups, which contain only the pattern and drumkit names. 

If necessary, always store in this order: preset > drumkit > pattern > 
setup. This applies only when creating your own “templates”. If you 
store your arrangement normally, the complete current status 

‘SilverSynth pro’ is  a virtual, analog synthesizer that was based on 

was initially intended as an electronic bass accompanier; 
however, it was at first hardly taken seriously due to its "unrealistic" 

e major style elements of 
an entire musical style. Today’s Techno productions still use the 

‘SilverSynth pro’ is the follow-on to the SilverSynth. The user now has 
oller that 

makes the typical 303 sound even squeakier. It also features a 

d echo. 

Furthermore, SilverPro has a "Shuffle" controller for adding "groove" 
to your synthesizer sequences. Finally, you can use the 

olume" controller to adjust the synthesizer volume. 

(Synthesizer + Sequencer) of the Robota is always stored and 
correctly loaded later with the arrangement. 

SilverSynth Pro 

the legendary Roland-TB303. This machine appeared in the early 
1980s. It 

characteristics. 

The device suddenly became useful later, when Techno Music was 
just becoming popular. The brute force and screeching sounds that 
this unit produced suddenly belonged to th

minimalist, synthetic but warm and unmistakable sound of this 
synthesizer.  

more influence on the sound. It features an "EnvMod" contr

distortion controller for adjusting the sound distortion, as well as an 
integrate

"MasterV

On the “SilverSynth” symbol is a menu that loads, saves, generates 
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or deletes (Clear all / Random).  

Programming 
On the left of SilverSynth there are four knobs and a switch to control 
the sound of the synthesizer. On the right there is a step sequenced 
which you can use to program the melodies. 

Filter Automation 

The SilverSynth pro offers automation for the rotary button controllers 
with which the filter and sound modulation can be set. Each 
movement of the automatic controllers can be recorded.  

Play/Stop: The sequence of the step sequencers is played and/or 
stopped, including recorded rotary button movements.  

t its cutoff frequency. This is the 

er the cutoff filter remains 

 as 

Record: Records the rotary button movements. The sequence of the 
step sequencer is played while you record the results of real-time 
buttons movements. 

Clear Record: Deletes the recording of the rotary button movements. 
Please remember that the notes of the sequence in the step 
sequencer are re-set, changed or deleted. 

Turning knobs 
Waveform: You can chose from basic waveforms that represent the 
main proportion of the sound. It is possible to switch between a 
rectangular waveform and a saw-tooth waveform. 

Cutoff: The Cutoff control steers the synthesizer’s low pass filter. This 
control is used to determine the brightness of the sound. At the 
upper limit the synthesizer sounds brightest, at the lower limit of the 
rotary button, the synthesizer sounds very hollow.  

Resonance: Technically speaking, the resonance control sets how 
much the low pass filter resonates a
frequency that is controlled by the cutoff control. This control largely 
determines the warmth of the sound. 

Decay: This control is used to control wheth
at the same frequency or whether the filter frequency changes when 
a note is played back. If Decay is set to the upper limit, then every 
new note initially sounds a little bright and then changes its sound
it progresses so that it loses more and more of its brightness. 
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s or lowers all sounds. 

 control determines the flow of the envelope 

dded. 

ets the length of the echo. The length of the 
echo is set in relation to the bars; it adjusts to the current BPM value. 

Shuffle: This control lends more ‘groove’ to the Synth sequences. 

sequence on a 16x12 grid. A note cell can be occupied by the left 

edly on one and the same note cell, then you 

ave 3. 

The lower rows (Accent and Slide) determine the further behavior of 
individual notes. Accent increases the volume of the note a little. If a 
cell is placed in the “Slide” row, then this note will not be struck 
again, only the pitch will be modified. 

Copper Synth 

Just like the SilverSynth, the CopperSynth is a step sequencer, it 
looks very similar and functions quite similar too. The most important 
difference is the sound.  

The sound is created by use of an additive procedure that resembles 
a mini moog. There are between two and three oscillators are used 
for the basic wave shape. The sound of the synthesizer corresponds 
to that of the typical bass synthesizers of the eighties. The 
SilverSynth is mostly used for higher pitches; Silver Synth and 

Tune: This control raise

EnvMode: This
curve. The further right the control is turned, the more high sounds 
will be a

Distortion: Here you can override the sounds. 

Delay: Delay can be used for reverb and echo effects. There are two 
controls. ‘Feedback’ (number of sounds repetitions) sets the intensity 
of the echo; ‘Length’ s

Master: The overall volume can be set in this section. 

Step Sequencer 

mouse key; the right mouse can be used to delete note cells. You 
can only set one note per column. To assist you, a scale of notes 
appears at the lower edge. 

If you click repeat
change the octave for this note. The color of the cell changes 
according to the octave. Blue corresponds to octave 1, red 
corresponds to octave 2 and green corresponds to oct
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o. CopperSynth make an excellent du

For the programming please refer to the chapter Silver Synth pro (on 
page 220)! 

Revolta 

The sine wave does not contain any harmonies and consists purely 

ll, clear, and pure. At deep positions it can be 
used very well to "beef up" a second waveform because of the lack 

ne octave deeper). "Purity" guarantees 
ar feel as only the basic tone is used. Sine 

out any other elements) are used a lot in 
ow booming sound and sonic transparency 

nts. 

Sawtooth, on the other hand, sounds very full as it contains quite a 

. This means that the standard pitch A (440 
Hz basic frequency) is superimposed with sections at 880 Hz, 1320 

is is the 
case in signal theory at least. 

In practice, however, analog synthesizers behave somewhat 
differently. The waveform sometimes looks a little bit rounder on an 
oscilloscope. In addition, the used circuits contribute to a 
modification of the spectrum as a result of distortions and component 
tolerance. 

OSCILLATORS 
REVOLTA consists of two oscillators that function as synthesizers. 
These produce the ground waveforms: sine, sawtooth, and pulse. 

of its own basic oscillation. The sound (also known from the dial tone) 
is correspondingly du

of harmonies (for example, o
that the sound gets a cle
oscillations (that is, with
Drum&Bass music where l
are important style eleme

comprehensive selection of harmonies. In relation to this "Harmonics" 
refer to the whole-numbered variations in the basic frequency. A 
sawtooth wave contains an equal amount of even-numbered and 
odd-numbered harmonies

Hz, 1760 Hz, 2200 Hz, etc. Here the drop in volume increases 
exponentially, each harmony is 6 dB quieter than the last. Th

Ideal sawtooth wave 
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"Analog" sawtooth 
wave of REVOLTA 

Sawtooth is the classic waveform for simulating string sounds. Bass 
sounds can also be created using this if you want them to have a bit 
of a bite. The famous TB-303 Acid Basses are usually sawtooth 
waves (when working with just one oscillator). The sound character of 
sawtooth is usually associated with "warmth". 

The rectangle/pulse wave is often made from two sawtooth waves in 
analog – as in REVOLTA. Theoretically, a rectangle wave should only 
have two states: a minimum and maximum value, that is a constant 
back and forth between the corresponding frequencies. The harmony 
series is similar to that of the sawtooth waves, but the rectangle 
signal only contains uneven harmonies (for example, at A 440 Hz, 
1320, 2200 Hz, etc., always the octave after the next octave). This 
gives the waveform a more hollow or "nasal" sound. A classic 
example of this is in wooden wind instruments like the oboe or flute. 

. By adding the 

ller it is, the more harmonies are achieved 
 Smaller pulse widths make the 

Usually an analog rectangle wave can be implemented quite easily via 
a so-called flip-flop circuit. In instruments however, people usually 
use two sawtooth waves: the second sawtooth is mixed into the first, 
but the waveform is inverted and delayed (phase shift)
two waves, a rectangular signal with variable "pulse width" (PW, see 
graphic) can be achieved. The pulse width is set up according to the 
delay of the second sawtooth wave and effects the sound of the 
harmony series: the sma
and the lesser the basic tone appears.
sound a bit "thinner". 

A pulse wave is composed of two 
sawtooth waves (A = normal, B = 
inverted + phase-shifted) 
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Pulse waves (50% and 10%) in 
REVOLTA 
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The pulse width can be modulated which can create "floating" 
e width modulation). The Roland JP-8000 is 

 selection in REVOLTA is that it's 
not restricted to the mere selection of the waveforms as would be 

tomated. We'll talk about this later on as well... 

ne oscillator controls the pitch of the 
other. Since the sound created during this process no longer follows 

e likely to be more usable musically. 
The correct term for this is actually phase modulation (PM). Most 

ever and since this is an 

Options for oscillator 2 

halftones up or down oscillator 2 is out of tune with the first. What's 
interesting here is when it's used to produce bass sounds for 

sounds (PWM, puls
famous for this type of PWM sound, which can be heard on 
numerous dance tracks. For this type of "phat" floating sound you will 
need a "Modulator"/LFO. We'll talk about this later... 

What's unusual about the waveform

expected. It's much more likely that you can run through the 
selection with the "waveform" fader on this synthesizer and create a 
mix out of sawtooth and rectangle. Running through the waveforms 
can even be au

When working with two oscillators, interesting sounds can be created 
via frequency modulation (FM). You will no doubt be familiar with this 
from the well-known digital synths like the Yamaha DX7 or the OPL 
chips of older sound cards. FM synthesis is also possible in analog. 
In REVOLTA, oscillator 1 is modulated via oscillator 2. Frequency 
modulation usually means that o

the usual chromatic scale and sounds a bit chaotic, the phase of the 
oscillator is modulated instead of the pitch in almost all FM 
synthesizers. As a result, only the sound's color changes, not the 
pitch, which in most cases is mor

manufacturers still refer to this as FM how
established term in music electronics, we use it too. 

With "mix" you can specify the mix ratio for each oscillator. 

The pitch of the second oscillator can be influenced relatively to the 
first. Here, the "semitone" parameter specifies by how many 
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ooming sound (as mentioned above with 
Drum&Bass). A kind of double unanimity can be achieved here by 

ds... 

he signal is actually "packed" into a temporal volume 
progression. 

m ill sound, like with a synthesizer for 
s. Not only would it be quite static, but it would be 

ch
hear a different transient oscillation process than with bowed string 

ca is can be started ("triggered") by 
pressing a key, which then runs it through multiple stages. These 
stages are usually called "ADSR": "attack" (velocity duration), 

ound decrease when the key is held), 
"sustain" (hold after the end of the decay phase) and "release" (the 
time it takes for the sound to ring out after releasing the key). 

creating a more b

tuning oscillator 2 up by 3, 5, or 7 halftones, thereby creating classic 
chord intervals. Or you can simulate a drawbar organ via two sine 
waves and modifying the second by 5 halftones... 

The "detune" fader modifies the second oscillator by one halftone 
max. For this reason, at lower values, light oscillations can be 
created. Perfect for "beefing up" bass & lead soun

ENVELOPE 
Here t

If you were to grip the signal located directly behind the oscillator 
odule, a long-lasting tone w

measuring purpose
quite boring as well. "Real" instruments/sounds always have a 

aracteristic volume progression. For example, in piano music, we 

instruments. To specify such processes, synthesizers contain a so-
lled Envelope Generator. Th

"decay" (duration of the s

 

With synthesizers the ADSR curve is often very different to the 
audible result. One of the reasons for this is that the volume 
progression is implemented with suspense modifications and the 
suspense is interpreted differently. In this sense a short attack time in 
Synth A may sound completely different to what Synth B produces. In 

OLTA, the circuit simulation functions with a 
"virtual" network of capacitors which are loaded and unloaded 
the ADSR module of REV
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 time. We have placed a lot of emphasis 
ng". The tuning tends to be viewed as 

 (AMP, "amplifier") as described above. The second is 
located in the filter module and controls the temporal filtering 

 required to do so. 

e still pressed. The sounds will be bound 
together, as the word "legato" implies. 

u often find when 
using software synths, but rather a precise simulation of a design 

 achieving high resonance or feedback (well-known 
whistling sounds) with enough internal amplification. The REVOLTA 

frequency modulation.  

 
high cut, band pass, and low cut. The low cut filter is a series 

o filter modules used in order to reach a skew rate of 
or the other modes, the 12 dB supplied is usually perfectly 

nt, meaning that only one module is used. 

 trigger frequency 

resonance, typical whistling sounds will be audible. The more "drive" 

independent of the level and
on achieving this "analog feeli
"weak" or "round". 

REVOLTA has two ADSR Generators: the first specifies the volume 
progression

progression from there when

A setting which all envelopes has is the "legato" parameter. If this 
button is pressed, the envelopes will no longer be restarted for new 
notes as long as keys ar

FILTER 
The REVOLTA filter is not a normal digital filter as yo

from the "real world". 

We use a so-called Sallen key circuit, which has similarities to the low 
cut and high cut of the Korg MS 20 device. This is fundamentally an 
amplification block with two 6 dB filter networks and one feedback 
path. Here the circuit achieves a slew rate of 12 dB/octave and is 
capable of

filter functions in the feedback part with an additional active step 
which limits the feedback signal. This can enable the filter, unlike with 
normal digital types, to be given a deep saturated sound, which 
produces typically analog sounds, from light keying to screeching to 
noises reminiscent of 

The filter parameters 
Type: Here you can specify the filter type. The selection consists of

connection of tw
24 dB. F
sufficie

Cut-off: Filter

Resonance: Amplification factor of the circuit and the related internal 
feedback. When there is feedback, please take note of the monitor 
volume. 

Drive: The filter behaves quite cleanly when turned down. At higher 
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e the saturation level in the feedback path appears, 
changing the behavior of the filter. The entire circuit is turned up at 

rtant for 
lively sounds. Unlike with the amp envelope, it doesn't control the 

the middle position, Env Mod does not 
have any effect. If turned to the right, the virtual "control voltage" of 

LFOs (Low Frequency Oscillators) 
ave a so-called low frequency oscillator. In 

REVOLTA, there are two. LFOs are fundamentally normal oscillators 
which do not oscillate in the normal frequency ranges relevant to 
music, but rather at very low frequencies. Its output cannot be 
perceived directly by the human ear (like a normal oscillator), but 
rather is used to modulate other parameters, that is, to change to the 
rhythm of the LFO. Usual LFO targets are the pitch (-> vibrato), the 
volume (voltage-controlled amplifier) for a tremolo effect (volume 
modulation) or the cut-off frequency of a filter. 

The parameters of LFO 1 & LFO 2 
Type: Here you can select the oscillation form of the LFO. Sine, 
rectangular, and "Sample&Hold" (random function) are available. 

Sync: This button enables the synchronization of the song tempo in 
order to create exact rhythmic modulations. The following parameter 
controls the interval: 

Freq: The frequencies of the two LFOs of REVOLTA  can be set over 
a long range. If the Sync Button is active, the fader will "snap" only 
with rhythmic intervals (for example, one quarter, one eighth, one 
eighth triplet or dotted). When the tempo sync is switched off you can 

Delay: This fader specifies the time span which the control voltage of 

 you can, for example, make a pitch modulation 
audible only when tones are held for longer, similar to the way a 

there is, the mor

the same time. 

Env Mod: The filter has its own envelope with attack, decay, sustain, 
and release faders. This envelope can often be quite impo

volume progression, but rather the cut-off parameter. With the Env 
Mod fader (envelope modulation) you can specify how strong the 
envelope affects the cut-off. In 

the envelope will be added to the cut-off fader, and if turned to the 
left it is subtracted. 

Most synthesizers usually h

control the frequency in Hertz directly from here. This goes deep into 
the audible range, enabling drastic effects like "Filter FM". 

the LFO takes to grow from 0 to its maximum value (a kind of "fade 
in"). The underlying "Timer" will be restarted every time a key is 
pressed. This way
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 switched off. In this case, the LFO is 

ice you 
make here is the so-called target modulation. Most of these targets 

arameters of OSC 2 will be 
modulated with symmetrical suspense (positive & negative centered 

the left and 

If set to the left, delay is
constantly active and oscillates at maximum amplitude. 

Destination: When you click on this list, a selection menu appears 
with (almost) all accessible synthesizer parameters. The cho

are additively modulated by the LFO, that is, the control voltage will 
be added to the corresponding fader position. Here, the LFO 
suspense is positive (Case A in the graphic below), only the stereo 
panorama, the semitone and detune p

around the start position) so that deflection only occurs to 
to the right of the fader position (Case B). 

 

Depth: This fader specifies the maximum amplitude of the LFO. It 
influences the strength of the modulation. 

Master module / global parameters 
On the left-hand side of REVOLTA you will find the following faders: 

Volume: The master volume of the synthesizer. The fader controls the 
amplification factor of the output level with a soft distortion 
characteristic. The step makes sure that the output level never 

signal softly into the saturation. When a 
strong resonance) internal distortions 

arise which sound softer and more musical than if they had 
overmodulated the next levels or the master outside the instrument. 

th it is not usually 

n adjust or set the octaves of the global 

exceeds 0 dB by leading the 
signal is too loud (as a result of 

You may have to monitor the audible level and use the supplied 
presets as a reference for the volume. 

Pan: The stereo panorama. With a single-voice syn
required, but we mentioned it: You can automate this parameter to 
make interesting stereo effects possible. 

Transpose: Here you ca
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lftone steps. You can use 
this, for example, to test out whether an octave sounds better one 

s the time to glide from the last tone 
played to the tone currently playing. The more turned up it is, the 

ess lasts. By automating the parameter, very lively 
solo passages can be played. Even statically, a short 
es can sound good. This can be implemented by 

he tone sounds a little bit distorted.  

When you click on the spanner symbol the LFO section disappears 
called config view (or "setup") opens. 

tuning for the currently selected preset in ha

octave higher or lower without having to transpose the MIDI data. 

Glide: This parameter is also known as "Portamento" in some 
synthesizers. The fader specifie

longer the proc
bass runs and 
glide for basslin
turning the fader up so far that t

SETUP / CONFIG VIEW 

(but is still active) and the so-

 

Here you can set an entire series of global parameters as well as 
specify whether or not REVOLTA should react to incoming "MIDI 
Control Change" messages (MIDI CC) and how strongly. 

ply to 

Parameters 

Master Tuning: In most cases all instruments can be set to the 

The settings are independent of the selected presets. They ap
the entire instrument. Should you have loaded multiple instances in 
one project, they will all share the same setup. 

Receive Channel: REVOLTA usually responds to the MIDI channel 1: 
Should you wish your data to be sent to a different channel, you can 
change it here. 

Pitch bend range: Here you can set by how many halftones the 
sound should be bent when you turn the pitch wheel on your 
keyboard. 

standard pitch A, 440 Hz. If you have an arrangement that differs 
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Oscillator Drift: Something that differentiates older analog 
es, is the lack of tuning stability. Many 
ave difficulties keeping their operating 

parameters for longer periods of time. The problem is often thermal, 
as an increase in temperature can influence the behavior of the 
movement of electrons and the properties of certain semiconductor 
materials. Modern analog synthesizers usually have temperature-
resistant integrated circuit, but they too are susceptible to the 
"random principle", making the oscillators constantly susceptible to 
small fluctuations. Use the "Oscillator Drift" parameter to specify how 
much "analog behavior" you wish to permit. At maximum, 
occasionally stronger tuning discrepancies are audible. Values in the 
mid field or in the first third are especially suited to making sounds 
with two oscillators sound less static and somewhat warmer, 
especially when OSC 2 was not detuned relative to the first one. The 
drift parameter, of course, has a large influence on the entire sound 
when REVOLTA is used with other instruments in a very large 
arrangement. 

MIDI Controller / Destination 
 Almost all available parameters in REVOLTA are not only controllable 
via direct manipulation on the interface, via LFO, but also externally 
via the MIDI Control Change function. Should you own a hardware 

rameters would you like to 
 the "Destination" list one 

 Filter resonance, etc. 

ld in the 

from this, you can use REVOLTA to globally tune to between 400 and 
480 Hz. 

synthesizers from digital on
transistor-based circuits h

controller or a keyboard with the corresponding faders, you can use it 
for realtime control of this synth. 

Since any unified classification of source or target is not possible, it's 
important to know what the connected device transmits with specific 
faders. You need to find out a few things to do this: 

• Which of the eight externally adjustable pa
modify? To do so, make your selection in
after the other, i. e. Filter cut-off,

• Which MIDI CC number should externally control this parameter? If 
you already know which fader/button sends which number to your 
device, you can select it directly from the list. If not, setup provides a 
Learn mode: To access this, click on the corresponding fie
"learn" column. Now when you move a fader on your computer, etc., 
the corresponding type (its CC number) is included and appears in 
the list. You can go through the list one by one and assign 8 
controllers max. 

IMPORTANT: If you wish to save the setup, don't forget to press the 
"Setup" button before leaving the view or closing the entire interface. 
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If you should leave the setup prematurely, the changes will be 
s state will be active once again. 

ta 2 

ta 2 is a further development of Revolta 1. It is polyphone 
yable with up to 12 tones, including an additional noise 

generator, a step sequencer and an extra flexible modulations matrix. 

s have been 
created by professional sound engineers and demonstrate the huge 
potential of this instrument from the word "go". First off, however, we 

 you to try out the various control functions 
and to experiment around as much as you like. The sky's the limit to 

discarded and its previou

Revol

The Revol
and pla

An own effects section with 9 different effects and presets, which 
have been designed from a famous designer, make its a full-fledged 
synthesizer for all kinds of lead, sequence and pad sounds. 

REVOLTA 2 has a whole array of presets. The sound

would like to encourage

your creativity. 

Revolta2 interface 
Warning: Here you will find only a short description of the Revolta 2 
interface. 

 

For a comprehensive documentation of this complex 
synthesizer please click the help button on the Revolta 2 
interface!   

The Revolta 2 interface can be displayed in two sizes. In rack mode 
only the elements necessary for preset loading are visible: 

 

By clicking the edit button you can open the complete 
interface. 
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 1. Main parameter: Here the volume, panorama position, pitch 

ulates the portamento time. 

ble with smoothly 
adjustable curve form and a noise generator. Both oscillators can be 
tuned to each other and used to modulate frequencies. 

3. AMP: This is the volume envelope. Here you can influence the 
temporal progression of a track's volume. A(ttack) stands for the 
volume increase at the start, D(ecay) for the length of time the 
decrease in volume takes on a section set with S(ustain) at the 
maximum volume. R(elease) is the length of time it takes for the 
sound to ring out. VEL specifies how much the envelope curve 
depends on the velocity. 

4. FILTER: Here you can switch on a filter which influences the 
sound. With FILTER TYPE, you can select a filter type. "Cut-off" 
regulates the filter frequency, "Resonance" controls the strength of 
the amplification of the filter frequency. VEL" indicates how much the 
velocity influences filter frequency, with "KEY" the filter frequency will 
be changed depending on the note pitch ("Keytracking"). The filter 
envelope (ADSR slider) influences the filter frequency depending on 
the time. "Env mod" controls the strength of the filter envelope curve, 
and with "drive" the filter can be overmodulated. 

characteristics ("transpose") and the play modes (POLY, MONO, 
LEGATO) can be set. GLIDE reg

2. Oscillator section: Two oscillators are availa
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ou can mix in 2 different effects out of a total of 9 
available effects. 

6. LFO1/LFO2/STEPSEQUENCER: Two LFOS and the step 
sequencer can be used to modulate single parameters of Revolta 2. 

7. Options and modulations matrix: The two buttons open the 
options page of the Revolta for general and preset-specific settings 
and modulation matrix. In the modulation matrix modulation sources 
are connected with modulation targets. Simple modulations like the 
Oscillator, where the pitch will be modulated via an LFO (Vibrato), can 
be set quicker directly on the interface. Much more complex 
modulations are possible in the matrix because the matrix offers more 
modulation sources (for example MIDI controller, oscillators) and the 
modulation source can influence more targets.   

8. VALUE DISPLAY: The value display shows the exact value of the 
parameter which was just modified. In addition, you can find out the 
load of the twelve voices. 

9. Preset section: Here you can select Revolta presets. Every sound

5. FX1/FX2: Here y

 
can be listened to, and an A-B comparison between two sounds is 
also possible (for example, an edited and an unedited sound). 
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 Jam Session lets you create complete songs single-
with a simple idea, a small riff, or a chord 

progression. This is then recorded and put straight into an endless 
 a melody on a different 

track. The program simulates working with hardware „Looping 

which can later 
be edited and compiled into a complete song. 

During an Auto Jam Session, everything you do is recorded. 

1. Start Samplitude Music Studio 14 and choose „New Auto Jam 
ssion“ from the start selection or 

2. Create a new arrangement. 

Auto Jam Session 

The Auto
handedly. Begin 

loop after the recording. Now, you can record

delays“, like, for example, the Gibson Echoplex. The difference is that 
Samplitude Music Studio 14 creates an arrangement 

Open 

Se
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am Session can be started via the „Playback/Record“ 
menu or via the button in the upper toolbar.  
The Auto J

 

Handling 

After start-up you’ll see, at first, the simple view of the Auto Jam 
Session. In the right half you’ll be given useful hints on how to use the 

 without resorting to the Help file by pressing the „F1“ key or 

in  the 

program,
Help button. 

Action: The most important handling element is displayed as an 
Action button (bottom left), which can also be controlled us g



 

Auto Jam Session 237  

 

www.magix.com

2nd click: The first recording starts. Record your first beat(s). As a 
ecording, the action button turns red. 

track, the recording starts. You’ll begin hearing 
the previously recorded loop. Now you can add an additional voice to 

5th click: The recording ends, playback of the first and the newly 
recorded loop continues. 

The next clicks start and end other recordings (Clicks 4 and 5 
ording, starts in a new track. All loops 

diately 

depending on their set modes (see below). 
ts provided. Here, 

e two 

space bar or via MIDI/joystick. 

1st click: Playback begins. Nothing is recorded yet. 

sign that it’s r

3rd click: Ends the recording. The recorded part is inserted into the 
arrangement as a loop and then played repeatedly. It serves as a 
speed measure for the next loop. 

4th click: In the next 

it. 

repeat). Every restart of the rec
recorded up until now are played continuously. 

Double-clicking on the action button stops the last loop recorded. 
Clicking three times ends all running loops. You can use it to 
separate various song parts from one another. 

By clicking on stop, the playback/recording is stopped imme

Auto Jam Session modes 

There are many ways to record a song: 

• Record everything by yourself. Here, the loop that was recorded first 
is set as a measure for the speed of the song in BPM (beats per 
minute). The buttons 1-8 function as mute or solo buttons 

• You can choose from one of the accompanimen
the speed of the song is taken from the template. There ar
types of mode: 

• Instrument mode (mute): The accompaniments consist of multiple 
individual instruments that can be muted using the buttons 1-8 (or 
the corresponding keys on the keyboard). 

• Variations mode (solo): These accompaniments contain multiple 
variations of the same instrument, between which you can switch 
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electively 

Technically, these effects are object effects. Switching the effects on 
and off creates separate objects from the loops. 

Half speed: The speed factor is halved when this button is pressed. 
(If you press the button twice, it will be played at a quarter of its 
speed, etc.) 

Double speed: The speed factor is doubled when this button is 
pressed. 

An application of this effect is, for example, playing „impossible“ 
guitar solos. Switch your existing arrangement to half speed, record 
your guitar solo and then click on double speed. Your 
accompaniment plays in original speed again and your solo now 
sounds twice as fast and an octave higher. 

Reverse: This effect plays the whole arrangement backwards. 
Opening it again resets it. 

during playback. 

Reset: Reverts every button to their original states and s
stops the last loop recorded, every self-recorded loop, all loops or 
deletes the entire project. 

Loop effects 

You can change your arrangement with these real-time effects. The 
loop effects affect either every track or just the last track recorded 
(see below). 
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Clicking on the „>>“ button opens the enhanced Auto Jam Session 
dialog. 

 

Tempo 
Here, you can select the tempo from the
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 list or enter one of your 
choice. 

at the speed adapts to that of the first recorded loop or 

hs are exactly 

„—“ means th
of the accompaniment (if chosen). 

Quantization 
Quantization guarantees that newly recorded loops fit into the 
existing arrangement by recording loops whose lengt
four times that of the first recorded loop or the loops begin or end on 
the bar or loop borders. 

There are multiple options for optimizing: 

Length of the next whole loop: The new loop is recorded with the 
same length or a whole-numbered multiple (2x, 3x, 4x...) of the 
original loop length. The loops always remain synchronous, but 
mustn’t have the same starting point. This is the preset quantization 
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starting points of the loops are all at the 
same positions. 

ded loop border. This is useful when, while recording, you 
always only get around to clicking on the action button (space bar) 

he starting point of the recording and the 
loop length are adapted to the bar. This is useful if you have recorded 

ats. This is useful if you want 
to record very short or uneven loops (for example, only ¾ bar). 

l of 
solo, mute and other effects (double speed, half speed, reverse). 

Record Device 
 

menu. 

Monitor: This button activates or deactivates monitoring. This means 

mode. 

Start + length of the next whole loop: It’s only after the next loop 
border that recording starts. The length is quantized like in „Length of 
the next whole loop“. The 

Length to previous whole loop: The loop end is shortened to the last 
excee

after the next loop. 

Start + length to next bar: T

the first loop over multiple bars. 

Start + length to the next beat: The starting point of the recording 
and the loop length adapt to quarter be

Both of these options are useful if the speed has been set (specified 
in tempo or by the accompaniment) 

Freestyle: Quantization is deactivated. No more loop starts or loop 
lengths are adapted when recording. It’s only recommended if you 
want to create chaos or are very „precise“. 

Quantize mute/solo/effects: This option also quantizes the contro

Only use loop effects on the last track: The loop effects are always 
used on the last track. 

You can select the desired soundcard or soundcard input in the flip

Visualizer: This button switches the visualization on or off. 

that the incoming signal is displayed in the visualizer and played by 
the soundcard output. 

Tuner: This button opens an additional visualization in the „tuner“ 
mode with which you can tune your instrument (for example, your 
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Recording time: Shows how long you’ve been recording. 

long your hard disk can 
record. If you have multiple hard disks or hard disk partitions, the 
recording capacity of these are also shown. 

MIDI / Joystick ... 

guitar). 

Recording information 

Remaining time: Here, you can see for how 

This button opens the Shortcut Editor of the Auto Jam Session. More 
information can be found under „Shortcut Editor“  > „Auto Jam 
Session“. Here, you can also „learn“ MIDI commands. 
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ers 

ose of markers, 
grooves, and tracks. This also includes a file browser with which 
media data can be found, sampled, and loaded.  

The Manager can be opened inside or outside the main window and 
does not block it. The Manager window has a multi-monitor capability 
and notes its last position when it is closed. A number of Managers 

ther. 

the 
Shortcuts keyboard) 

• File browser (on page 243)  

• Tracks (on page 248)  

• Ranges (on page 251) 

To open the Manager, click on the “Manager” entry in the toolbar or 

indows in addition 
to the one already open. 

w.  

The Manag

The Manager brings frequently needed administrative and control 
functions together inside one window, including th

can be opened simultaneously in various different views and 
independently of one ano

The Manager integrates the following sub-windows (with 

• Objects (on page 245)  

• Markers (on page 249)  

• VSTi (on page 253) 

select the entry “Open new Manager” in the “Tool menu”. With this 
menu entry you can also open further manager w

Click with the mouse on the window tab at the bottom edge of the 
Manager window in order to open the required sub-windo
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File browser 

 

Samplitude Music Studio 14 contains a file browser integrated into 
hich the files can be sampled and directly loaded 

 browser” tab on the bottom edge 
w. 

 in a similar way to Windows Explorer. 
es and files are displayed with directory and file symbols in 

ction menu found in the toolbar lets you quickly switch 
ll data storage devices connected to the workstation. 

As known from other Manager windows, the Search option lets you 
search the current window for directories or files. Enter a search item 

the Manager with w
into projects. The browser allows favorite folders to be defined and 
provides access to the folders that were last opened. 

In order to display the file browser, click on the ”Manager” button in 
the toolbar and then select the “File
of the Manager windo

Menu: Tools / Manager / File browser 

Navigation/Favorites 
The file manager works
Directori
the form of a list. 

Navigation is achieved with the help of the mouse or keyboard. A  
drive sele
between a

A display filter located in the toolbar lets you limit the display to 
certain media types, e.g. .WAV, MIDI or project files, only. "All media 
files" is   displayed by default. 
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into the input box and click on “Enter”. Found directories or files are 
d and highlight several entries that meet this 

search criterion by entering one or several first letters. 

 

icon in the toolbar to preview a marked audio 
file. In contrast, every highlighted audio file is played immediately if 

box is checked. This way you can listen to a complete 

highlighted. You can fin

The File Browser opens as a tiled window by default. The right box 
hosts the favorites list, which you can fade out using the “Options” 
toolbar. Use “Add” or “Remove” to add and remove directories from 
the list of favorites.

There is a combo box below the favorite list displaying the last used 
paths and which lets you change the current project directory. 

Preview audio files 
You can use the Play 

the “Autoplay” 
list using the cursor keys only. Clicking on the play button again 
stops continuous playback again. 

Hint: During playback the controls of the transport console are 
allocated to the media file. Playback and positioning functions are 
fully available. 

Playback is not routed through the Mixer or internal effects. In 
ad” window, which uses 

routines of the operating system, playback uses the audio device 
contrast to the playback features of the “Lo

selected in the Play Parameters (“P”). This can be a MME, WDM or 
ASIO device. If no playback occurs, first check that the settings and 
routing of this device is correct. 

Note: To preview certain media data, e.g. in WMA format, you have 
to convert these files to .Wav format. Conversion is carried out 
automatically in the background. 

Load files from the browser into projects 
Some media files can be inserted from the browser into an opened 

Browser list is in the foreground, pressing “Enter” leads to the same 

t and dropped into an empty 

project at the desired time position via drag & drop. If the File 

result. 

If an audio file is dragged from the clip lis
space or into the title bar of the program window, it is opened in 
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Wav

If se
curre cts, with the loading options 
("Options") will be taken into account. This way you can specify 

 into the current project one after 

. The load option settings are valid also for 
files loaded via the "Load" dialog of the program. 

 file (right-
click): 

• Load file 

 reversed! 
• Highlight all files 

application 
that is linked to this file type. This can be an MP3 player or a different 

en in Windows™ Explorer: Opens the current directory as a new 
Windows Explorer™  window. 

Object Manager 

e Editing Mode. 

veral files are selected in the list, all files will be inserted at the 
nt cursor position as new obje

whether all files should be inserted
the other, one underneath the other, alphabetically or according to 
their time stamp positions

There are further options in the context menu of a media

• Delete file: Physically removes file from data carrier. Warning! This 
process cannot be

• Open via standard link: The file is opened in the Windows 

.Wav editor. 
• Op

 

The object manager integrated into the Manager lists all the objects 
contained in the current project and enables selected object 
parameters to be edited. 
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lay the Object Manager, click on the “Manager” button in the 
toolbar and then select the “Objects” tab on the bottom edge of the 
To disp

Manager window. 

Menu: Tools / Manager / Object Manager 

You can export information from the Object Manager as a text file. 
indows Text 

Editor opens with an extract from the Object Manager list. The 

 object name(s) 
• Start position in the project  

Object view and selection 

are listed that actually contain Objects. 
As an option you can choose to display Objects of the current tracks 

and close the track 
Object display in the entire window. Click on the “+” symbol left of the 

 Object name lets 
you select single or multiple Objects, which then appear in the Project 
Window as “selected”. If an Object is selected that is part of an 

r Objects of the selection are also selected in 
the Project Window and Object Manager. You can recognize grouped 

Search for Objects: As in other Manager Windows, the Object 
lso p es a search option that allows you to search for 

Objects in the current window. Enter a search item into the box and 
press “Return”. Found Objects are highlighted, but are not selected in 

Click on the “Export text” button in the toolbar. The W

following information is saved: 

• Project name and path 
• Track and

• Path of source file.  

You will find this file afterwards in your project folder (Project 
name.txt). 

Objects are displayed in a tree structure and sorted according to 
tracks, whereby only tracks 

only (Toolbar: “Options”). 

You can use the +/- keys of the toolbar to open 

track number to explode the view of a single track. 

Selecting Objects: A square checkbox next to the

Object group, the othe

Objects by the number of the Object groups in the Object Manager 
group bar. 

Manager a rovid

the Project Window. 
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• length 

• volume 
• lock 

To edit a parameter, double-click on the relevant value and enter a 

he up and down 
cursor arrows permit vertical navigation within a column from one text 
box to another. 

Deleting, renaming and editing objects 

uble-clicking on the Object names and 
entering a new name. The procedure of changing a marker position 
directly in the list is the same. 

To edit an Object directly from the Object Manager, right-click on the 

Edit object parameters 
You can edit the following object parameters in the Object-Manager: 

• start position 

• end 

different value. Numerical values can be changed by Drag&Drop with 
the mouse, whilst Ctrl+Shift allows larger or smaller value changes. 
“Tab” switches on to the next editable value. T

You can delete Objects directly in the Object Manager by selecting 
one or several Objects simultaneously and pressing the “Del” key. 
Alternatively, you can delete an Object via its context menu. 

You can rename Objects by do

Object you want to edit and start the Object Editor. 
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Track Manager 

 

The Track Manager represents all the tracks contained in the current 
ess to solo, mute, and record 

but also hides tracks in the project window and mixer. 

Menu: Tools / Manager / Track Manager 

The Track Manager contains all tracks of the current project. You can 
double-click on the track number to select a track. The track will be 

window. If the track is outside of the visible 
display, the project window will scroll to this vertical position. 

 for tracks in 
the current window. Enter a search item into the box and press 

You can delete tracks via the Manager by selecting one or several of 

project and not only provides direct acc

To display the Track Manager, click on the “Manager” button in the 
toolbar and then select the “Tracks” tab on the bottom edge of the 
Manager window. 

Track view and selection 

displayed in the project 

Search for tracks: As in other Manager Windows the Track Manager 
also provides a search option that allows you to search

“Return”. Found tracks are highlighted. 

Rename, delete and insert tracks. 
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sing the “Del” key. Alternatively, you can also 

You can rename tracks by double-clicking on the track names and 
rocedure of changing a marker position 

column. 

 present in the same way as they would be, had you 
opened the Object Manager from the Project window. 

Marker Manager 

these tracks and pres
use the context menu to delete a track. 

entering a new name. The p
directly in the list is the same. “Tab” moves on to the next editable 
value. “Cursor up/down” navigates you vertically within a column if 
this is a text 

To edit an Object directly from the Object Manager, right-click on the 
Object you want to edit and start the Object Manager. Here, all 
functions are

You can also insert new tracks directly in the Track Manager. Right-
click on a track entry and select “Insert track” from the context menu. 
A new track is added after the final track of the project. 

 

The Marker Manager represents all the markers contained in the 
current project, regardless of type, and makes it possible to jump to 
or start playing them directly from the list. 

To display the Marker Manager, click on the “Manager” button in the 
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You can export information from the Marker Manager as a text file. 
Click on the “Export text” button in the toolbar. The Windows Text 

xtract from the Marker Manager list. The 
ved: 

ect 

o provides a search option that allows you to search for 

arker” 
button in the toolbar. A Range surrounding the selected Marker is 

 markers, changing marker name, position and type 
You can delete Objects directly in the Object Manager by selecting 
one or several Objects simultaneously and pressing the “Del” key. 
Alternatively, you can also use the context menu to delete a track. 

You can rename markers by double-clicking on the marker names 
and entering a new name, or you can use the context menu. The 
procedure of changing a marker position directly in the list is the 
same. Please use the same method to change a marker position 
directly from the list. “Tab” moves on to the next editable value. 
“Cursor up/down” navigates you vertically within columns if these are 

toolbar and then select the “Marker” tab at the bottom edge of the 
Manager window. 

Menu: Tools / Managers / Marker Manager 

Editor opens with an e
following information is sa

• Project name 
• Marker type 
• Marker name 
• Marker position in the proj

You will then find the file in your project folder (Project name.txt). 

Marker view and selection 
In the Marker Manager you can display all markers of the current 
project. 

Searching for markers: As in other Manager windows, the Marker 
Manager als
markers in the current window. Enter a search item into the box and 
press “Return”. Found markers are highlighted. 

Jump to and play from marker position 
Double-click on a marker in the type column to position a playback 
marker on a different marker position. 

Playing markers: Select a marker and click on the “Play m

created and playback is started. 

Deleting
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name columns. 

Tip: You can change the type in the context menu of the respective 
marker anytime, for example, if you want to change a position marker 
into a CD track marker. 

Range Manager 
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The Range Manager represents all ranges contained in the current 
project and makes it possible to select them directly from the list.  

In order to display the Range Manager click on the “Manager” button 

Defining and search for ranges 
Defining Ranges: To save a Range in the Manager, you first have to 
define a Range in the Project Window. Next, click on the “Define new 
Range” button in the toolbar of the Range Manager. 

Ranges that are saved using the program's “Save Range” feature 

in the toolbar and then select the “Ranges” tab on the bottom row of 
the Manager window.  

Menu: Tools / Managers / Range manager 
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Searching for Ranges: As in other Manager windows, the Range 
Manager also features a search option that lets you search for 
Ranges in the current window. Enter a search item into the box and 
press “Return”. Found Ranges are highlighted. 

Edit range parameters 
You can edit the following parameters in the Range Manager: 

• Name 
• Start 
• Length 
• End 

To edit a parameter, double-click on the respective entry and enter a 
different value. Numeric values can be changed by drag & drop, 
whereby Ctrl+Shift allows for larger or smaller value changes. “Tab” 
moves on to the next editable value. “Cursor up/down” navigates you 
vertically within a column if these are name text boxes. 

(Alt+F2, Alt+F3, etc.) appear in the list with the F2, F3, etc. indicators. 
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VSTi Manager 

The VSTi Manager facilitates easy display, inserting and deleting of 
d Rewire instruments in the current project. If the 

, the outputs to the assigned tracks are 
ent opens the plug-

VSTi Manager in "Routing Setup". In the appearing dialog you can 
 can either route all 

outputs to the current track or, if you like, create new mono or stereo 

MAGIX, VST, an
instruments are opened
displayed. Right-clicking on the selected instrum
in dialog of the selected VSTi. Instrument outputs are routed in the 

specify how many outputs you want to route. You

tracks. Pressing the Del key removes a selected instrument 
completely from the project. If only individual output signals were 
selected, routing to a track is cancelled by pressing the "Del" key. 

 

Detailed information on the routing settings of instruments as well as 
on managing the outputs can be found in the chapter "Software/VST 
instruments > Routing instruments (on page 189)". 
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 Sound 

Surround Panorama Module 

In the Surround Panorama module the panning of a track or an object 
is set and edited on the Surround bus. 

Open the dialogue 
• Mouse right-click on the Surround Pan Display of the relevant 

channel line in the mixer (this is only possible if the twin-channel 
Surround mode is already active), or 

• Mouse right-click on the button or regulator in the relevant track in 
the VIP, or 

• Open the track menu of the VIP in the track information with a 
mouse right-click and select “Pan / Surround editor”, or 

• Select the required track in the VIP and select “Track” -> “Surround

Surround

 
panorama-module” 

In the title line of the Surround panorama module the track is stated 
that it is currently being edited. 

Example: “Surround panorama module: Track 4” 
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In the panorama display the loudspeaker channels of the Surround 
set-up are shown as blue dots. Activating the options underneath the 
panorama display allows the following information to be displayed in 
addition: 

Name 
The loudspeakers are designated with defined abbreviations: “L” 
(left), “C” (center), “R” (right), “Ls” (left surround), and “Rs” (right 
surround). 

Volume 
A level indicator appears next to each loudspeaker and shows the 
value of the level share that the sound source is transmitting on this 
Surround bus. For the stereo modes the total of the level of both
sources is always shown. If the shift key is held down and the mouse 

ill be shown 
briefly.  

So

Ea
fie
be  This 

 

is clicked on a source, the value for only this source w

und field 
The input signal is presented as a field made of concentric circles. 

ch red line corresponds to a level-gradient of 3 dB in the sound 
ld. The loudspeakers are arranged in such a way that the distance 
tween each loudspeaker and its neighbor is constant.

arrangement makes a uniform distribution of the sound source 
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po e 
channels that cannot be achieved in other modes. 

Surround active 

elements in the track box or the mixer. 

ht-hand 
channel is placed in the Surround field. For the individual cases 
please read the section on “Stereo and mono signal processing with 

The parameter controls the share of the center in the distribution of 
the sound source to the front channels. In certain working ranges 

eserve the center channel for 
dialog and to mix music and noises without share in the center. A 

 also described as divergence. 

Automating Surround 

This section of the dialog is described in the section on “Automation 
. 

o and mono signal processing with 
twin-channel Surround 

Mono 
The following applies to stereo signals: A mono total is formed from 
the signal that is positioned as a single mono sound source in the 

ssible to all channels. Level relationships are created between th

Settings 

Activates the twin-channel Surround mode.  

In the deactivated state the stereo position can only be determined 
via the control 

Pan L/R 

This determines the way in which the left-hand or the rig

twin-channel Surround”. 

Width 

Affect the extension range of the loudspeakers (sinking). 

Center 

(e.g. film sound) it is customary to r

signal positioned exactly in the middle is reproduced in the 5.1 format 
with Center = 100% exclusively through the center channel, or with 
0% exclusively as a phantom sound source throughthe channels L 
and R. This parameter is often

of twin-channel Surround”

Stere
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The following applies to mono signals: The signal is positioned as a 

X-Sym. 

lly to the x-axis. This, for instance, 
enables a stereo signal to be panned very easily from Front L to 

The following applies to mono signals: In addition to the original 

The mirror axis is the x-axis. 

xis. This enables, for 
instance, a stereo signal to be panned very easily from Front L to R. 

irror sound source of this signal is 
positioned. 

the y-axes. This 
enables, for instance, a stereo signal to be panned very easily from to 
Front L / Surround R.  

The following applies to mono signals: In addition to the original 

The following applies to mono signals: The original and the mirror 

panorama. 

single mono sound source in the panorama. 

The following applies to stereo signals: The left-hand and right-hand 
channels are aligned symmetrica

Surround L.  

mono source a second (mono) mirror sound of this signal is 
positioned. 

Y-Sym 
The following applies to stereo signals: The left-hand and right-hand 
channels are directed symmetrically to the y-a

The following applies to mono signals: In addition to the original 
mono source a second (mono) m

The mirror axis is the y-axis. 

XY-Sym. 
The following applies to stereo signals: The left-hand and right-hand 
channels are aligned symmetrically to the x and 

mono source a second (mono) mirror sound source of this signal is 
positioned. This is mirror-symmetrical to the original course with 
regard to the x and y-axes. 

Parallel 
The following applies to stereo signals: The left-hand and right-hand 
channels are kept at a constant distance to one another and shifted 
parallel to one another during movements. If the Ctrl key is held down 
the distance between the two sound sources can be altered.  
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rces at a constant distance to one another and 
shifted parallel to one another during movements. If the Ctrl key is 
held down the distance between the two sound sources can be 

The following applies to stereo signals: The same level shares as 
m no source are sent to the various channels, depending on 

the position of the sound source. However, for all left-hand channels 
only the left-hand signal is used, for the right-hand channels only the 

for the center and LFE channels the mono 
proportion.  

The following applies to mono signals: No special function, identical 

mation of twin-channel Surround 

ama-module 

 sound source is 
moved during the playing process, this movement is recorded and 

the sound source can be drawn in the 
Surround panorama. This series of movements is carried out in the 

e VIP is played. Later 
editing of the curve is possible with the curve editing mode in the VIP. 

tomation is to take place. Then the “Drawing 
mode” function likewise has to be switched on in the Surround 

hat you can simply put the source signal in the 

sound sou are kept 

altered. 

Stereo Thru 

with a o

right-hand signal, and 

with mono-mode. 

Auto

Surround-Panor
Panning movements in track-related Surround panning can be 
automated. For this purpose first the automation is switched on in the 
Surround panorama module. This can also be done by pressing the 
button of the relevant track in the VIP window. If the

shown in the VIP as a curve. Later editing of this curve is possible 
with the Panorama drawing mode of the mouse in the VIP. 

Drawing 
For this automation mode a range first has to be marked in the VIP 
within which the change is to take place. The drawing mode is now 
switched on in the Surround panorama module. Now any required 
series of movements of 

previously marked time range the next time th

Processing the Surround Sound automation 
Possibility 2: Drawing mode in the Surround panning dialog 
In order to prepare the drawing and movement for a Surround sound 
placement of the source signal, a range first has to be selected in the 
VIP track in which the au

panning dialog. After t
panning dialog into a new position. Samplitude Music Studio 14 
generates the automation events automatically in order to generate 
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Possibility 3: Drawing automation curves in the VIP track 

function can also 
be switched on. As the next step the Panorama drawing mode has to 

ts for this curve. 

this movement for the automation curves. 

Samplitude Music Studio 14 allows you to draw new Surround Sound 
automation curves in a VIP track or to change existing curves. Make 
sure that the button for the corresponding VIP track is activated. In 
the Surround panning dialog the “Automation on” 

be selected from the toolbar. You can draw new curve events with it 
in the VIP track. Place the mouse pointer close to an existing curve 
and click the left-hand mouse button. While this button is held down 
you can create new even
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Burning Redbook compatible audio CDs is a vital feature of 

g the write 
process. As trackbouncing was not performed first and no image is 

 resources must be available for 
processing while writing. If your PC is too slow and writing is 

upte an ert nal method, 
trackbouncing. 

o

To standardize the ture of CDs and to make them 
compatible with the C ony a aid down individual 
standards for the various types of CDs. The names simply arose from 

ch these standards were recorded. The 
term "Redbook" is common language for the Compact Disc Audio 
Standard. The requirements listed here have to be observed for 

production. Audio CD players only read CDs created 
according to the Redbook format. It is therefore necessary to first 

 onto an audio 
disc compatible with any audio CD player. 

udio CDs is 
nothing exceptional any longer, and permanently dropping prices for 

material is stored digitally, and these data are 
read by the CD player and transformed back to the analog plane. 
While in action, track indexes show the CD player which song starts 

sition. 

sic Studio 14 can write an audio CD directly out from 

converts stereo sum and indexes into a data stream that is fed to the 

Burning CDs 

Samplitude Music Studio 14. You therefore won't require any other 
software for writing a CD. You can also write CDs "On the fly", 
whereby all processing is performed in realtime durin

created, no extra space is required on the hard disk. 

However, sufficient system

interr d, you c of course rev  to the conventio

Redb ok 

data struc
D drives, S nd Philips l

the color of the books in whi

industrial CP 

convert PC files into this format before writing them

Writing 

Some years ago, there was but a small number of select studios in a 
position to carry out CD mastering. Today, writing of a

CD-R burners and media are within everyone’s reach. 

On the CD the audio 

at what po

Samplitude Mu
the program too. Before the write process starts, the track indexes 
are directly set in the VIP window. Then Samplitude Music Studio 14 
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 such that an audio CD player can read this information as 
digital audio data later on. 

ning CDs in  Samplitude Music Studio 
14 

D the VIP window must at first contain 
audio material. You may either record it new or import existing wave 

irtual project. 

 CD will later sound exactly like 
you will hear the playback via a stereo sound card. All settings for the 

indexes to mark the starting position of each song. If 
the VIP window contains but one stereo track in which each song is 

cause Samplitude Music Studio 
14 to create indexes by means of the button ”automatic indexes”. 

index to be positioned at the beginning of each 

s may be set without any rest either. Samplitude 
Music Studio 14 is one of the few audio programs permitting this. 

 function if your PC is not powerful enough. 
Now click onto the button ”create CD” in the toolbar or select ”CD > 

 in th  This dialog offers two options:  

the fly”. In this mode, all effects are calculated in real-time. 

eo file that contains all information on the multiple-track 
project.  

The first option would be a much more simple and convenient 
. 

CD burner. 

The CD-R drive modifies an assigned layer of the medium by means 
of a laser

Bur

1. In order to write an audio C

files into the v

2. Mix your recordings by means of the real-time functions of the VIP 
window and the mixer window. The

playback will be audible on the CD too. 

3.Set the track 

created as separate object, you may 

This will cause an 
object. Tracks and indexes may be arranged in Samplitude Music 
Studio 14 at discretion. Thus rest intervals may be continuously 
adjusted, and indexe

4. When you have made all settings you can write the CD in realtime, 
or you can use the offline

create CD” e menu.

Write ”on 

Create complete new files. Samplitude Music Studio 14 creates a 
new ster

method to burn a CD

5. One click onto the button ”OK” starts the writing process, and 
Samplitude Music Studio 14 starts searching for available CD-R 
drives. If several drives are connected to the system you will be 
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 drive desired. Before burning, the writing process 
can be simulated. You may check by that whether the capacity of the 
asked to select the

computer is sufficient for the writing process.  

Once sta cannot be stopped nrted it o more. 

DSP Display 

During the writing process on CDs in real-time the system capacity is 
of the essence. Once the writing process started it cannot be 
stopped no more. The whole CD becomes unserviceable upon an 
abnormal termination due to a system not fast enough. When ”on the 
fly” is selected the computer must calculate the playback with all real-
time functions and simultaneously write the data onto the CD. 

The DSP display is a fine expedient to assess possible problems 
 CD. The below table gives you a clue for the 

e 
to the configuration of your system and the speed of its components. 

Nearly 100 percent  single speed 

late the writing process at first to check the 
limit performance of the system. Should the system become 

 the number of tracks or real-time effects 

when writing onto the
maximum possible writing speed. Individual deviations may result du

DSP Display and Writing Speed 

Up to 50 percent  double speed 

Up to 25 percent  fourfold speed 

Particularly when first using a new and unknown computer system it 
is recommended to simu

overloaded, a reduction of
will help by combining parts of the VIP window by track bouncing. 

The offline variation of the writing process offers another possibility. 
At first, it creates a new stereo file that will be the basis for the writing 
process. 
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File menu 

The project menu contains wide-range functions for generating, 
managing, loading and saving projects. 

New Virtual Project (VIP) 
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A new virtual project is opened, you can choose the track and select 
a name for the new VIP. 

  Track Number: Sets the number of tracks for the virtual project.

Sample Rate: Sets the sample rate of the virtual project. 

Name: Each new VIP can be named here. 
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from six different display types for the 
grid. 

 Object grid. Objects will be snapped 
together sample exact when this option is active. 

Lock Recorded Objects: Recorded objects are immediately locked 
re placed into a VIP track. This prevents accidental 

moving and is especially helpful for multi-track projects. 

Project-patterns: Projects (arrangements) can also be saved as 
 in the File-Menu. The patterns are empty arrangements that 

contain all of the settings (f. ex. of the VIP-display) of another project. 

Auto-Crossfade-Mode: see Edit-Menu (on page 280) 

You can open various file types here and load them into Samplitude 

Key:  o for Virtual Projects 

Key:  W for WAV files 

Key:  ALT+S for sessions 

Virtual Projects are multi-track projects in Samplitude Music Studio 

Grid: Activates the grid display. 

Units of Measurement: Select 

Snap to Objects: Activates the

once they a

patterns

Keys:  E 

Open 

Music Studio 14. 

Key:  L for RAM Wave Projects 

Key:  Shift + L for HD Wave Projects 

Virtual Project 

14, which make use of Wave projects. When loading a virtual project, 
all associated Wave projects (RAM and HD Wave projects) are 
opened if they were not open prior to loading the VIP. The windows 
of the individual Wave projects remain minimized to prevent cluttering 
of the screen. They are initially only visible as icons. 

Once the Wave projects are loaded, the VIP project window is 
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Object 

projects. 

A previously saved Samplitude Music Studio 14 session can be 

and Import Sample->WAV: 
The command Open->WAV opens an already existing WAV file and 
edits the file as a HD Wave project. Samplitude Music Studio 14 

e corresponding graphic file in 
the source folder. 

e process takes much more time, 
since the audio file has to be copied with Open Project->WAV. Import 

Import Audio 

avi files or Sample 
Dump files into a Samplitude Music Studio 14 project. You will need 

displayed. 

HD Wave Project 
HD Wave projects contain audio data, which is directly loaded from 
the hard disk, together with the graphical information, marker position 
information, etc. The audio format used for these files is the WAV 
format. 

RAM Wave Project 
RAM Wave projects contain audio data in Samplitude Music Studio 
14’s proprietary format. These files are loaded into the RAM memory 
of your computer, including their associated graphic files, marker 
position information, etc. 

Contains playback instructions (link to a Wave project, track, time 
position, parameters, etc.) for audio data. Objects are used in virtual 

Session 

loaded with this command. All projects and their related windows are 
arranged on the screen the way they were saved to the session. 

Load / Import 

Difference between Open->WAV 

automatically creates a HDP file and th

When importing a WAV file, the complete file is copied. Additional 
hard disk space is needed and th

Sample->WAV has to be used when intending to use the WAV file as 
a RAM Wave project. 

Samplitude Music Studio 14 gives you the option of importing Wave, 
AIFF, MPEG, MP3 , MS audio (.wma), audio from .

to specify which type the project is going to be, a RAM Wave Project, 
or a HD Wave project. 



 

 266 File menu  

www.magix.com

udio CD Track(s) 

This option is located in the menu “CD” too. 

This function allows you to import audio data from most CD ROM 
drives and CD-Writers in the digital domain,without any loss in 
quality. Please contact our technical support for the latest list of 
supported drives. 

The HD Wave projects are recorded as WAV files and can therefore 
be edited with other audio editing programs without having to convert 
them first. 

To do this, please follow these steps: 

1. Open the drive list dialog and select your desired CD-ROM drive, if 
you have more than 1 drive 

2. Click on the “Track List” Button 
3. In the CD track list dialog select one or more tracks in the list box 
4. Click on “Copy Selected Track(s)...” 
5. Select a filename for the new WAV file or HD Wave project and 

click O.K. 
6. Now the audio data is copied from the CD-ROM to your hard disk 

as a new WAV file. 
7. Close the track-list dialog and the drive list dialog, in your VIP 

appear one or more new objects, containing the audio data from 
your CD. 

Features of the Drive List Dialog 
Track List: This button opens the track list dialog for selecting several 
audio tracks of your CD. 

Configuration: This button opens the drive configuration dialog, 
where you can select special copy modes and SCSI IDs... 

Reset: Restores the standard drive settings. 

Add Drive: Creates a new drive entry in the list for editing the 
configuration data. 

Delete: Deletes the selected drive entry from the drive list. 

Save Setup: Saves the drive list and all configuration data in a *.cfg 
file. 

Load A
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rive list and all configuration data from a 

rack(s): This button starts the audio data copy 
process; all selected tracks from the list are copied into one WAV file. 

t selected track in the list. 

ng. 

Resume: Resumes playback if previously paused. 

Select all tracks: Selects all tracks of the CD for copying the 

es the drive door of the CD ROM drive 

Host Adapter Number: Lets you specify the number of your SCSI 

SCSI-ID: Lets you set the ID of your CD ROM drive. Be sure to set 

Alias: Lets you select a manufacturers type of your CD ROM drive. 

Copy Mode Normal: Copies the audio data without any software 

Copy Mode Sector Synchronization: Copies the audio data using a 

Copy Mode Burst: Optimizes the speed of the copy process, no 

Load Setup: Loads the d
*.cfg file. 

Features of the Track List Dialog 
Copy selected T

Play: Starts audio playback of the firs

Stop: Stops audio playback. 

Pause: Stops audio playback for later resumi

complete volume. You can select multiple tracks with Ctrl + mouse 
click or with Shift/Alt + Cursor keys! 

Unselect tracks: Clos

Features of the CD ROM Drive Configuration Dialog 
Drive Name: Lets you edit the name of the drive in the list. This is 
useful if you create more than one entry accessing the same physical 
drive. 

adapter – normally 0. 

the correct ID, there is no error checking! 

SCSI-LUN: Select the SCSI LUN parameter, normally 0. 

correction. 

software correction algorithm. This is useful, because some CD ROM 
drives cannot seek exactly to the same position between two read 
accesses but Samplitude Music Studio 14 can correct these 
differences using this algorithm. 
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 correction is done. 

Sectors per Read: Defines the number of audio sectors per read 
umber the faster the copy process will be. Not 

all SCSI adapters support more than 27 sectors! 

The current project is saved with the name displayed in the project 
 a name for your project, 

Samplitude Music Studio 14 will ask you to do so. 

t as 

ts will be saved 
with the new names (the source file remains untouched). HD Wave 

sk. Samplitude Music Studio 14 
rat py of it for reasons of conserving space on your 

hard drive. 

ift + S 

This function in menu “Project” allows saving a VIP with all needed 
ecified directory. This makes it 

easy to copy all files of a VIP to a backup disk etc. 

 number of tracks or the type of grate are 
maintained and saved without the objects and HDPs. These patterns 
can be loaded when you are creating a new Multi-track project (Menu 

software

cycle, the higher the n

Sync Sectors: Defines the number of audio sectors used for the 
Sector Synchronization. A higher number results in a better 
synchronization but also in a slower copy process. 

Save Project 

window. If you previously have not specified

Keys:  S 

Save Projec

You can define the path and name of the new project you want to 
save your work under. RAM projects and virtual projec

projects are renamed on the hard di
will not gene e a co

Keys:  Sh

Save complete VIP in 

Wave projects (*.RAP., *.HDP) into a sp

Save Project as Template 

This option allows you to create project-patterns, where all project 
settings such as the



 

File menu 269  

 

www.magix.com

File > New Multitrack Project). 

D 

Save Object 

e object also has to be available if you want 
to reload the object. 

Save session 

Here you can save an entire Samplitude Music Studio 14 session. In 
addition, if you save a session with the name “startup.sam” and place 

ude Music Studio 14 program file 
(default installation would be c:\MAGIX\Samplitude Music Studio 14 
…), Samplitude Music Studio 14 will load that session the next time 
you start the program. 

eing saved). But all 
corresponding files are renamed immediately in the case of HD Wave 

Delete HD-Wave Project 

(If you wanted to delete a HD Wave project (HDP) from a file manager 

Burn Project Backup on C

This option lets you easily create data CD backups of the whole 
project. For this purpose, the external  Samplitude Music Studio 14-
CD burning software is started. 

An object can be saved. This file only contains realtime data (wave 
files, fades, names, etc.), not the actuval audio data. The wave 
project referenced by th

it into the directory with the Samplit

Rename Project 

The “Rename Project” command will let you rename a project file 
rather than save it to a different file. For RAM Wave projects, only the 
internal names are changed (without b

projects. 

RAM Wave projects need to be saved after renaming the project. 

HD Wave projects are deleted from the hard disk. Use this command 
with caution, as all corresponding files are lost. 

such as Windows Explorer, it would also be necessary to delete the 
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 Vir jects 

rojec  you c mfortably delete 
VIPs and all wave projects used in the VIP. All files belonging to a 
multi-track project (the WAV file containing the audio files, files with 

nd the HDP file with the project information) will 
be lost. 

ediately after pressing OK. 

rmat 
the various 

Samplitude Music Studio 14 formats for wave projects. 

ve projects (2 connected 
mono samples) into stereo wave projects. 

A Stereo Wave Project is copied and converted into a Left Mono 
t an t Mono Wave Project . 

2Mono > Stereo/LR-Wave 
project. This is a 

convenient way of editing joined mono samples with the same 

one L&R wave 
project. You can then perform common operations and apply them to 
all samples. 

After applying the command you will be prompted to activate the 
 the active 

mono wave project. To do this, click on the title bar of the 
corresponding window. Please note that only mono projects can be 

 projects of the same bit  and sample rate. The 
lengths of both projects are adapted to each other. 

graphic files related to the project files.) 

Delete tual Pro

With the command Delete Virtual P ts an co

the graphics data, a

Warning: There will be no further security query. The data will be 
deleted imm

Convert audio 

Save in Fo
Use this function to convert wave projects between 

This can be useful, for instance, if you want to convert RAM-wave 
projects in HD wave projects or L&R wa

Stereo Wave> Mono 

Wave Projec d a Righ

Two mono projects are linked to one L&R Wave 

operations. 

Here you can connect two mono wave projects to 

second mono wave project that you want to connect to

linked to mono wave
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Wave - 2 Mono 
L& R Wave projects can be split into two independent mono projects 
using this function. This way you can break the fixed connection of 

 one another and edit them individually. If you wish to 
edit them again together, select the function 2 Mono > L&R Wave. 

L&R-Wave - 1 Mono 
The current L&R Wave project is converted into a mono mode. If it 
was a stereo project before, both channels will be mixed. The 
previous samples are first added with 100% of their image and then 
divided by two to prevent over modulation (distortion). This is an 
equivalent of reducing the volume by 6 dB. 

1 Mono - L&R-Wave 
The original mono Wave project is duplicated and converted into a 
single L&R Wave project with the same sample in both channels.  

Export audio 

Here you can export VIPs, HD wave, or RAM wave projects in the 
formats WAV MPEG (1:10), Dump, MS-Audio, AIFF with Quicktime, 
16-bit AIFF and Real Audio or MP3. 

L&R-

the samples to

Note on exporting audio: The audio data from HD Wave Projects can 
be further processed or imported directly as WAV files from HD Wave 
Projects. The use of the "Export sample" function is only necessary 
when the data is to be copied. The storage space required on the 
hard drive is not increased; of course, copying requires considerably 
more time. 

Make podcast 

Podcast is the name for a relatively new Internet transfer form. It is 
made up of "pod" from "iPod", the name of a popular portable MP3 
player, and the term "casting" for broadcasting content to a wide 
group of listeners/viewers. 

A podcast is therefore something like an online radio station. 
"Broadcasting" webradio stations means you can only listen to and 
record the currently broadcast radio station. Podcasting is different. 
You as the listener can subscribe to the podcast and the files will be 
downloaded at a specific time and you can listen to them whenever 
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e move with your portable player. The 
nd placed on an Internet server for 

download.  

nt as podcast show (audio)" in the 
@Services > MAGIX Podcast Service menu and the exciting journey 

to the pages of the largest podcast providers begins. 

The first stop is your personal MAGIX Online Album, the place your 
nline home. From here it can be accessed from 

you like, for example, on th
shows are pre-produced a

Select the "Upload arrangeme

of your podcast 

podcast will call its o
anywhere in the world. Login with your password or register.  

Your free MAGIX Online Album with 128 MB webspace can be set up 
at any time. It will then be available to you from anywhere in the 
world.  

When uploaded via the "Make podcast" button the podcast will be 

ted folder "My podcasts".  

sent to your personal MAGIX Online Album. In the MAGIX Online 
Media Manager of your MAGIX Online Album the cast can now be 
found in its new format in the newly crea
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Now take a look at your album website: Here you can listen to the 
cast on your own website. You will immediately notice the small 
button "Subscribe to RSS feed" which allows any user of your MAGIX 
Online Album to automatically receive podcasts now and in future. 

 

 

www.magix.com

How

guarantee that your podcast will be sent from your MAGIX Online 

Here
audi
14 
international podcatchers. The distribution depends on the topic of 
the podcast. 

You may even find your podcast via a search engine without knowing 
how long the journey of a cast over the web may be. 

With Make podcast you can publish your project as a track on your 

 is your podcast distributed? 
Your RSS feed - the technology behind a podcast - will automatically 

Album to many large podcatchers, including MAGIX Podcast Service. 
 your podcast can now be subscribed to by a worldwide 
ence. Currently, a podcast created with Samplitude Music Studio 
and uploaded to MAGIX Online Album is sent to 10-20 

podcast. 
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The Export podcast dialog now opens. Here the required information 
 to be entered. for your podcast track has

 

Title: This is the title of your podcast. A podcast typically contains 
d regularly. This is not where 

st to which the track belongs. You 
d to MAGIX Online Album. A 

lbum.   

 MAGIX Online Album. You can only upload one 

nt to enter a unique name and description 
so that other listeners will find your podcast. 

re you enter your email address so that you 

tomate work processes. You can 
n of a wave project in the same 

several tracks, and new ones are adde
you enter the name of the podca
can enter the name when you uploa
podcast then corresponds to an a

Export podcast: The project is encoded as an MP3 and then 
uploaded to the
contribution at a time (one file). 

Description: It is importa

Person responsible: He
can be contacted. 

Batch-processing 

Batch-processing lets you au
stretch out a specific editing functio
way onto a file list of any size (the "batch"). The files are then 
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ude: 

 
• Linear fade in and out 
• All realtime effects available in the Mixer master 

rd width (16/24/32 float), sample rate, 
stereo/mono/left/right 

For example, you can normalize an entire folder of 24-bit wave files to 
ginning and end of each, compress with 

the multi-band compressor, convert to 16-bit, resample at 22kHz, 

Source files 

Possible editing processes incl

• Normalization

• Format conversions: Wo

• Save in all available export formats. 

96%, add 5ms fade to the be

and save as MP3. 

 

Here you can create the list of the files you wish to edit with the "Add 
file" button. Multiple selection is possible. With "Load folder" all audio 
files in a folder as well as all subfolders are added to the list. All audio 
formats that Sequoia can import can be loaded. With "Save list" you 

ormat) so that you can can create a playlist (in the widespread *.m3u f
use your file selection once again. Use "Delete" to remove all selected 
list entries. "Delete all" removes the entire list. 
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Effects 

 

Amplitude: You can normalize to a specific maximum value in %/dB 
or sink/raise the level by a certain value. Read more on this in the 
"Effects" menu chapter > Amplitude/Normalize. 

Effect presets – Mixer master channel: So that you don't have to list 
out innumerable effect settings in the batch processing dialog again, 
the effects can be integrated using mixer preset files.  

 Mixer 
.mix). This happens via the "Save Mixer Preset" button in the 

 www.magix.com

In the Mixer it's possible to export all settings of the Mixer in a
preset (*
Mixer. 

the batch-processing function 

trips, groups, etc. will be ignored). With "Edit 
preset", you can open a special FX routing dialog from which you 

(More information on FX routing can be found in the Effects chapter). 

" folder can 
be selected directly from the list box. 

Effects: Beside the master effects of the Mixer preset the non-
realtime effects "Resampling/Timestretching", "Remove DC offset", 
and "Remove modulation" (DeClipping) can be used. "Settings" 

When you load the *.mix file into 
("Load preset") all effect settings of the master channel will be 
calculated into the file batch. (All other data from the Mixer preset, for 
example, channel s

have access to all effect parameters. 

Mixer presets which were saved in the "/fxpresets/batch
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opens the corresponding effect dialog. 

Fades at the beginning and end of projects: Linear fades of any 
length can be added to the beginning and/or end of files. 

Destination format 

 

All settings on this page can be saved as presets. You can freely 
choose the bit resolution (16/24/32-bit), the sample rate, 
stereo/mono/left/right as well as the save format with the 
corresponding format options. You can find out more about the 
sample rate in the "Offline Effects" menu > "Change Sample Rate..." 

Read more about export formats in the "File" menu > "Export". 
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Destination files 

 

There are various options for saving the files you edited: 

• Replace

 www.magix.com

 files: The original file is replaced by the edited one. If the file 
is used in a VIP, the VIP is closed first. 

y with changed name/Save files in 
ved in the source directory or in any 

ix/prefix is added to the file 
 be deleted after editing. 

• Keep source directory structure: This option saves all files including 
is allows you to keep folder structures of CDs. 

rrectly. To restore the Internet connection, click the 

• "Save files in source director
directory": The edited file is sa
chosen directory. The specified suff
name. Optionally, the source files can

the source path. Th

Connect to the Internet 

This menu item allows you to terminate an existing Internet 
connection directly from within Samplitude Music Studio 14. You will 
have to enter the necessary connection details and a modem should 
be installed co
"Dial" button. 

Warning: the Internet connection only works if you have registered 
with an Internet provider or have the necessary access data. 
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FTP Download 

s the MAGIX Server, where you will always find 
new sound-material. Once again, the only thing you need is a working 

t onnec

o a new, 
empty message as an attachment. All you have to do is enter the 

 "Send". 

Closes Samplitude Music Studio 14. 

This option allows you to build up a direct connection to any FTP-
server on the Internet in order to download sound material directly 
into your Samplitude Music Studio 14 so that you can edit it there. 
The pre-set server i

Interne  c tion. 

Send project via email 

This option compresses your VIP to an audio file in WMA format. 
Then your mail program is opened and the project is added t

address and click on

Close Project 

Closes the arrangement. 

Exit 
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u contains all functions, which are similar to cutting on a 
tape machine.  

ack sensitive ranges, so only the 
selected tracks are manipulated. 

 Wave projects. Others 
only for virtual projects (VIP), while some of the functions will work in 

rking with a virtual project (VIP) a selected range is always 
required for the cut functions. The beginning and end of the selected 

ds of a cut. The vertical position 

tween the edit points. This will automatically 
create fades at the object edges. 

rojects.) In virtuellen Projekten kann eine 
spurselektive Bereichsmarkierung erfolgen, so dass nur bestimmte 
Spuren von den Schnittoperationen erfasst werden. 

l projects. Up to 100 changes can be kept in 
memory and traced backwards. That means virtual processes can be 

tisfactory. 
Samplitude Music Studio 14 offers a convenient undo option for VIP 

axi  of 100 undo steps can be retraced. This number 
can be configured in File/Preferences/Undo Definition. 

Edit menu 

This men

In virtual projects, you can select tr

Activate cutting and copy also makes a project named Clip activated. 
The window for this project will appear if double-click on the icon. 

Some of the functions are only available for

all types of projects. 

When wo

range determine the start and en
indicates which tracks are affected by the edit. 

It is recommended to use the Auto-Crossfade function to achieve 
smooth transitions be

Please note that these functions are processed for both channels 
when working with stereo and L&R Wave projects. (If only one 
channel is to be edited, you will need to convert the Wave project into 
two mono Wave p

Undo 

Samplitude Music Studio 14 offers you a comfortable way of tracking 
your changes in virtua

reversed (undone). Range and marker manipulations can also be 
undone using the “Undo” feature.Thanks to this extremely efficient 
feature, critical operations can simply be tried and then reversed to 
return to the original status if the results are not sa

objects. A m mum
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Keys:  Ctrl+Z 

Redo 

Redo revokes the latest undo command. 

Keys:  Ctrl + A 

Undo-History 

 

Displays the Undo History dialog. 

Cut 

Wave Projects 
The audio data in the selected range are copied from the current 

lip. The material behind the removed range is 
merged with the material in front of the removed range to close the 
Wave project into the C

gap. The complete Wave project becomes shorter. 
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was copied or removed from. 

ct. Another 
attribute adopted is the bit resolution and the sample rate of the 

The previous contents of the Clip are deleted. 

ssful removal of the selected material, Samplitude Music 
Studio 14 drops a marker at the position the removed range 
previously started. This allows you to insert the contents of the Clip 

if you accidentally 
removed the material. Use the function Edit->Paste/Insert Clip to 

Virtual Projects (VIP) 
 VirtClip and is 

removed from the current VIP project. The VirtClip does not contain 

The material behind the removed range is appended to the material in 
front of the removed range. The VIP project becomes shorter if the 

n shorten VIPs, 
which contain empty space behind the last object. 

lected 
range drops a marker at the position the removed range previously 
started. This allows you to insert the removed material with 

 
sample length becomes shorter. 

ve the deleted sample data, use the “Cut” 
command. Using this the “Delete” command will delete the data from 

Please keep in mind that the Clip always contains the same attributes 
as the Wave project the material 

If you cut material from a mono Wave project, the Clip becomes a 
mono Wave project. If material from a stereo Wave project is cut or 
copied to the Clip, the Clip becomes a stereo Wave proje

originating Wave project.  

After a succe

into the Wave project at the exact same spot 

insert the Clip contents. 

In virtual projects the selected range is copied to the

actual audio information, only the links to the audio files. The VirtClip 
also contains as many tracks as the removed range. 

selected range did cover all tracks. This way you ca

As with the Wave projects, a successful removal of the se

Edit->Paste/Insert Clip. 

Keys: Ctrl + X or X 

Delete 

The data of the current range is deleted. The sample data after the 
deleted range is added at the position the deleted range started. The

Please note that this command will not save the deleted data to the 
Clip. If you want to preser



 

Edit menu 283  

 

www.magix.com

Copy 

The current range is copied into the Clip but not deleted in the 

Paste from clip 

re inserted into the current project behind 
the position of the play cursor or the beginning of the currently 

 to make room for the Clip 
contents. The samples or audio tracks become longer. The Clip 
remains unchanged during the procedure. If the Clip was empty, an 

ete, the inserted contents are 
removed and the project is returned to the original state. 

selected ranges, the program utilizes the 
beginning position and relative track position as the insert point for 

Clip Project Clip Channel Project Channel 

Stereo Stereo 
l 1 

Channel 1 

Channel 1 
Channel 1 

Channel 1 
Channel 1 

Channel 1 
Channel 2 
Channel 1 

Keys:  Ctrl + V or V 

the current sample and preserve the contents of the Clip. 

Key:  Del 

project. The sample length is not varied. Please note that the former 
Clip contents are deleted. The Clip again has the same attributes as 
the project. 

Keys:   Ctrl + C or C 

The contents of the Clip a

selected range. The data or objects that are located behind the insert 
position are moved out of the way

error message is displayed. 

After inserting the contents, the program selects a range over the 
inserted area. If you select Edit>Del

In virtual projects using 

the VirtClip or Clip contents. 

Mono Mono Channe

Mono 
Stereo 

Stereo 
Mono 

Channel 2 
Channel 1 

Channel 2  
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Extract 

Wave projects: The current range is retained, the data before and 
 is irrevocably deleted. The length of the sample is thus 

Virtual projects (VIP): All tracks of the VIP keep the length of the 
tive of the position of the range. 

This function does not work track-specifically. Here, the objects 
before and after the range are deleted. This function does not 
influence the VirtClip. 

More 

Insert Silence 
The ‘Insert Silence’ option will insert ‘blank’ data at the current play 
cursor position or the starting position of the currently selected range. 

Append Projects 
can be appended with another project, 

directly behind the material of 

menu and click on the project you want to add to the 

the VIP 
at the 

 
hich the material 

Alt + Delete 

This function is the counter part of the ‘Cut’ function. 

after the range
reduced and the content of the clip remains. 

selected range, irrespec

With this function a project 
rial of one project is copied i.e. the mate

the first. 

You need to first select the object you want to append. Then you 
activate the 
first. 

A particular use of this option is the ‘cleaning up’ of VIP’s that contain 
numerous physical samples. 

Set Silence 
Copies the selected VIP Range into the Clip and clears it in 
Project. The Project length is not changed. Please note th
previous Clip contents are deleted. 

This is a good way to remove a section of a VIP for use elsewhere
without affecting the length of the Track(s) from w
was removed. 

Keys:  
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Shortcut: Alt + C 

The current range of a Wave project (HDP or RAP) is copied into a 

ift + C 

The current range is replaced with the Clip contents. The overall 
e data that occupied this 

position before cannot be recalled. The Clip contents are not 

selected range determines the position and 
track in which the Clip is inserted. 

Keys:   Alt +v or Insert Key 

Mix with Clip 
re mixed. Much like with 

 doesn't drop 
suddenly, while on the other hand, there is the danger of 

Copy and Silence 
Replaces the selected Range with silence (VIP). This command is 
useful when you want to remove material without changing the length 
of the VIP Track(s).  

This command will not save the deleted data to the Clip. If you want 
to preserve the deleted data in the clipboard, use the Edit > 
Copy+Clear command.  

Copy as 

new file. A file requester appears to select the name of the new 
project. 

Keys:  Sh

Overwrite with Clip 

sample length remains unchanged. Th

changed. The assignment of the Clip channels follows the table 
mentioned above. 

In virtual projects, the 

The range contents and the Clip contents a
the "Insert" function, the rules for channel assignment between 
project and clip also apply here. The clip itself remains unaffected. 
Please note that with this function both components (i.e. the sum of 
both) are entered into the mix at 100%. On the one hand, it 
guarantees that the volume of the project sample

overmodulation.   You may have to adjust the amplitude of the 
project prior to this (see Edit menu). 

Crossfade with Clip 
The content of the range is crossfaded with the content of the clip. 



 

 286 Edit menu  

www.magix.com

ich have been 
previously selected. Individual volume events can be deleted by 

Delete Panorama Handle 
This function deletes panorama curve events, which have been 

al events can be deleted by selecting the 
Object and Curve Mode mouse mode and double clicking the left 

Volume/Pan curve active 
This option has the same functionality as the corresponding buttons 
in the track info box: the corresponding curve is activated so that it 

e Undo Levels 

 exist in the VIP anymore. You won’t be able to process or 
delete the Wave project if the Undo chain still contains a reference. 

Delete curve handles 

Delete Volume Handle 
This function deletes volume curve events, wh

selecting the Object and Curve Mode mouse mode and double 
clicking the left mouse button on a volume curve event. However, 
when deleting several curve events, the “Delete Volume Handle” 
function is the best tool. 

previously selected. Individu

mouse button on a volume curve event. However, when deleting 
several curve events, the “Delete Panorama Handle” function is the 
best tool.  

can be edited. 

Delet

This feature will delete the Undo levels of a virtual project. This is 
useful, if for example certain Wave projects are left in the Undo chain, 
but do not

After deleting the Undo levels, these projects are available again.  

Crossfade Editor 

Crossfading with the Crossfade Editor 
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In the VIP select the objects into which you wish to fade and open 
the Crossfade Editor. 

 

The following editing options are available for selection: 

e" menu. This range has to be selected before 
opening the Crossfade Editor. 

ts of different curve types available 
for selection for the crossfade: 

Linear (0) 

Exponential 

Logarithmic 

Crossfade Length: The length of the crossfade can be set in 
varyingly large steps. A click on the "+" / "-" buttons 
increases/decreases the length in small steps, the "++" / "--" buttons 
in larger steps. Use the button "-/+" to customize these step effects 
to your needs. The crossfade length can also be defined by a 
selected range in the VIP by clicking on the "Get Range Length" 
button in the "Rang

Fade In / Fade Out: There are lo
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Sine/Cosine 

ear curves require less computer 
power than non-linear. 

s for fade in/out in the Crossfade Editor are applied 
to the selected object if it does not overlap any other object. 

The current settings are defined as preset. This is useful, for example, 
bject is split with the "T" key and you wish to create a 

crossfade between the two objects. When opening the Crossfade 
Editor, the specified settings are set as default.  

Global settings: Get 

itor. 

e Length: The range length of the range selected in the VIP 
 the crossfade length. 

 you can specify how much of the fade should be 
order. Usually, the entire fade can be found 

object, tha arting point is at 
%) as is normal with fade ins/outs of 

, it may be 
ify it. If, for example cond object starts with a 
d be better to execute the crossfade beforehand in 

tack" of the drum at. 

The value can be changed from 0% (fade within the object borders) 
to 50% (fades symmetrical to the object borders) to 100% (fade 

borders) – the object is then stretched by the 
percentage of the fade length. The "actual" beginning of the object is 

With a fade offset of over 0% make sure that the corresponding audio 
 wave project, otherwise it may be the case 

not be faded in or out. 
If, for example, the object starts at the exact beginning of the wave 
project, you will no longer be able to crossfade if the fade offset rises 

Cosine 

The faders can still be used to change the curves in the 
corresponding available range. Lin

Note: The setting

Global settings: Place 

when an o

Use this button to get the presets of the Crossfade Ed

Get Rang
is set as

Fade Offset: Here
outside of the object b
within the borders of the t is, the fade st
the start of the object (0
individual objects. If the fade becomes part of a crossfade
necessary to mod , the se
drum beat, it woul
order to keep the "at  be

outside the object 

displayed as a dashed line. 

material is available in the
that an object with a modified fade offset can
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 the crossfade 
of the selected object. The fade out time of the first object is set to 0. 

rts playback in the selected range or at 
the cursor position. 

Move crossfade position: The end of the first object and the end of 
c d obje y. The ++/--/+/- buttons are used 

to set the crossfade length. 

Permit asymmetrical crossfades: The fade offset settings of both 
 re no longer connected to one another and can therefore be 

set independently of one another. 

de active 

 turned on, all newly recorded or cut material in a VIP 
or material that is copied from a Wave project into a VIP track has an 

plied to it. 

 for fade-in and fade-out parameters are assigned to 
 

in the Edit->Crossfade Editor. 

If two objects are overlapped that had an automatic crossfade 
a real-time crossfade is the result. 

ack etc., which requires a 
soft passage without the unwanted “pops”. If needed, each 

d  can be edited in the editor or by manually manipulating the 
handles.  

above 0%. 

Crossfade off: The "Crossfade off" button deactivates

Play / Stop: This button sta

the se on ct are moved equall

objects a

Auto Crossfa

If this option is

automatic crossfade ap

Global settings
the object. These settings can be changed with the crossfade editor

applied to them 

The auto crossfade mode is an excellent tool to easily perform a 
linear cut of a spoken voice track, jingle tr

crossfa e
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4. 

Rebuild Graphic Data 

Sections 

Samplitude Music Studio 14 allows the optional display of one, two or 
e samples belonging to one Wave project or the 

f a sample. 

lect “2 c Studio 14 will display the same 
sample in two window sections. Each section can be handled 

possible, for example, to represent the complete 

e “3 sections” is especially useful for searching for loop 
points in Wave projects. 

lower left displays the beginning of the loop range and 
the section on the lower right the end of the range. Use the split 

 b). 

ions can be 
handled independently.  

of a range by clicking, then keep the mouse button 
pressed, and change over to another section. Samplitude Music 

of the range and at the desired 
location release the left mouse button to determine the end of this 

View menu 

This menu contains tools for manipulating the display of Samplitude 
Music Studio 1

Display inaccuracies after complicated sample processing can be 
fixed by using this menu option. The screen (window) will be cleared 
and redrawn to display the project properly. 

three sections of th
VIP itself. Other audio editing applications usually show only one 
window o

If you se ”, Samplitude Musi

separately. It is 
sample in one section and a zoomed in version of a certain range in 
the other. 

The mod

The whole sample can be shown in the upper section, while the 
section on the 

range function for this purpose (key

Go back to 1 view with Shift b! 

This is only an example of the mode “3” view. All sect

You can also drag ranges over the section bounds. Establish the 
starting point 

Studio 14 will show you the size 
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Fix vertically 

ed (pulled) in Samplitude Music Studio 14 
horizontally and vertically as well. If this option seems too strange to 

l 
representation in range dragging. However, a trade-off is, that you 

/Aux Busses 

rid option. Select between several line styles. 

range. 

Ranges can be dragg

you, you can fix the upper edge of a range(s) to the maximum value 
and the lower end to the minimum value. Thus, you get the usua

will not be able to define the vertical extension of a section by 
choosing the vertical range button. 

Hide SubMix

With this function you can hide or minimize the tracks of the mixer 
busses. Please read the corresponding notes in the Mixer chapter. 

Show Grid 

With this option, you can define the type of grid that is used for the 
Show G

Key:  # 

Grid Lines 

With this option, you can define the type of grid that is used for the 
tion. Select between several line styles. 

Units of Measurement 

e varius measurement settings. 
They will affect the start and length details of the current range in the 

f the 
play cursor (position line). Measurement units such as samples, 

Show Grid op

In this submenu you can adjust th

project window, the grid measurement and the position details o

milliseconds, SMPTE (with different frame rates), bars and CD-MSF 
are commonly used. 
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Snap to Grid 

When working with virtual objects the Virtual Grid becomes available. 

ally the beginning of the 
object to be shifted to. A hot spot when defined will be used as a 
reference point as well. 

If several objects have been selected, the move is performed in lining 

n can be used to easily rearrange objects with their audio 
patterns and gain sample-exact connections. 

This function switches the Grid on and off. 

Objects can only be shifted to the beginning, the end, or the hot spot 
of another object. The reference point is usu

up the beginning of the last selected object in the sequence with the 
reference object or Grid point. All selected objects remain their 
position to each other. 

This optio

Keys:  R 

Snap and Grid Setup 

 

Object s the objec: Activate t grid. 

Range: Activates the range grid and enables the use of the current 
 clicking on the button “Get Range”). 

This option is very useful if you have found the perfect location 
selected range as grid base (by

defining a particular music bar in the sample. To transfer the range 
into the grid, use the command “Get Range”. 
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a : Activ  on bars and beats. You can 
specify the speed of the measure by entering the BPM (Beats Per 
Measure) value in the dialog box. By clicking on the “Bar Definitions” 

options to specify the parameters for this 
option such as the time signature. 

umber of beats in the 
measure would be 4. The length of the range would determine the 

i eded to play the sample in the selected time 
frame. 

s dialog lets you specify the bar settings, e.g. 
Numerator / Denominator, the speed in beats per minute and the 

 Tab 

spla

Definition 
> Display options (on 

page 457). 

Mode 1 has been selected for displaying virtual projects 

Mode 2 has been selected for displaying virtual projects 

y modes with the Tab key. 

Switches the display of virtual projects between both modes. 

Key:  Tab 

and zoom level 

left of the VIP. The four buttons in the lower left-hand section of the 

Bar Sn p ates a grid, this is based

button you have more 

If a complete 4/4 measure is selected the n

speed n BPM that is ne

Bar Definitions: Thi

timer resolution in peaks per quarter note. 

Keys:   SHIFT + R 

Key for switching the two modes: 

VIP di y 

Opens the General Settings dialog in Design 

Mode 1 

Modus 2 

This mode also includes an enlarged display of volume and panorama 
points. This means you can quickly switch between normal and 
enlarged displa

Change mode 

Store position 

This function does the same as the snapshot-buttons at the bottom 
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u to save four setups. 

 saved screen section including the zoom level. 

 of the horizontal (red) position 
bar. 

Vertical 

This menu contains all the functions of the vertical (blue) position bar. 

Virtual project window allow yo

Get position and zoom level 

Opens the

Horizontally 

This menu contains all the functions
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cks 

ed by one empty track. 

Add several Tracks 
ed by one empty track, which is inserted 

below the selected track. 

ty Track 
The virtual project is expanded by one empty track, which is inserted 

ubmix bus" you can add a new submix bus as a 
new track again. The option "New AUX bus" is identical. The new bus 

New track folder 

r. 

Tracks can be moved into the folder with drag & drop, by clicking on 
. The mouse pointer turns into a hand. 

Similarly, tracks can be removed from the folder via drag & drop and 

n also be grouped. This means an action 
performed on a folder track affects all contained tracks. Tracks in a 
folder can be: 

• faded out with the Reduce track button. All tracks included in the 

rs of the tracks are 
scaled relative to another, independent of the current function of the 

orresponds to the first 
track of the folder, joint switching is only possible with different/multi-

Track menu 

Insert new tra

Add one Track 
The virtual project is expand

The virtual project is expand

Insert emp

below the selected track. 

New SubMix/Aux Bus 
In menu item "New s

is always inserted after the active track. 

Inserts a new folder track in front of the marked track. If a range 
across several tracks was highlighted before creating the folder track, 
each of these tracks will be added to the folde

a free area in the Track box

out of the Track box. 

Certain actions ca

folder track are displayed in reduced size. 
• switched to mute, lock, monitoring, and solo. 
• volume controlled. The individual volume fade

track volume fader (MIDI, CC, or audio level) 
• can be activated (the displayed condition c

track recording devices) 
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nlarged (opened up), all included tracks 
are displayed as well with a frame in the color of the folder track. The 

 available in the Mixer. 

Normally all the tracks can be seen with the objects they contain in 
the folder in a smaller display. Section marking in the folder track is 
carried out across all tracks. Use this view mode for section-based 
cut operations across all tracks of the folder track. 

By right-clicking on the Track box of the folder track, the contained 
track can be used as a reference track. The objects of this track are 
displayed in the folder and can be used for simultaneous object-
based cutting operations for all objects of the other tracks in the 
folder track that are grouped with these objects. Object groups like 
these typically originate from multi-track recordings. 

The usual method of working with folder tracks would be as follows: 

1. Initiate a multi-track recording. This creates several grouped 
objects, one below the other. 

2. Select an area over all the objects that you wish to edit together. 
You can now create a folder track! 

3. Minimize the folder track and choose one of the contained tracks 
as a reference track. 

4. The object of the reference track now appears in the folder track 
instead of the emblematic display of all contained tracks. All object 
editing, cuts, fades, and Object Editor effects of this object are 
now applied to all objects of the folder tracks! (Changes in the 
Object Editor take effect only after Apply/OK) 

Folder tracks are not visible in the Mixer. 

Cut Track(s) 

Cuts out the complete tracks that have been selected by the range. 

Copy Track(s) 

All selected tracks in the VIP are copied into the VirtClip. 

If the folder track display is e

track color can be selected in the track settings. If the folder track is 
minimized, the tracks included in the VIP are hidden. They continue 
to be available in the Mixer. They are also
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All selected tracks are deleted from the actual VIP.  

Track Properties 

Here you can edit the properties of the active track. These are: 

Mute: The mute button mutes the active track. 

Solo: Switches the active track to Solo mode. 

Solo exclusively: This setting switches the active tack to Solo 
exclusive mode, i. e. you will only hear the activated track. All other 
tracks are muted, unlike solo mode. 

Record: Activates Record mode. 

Lock: Locks the activated track. 

Volume/Pan-curve active: Displays the volume or pan curve of the 
activated track. 

Submix/AUX bus: If the activate track is a bus, it can be defined as a 
submix and/or AUX bus. 

Track Effects 

Please read the chapter “Menu Effects”! 

Copy/Paste Track Effects Settings 
With this command you can copy the complete effects settings of the 
active track into the clipboard. 

Copy/Paste Track Effects Settings 
With this command you can copy the complete effects settings of the 

Insert track(s) 

The clip is inserted from the track with the current range setting. New 
tracks are created in the VIP. 

Delete Track(s) 
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her track). 

Reset Track Effects settings 

D

Th

Th

T

Th
ob
to reduce the PC's processor strain of having to process effects and 

separate VIP and can be edited/recalled at any time. This way it's 

m

Tr

Bus/Aux bus tracks can be frozen just like regular tracks. This 

in
on

active track into the clipboard (to paste it on anot

Reset all Track effects settings to its defaults, i.e. no effects are 
applied at all.  

Surround Editor 

Please read the chapter "Surround". 

irectX Plug-Ins 

Please read the corresponding explanations in the "Effects" chapter. 

Maximize Track 

is Option minimizes all tracks except the selected track. 

Minimize none 

is Option un-minimizes all tracks. 

rack Freeze 

e selected track is rendered into a wave file which replaces all 
jects on the active track. Here, object and track effects are added 

plug-ins. 

The advantage of Track Freeze is that the frozen track is saved in a 

also possible to work flexibly and to keep resource usage at a 
inimum even when working with less powerful computers. 

ack freeze for AUX busses/submix busses 

enables a complete group of tracks to release the required CPU load 
cluding all effects, fades, crossfades, and automation settings in 
e step. 
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Su

• Tracks routed onto the submix bus are not changed but remain 

• The submix bus is muted ("Track" menu > "Track options" > "Mute 

• Only AUX send settings in tracks are taken into account (not in 
objects). 

risk is added before the name above the AUX send faders 
(mixer). 

• Changes made after freezing to the tracks transmitting to the AUX 

Track Unfreeze 

n the temporary 
trackbouncing VIP. 

bmix bus 

instead. 

bus input"). 
• The file created while freezing is inserted into the AUX track as an 

audio object. 
• Changes made to the tracks after freezing which are routed to the 

submix bus have no effect on the signal output while playing. 

AUX bus 

 

• Tracks routed onto the frozen AUX bus are not changed but remain 
unchanged instead. 

• The AUX bus input is muted ("Track" menu > "Track properties" > 
"Mute bus input"). 

• The color of the AUX send fader (mixer) in the affected tracks is blue. 
• An aste

• The file created while freezing is inserted into the submix track as an 
audio object. 

bus are not updated in the file created while freezing. Therefore, if 
objects are moved into tracks transmitting to an AUX bus, the audio 
signal on the corresponding AUX will remain the same. 

This menu item removes the wave file created during "Track Freeze" 
and brings back the track that was saved i

Changes made in this project are applied to the track as well. 

Note: If tracks were added in the reference project (the project 
created while freezing), "Track Unfreeze" is not possible. 
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The next (lower) or previous (upper) track in the VIP from the view of 

Key: 

Activate previous track  Cursor up 

Activate next /previous Track 

the currently activated track is activated. With the Cursor keys you 
can conveniently scroll up or down. 

Activate next track   Cursor down 
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d ranges have 
no effect with these functions.  

roject, the range 
beginning has the same function as the play cursor. 

New Object 

It will also be the currently selected object. This is the same 
rop method explained earlier in this 

chapter.  

 

ts remain in their positions. The previous 
contents of the VirtClip are replaced with the cut object. 

Copy Objects 
To place a copy of the currently selected object into the VirtClip 
select this option. The contents of the VirtClip can then be inserted 
into the project using the “Insert Objects” option (see below). The 
previous contents of the VirtClip are replaced. 

Object menu 

Contrary to the menu Edit all functions in this menu exclusively 
manipulate selected objects in virtual projects. Selecte

Ranges are used to determine insertion points or cut positions of 
objects. When inserting material into a virtual p

Use this function to create a virtual object. The current range in the 
Wave project will be inserted into the virtual project at the play cursor 
position.  

procedure as the drag & d

New Synth Object 

Please read the Synth Onject chapter! 

Cut objects

Cut Objects 
The currently selected object is replaced with empty space and 
copied to the VirtClip. The length of the current project remains and 
all other non-selected objec

Insert Objects 
Objects in the VirtClip can be inserted in the project at the current 
play cursor position. The other objects in the project maintain their 
positions. Please note that the newly inserted object might cover 
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The selected objects are deleted from the current project. The length 

Keys:  Ctrl + Del 

 Edit->Extract works similar. However, 
the Edit menu function requires a previously selected range! 

l object is overlaid with the copied 
object. The duplicate object can easily be shifted to a desired 

This option does not make use of the VirtClip, so all contents of the 

te and drag the copy 
to a new position in the project. 

se the drag & drop functionality for the Object 
or Universal Mouse Mode: 

 them in 
sequence. Another dialog is displayed, which allows you to determine 
how many copies of the selected objects are to be duplicated, the 

ce and the overall length of the duplication. 

portions of the already existing objects. 

Delete Objects 

of the current project however remains the same. Previously 
unselected objects keep their positions. The contents of the VirtClip 
remain unchanged. 

Extract Objects 
All objects not currently selected are deleted.  

Please note that the function

Duplicate Objects 
All selected objects are duplicated and pasted to the same position 
as the original objects. The origina

position by using the mouse. If several objects have been selected 
before the duplication, press the shift key before shifting to ensure 
that all objects remain in selected status and are shifted together. 

VirtClip remain unchanged. 

This function is also available using your mouse. Press and hold the 
Ctrl-key, click on the object you want to duplica

Another option is to u

If multiple objects are selected, press the Ctrl key and drag the 
selected objects to the new position. This allows you to duplicate the 
selected objects easily and without using the VirtClip. 

Duplicate Objects multiple 
This function duplicates multiple objects and places

separating distan

This is also another way of building Loop-Objects! 
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ked, all created objects are 
grouped together. 

Delta Time: This determines the relative position of each created 

cted object. At 
the default setting the duplicated objects line up without a gap 

ve, the duration can be specified, which are 
the combination of time difference and the number of duplicated 

This function splits or separates selected objects so that individual 

dent objects. 

d at the current marker position, which results in two 
independent objects. 

Split Objects 

This function splits or separates selected objects so that individual 
object sections can be further manipulated. All selected objects are 
separated at the current play cursor position, which results in two 
independent objects. 

If a range is selected, the cut occurs on both range borders. It is not 
necessary to select objects prior to choosing the range and calling 
the Split Objects function. If an underlying object is separated, the 
newly created object covers the original underlying object. 

Keys:  T 

The following parameters are available: 

Number of Objects: Determines the number of objects that are 
created. 

Group created Objects: When chec

object to the next (from the beginning of one object to the beginning 
of the next). The default setting is the length of the sele

between them, this creates a seamless loop. 

Duration: As an alternati

objects. 

Split Objects on Marker position 

object sections can be further manipulated. All selected objects are 
separated at the current marker position, which results in two 
indepen

Split Objects on Marker position 
This function splits or separates selected objects so that individual 
object sections can be further manipulated. All selected objects are 
separate
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The selected range needs to be located within the 
confinements of the object you want to trim. 

Keys:  Ctrl + T 

Group objects 

Builds a new object from the ones selected. Here, trackbouncing is 
used. 

Lock objects 

Lock Objects 
To protect objects from unintended shifting use this option. First, 
select the objects you want to “lock” in place and activate the lock 
function. A diagonal line is placed across the locked object. 

Unlock objects 

Disable Length changes: The length handles are disabled. 

Move Object 

Trim Objects 

This function trims the object borders to the currently selected range 
borders. 

In the Options menu you can specify the functions you want to lock. 

Here an object can be unlocked, which lets it be moved again. All 
selected objects will be unlocked 

Lock Definitions 
Here you can select, which options should be disabled: 

Disable Moving: Disables moving of objects (default). This is useful in 
multi-track projects to avoid delays between several tracks. 

Disable Volume changes: The volume handles are disabled. 

Disable Fade In/Out: The fade handles are disabled. 

This menu contains functions for moving the objects themselves and 
also for moving the wave project within the object and there are also 
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lves in the menu and can be changed 
with the “Keyboard shortcuts and menu editing” function. 

In the picture shown here the menu contains the standard settings for 

This moves the selected object to the actual playcursor position. 

This moves the selected object to the original position where the 

The current object position is used to reset the Original Position 

Mute objects 

With this function, a loop can be defined within an object. An area, 
which indicates the loop length, must be selected in the object first.  

The object then becomes the loop object. That means that the 

other functions for moving a cross-wire between two objects and for 
changing the object loudness..  

This menu mainly exists for issuing keyboard commands that can be 
seen next to the entries themse

the keyboard commands. 

Commands for moving objects can also be found in the lower toolbar 
(range bar). 

Object to Playcursor Position 

Object to Original Time Position 

material was originally recorded. This is often helpful if an object was 
accidentally moved. 

Set New Original Time Position 

attribute for the object. This is also used in the Take Manager. 

The selected objects will be muted. 

Build Loop Object 

number of loops can simply be “raised” with the “length handlers” at 
the bottom of the object.  
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enerated loop objects are ideal for generating long drum 
sequences from only one drum loop! Loop objects also help to save 

f the object’s beginning, the hot spot is 
now used when the object is snapped to the grid. Stroked vertical 
lines illustrate hot spots. Hot spots may stand outside an object (in 
front of or behind the object). This function is very useful for a case 
where the portion of an object to be synchronized does not line up 
with it’s beginning.  

Select Objects 

cts > Switch Selection 

 objects are grouped together. All operations are applied 

Such g

memory, since in the VIP only one object is handled rather than 
multiple objects or copies of the same material or very long samples! 

Hotspot 

The current play cursor position is turned into a reference point for 
the snap function. Instead o

To select all objects located partially or entirely in the selected range, 
or at the current play cursor position.  

Select Obje

To select all objects located partially or entirely in the selected range, 
or at the current play cursor position. 

Group Objects 

All selected
to the whole group.  

Ungroup Objects 

Selected objects are ungrouped. Individual objects are available for 
processing after that. 

Object color/name 

Object Foreground Color 
After selecting the desired color, all selected objects in the project will 
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Object Background Color 
The background color selected in the color grid is applied to all 
objects. 

Object Name 
The selected new name is applied to all selected objects. 

Object Editor 

 

The Object Effect Window 
FX Inserts 

These effects are assigned to each audio object in real-time.  

In the Volumen/Pan section you edit panorama and volume-specific 

The AudioStudio FX Inserts supports the following high-end audio 
effects:  

• Clean FX (Denoiser, Dehisser) 
• Sound FX  
• Vocoder (also contains a real-time freehand correction filter to filter 

out dissonant frequencies  
• FFT-EQ with SoundCloner 

settings.  

With the on keys you can switch plug-ins on or off.  

Plug-ins 
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ery effective dialog for plug-in 
processing. With one click on an effect slot a menu opens in which 

The practical "On" button makes it possible to switch the plug-ins on 
and off in a flash for comparison purposes. The "Edit" key makes it 

ted plug-ins and their settings. More 
detailed information can be found in the section on "Plug-ins". 

The Position/Fades Window 
Length and End of an object numerically in a number of formats. 

For all entry fields regarding duration, you can select a duration 
length from a list on the right. 

Position/Length  

Object Start/End: Numerical entry field in the VIP  

Object Length: Numerical object length. 

How to move an object in increments: Here the increments for 
shifting the object is numerically edited. The object is then shifted 
according to the selected increment when you press the arrow key 
behind the input field.  

The Pitchshifting/Timestretching Window 
n of an object can be changed independently at the 

same time. In this window you can adjust pitchshifting and 

itchshifting in the "effects" section.  

Timestretching and pitchshifting can be employed independently of 
each other (except when resampling). 

Timestretching (change of speed): speed re-alignment can be 

The plug-in section offers you a v

you can select DirectX and VST plug-ins. This menu also contains an 
entry for the effects from the "Vintage Effects Suite". 

possible to configure the selec

Wave Start: Shifts the wave content within the object. 

Wave Project: Allows you to exchange wave projects and objects. 

Pitch and duratio

timestretching parameters for the selected object. For more details (in 
particular regarding the modes used) please read Resampling / 
Timestretching / P

Pitchshifting: pitch re-alignment can be entered either as a factor 
relative to the initial value or absolutely in semi-tones and 
percentages.   
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 This is read either 
directly from the wave project, from the Loop length, or determine 

entered either as a factor relative to the initial value or absolutely as a 
new object length. You can also enter a completely new tempo so 
long as the original speed of the object is entered.

automatically by stretching a range over the object. 

Note: One of most frequent applications of the object editor is the 
organization of your own CDs. Each song can be a separate object. 
This creates an extremely flexible working environment that is fast 
and efficient. 

Object Manager 

In the object manager all objects used in a VIP are indicated in 
 appearance. With this option the object 

manager features a function which is often offered in other programs 
sequence of their temporal

with 'Play Lists'. 

 

In the object manager objects can be selected, which are also 
activated in the VIP. If you press play, a range over the selected 

Particularly productive in the object manager is the search function : 

object is applied. Small objects can be identified and manipulated 
easily.  

Ctrl + a mouse click will select several objects; Shift + a mouse click 
will select all objects between two selects (like in the Windows 
Explorer). 
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 than 
just the graphical representation of the objects. For example you 

 all 
objects that contain the name 'Intro'. You simply enter the search 
criteria in the text field and click on 'Search'. All found objects will be 

 available for further processing. 

Opens the wave project (contains audio files) belonging to an object 
and displays it in the wave window. 

the part of the audio data which 

ffline) editing In the wave window. 

Cut g (Edit 
men

D st

Please note that the cut and copy processes, fades, crossfades, etc. 

Almost every effect can be used on objects directly in the virtual 
. 

k in single-track virtual projects 
even if you only want to edit WAV files in Samplitude Music Studio 

You can look for certain objects with it in full text mode rather

could look for all HD Wave projects with the name 'XYZ.HDP' or

selected and are

Take Manager 

The description can be found in the "Tools" menu. 

Wave Editing 

The range corresponds precisely to 
the object accesses. 

You can carry out destructive (o

and copy functions are available for destructive editin
u) as well as complex effects (Effects menu). 

e ructive editing is not necessarily a recommended method. 

If you have duplicated objects, i.e. several objects are using the same 
audio data, all these objects will have changed once you have 
changed the wave project. 

can be performed much more elegantly and more quickly as non-
destructive virtual projects. 

project

Please also note that it is better to wor

14. You can quickly and conveniently perform all editing operations 
here. If you have to use longer WAV files, for instance, you have to 
wait after each editing sequence until the audio data has been copied 
to the hard drive. However, you can work considerably faster if you 
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use virtual projects. 

With the Trackbouncing function (Tools menu) you can create a new 
WAV file from the virtual project. 
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easily save, burn and reopen ranges and marker positions 
via the function and number keys. 

Range all 

The range will cover the complete sample. This command comes in 
handy if you want to apply changes to the entire sample with 
functions that normally only address certain ranges. 

Keys:  A 

Move play cursor 

This submenu command sets the start position of the play cursor 
(position line) to the following position of the project: 

To start Home 
To end End 
to Start of Section Ctrl + Home 
to End of Section Ctrl + End 

croll mode Alt+Cursor left 
Right move in page mode Cursor right 

Object edge left Ctrl+Q 

Track marker left F2 

In this submenu you will find options and keyboard shortcuts for 
adjusting the play and edit range in the VIP. 

Range start to left/right 
Moves the start of the range to the left (right) 

Range menu 

This menu contains many functions for managing selected ranges. 
You can 

Move left in side mode Cursor left 
Left move in s

Right move in scroll mode Alt+Cursor right 

Object edge right Ctrl+W 

Track marker right F3 

 

Edit Range 
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 Alt + NumPad * (right) 

e 

Right:  Alt + NumPad "+" 

(or Shift + Arrow right) 

e extended toward to the beginning 
of the project. 

 to end 

Keys: Shift + End 

t by the length of the range. Its end will 
be its former beginning. If there is not enough room to place the 

Flip Range right 
gth of the range. Its 

beginning will be its former end. Keep in mind that if there is not 
xecuted. 

Keys: Ctrl + Shift +right 

Beginning of Range -> 0 
This function shifts the beginning of range to the right of the next zero 
position. 

Shortcut: Alt + NumPad / (left) 

  

Move range end to left/right 
Moves the end of the rang

Keyboard shortcut:  

Left:  Alt + "-" (NumPad) 

   or Shift + Arrow left 

   

Range to beginning 
The beginning of the range will b

Keys: Shift + Home 

Range
The end of the range will be extended toward the end of the project. 

Flip Range left 
The current range is shifted lef

range, the command will not be executed. 

Keys:  Ctrl + Shift +left 

The current range is shifted right by the len

enough room to place the range, the command will not be e
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This function shifts the beginning of the range to the left of the next 
zero position. 

Keys:  Shift + Page Up 

End of Range -> 0 
This function shifts the end of the range to the right of the next zero 
position (change in polarity). “Zero position” is the next sample value 
with zero value or the boundary between a positive and a negative 
sample value (or vice versa). This is particular useful for searching for 
loop points. 

Keys:  Ctrl + Page Down 

e end of the range to the left of the next zero 

- 0 

 left marker 

rt to the next marker on the left, i.e. the range will 

Keys:  Page Up 

Beginning of Range <- 0 

End of Range <- 0 
This function shifts th
position. 

Taste:  Shift + PageDown 

0 -> Range <
This function shifts the beginning of the range to the left  and the end 
of the range to the right of the next zero position.  

Taste:  Shift + PageDown 

Set range start to
Moves the range start to the next marker on the left, i.e. the range will 
be expanded. 

Keyboard shortcut: Shift + F2 

Start of range to left object edge 
Moves the range start to the next marker on the left, i.e. the range will 
be extended up to the end of the next object on the left. 

Set range start to right marker 
Moves the range sta
be extended. 

Shortcut:  Shift + F3 
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range will be extended up to next object on the right. 

nd lets you set the range length to 1, 2, 4, 8, and 16 

The upper section displays the whole sample. The section located at 
ys the data near the beginning of the range. The 

section at the bottom right displays the data near the end of the 

 lower 
on will display the location of the entire 

range. You can also define ranges across several sections. 

In order to revert splitting the display setting has to be changed to a 
View > Sections > 1" or "Shift + B). 

Key: B 

Deactivate: Shift+B 

The upper section displays the whole sample. The section located at 

Set the end of the range to the right object edge 
Moves the end of the range to the next marker on the left, i.e. the

Range length 

This comma
bars. You can set the tempo in BPM with menu View->Snap Setup. 

This command lets you set the range length to 1, 2, 4, 8, and 16 
bars. You can set the tempo in BPM with menu View->Snap Setup. 

Split Range 

This function is in particular useful for working with loops. If not 
already displaying in Split Range Mode the project is first switched to 
this mode displaying three sections on the screen. 

the bottom left displa

range. 

The boundaries of the range can be exactly positioned in the
sections, while the upper secti

section again ("Menu 

Split Range for Video 

This function is in particular useful for working with AVI Videos.  

the bottom left displays the data near the beginning of the range. The 
section at the bottom right displays the data near the end of the 
range. 
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The boundaries of the range can be exactly positioned in the lower 
pper section will display the location of the entire 

range. You can also define ranges across several sections. 

display with Shift + b or View->Sections->1. 

Another powerful feature of Samplitude Music Studio 14 is the option 
ving different ranges for future retrieval. An 

unlimited number of ranges can be defined. You can for example 
nd compare them while you recall their 

litude Music Studio 14 even lets you choose a range while 
playing. The specified range becomes the current one and is audible. 

Get Range Length 

B
defined ranges as the current range. 

Both lower sections are zoomed down to single frame accuracy. 

sections, while the u

To undo the split, the display has to be returned to a 1 section 

Store Range 

of defining and sa

specify different loops a
ranges.  

All ranges of a project can be seen in menu Tools->Range Manager. 
There all ranges can be renamed or played. 

When selecting this menu option, the selected range needs to be 
stored by entering a numerical value the range is associated with. 

Keys:  Shift + F2 ... F10 

Get Range 

By selecting this option, you can choose one of the defined ranges as 
the current range. 

Samp

Using this method, you can change between two ranges comparing 
them with each other. Ranges can also be named and recalled with 
the Range Manager (Tools menu). 

Keys:  F2 ... F10 

y selecting this option you can choose the length of one of the 
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Ke

You can store an unlimited number of markers wherever the play 

SHIFT + 1 ... 0 

 start position. You should keep in mind that, 
whenever a marker has been defined, the range between the marker 
and the end of the sample is played. 

ys:  Ctrl + Shift + F2 ... F10 

Save markers 

cursor is placed at. This lets you set markers. 

Keys: 

Get Marker 

The new start position of the play cursor (position line) is set to the 
saved position of the corresponding marker number. Playback starts 
at the jumped-to new

Keys:  1 ...9, 0 (via the Alpha keyboard) 

Markers on Range Borders 

This function sets two markers to the beginning (S) and the end (E) of 

This is very useful to select the regions of sample CDs etc. 

 minimum length in ms of a ”silent” area.  

Starting number: The markers will start to count from the number 

a selected range. 

Set Markers on Silence 

This function sets markers on silent regions in the sample (only in 
Wave projects - HDP or RAP). You can choose the minimal length of 
the pause, a threshold level, the start number and a prefix for the 
marker name. 

Min. Time (ms): This is the

Threshold (dB): This is the maximum volume of a ”silent” area. The 
level of the area in the project will be set on the level of the threshold 
in the graphic display!   
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you type in this dialogue box. 

Prefix: This allows you to insert additional symbols (letters would be 

Delete marker 

All markers of the project will be deleted. 

stance, if the 
adjacent marker was accidentally deleted with a mouse-click. 

appropriate), which will be placed in front of the marker-numbers. By 
doing this, you will able to distinguish between new and older 
markers.  

The selected marker will be deleted. 

Delete all markers 

Recall last range 

Get the last selected range. This makes sense, for in

Range Editor 

Here you can change the start and end position of the selected range 
numerically in different measurements. 

 

Change values in the Range Start section:  

nge Length section:  

The end will be maintained. 
Change values in the Range End section:  
The start will be maintained. 
Change values in the Ra
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The start will be maintained. 

Please note the format of the “Bar” dialog box. The format is 

ghlights the current range. 

By selecting a range name, the corresponding range in the project is 
selected/activated. 

In the lower line you can enter/modify the range name. Furthermore 
you can delete ranges and save new ranges in the Range Manager. 

With the "Play once" button you can play the selected range once, 
"Play loop" activates looped playback. This makes the Range 
Manager particularly useful as a jingle player. 

Edit time display 

Here you can numerically enter various parameters of the range, for 
instance range start, range length, etc. - in the currently set 
measurement unit. 

Object Lasso 

The normal way to select several objects at once would be to click on 
the free space on the right of the object in the lower area of the track
and to pull a frame around the selected objects. 

frame, without moving the object you clicked on (which would be the 

displayed as a 4/4 beat with 96 clicks per quarter. Displayed are the 
bar, beat, and clicks. 

The number of beats per minute (BPM) can be set in the BPM dialog 
box in View->Snap Setup.  

Range Manager 

In the Range Manager all saved ranges of the current project are 
displayed. 

A colored bar hi

 

Sometimes, however, there is not enough space between the 
objects. The object lasso solves this problem. 

Once activated, you can click on an object and pull up a selection 
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case in the standard mode). 

Once you selected your objects the mouse returns to the standard 
mode, that means that you will have to reactivate the object lasso 
each and every time you want to use it. 



 

Realtime effects menu 321  

 

www.magix.com

at
w
th
O ffects Menu (on page 322). 

Realtime effects menu 

This menu entry permits fast access to the relevant real-time effects 
 Object level. Correspondingly, menu entries are provided here 
hich can be controlled via the Object Editor. For more details on 
ese effects please read the relevant articles in the chapter entitled 
ffline E
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ts menu 

In this menu you'll find many high quality audio effects, to get the 
 modern music production on your 

recordings. 

he complete audio file is to be processed with 
the DSP function, the whole file needs to be selected as a range in 

sed with their complete 
content, no matter which range is selected in the Wave project. (An 

 the Auto-Crossfade-Mode 
(menu Edit->Auto crossfade active) to prevent pops during the 

f 
several objects are selected in the VIP, the effect is applied to each 

ysical 
audio file(s). 

ges to the 
hard disk. 

 disk (shortcut: “S”).  
• In HD Wave projects, the changed audio material is immediately 

lete contents of 
the Clip window (shortcut: “A”). The effect can now be experimented 
with on the temporary copy of the audio material. 

the respective effects knob of a 
channel can also access the real time effects dialogs in the Mixer 

Offline effec

professional sound of a

Important tips regarding the effects functions 

• The following effects can be directly applied to VIP Objects: 
• Please note that in Wave projects most functions are only available 

for selected ranges. If t

the Wave project (also see Menu Range->Range All). 
• Selected objects in VIP projects are proces

exception is the function Get Noise Sample.) 
• If you don’t want to alter the whole object, you would first need to 

cut the object apart (select a range over the desired length and 
press the key “T”). We suggest turning on

object transitions. 
• It is even possible to apply an effect to multiple selected objects. I

individual object and its corresponding audio material in the ph

• A suggestion regarding the differences between RAM and HD Wave 
projects: With RAM Wave projects you can decide after an applied 
edit whether you want to keep the current version. Since the audio 
material is only processed in the computer memory, it is possible to 
simply close the Wave project and not saving the chan

• To keep the changes, the project would need to be saved to the 
hard

saved to the file on the hard disk. 
• You can also work with a copy of the audio material for test 

purposes. To accomplish this, copy the selected range in the Wave 
project to the clipboard (shortcut: “C”). Next, open the Clip window 
(this window is icon-ized at first) and select the comp

• Clicking the right mouse button on 

window. The corresponding effects dialog will appear, which can be 
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Amplitude/Normalize 

This function modifies the sample’s overall amplitude. The data is 

lues are weighted with the 
new factor. 

Amplitude/Normalize > Normalize 

altered so that the maximum amplitude occurring in a specified range 
is set to 100% (or any other value between 1-400%). Samplitude 
Music Studio 14 will first attempt to detect the maximum and relate it 
to the percentage chosen. Then all other va

 

The Normalize function is designed to fully modulate or over-
modulate samples. A particular application is processing that is done 
before a conversion from a higher sample resolution to a lower 
resolution takes place. Since the dynamic range of the low resolution 
is smaller, it still can be fully utilized by applying the Normalize 
function. 

If working with sounds from one single instrument, you should set the 

r 
example, you will be able to over-modulate the sample to 120% to 

As preparation for further physical processing, such as filters, reverb, 

factor to 100%. 

If, however, your audio material has background percussion fo

200%. This will only cut off the new percussion peaks. The same 
method allows you to alter the sound of natural instruments by over-
modulating them. 

dynamic compression etc., a level reduction of 50-70% is suggested. 
This should avoid clipping during post processing. 

An important reselect: If the volume level during the recording is 
relatively low and the material is later normalized, the result will not be 
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of the same quality if the recording level is maximized to its fullest 
range. If for example the volume level was only set to 50% of the 
possible range, the audio material will be in 15-bit quality. Even 
normalizing the material to 100% will not change this aspect. 

Editing mode: In virtual projects, a virtual normalization function is 
available. Sample data remain unchanged — the object volume is 
adapted in such a way that the loudest passage in the object equals 
0 dB (corresponding to 100%). This virtual normalization is non- 

you 
nt to normalize objects individually or 

t the parameters for quick 

rmalize > Loudness adaption 

 the songs uniform.   

ver, titles each with full volume 
ecause a crucial factor in the 

part of the song) and the object level has to 
be adjusted accordingly.  

destructive and extremely fast!  

Selecting several objects: If you have selected several objects, 
can decide here whether you wa
as a whole. 

Quick access: This section allows you to se
access. Instead of having to open the dialog each time you want to 
normalize, simply press the “n” key. 

Keys:  Shift + N 

Amplitude/No
This function raises the sound volume of all objects to the maximum 
level without the material over-steering. Unlike the master 
normalization function, each object is normalized separately. It serves 
the purpose of reconciling finished songs (each as one object) in 
volume. This makes the volume of

All according to the producer, howe
control can still sound different b
perception of sound volume is also the relationship between the soft 
and the loud parts of a piece of music. The average loudness (RMS) 
of the song therefore has to be identified in addition to the absolute 
level (which is the loudest 

It can thus perfectly well happen that songs with high peak values but 
a lower level of loudness are normalized onto a value above 0dB (full 
volume). In order to avoid over-steering nevertheless, the Limiter (see 
MultiMax) is therefore activated automatically.(see MultiMax). 

Tip: Volume fluctuations within a song can be removed with the 
“Leveler” presets in MultiMAX. 
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This function allows sample ranges to be faded in or out. The 

 of the range. When the function 
has been called, a window appears in which you can specific 

A simple fade-in operation would be performed with the parameters 

 Of course you can also try other values and thus 
achieve interesting results. The transitions can be created with 

However, please note that high-performance realtime fade and 

de routines. 

Amplitude/Normalize > Fade in/out 

amplitude is varied in its time characteristic from the start value of the 
beginning to the final value at the end

parameters for this operation. 

from 0% to 100%, whereas normal fade-out requires the specification 
from 100% to 0%.

different curve types - from logarithmic to exponential. 

crossfade options exist in virtual projects, which normally eliminate 
the requirement of using destructive fa

Key:  F 

Amplitude/Normalize > Set Zero 
Sample data values in a selected range are set to zero. Noise and 
imperfections in a sample can thus be eliminated. Diese Funktion ist 
reversibel. 

is function you can switch left and right stereo channel.  

This is useful to correct recordings with switched channels.This 
, that is, if you don't re-select the range, 

opening it again will bring back the original material.  

Switch Channels 

With th

function can be reversed
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S

The Stereo-FX-Enhancer allows you to reposition your audio material 
in the stereo panorama. Whenever a stereo recording sounds 

tereo FX 

undifferentiated, the extension of the basic stereo-width can provide 
a more transparent sound. 

 

Basic stereo width controller: Here you can adjust the width of the 
basic stereo panorama from mono (leftmost side), over unchanged (in 
the centre) to maximum width (”Wide”, rightmost side). When setting 
the stereo panorama to smaller values, the sound level may rise. In 
an extreme case – it means that if the left and right channels contain 

material and the Basic stereo width controller is set to 

e 

a manner will sound hollow 
during mono playback. 

e for each channel and the stereo 
panorama. The damping for the left and the right channel will be 

 the right or to the left 
inside the stereo panorama.  

 indicator): This is a graphic display of the 
phase position of the audio signal. Here you can check the 

 If not, some frequency areas may 

Karaoke Preset: THis preset opens a special karaoke effect that 
more or less eliminates vocals during playback by deleting middle-

identical audio 
”mono” – the sound level increase can be as much as 3 dB. 

While increasing the basic stereo width (values exceeding 100) th
mono sound compatibility gets worse. This means, that recordings 
that have been manipulated in such 

Volume fader: Adjust the volum

indicated in dB values under the controllers. This allows you to 
reposition an originally centred recording to

Stereo-meter (correlation

orientation of your signal inside the stereo panorama and the effects 
caused by the Stereo-Enhancer.  

In order to achieve the best possible mono-compatibility, the graphic 
should resemble a diagonal line.
eliminate each other when the stereo signal is played back on a 
mono player. 
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range frequencies typical for the human voice when singing. This 
e singing.   

vice versa. This function, too, is reversible. The 
“Invert” function permits samples with different phases to be 

le mixing functions (which are, from a 
mathematical viewpoint, adding functions) you can actually subtract 

ted sample. 

Equalizer 

r 
Volume”-controllers in the main menu. 

allows someone else to take over th

Invert Phase 

The sample data within the selected range is inverted along the 
amplitude axis. This phase inversion means that negative values 
become positive and 

matched. Along with the availab

samples by applying this function to the selec

The 10-band-Equalizer splits the frequency spectrum into 10 areas 
(”bands”) and provides them with separate volume faders. This offers 
a whole spectrum of impressive effects, from a simple bass boost to 
complete alienation of your sound. However, raising the levels too 
much, especially in the case of the lower frequencies, will also 
increase the general sound level, and distortions may appear. In this 
case you should lower the main sound level using the "Maste

 

Slider: Each of the 10 frequency areas can be raised or lowered 

y areas in a 
flexible way, avoiding override of isolated frequency areas that would 

ound. 

e that 
value manually, you can compare the original preset sound with the 

here no 

separately using the corresponding 10 volume sliders. 

Link Bands: This switch links the different frequenc

result in artificial s

A/B: If you chose a preset value for an effect and want to chang

new settings by pressing the A/B button.  

Reset: Resets the equalizer to it's original (neutral) settings w
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Touchscreen (right EQ section): This is the ”sensor field” of the EQ: 
draw a frequency curve using your mouse, and it will be immediately 

responding slider positions on the left side of 
the EQ. 

This audio effect allows you to draw the wildest filter effects with the 

translated into the cor

FFT Equalizer 

mouse.  

 

A red line is drawn in the graphic area with the mouse. The left side 
of the graphic represents the low tones, the right the high tones. 

Real-time replay can be switched on with the "Test" button.As of 
now, you will be able to hear all changes in the red line. A ‘hill’ in the 
left part of the graphic results in a strong increase in the bass, a ‘hill’ 
on the right side considerably increases the treble. Great effects are
frequently achieved if a filter curve is initially deleted over the entire
area (if everything in the display is set to low values). This removes 

automatically prevent an over-addressing of the audio material. The 

 
 

almost all the sound. Now, only individual frequency ranges can be 
made audible in the upper section of the display with a few clicks of 
the mouse. This rapidly turns a normal drum loop into Science Fiction 
noises! The filter curve can quickly be reset to its original condition 
with the Reset button. The option "Prevent clipping" attempts to 
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trols the volume of the material. 

Dynamics 

Th or is basically an automatic, dynamic volume 

stay loud whereas the volume of silent passages will be raised. The 

so ade of compression can 
g the Ratio-controller. The threshold is controlled by 

 can also be controlled 

"volume" control con

e Compress
controller. The dynamics of a track will be limited, loud passages will 

compression is normally useful, if you want to make your material 
und more powerful and smashing. The gr

be adjusted usin
the Threshold button and attack and release
by the corresponding buttons. 

 

The processing of the track is as "prospective" as with high-end 
professional studio equipment. This means that there are no peak 

ca

Se ensor field of the compressors can be 

ch

Ratio: This parameter controls the compression ratio. 

g levels. Short attack times can result in a ”pumping” sound, 
as the volume will be raised or lowered very quickly. 

Release: This value controls the delay in which the algorithm reacts 

ffect and then changed it 
nd settings with the new 

overrides (blasting, clipping) or other disturbances, as the algorithm 
n not be "surprised" by sudden peaks. 

nsor field: The s
manipulated intuitively, just by a movement of the mouse, which will 

ange the colour of the graphic and the effect settings.  

Threshold: Adjusts the threshold above or below the active 
compression. 

Attack: Adjusts the delay, in which the algorithm responds to 
increasin

to falling levels. 

A/B: If you chose a preset value for the e
manually, you can compare the original sou
ones pressing the A/B buttons.  

Reset: Resets the Compressor to the original values. In this state no 
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he actual settings as an 
effects file, so that you can use them for other projects. 

Multimax 

e separately for each 
band. 

s, for 
example, that a single peak level in the bass section will not drag the 

system resources are used and no effects are added to the original 
sound. 

Load/Save: This option allows you to save t

The MultiMax is a compressor with three independent frequency 
bands. The dynamic processing takes plac

The main advantage of a multi-band compressor over a ”normal” 
compressor is that warping and other bothersome side-effects are 
reduced drastically by the dynamic processing. This mean

level of the whole signal down. 

Otherwise, the multi-band technology enables precise treatment of 
individual frequency bands. 

 

Frequency Band Settings: Made directly in the graphic display. 
Simply click on the dividing lines to shift them. 

ntains a limiter that harmonizes levels so 

by using the presets in 

high compression will result in audible noise 
(usually defined as a pumping sound). Particularly radio recordings 

Bass/Mid/High: Regulates the degree of compression for each 
frequency band.  

Limiter: The MultiMax co
that, for example, too high a level is automatically reduced, and quiet 
passages remain unaffected. 

Presets 
Two further special functions can be called up 
MultiMAX. 

Dynamic expander: Too 
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 and loudest part). The Expander 
enhances the dynamics of the recording. 

layer is 
available. Cassettes recorded with Dolby B or C sound more muffled 

Noise Gate: This Cleaning function suppressed noise entirely below a 

ee. 

ntrol handle is made void. Larger 
volume differences can therefore be adapted within a song. To 

 between different songs, also use the 

De-Esser: These special presets remove overemphasized “s” sounds 
alpresets dienen zur Entfernung von 

überbetonten Zischlauten in Sprachaufnahmen. 

are recorded with very high compression rates to increase the 
perceived volume. Unfortunately compression reduces the dynamics 
(interval between the quietest

Cassette NR-B decoder: Samplitude Music Studio 14 simulates 
decoding of Dolby B + C noise suppression if no Dolby p

and slurry if played back without corresponding Dolby. 

certain noise level. This lets you create, for example, song transitions 
that are entirely noise-fr

Leveler: This function brings the entire material up to a uniform 
volume automatically. The volume co

balance volume differences
function “Volume adjustment” function in the effects menu. 

in speech recordings. ezi

Tip: The limiter can also be used independently of the MultiMax. 

D

dy who records audio has 
encountered this one before. The perfect live recording contains 

eclipping 

Samplitude Music Studio 14 contains a one of a kind function to 
remove digital or analog clipping. Anybo

clipping at the most important moment. This alone may render the 
recording unusable! 

 

Samplitude Music Studio 14 uses high-grade algorithms to 
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ontaining the clipping. The algorithm uses 
the material before and behind the clipping as a reference point. 

al that contains 
obvious clipping, such as a piano or voice recording. Distorted 

 protection mechanism so that the level 
never reaches the digital maximum signal. In these cases a setting of 

e improved with the algorithm. 

Remove DC offset 

interpolate the passages c

Once processed, the total volume level for the material can be 
reduced to prevent further clipping. 

The declipping algorithm is especially useful for materi

drumbeats are normally not salvageable 

Minimal Level of Clipped Samples 

This setting determines the volume level the algorithm considers 
offending material. There are sound cards that exhibit different 
clipping behavior and this setting becomes an important issue. Some 
DAT recorders have an analog

–0.5 dB or lower make most sense. 

By entering a value of –6 dB all samples above half of the digital 
maximum are considered ‘distorted’ and are recalibrated. Even 
analog distorted material can b

 

This function in menu “Effects” removes a DC offset in the selected 
range of a Wave project (RAP or HDP). Some sound cards produce 
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such a DC offset while recording, so it is useful, if you can remove it! 

Dehisser 

The Dehisser was especially designed to eliminate the band noise, 
which is all so typical for analogue tape recordings, micro-preamps or 
AD-transducers. 
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Noise Level: Here you will have to determine as exactly as possible 

 excessive value will result in a dull 
sound as part of the band noise and part of the original audio signal 

ding is low, you should experience no 
problems while adjusting it.  

n allows you to adjust the damping of the 
band noise in decibel units. In many occasions it is the best solution, 

Removed Hiss: This option allows you to listen to the music that 

the noise level at which the Dehisser starts to work. If you choose a 
level that is not high enough, the band noise will not be completely 
eliminated. In such a case you will notice tweeting sounds (the so 
called "melodic band noise”). An

recording will be eliminated by the Dehisser as well (for example: air 
intake sounds of brass instruments) (see Artifacts) 

If the noise level on your recor

Noise Reduction: this optio

not to eliminate the noise completely, but to damp it only -3 - -6 dB, 
hence maintaining the natural sound of the original material.  

would be filtered away by the Dehisser. 
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Amp Simulation 

The 
simu rties. It is especially suitable for 

Amp simulator is a newly-developed real-time effect that 
lates tube amp sound prope

guitar sounds, but also for the organ or recordings of vocals. 

 

Amp Model: Here you can select from a range of amplifiers whose 
sound can be simulated. 

EQ-Section: A 3 band equalizer for setting the bass, mid-tones and 
treble. 

Bright: The Bright button is for a particularly sharp sound display, 
that can be jarring when used with the following automatic 
controllers:  

Distortion: Creates distortion in typical analog amplifier fashion. 

Volume: Controls the entire volume of the amplifier module. 

Vocoder 

The principle of the Vocoder is as follows: Carrier material (e.g. a 
surface sound or a synth chord) is affected by a modulator (e.g. 
language or singing) so that one gets the impression that it is 
speaking or singing. Rhythmic surface sounds can also be developed 
if modulated with a drum loop.  

This is done via the transmission of the frequency characteristics of 
the modulator (speech) on the carrier (chord).  

Speaker Model: Here you can select from a range of speakers whose 
sound can be simulated. 
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Carrier Input 
ve the desired carrier sample. Some special 

carrier samples that have been loaded automatically from the 
listed. 

Here you ha  to select 

"Vocoder" directory are 

 

www.magix.com

 number of samples of the current projec
You can use the "Carrier Sample" checkbox to load any 

t or predefined carrier 
sample. 

 Here yo an play theu c  carrier on its own for test purposes. 

ts you add noise to the carrier sample. This 
er material can not be modulated sufficiently 

 

Dynam: Influences the dynamics of the modulator signal to reduce 
coder. 

speed at which the Vocoder adjusts to the 
modulator spectrum. The greater the value, the "lazier" the Vocoder 

e sound changes in the 

Noise: This controller le
makes sense if the carri
or is irregular. It's good for "filling" drum loops with too many pauses 
between the beats. 

Material containing all frequencies in equal amounts are particularly 
suitable, such as strings, orchestra chords, broad synthesizer pads, 
hissing or wind noise.

Filter 

the modulation depth of the vo

This prevents two often undesired side-effects of modulation: On the 
one hand the volume change of the modulator signal is added to the 
output signal in a slightly more moderate form which may improve the 
power of the vocoder voice. On the other hand the low-level share of 
the modulator signal is ignored in order to prevent modulation of the 
carrier by breathing or noise. 

Smooth: Affects the 

follows the modulator and the "smoother" th
carrier sound.  

Filter graphic 
Exactly as with the freely drawable filter, here any frequency 
characteristic can be drawn in to optimize the results of the Vocoder. 
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ies can be eliminated as 
the curve is corrected downwards to the left. Likewise, weak heights 

to the right. 

Mixer 
xer you can also mix parts of the carrier and modulator 

signal to the vocoder output signal (Out).  

If the output signal of a track is used as a carrier in the vocoder, this 
track will first be muted. In the vocoder mixer you can then make it 

In the "Preset" list window you can select predefined vocoder 
settings. The disk system is used to all custom presets. The presets 

e selected carrier signal. Reset 
restores the vocoder default settings. 

Room Simulation 

add a high-quality room simulator to the audio 
material. 

For example, simple disturbing bass frequenc

can be strengthened as the curve is raised 

In the Mi

audible again. 

Presets 

all contain vocoder settings, except th

This function lets you 

 

Reverb type: Here you can choose between a short, medium and 
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 reverb 
section is calculated and then played so that you get an impresion of 

Reverb share: Here you can set the balance between 

the original signal (without reverb) and the actual reverb. 

Volume: Here you can adjust the master volume. 

Test: This button activates the preview function. A short

the settings. 

Echo/Reverb 

 

The reverb effect device offers newly developed and very realistic 
reverb algorithms to add more room depth to your recording. 

Reverb supplies a high-quality reverberation which can be defined 

Room size: This control button controls a room simulator which 

trol is turned completely to the left, it sounds as if the audio 
object has been recorded in a tiny room, turned completely to the 

Time: Here the length of the ‘reverb trail’ is determined, i.e. the fading 

Colour: Here it is possible to control the type of reverb – rather dull 

ines the mixing ratio between the unedited 
original sound (‘dry’ signal) and the reverb portion (‘wet’ signal).  

Echo 

Reverb 

more closely with ‘room size’, ‘time’ and ‘colour’ and mixed into the 
original sound with ‘mix’. 

calculates the reverb effect in dependency on the room size. If the 
con

right, one can listen to the object as if it had been recorded in a 
cathedral.  

phase of the sound. 

than high-pitched or vice versa.  

Mix: This control determ

The echo effect is defined more closely with ‘delay’ and ‘feedback’ 
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Delay: Here the period of time between the individual echos can be 

Feedback: Here the number of echos can be adjusted. Turned 

etitions 

rechting/Resampling/Pitchshifting-Editor. 

determined; the more you turn the control to the left, the faster will 
the echos follow each other.  

completely to the left, there is no echo at all, turned completely to the 
right there are virtually endless rep

Resample / Time stretching 

Opens the Timest

Note: If you only want to change the sample rate of an audio file, use 
the Adjust sample rate option from the Effects Menu. 

 

All algorithms in this dialog use the time factor parameter and pitch 
as input parameter.  

The time factor calculation (from the original length/original speed and 
the length required / speed required) can be comfortably activated on
the right side of the dialog. 

M Synthesizers transpose samples during this 
procedure. Time factor and pitch are dependent upon each other: the 

 

Resampling 
Samplers and PC

shorter the audio material, the more higher the pitch. The effect is 
comparable with changing the playing speed of record players or 
tape recorders.  
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retching/Pitchshifting procedures. If pitch change is justified by 
changing the speed (and vice versa), use this algorithm. 

ling, very small 
aliasing effects may occur. the anti- aliasing filter helps in this regard. 

ked mode, thereby, 
keeping the room effect of stereo signals. For drum loops or other 

Smoothed 

bout strong artifacts. The 
material is "smoothed", which makes the sound softer and emits it at 

re complex spectra (sound mixes from various 
instruments or finished mixes). This algorithm is not very well-suited 

Recommended for: 

• Speech with background noise like, for example, video sound 

The effect is relatively loss-free, the sound loss is smaller than with all 
Timest

When lengthening the audio material by resamp

Alternatively, since this filter requires additional CPU load, it can be 
activated for the computation and the real-time preview. The filter is 
also available for the other algorithms that use resampling internally 
when pitchshifting.  

Default 
An algorithm is used that usually delivers very good results with 
factors from 0.9 to 1.1, that works in phase-loc

"beat heavy" material, this algorithm is only partially suitable as it can 
change the groove and, in rare cases, can fade out or double beats. 

Time compression (sample length is reduced) is more successful with 
this algorithm than timestretching, i.e. it is better to reduce the longer 
sample than vice versa when adjusting two samples to another. 

Here a considerably more complex algorithm is used which requires 
more processing time. The material can now also be used on very 
large factors (0.2...50) without bringing a

an adjusted phase level. This smoothing is hardly audible, for 
example, with speech, singing or solo instrumentation. Problems may 
arise with mo

for drum loops and other material with strong transients. The groove 
remains intact, but because of phase shifting the attacks are slurred. 
With small corrections (factor ca. 0.9 – 1.1) the setting of the smallest 
possible smoothing value should be used.   

• Orchestra instruments: String instruments, wind instruments... 
• Speech, single voice and multi-voice song 

• Synthesizer areas, guitars... 

Not suited for: 

• Stereo mix 
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 be used on other material like monophonic bass runs or 
sequencer lines. The algorithm splits the material into individual 

These "snippets" are then compiled into the new temporal measure: 

, it should be used because, in this case, 
the time change occurs without any loss of quality at low CPU strain. 

• Samples which can be split into individual notes or beats 

Definitely not suited for: 

at markers do not exist, the algorithm fails 
completely and silence is the result. 

Beat marker stretching 

 not occur. Unlike the "Beat marker 
based slicing" algorithm, this algorithm doesn't fail fully when there 

her very 
closely (<1000 samples). 

• Drum loops, percussion 

CPU strain: very high 

Beat marker slicing 
This mode is centered especially around customizing drum loops, but 
can also

components, individual notes, or beats, which are then selected via 
the beat marker. 

If the tempo is increased, individual beats begin overlapping, if it is 
slowed down, short pauses between the beat become audible. 

If this algorithm can be used

Recommended for: 

• Drum loops, if the beats do not overlap and there is not much reverb 

• Everything else where be

CPU strain: minimal 

This algorithm works similar to the standard algorithm. Unlike the 
previous algorithm, this one synchronizes the stretched material with 
the beat markers. This way the groove remains perfectly intact and 
doubled or faded out beats do

are no markers or wrongly placed markers, but rather, the 
synchronization quality is reduced or has errors. In practice, 
automatic marker generation is usually enough for good results. You 
should avoid having beat markers which follow one anot

Monophone voice 
This is a special time-stretching and pitch-shifting function for vocal 
solos, speech or solo instruments. The material must not contain 
background noise, and excessive reverb may also be detrimental to 
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realistic background choirs can be "composed" from 
just one solo voice. The formants, however, can be shifted by +- 12 

itch should be cut 
out as an object, so that it can be manipulated independently of the 

d moved 
down. If the pitch is now changed, the second voice has been 

xample, to make a 
grandfather voice. 

Recommended for: Speech, single voice vocals, single voice 
 low reverb and low background 

noise. 

Change Sample Rate 

hole audio file. This 
may be needed to convert a DAT recording at 48 kHz to 44.1 kHz for 

the use of this method. With suitable material the audio quality is very 
high. 

With the "Use formant correction" option the formants remain the 
same when pitchshifting, that is, the "Mickey Mouse effect" does not 
occur. This way, 

half tones. Here, vocal distortions can be achieved.  

Typical usage of this algorithm: 

• Intonation correction (the note with the imprecise p

other notes). 
• Harmonizer effects: An object with vocals can be copied an

changed, etc.  
• Generating background vocals from existing vocal samples 
• Timestretch/Distortion of a speech sample, for e

instruments without overlapping, with

Use this function to change the sample rate of a w

use on an audio CD. 

 

After choosing the new sample rate you can select a filename for the 
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creased the sample rate change will take place 
without any quality loss – the sample material will not experience 

rtones or high frequencies may be 
lost during the sample rate change. For example, if the resolution of a 

response is always half of the resolution specified. For a conversion 

s frequently rumoured to be in 

This function utilizes a complex algorithm for optimizing loops in 
Wave projects. It is useful when samples are to be used for 

new project. 

If the resolution is in

fidelity reductions. (The needed hard disk space will increase though.) 

If the resolution is reduced, the ove

44.1 kHz sample is reduced to 22.05 kHz, the frequency response of 
the resulting sample is reduced to 11.025 kHz. The frequency 

from a 48 kHz sample to 44.1 kHz, this loss in quality is not 
significant, since the human ear only recognizes frequencies up to 20 
kHz. (A resolution of 48 kHz is often only used because the digital to 
analog conversion can take place with much higher precision without 
expensing a lot of effort.) 

Please note that resampling to 44.1 kHz can also be done while 
recording in real-time. 

The Playback Parameter window (Shortcut: p) contains a Vari-speed 
option for real-time resampling during playback. The Record window 
(Shortcut: r) lets you resample to 44.1 kHz in real-time from any of 
the selected sampling rates. 

Reverse 

The sample data in the selected range is reversed along the time axis 
ie the file will now play backwards with the end now placed at the 
beginning. This allows for very interesting effects, not to mention the 
‘backwards masking’ hidden message
various songs.... 

This function is reversible: if you do not select a new range, calling 
this function once more leads to the original material. 

The option is only available when working in Destructive Editing mode 
ie directly on an HD Wave file. 

Build Physical Loop 
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s as well as wave table synthesizer. 

Before you can process a sample you need to select a range in your 
dy defines the rough edges of the sample loop. 

 during playback to 
find the best loop position. A comfortable way to look at the loop 

the split range mode by pressing “b”. The 

ption-free loop the outer limits of the range will be 

op will be used for the 
crossfade. This offers you a feature found in professional hardware 

DirectX Plug-Ins 

instrumental sound

sample that alrea
Remember that you can shift and vary a range

positions is by activating 
sample will be displayed in 3 sections. 

To gain an interru
set to zero. By applying a crossfade to the material at the loop end 
containing the sample data in front of the loop beginning, Samplitude 
Music Studio 14 will create a ‘smooth’ transition between loop-end 
and loop beginning. 

When a marker is set in front of the selected range, the range 
between the marker and the beginning of the lo

samplers. To achieve a short crossfade set the marker close to the 
loop beginning. To receive a long crossfade position the marker 
further away from the loop beginning. 

Notice that the distance between marker and beginning of the loop 
range needs to be smaller than the loop range itself to make a 
crossfade possible. 

With the aid of this dialog it is possible for Microsoft DirectX and VST 
compatible plug-ins to be used for effect calculation in Samplitude 
Music Studio 14. This opens up the possibility to you of using almost 
any effect algorithms from third-party suppliers in addition to the 
integrated effects in Samplitude Music Studio 14. 
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completely, and 
without any change in length. This is the case with most plug-ins, e.g. 

In the mixer in Samplitude Music Studio 14 plug-ins can be included 
as real-time effects. Here, however, the plug-ins have to be capable 
of processing audio data blocks immediately and 

hall, echo, dynamic compressors). Other algorithms such as 
Timestretching plug-ins fail at this point because of the associated 
length change. 

 

Working method and use 

the plug-in is opened 
in which specific effect settings can now be made. You can set up a 

portant to ensure that the plug-

cted in 
each case in the list on the left can be deleted again with the 

When you open the plug-in dialog you will see on the right-hand side 
a list of the DirectX and VST compatible plug-ins that are installed on 
your computer. Activate one of them and press the arrow in the 
middle; the activated plug-in is transferred to the left, into the list of 
active plug-ins. At the same time the surface of 

chain of effects in this way, but it is im
ins are all compatible with one another. For instance, stereo and 
mono plug-ins must not be coupled together. The plug-in sele

“Remove” button. 
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 plug-in dialog 
The plug-in dialog in the VIP tracks and in the mixer enable you to 

If you have installed various different VST plug-ins in other folders 

io 14. This VST plug-in will be additionally registered and 
from now on will turn up in the plug-in dialog as a VST effect. 

VST plug-ins that you no longer want to see displayed with the 
emoved if you click on them and take 

them out of the list with the “Del” key.. 

Buttons in the dialog 
s in the top right-hand corner of 

the dialog field you can save and insert and complete plug-in set-up 
(the sequence of the plug-ins with all the set parameters). Plug-in set-
ups can thus be transferred conveniently if the various possibilities for 
plug-in use in Samplitude Music Studio 14 are utilized. 

Copy/Insert: This enables complete plug-in configurations to be 
transferred quickly between tracks or objects. 

Play/Stop: This button activates the real-time preview with the active 
plug-ins in the left-hand list. This function is ideal for testing the 
settings of a plug-in if this runs quickly enough for the real-time 
calculation. 

Remove: The selected plug-in is removed from the effects plug-in list. 

Settings: opens this dialog...  

Direct X / VST plug-in set-up 
• The “Write DirectX-logfile” option only serves support purposes and 

should normally be switched off.  
• Here the “Start all object-related plug-ins” option can be activated at 

Play-Start. Some plug-ins cause delays when switched on, and in 
this case they should be switched on at Play-Start because 
otherwise there can be a failure when the relevant object starts to 
play. 

Pre and Post in the

loop in the effects “pre” or “post”.  Mark them on the left in the plug-
in list as “pre” or “post” before you load them. The plug-in will then be 
looped in “pre” or “post” accordingly. 

Drag&Drop of VST plug-ins 

than in Samplitude Music Studio 14 you can simply pull the relevant 
dll-files out of the Explorer and directly onto a track in Samplitude 
Music Stud

Removing available VST plug-ins from the list 

available ones can be easily r

Save/Load: With these two button
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s during the scrubbing/jogging: Under 
s can cause errors during the 

scrubbing/jogging or simply break down. With this option the link to 
the DirectX plug-ins can be deactivated and thus circumvented. 

Process only left (right) stereo channel 

 activating ”Left/Right processing only”. This options is 
only available when in Wavediting /destructive Editing mode. 

• Deactivate all DirectX effect
certain circumstance DirectX plug-in

Only the right / left channel of a stereo Wav project will be affected by 
effects when

The same effect have the L/R buttons in the lower left corner of the 
WAV project window.   
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Track Bouncing 

 mixed and all real-time 
processing, cuts, crossfades; all Mixer settings, Mixer effects, DirectX 

The function “Track Bouncing” may require a large amount of 
storage, depending on the length of the VIP. 

Four track projects are internally mixed to combine two tracks for 

2 dB. However, 

Only selected Range: Samplitude Music Studio 14 uses any selected 

isplays the 
peak level of the mixed WAV file in dB. Further processing of the 

Use this function to convert the objects within a selected range to a 
new WAV file. The selected objects in the VIP are replaced with the 

Tools menu 

The current virtual multi-track project (VIP) can be converted into a 
WAV file or Samplitude Music Studio 14 HD Wave project and saved 
with a new name. All tracks in the VIP are

Plug-Ins, Volume automation and Panorama automation are included 
in the bounced version. 

playback on each channel. To prevent clipping, an amplitude 
reduction of 6 dB is applied (which corresponds with a 50% 
representation of the source material). 

For eight track projects, the reduction is normally 1
you can change the value in Options-> Project Info (shortcut: i). 

There are two variations for the track bouncing implementation: 

range in a VIP for the track bouncing. This command does not work 
track selected, meaning that the number of tracks that are spanned 
by the selected range does not matter. The track bouncing will 
always use all tracks for the period of the selected range. 

Complete Project: The complete contents of the VIP project are 
used. 

Calculate Maximum Amplitude: When check, this option d

bounced audio file can use the specs to make precise adjustments. 
After the track bouncing process, Samplitude Music Studio 14 
displays a dialog with the maximum amplitude value. 

Range trackbouncing 
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amples 

Using this function can conserve a lot of storage space. However, the 

e extended. 

ily back up to any 
backup medium such as CD-ROM, Data DAT, and others. 

Freeze Data Administration 

es necessary. 

ntioned previously, freeze data and 

e current project. 

at this point in time is also kept, even if it is no longer required for 

track-bounced version. This is very useful to combine multiple objects 
into a single object so that the function to create track markers 
automatically can be used. 

Remove unused S

This function removes all material from Wave projects belonging to 
the current VIP that is not used by any of the VIP objects. The objects 
in the VIP will point to the proper audio ranges in the linked audio 
files. This leaves the VIP itself unchanged. 

downside of using this option is that object length changes are 
possible only in a limited form. Object can be made short, but they 
cannot b

Tip: If you need the complete contents of the audio files for other 
production projects, it is recommended to archive the finished project 
in the following way. Save the complete project to a new folder 
(File->Save Complete Project to). The VIP is now located with the 
complete contents, in other words all the audio files, in an unaltered 
form (WAV, RAP, etc.) in the same folder that the VIP was saved to. 
Next, use the command Remove Unused Samples. The same folder 
will now only contain the audio data or samples that are actually used 
by the archived VIP. The contents can be eas

Delete Freeze Data 

When saving freeze files, a considerable amount of data may accrue. 
Automatic freeze data administration therefore becom

The principle is simple: As me
freeze VIP’s are stored in a special directory within the current project 
directory. After completion of the current project, all freeze data no 
longer required is deleted in the background. 

Data requiring an unfreeze is preserved, as long as the respective 
frozen tracks or objects are found within th

There is, however, one limitation: If freeze data exists at the moment 
that the current project is temporarily stored, all freeze data existing 
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Example: 

d 
brought to completion. During completion, the freeze data and freeze 

If, however, the current project is stored temporarily before track 2 is 
ze data of track 2 is also kept. 

l command to get rid of data that is no longer 
required: Delete freeze data (tools menu).  

no longer required in the current project 
is deleted.  

Existing freeze projects, however, remain unaffected. As the original 
VIP, 

unfreeze after project completion.  

Track 1 and Track 2 are frozen. Track 2 is unfrozen before 
completion of the current project. The project is then saved an

VIP of track 2 is deleted. Freeze data and freeze VIP of track 1 
remains unchanged. 

unfrozen, the free

Deleting freeze data manually 
There is a specia

If no freeze data (yet) exists in the current project, this command is 
disabled and cannot be selected. 

Hereby all freeze audio data 

state prior to the use of the freeze command is found in a freeze 
it can be re-established, as long as the necessary audio data is still 
found in its original position. 
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This dialog contains a powerful generator of several test tones. 
Please be sure to have activated a Wave project (HDP or RAP) before 
opening this dialog! 

 

The generated waveform is stored in the Clipboard with the same 

Square, pulse, triangle, sine, 

 click on the OK button or press 

properties as the opened wave project. Please rename the Clip after 
generating the waveform, so it can be easily included into other 
projects without naming conflicts. 

You can adjust type, frequency, and length in samples of the created 
waveform. 

The generated samples are always fully amplified. The volume level 
can be easily reduced with the normalizing function (Normalizing). 

The following types can be selected: 
saw up, saw down and white noise 

Length: Use these boxes to enter the desired length of the generated 
tone in samples, milliseconds and SMPTE. 

Wave shape parameter: The wave shape parameter determines the 
pitch and volume. 

Once you've made all your settings,
the ENTER key. 

The generated signal will then appear in a new window and is 
available for further editing. 
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ager Open new Man

This menu point opens a new Manager window. Several Managers 
can be opened simultaneously.  

Manager 

Please also read the corresponding chapter The Managers (on page 
242). 

Take Manager 

The Take Manager is another powerful feature of Samplitude Music 
Studio 14. It is especially for those who work with many different 
recording takes and need to manage them. 

Samplitude Music Studio 14 registers the VIP position of the 
recorded audio material. This time stamp is stored to the HD or RAM 
Wave project and offers the option to always return the recorded 
object to its original position. 

Application Examples: 

• Selection of the best take after five loop-punch recording passes. 
• Locating the best material between bars 32 and 34 of 12 takes from 

a classical production. 
 of 30:00 

bject. This 
could be the last created object after using punch-in recording. This 
object is referenced in the take list with a colored “O”. 

• A clear overview of all available takes during a SMPTE time
to 35:00. 

Basis for working with the Take Manager is a selected o

Attention: The Take Manager does not work if objects are used in a 
VIP, which are not created by recording material into Samplitude 
Music Studio 14. This would be the case for any material imported 
through the WAV Import or CD Track features! 

When objects are present that where not created through recording, 
a manual time stamp can be assigned to the objects by using the 
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play Filter 
Same File Only: Only those takes are displayed that belong to the 

Same Track Only: Only those takes are displayed that a positioned in 

Match Time: Only those takes are listed that match the original time 

Play: Starts the playback. Before opening the Take Manager set the 

Replace: This replaces the selected object with the currently chosen 

Statistic (Verbose): Creates a new VIP with the currently shown takes 
from the Take List. Every take is listed in a new track. The VIP can be 
used to audition the individual takes with the Solo and Mute functions 
of each track. 

Statistic (Brief): Creates a new VIP with the currently chosen takes 
from the Take List. All takes are lined up on the same track. 

Timestretch Patcher 

This tool enables wave files used in Samplitude Music Studio 14 and 
other MAGIX programs (e.g. MAGIX music maker) to be patched.  

Additional information and settings are written into the wave project 
to make them easier to find, thus ensuring better Timestretching or 
Pitchshifting results.  

The following can be patched: 

• Algorithms for Timestretching/ Pitchshifting 
• BPMs 
• Beat markers 

Algorithms for Timestretching/ Pitchshifting 
Different algorithms (besides the standard algorithm) can be used for 
real-time Timestretching and/or Pitchshifting for better results. Check 

function Object->Set New Original Position. Once completed, the 
Take Manager will list the objects in the take list. 

Dis

same audio file as the selected object. 

the same track as the selected object. 

position of the selected object. 

play cursor to the desired playback position. 

takes from the Take List. 
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g/ Pitchshifting for more details. With the 
e optimal Timestretching algorithm in the 

wave project. This ensures that the "correct" algorithm is used 
automatically when Timestretching/Pitchshifting is used on these 

. with the Timestretch mouse mode).  

BPM value 
Patches the BPM value (beats per minute). This is useful for when the 

be determined later in order to adapt the 
wave project to the tempo of an existing arrangement. 

Patches only work if you have opened the wave project in destructive 
wave editing mode and if it is not open in a VIP simultaneously. 

On the right  of the dialog (Patch) you can select the algorithm to be 

ted algorithm in connection with the 
Play/Stop and Play original buttons. Patch saves the information in 

Remix Agent 

atically 
determining the tempo in BPM (Beats per minute) as well as for 
creating remix objects. Use the context menu and/or the effects 

Resampling/ Timestretchin
Patcher you can store th

projects as object effects (e.g

Beat marker 
Beat markers are also saved in the wave project when using beat 
marker-based algorithms. 

In contrast to the Timestretching dialog, the patcher is non-modal, 
meaning that if the patcher is open, you can move beat markers in a 
wave project while checking out the Timestretching result. 

Timestretching factor must 

Patches in brief 

used and specify the wave file tempo. On the left side (Test) is the 
control element from the Timestretching/Pitchshifting Dialog. 

It allows you to test the selec

the wave file.  

Samplitude Music Studio 14 offers Remix agents for autom

menu.  
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Remix Agent – Tempo and Beat Assignment 

 

The Auto Remix Assistant is a powerful tool that determines the 
tempo(measured in beats per minute, or BPM) as well as the timing 
of the beats for songs’ quarter notes. This is important. For example, 
when an audio CD title is imported into Samplitude Music Studio 14 

ffects or 
synthesizer voices. 

ix Assistants 

• When the tempo of the arrangement must be adapted to the tempo 

• When the tempo of the song must be adapted to the tempo of an 

create a remix object, 
which can then be re-arranged as desired. 

Requirements 
• The song must be longer than 15 seconds. 
• The songs have to contain "rhythmic" music. 

and you then wish to mix in sounds such as drum loops, e

When to use the Auto Rem

of the song.  

existing arrangement. 
• When the song is to be cut up precisely to 
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• The song must be in stereo. 

Preparation: Setting the Start Marker and Object End 

he song object in the Arranger where 
detection is to start. If the song contains a long intro without beats, 
set the start marker after the intro. As a rule of thumb, the Auto 

be "fed" with "dance" music.  

 start marker lies before the song object, the object is examined 
from the beginning.  

.  

the automati o and bar recognition 
After Ex opens, the selected track object will be analyzed. Following 
the analysis the track will be played. During playback a metronome 

d result will sound, and vertical tick 
marks will visualize the quarter note positions in the wave form 

The following will be indicated: 

• Position of the start of the measure (one): red lines. 

nal blue lines. 

lay the metronome volume can be 
adjusted. To the right the calculated BMP value will appear. If the 
BPM value is valid, the display will be green. 

If the metronome clicks match the rhythm of the music, the bar starts 

Correction - Manual Tempo and Onbeat/Offbeat setting 
If the result is incorrect, you can help the Auto Remix Assistant with a 
few mouse clicks on the correction buttons.  

There are two possibilities: On the one hand, the “Tempo correction” 

Before opening the Auto Remix Assistant one should set the start 
marker at the position in t

Remix Assistant should always 

• The start marker should be set before a quarter note beat or, better 
still, briefly before a beat at the start of a bar. 

• If the

• If detection is not performed by the end of the song, the object can 
be shortened accordingly with the object handle at the end of the 
object

Checking c temp

corresponding to the compute

display. 

• Position of the other quarter notes (two, three or four): green lines. 
• Reliably recognized positions: thick lines. 
• Unreliably recognized positions: thin lines. 
• Tapping is indicated by additio

If the tempo and beat information is already available, dots above the 
display at the corresponding positions will appear. To the left 
underneath the waveform disp

will then be determined. If not, you can correct the tempo manually. 
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list offers alternative BPM numbers, which could also fit with the 
le BPM values are detected automatically – the 

total number op BPM can therefore deviate from song to song. 

p 
Tempo button must be clicked with the mouse in time with the music. 

ith repeated tapping of the tempo correction button, one should 
keep an eye on the color in the BPM display. In the “unlocked” 
condition (red) the tapping is not in time with the music. One should 
tap until the “locked” condition is displayed. After a short time one 
hears if the result is correct through the metronome.  

Subsequently, Offbeat correction takes place - if required. If the 
detected quarter notes beats lie around the length of an eighth note 
(transferred behind the real positions of the quarter note beats), one 
or more alternatives can be selected from the Onbeat/Offbeat 
correction list.  

Set the start of the bar 
Start bar correction takes place next. The beat at the start of the bar 
should coincide with the high sound of the metronome, or the red line 
in the wave form display. 

Correction is achieved in one step: If the start of the beat can be 
heard, click on "Tap One" once using the mouse or press the "T" key 
on the keyboard. Alternatively, you can also choose by how many 
quarter notes the "One" is to be moved back. 

If the start marker is set right before the first beat of a bar, no 
correction is necessary. 

music. The adjustab

Tap Tempo: With difficult audio material we recommend the use of 
the Tapping Input mode. Either the T key must be pressed or the Ta

W

Hint: After every adjustment, the metronome and tick mark 
visualization react with a delay. 

Step 3: Use of the BPM and beat recognition 
With this last step you determine what is to be done with the material 
that is currently being analyzed. You have three possibilities:  

1. You want to generate remix objects from the song (the analyzed 
material)  

2. You want to bring your project tempo into line with the tempo of 
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3. You initially only want to save the tempo and beat information in 
the audio file and to edit them later. 

Generating remix objects 

equired way in the VIP.  

Some examples of this use: 

• Generate loops out of complete songs that you can then use with 

ongs, i.e. change the sequence of the remix object, cut and 
double the individual parts or beats of the songs, or enhance the 

ith any other loops, samples, etc. 

ntizing: The new objects are fitted exactly into the beat 

slight tempo fluctuations 
that can result in different bar lengths. In order to ensure that the 

to the rigid beat grid of the arrangement the object-

corrections use resampling. If the necessary corrections are 

the song or vice versa 

The song is cut up beat by beat into individual objects that can then 
be used and re-edited in any r

your own material from complete songs that they can then use with 
their own material. 

• Remix s

song w

Caution! The “Generate remix objects” option can only be selected if 
the remix agent was opened from a VIP. 

Audio qua
grid of the arrangement 

In the case of hand-made music there are 

objects still fit in
timestretching option is activated and used in such a way that the 
differences in lengths are corrected. 

For small 
very small the higher-quality resampling technique can be used 
instead of timestretching.  

Note: if you later decide to alter the tempo of your multi-track object 
and to adjust the audio object in the VIP to the new tempo value, 
clearly audible pitch changes will appear in the remix. 

Remix objects in Loop mode: The new objects are put into loop 
ith the right-hand object 

mouse gripper the object keeps being played at its original length. 
mode. When the objects are lengthened w

Setting arrangement tempo at object tempo: The arrangement (VIP) 
takes over the BPM value it has found. If you want to use the 
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, as with remixing, 
this option should be active.  
dissected song as the basis for a new composition

Note: the time correction is allocated to the objects by setting the 
object real-time timestretching and can therefore be corrected in the 
Object Editor. Conversely, timestretching settings that have already 
been set can be over-written. 

Grouping: The remix objects are grouped. 

Use cross-fades: The remix objects are superimposed. The 
parameters of the superimposition can be set in the Cross-fade 
Editor. 

Exit: The dialog is closed without the changes being saved. 

Adjust tempo: This option offers you the possibility of adjusting the 
song tempo to your project speed or the project speed to your song 
tempo. 

Caution! The “Adjust tempo” option can only be selected if the remix 
agent has been opened from a VIP. 

Set object tempo to arrangement tempo: This adjusts the object 
length to the existing arrangement. Three different procedures are 
possible: 

Timestretching: the pitch of the song remains constant but under 
certain circumstances the sound quality may suffer.  

Resampling: Resampling changes the pitch, in the same way as 
changing the speed on a gramophone, but very largely retains the 
sound quality of the song. 

Note: if you later decide to alter the tempo of your multi-track object 
and to adjust the audio object in the VIP to the new tempo value, 
clearly audible pitch changes will appear in the remix with objects 
edited with resampling. 

Audio quantizing: In audio quantizing the tempo adjustments are 
calculated into the audio file. This is done in such a way as if initially 
remix objects (see below) were being produced and immediately 
compiled into a new audio file. If the recognition is uncertain the 
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treme tempo fluctuations. It is particularly 
the start marker before calling up the Remix 

Agent in such a way that the tempo is recognized with certainty. 

 music always 
match the bar starts of the arrangement and therefore do not tend to 
wander away from one another. 

Set arrangement tempo at object tempo: The arrangement (VIP) 
has found. If you want to use the 

dissected song as the basis for a new composition, as with remixing, 
this option should be active.   

Change global setting: The BPM value of the arrangements (VIP) is 

 map: From the position of the Play cursor to the final 
position of the remix object, a tempo marker is set for each bar in the 

Generate bar marker in the current range: This option enables 

 of the starts of the quaver-bars 
(the positions of all lines presented in the wave form display). 

One example of the use in both cases: 

Alter global setting”). 
2. Then adjust the tempo of the second song to the project tempo 

 the tempo of both songs now match 
exactly it will be possible to fade from one song to the other 
without any problem. 

Save only tempo and beat information: If this option is selected the 

result can include ex
important here to set 

The advantage of audio quantizing is that small tempo fluctuations 
are evened out in the music. The bar starts of the

takes over the BPM value it 

set at the calculated value. 

Adjust tempo

arrangement (VIP). 

markers to be set at start of each bar in the song (the positions of the 
lines marked in red in the wave form display). 

Generate quaver markers in the current range: Select this option in 
order to set markers at the positions

Mixing two songs:  

1. First adjust the project tempo to the song over which you intend 
to dub in the second song (“Set arrangement tempo to object 
tempo”, “

(“Set object tempo to arrangement tempo”). 
3. As the project tempo and

tempo and beat information is transferred to the audio file. The 
objects in the VIP and the VIP itself remain unchanged. 
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t markers in the current range: With this option 
markers are set at the start of each bar in the song  (the positions of 
the lines marked in red in the wave form display). 

Generate quaver markers in the current range: Select this option in 

Generate bea

order to set markers at the positions at the start of each quaver-bar 
(the positions of all the lines marked in red in the wave form display) 
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k/Record menu 

t or the range is played once. 

The project or the range is played in a loop. 

Key:  Space 

e 

 the range until you press the stop 
key (button). This mode is very useful when testing loops for 

ace 

Play with Preload 

to be started. 
Another window will appear with which playback can be started at 

Keys: Shift + Space 

Pl bjects 

layed. All unselected objects will be 

Playbac

Play once 

The projec

Key:  Space 

Play loop 

Play in Rang

If you have specified a range selecting this menu option (or button) 
will start the playback of the sample from the beginning, enter the 
range and continue to loop through

instrument samples. 

Key:  Sp

All buffers are loaded and the playback is ready 

your convenience. No delays will occur. This function is useful on 
slower systems and if  synchronization must be started in manual 
mode and an exact start has to be performed. 

Play only selected objects 

ay only selected o

Only selected objects will be p
muted temporarily. If the playcursor is not on the first selected 
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Stop 

rojects types. 

 Play Direction 

k direction can be changed even during the actual 

Restart Play 

 actual playback. 

object’s time position, it will be replaced to it 

Key:  Alt + Strg + P / Alt Gr + P 

The playback is stopped for all p

Stop and go to current position 

The playback is stopped; the play cursor goes to the current position. 

Change

The playbac
playback. 

Playback will start at the beginning even during the

Keys:  Backspace 
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option is designed to quickly enter playback parameters. 
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Sample Rate: The sample rate can be changed here as long as the 
soundcard supports the new rate (some soundcards even support 
changing the rate while playing the sample!). This is especially useful 
to hear notes in a sample range played in a different octave. When 
selecting half the sample rate the pitch should be the same. It would 
be played one octave lower. 

Device: To specify the driver of the sound card use this dialog box. 
This is necessary if playback takes place through a single sound card 
device. This is especially important if multiple output devices are 
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located in the computer. 

The “Autoscroll” section will let you activate the Autoscroll feature. It 

 cursor during playback. When 
working in “2” or “3” section display mode, the autoscroll feature will 
cause the individual sections to follow the play cursor as well. If you 
have zoomed into one of the sections, the play cursor will move 
through the section faster resulting in more screen re-draws. 

You can choose between page and soft scrolling. But be careful: 
Scrolling requires CPU power (depending on the processor, graphics 
adaptor and resolution), so that the CPU may be overloaded in critical 
situations which may result in playback dropouts. You should then 
deactivate autoscroll mode. 

Scrubbing: If you press the Insert key (Insert or 0 on the number 
pad), Samplitude Music Studio 14 will switch to "Scrubbing Mode". 
This means that the playback speed can be controlled directly by the 
mouse. The further to the right the mouse goes, the faster 
Samplitude Music Studio 14 plays. 

In comparison to many HD recording systems, this even works in a 
virtual multitrack project. 

Use the Scrubbing Mode to find passages, crackling, etc. in materia
– the older generation of sound engineers are, no doubt, very familiar 

Relative: The relative distance between the play cursor (positions bar) 
and the mouse position can be used to control the speed. The play 

t of the mouse. 

Center = no movement 

Right border = double speed forwards 

A Tip Using Scrubbing: The scrolling becomes “softer“ when using 

is especially useful when working with long disk files. The HD Wave 
project window will follow the play

l 

with this method from analog tape editing. 

There are two scrubbing modes (in playback parameter window - key 
p): 

cursor follows the movemen

Absolute: You can also use the absolute position of the mouse in the 
window to control the speed: 

Left border = double speed backwards 
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 to test your 
system for error free playback with 

es (4000, 2000 samples) scrolling is 
"softer".  Test if your computer functions at this buffer size without 

the Soft Scroll mode, editing becomes very 
convenient on faster computers. 

Record options 

d 
to open the dialog again, just start record by the record button at the 
transport control or clicking the toolbar icon  

small buffer sizes (2000, 4000 samples). You may need

Tip for scrubbing: For buffer siz

any playback errors. 

Combined with 

Record 

Starts recording. 

This menu option opens the Record window. All necessary settings 
for the recording can be performed here. If once set, you don’t nee

 

Re n Stereo and Mono, wheth
to record the audio into a RAM Wave project or to the har

cord mode: Select betwee er you want 
d disk as a 

HD Wave project. 

Preload: The Preload option allows you to load all the buffers before 
the recording actually begins. This enables you to an immediate 
recording once you click the recording button. Otherwise Samplitude 
Music Studio 14 will load the buffers and depending on the size of 
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rs and the overall computer speed this may take a little bit of 
time. 

elect the sample rate of the audio file. Make sure that 
your sound card supports the chosen sample rate.  

ith a different sample rate. For example, many times a 
DAT tape is recorded at 48 kHz but the tape needs to mastered and 

Device: This selects the desired device driver you want to use for the 
recording. If you have more than one sound card installed in your 
system, this window will let you specify which card to use. Make sure 
the sound card is properly installed in Windows and is operational. If 
you do not see an entry in this window, check whether a device 
driver has been installed for your sound card. This usually is done 
during the software installation for your sound card. 

? (Device): By clicking on the “?” button you can check on the record 
capabilities of the selected sound card. It shows you information on 
the sound card driver and it’s capabilities. 

Info: Dialog for detailing soundcard properties. If your soundcard 
supports 24 bit recording, you can activate this recording mode via 
the Info dialog. 

Playback while Recording: Simultaneous record and playback is 
especially important when wanting to monitor existing tracks while 
recording a new track. This option allows you to turn the feature on. 
To conserve system resources and keep the recording error free on 
slower systems, you may need to turn this feature off. 

File Name / Browse: The name of the audio file to be produced and 
the pre-set index path are displayed at the bottom of the Recording 
Window—both can be changed by clicking on the File Button. 

Set CD Track Marker: While the recording is running, you can set 
Track Markers, by clicking on the Set CD Track Marker tab in the 
Recording Dialogue. 

Automatic Recording Stop: When this field is activated, the 

the buffe

Sample Rate: S

Resampling to 44.1 kHz: Some Samplitude Music Studio 14 versions 
can perform a real-time sample rate conversion to 44.1 kHz if you are 
recording w

prepared for Red Book audio CD processing, which needs to be in 
44.1 kHz. Samplitude Music Studio 14 allows you to automatically 
convert the audio during the recording, eliminating the additional 
sample rate conversion step after the recording. 
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fter approximately 16 seconds of 
, for instance, a record recording 

without having to worry about stopping it at the end. 

n: When this field is activated, Track 
Markers will be set automatically at the end of pauses between 

ate objects in a 
VIP once you are done with the recording. 

inning this. 
While recording, the LED control displays move slower, do, however, 
show each maximum level. 

sant ”clipping” sounds. 

n open the oscillograph or phase correlator. 
The oscillograph displays the wave form at the input in a scaleable 

Tuner: For “tuning” guitars and other string instruments. A calibrating 

llows you to specify an offset, which is 
calculated in samples. Sometimes it is necessary to compensate for 

recording stops automatically a
silence. This allows you to make

Automatic CD Track Recognitio

songs. 

Create VIP object with name: Samplitude Music Studio 14 allows 
you to choose whether you want to automatically cre

Monitor: This checkbox activates the VU meters. Please note that the 
correct recording device must be selected prior to beg

Recording level: This display indicates that the signal level to be 
digitized is correctly set. Play the loudest part of the material to be 
recorded and watch the display. 

Low-level recording leads to a loss in sound quality, while high-level 
recording can produce unplea

You can adjust the record level either on the sound source or with the 
mixer of your sound card. 

Osci./Correl: Here you ca

window. 

The phase correlator displays the phase level of a stereo signal. A 
vertical line corresponds to a mono signal, and a horizontal line 
corresponds to a 180° phase-inverted signal which usually indicates 
an incorrect cable connection. 

line appears when the A0 note is played. If deviating tones are 
played, the deviation can be read on the basis of the calibration line 
and the numerically indicated pitch is corrected accordingly. 

Record Offset: This option a

any delays due to processing speed and other factors, such as your 
sound card’s ability to switch between playback and recording mode. 
Delays can occur between the recording and the playback of audio 
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. Good values to start with are in 
the 20-2000 sample range. You can determine this value by playing a 

then measure the offset precisely using the 
zoom functions. 

a marker at positions you 
want to select for later clean-up or similar tasks. 

ord: Starts recording by activating this button.  

Should the computer become overloaded due to swapping data or 

 or the space key. 

. 

 recording) 

Record mode/Punch in 

ying the VIP. 

ode. Punch-In and Punch-Out are 
a process automating the recording start and end of an audio 
segment. Once the Punch mode is active, the Punch-In Record can 
be used to record audio segments without stopping the playback. 

Requirement for this mode is an armed Record track. Use the “REC” 
button on each track to select it for punch recording! 

Punch Recording can be done in two ways: 

1. Punch-In/Out “On-The-Fly”: This allows you to start the recording 

when the Playback while Recording feature is turned on. This option 
allows an adjustments if this occurs

project with a distinct start in a multitrack VIP and recording it 
simultaneously. You can 

Set Marker 1: You can drop markers into the project. The current 
position of the play cursor is used to drop 

Rec

Stop: Stops the recording process. Samplitude Music Studio 14 will 
ask you whether you wish to keep the recording or delete it. 

hard disk access for example, simply interrupt the recording with a 
click of the right mouse button

OK: Closes the Record Parameter dialog

Key: r (second r starts

Record without Playback 
Use this option to record without pla

Play while recording 
This option corresponds to the option in the recording options with 
the same name. 

Punch In Mode active 
This option activates the Punch m
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at any time during the playback. Once the recording 
commences, it can be stopped at any time (punch out), while the 
playback continues. 

This is very similar to tape based multi-track recorders, which allow 
you to correct mistakes during previous recording takes by 
overwriting segments of the tape. 

Simply start the playback with the Spacebar. The Punch-In recording 
can be started by clicking on the Punch Record button in the toolbar. 

2. Punch-In/Out with Markers: The second method is the punching in 
and out of recording using special markers. This is a more automated 
way of dealing with punch-in/out recording. This is useful when 
specific punch-in and punch-out points are determined and you don’t 

 defines the beginning 
and end of the recording. The functions Set Punch-In Marker and Set 

(punch in) 

want to take any risks in possible punching in or out of the recording. 
Don’t panic though! The punching in and out with markers lets you 
specify the exact points the recording is to start and stop. To operate 
in this mode, a range has to be selected, which

Punch-Out Marker are used to tell Samplitude Music Studio 14 where 
to punch in and where to punch out. Next, set the play cursor to an 
appropriate position prior to the punch-in point and start the 
playback/recording with the Punch Record button in the Punch 
Toolbar. 

Important: When working with the punch in/out functionality, make 
sure that the Auto Crossfade mode is activated, by clicking on the 
corresponding button in the Samplitude Music Studio 14 toolbar. The 
auto crossfade will create smooth transitions between the takes. This 
helps to prevent little pops and clicks! 

There is also a way to perform looped punch-in recording! Simply 
select a range over the desired punch region. The range is played 
back until you stop the playback with the Spacebar. Each time the 
program loops through the range, new takes are recorded at the 
punch markers. To find the best take after the recording is 
completed, use the Take Manager! 

Pun
is

ch In Record 
 function/buttTh on starts and stops the punch-in recording. 
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Set 
This 

Set End Marker 

Live Input Mode 
udio 14 – 

the Live Input Mode! When working with this mode, Samplitude 

 material. 

ject is also played back while the live inputs are 
processed. 

Latency: The audio processing in Samplitude Music Studio 14 

buffer settings. Use settings that enable the program to process the 

ion to 2000 samples results in a delay of 
only 0.2 seconds. Experiment with the buffer settings to find the 

cy may not make it possible to use the Live Input Mode to 
replace an analog effects device. However, it leaves room for some 

Start Marker 
function/button sets the punch-in marker 

This function/button sets the punch-out marker. 

Remove Punch Markers 
This function/button deletes the punch-in and punch-out markers. 

This is another very powerful feature of Samplitude Music St

Music Studio 14 lets you use the real-time Mixer to mix live inputs 
from the sound card with recorded audio

This turns Samplitude Music Studio 14 into a full-scale digital real-
time effects device, including DirectX Plug-Ins! 

The Basics: The Live Input Mode basically functions similar to 
recording audio material – without writing it to disk! A channel that is 
to be used for live mixing has to be armed for recording. 

Once the playback of the VIP is started with the Spacebar, the live 
signals on the input of the audio device(s) are routed through the 
Mixer. Use the controls in the Mixer window to create a mix. In 
addition, any VIP ob

obviously takes time. This may lead to small delays at the outputs 
versus the incoming signal. This delay is very much dependent on the 
VIP Buffer size. The latency can be reduced by using smaller VIP 

real-time audio without introducing any errors. A setting of 4 buffers 
at a buffer size of 8000 stereo samples creates a delay of 0.7 
seconds. A buffer size reduct

optimal settings for your system! 

The laten

very interesting application aspects. 

Samplitude Music Studio 14 as Live Effect Processor: If you are 
looking for fancy effects that are not offered by effect units in your 
rack, try to use some of the integrated effects in Samplitude Music 
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 with the FFT Filter, the 
EQ’s and the Stereo Enhancer. You may also use the many DirectX 
Studio 14. A live signal can be processed

Plug-Ins available. There is no limit to your creativity! 

Note: If you have an ASIO driver for your soundcard, you can pretty 
much switch the latency off. Please read the “Samplitude Music 
Studio 14 as external effects device” section of the “Effects” chapter. 

Monitoring 

New, more flexible input signal monitoring is now available through 
ASIO driver support. 

t monitoring on/off 

the VIP or mixer is activated) are played 
according to the selected monitoring type at the output. Furthermore, 

eters in the VIP and mixers react according to the 

Monitoring > Inpu
This function activates/deactivates the input monitoring (corresponds 
to the “REC M” button on the transport console). When actively 
monitoring, the input signal of the tracks for active monitoring 
(loudspeaker button in 

the LED peak m
input signal. 

Note: If the REC button is activated on a track, then the loudspeaker 
button is activated simultaneously in order to switch on monitoring. 

Monitoring > Tape pl toring ayer moni
The preset method of monitoring as on a tape player and well-known 

de Music Studio 14 versions:  

When STOP is shown, the input signal is rendered, PLAY renders the 
ers the input signal. If the option is 

r Monitoring 
ith the normal characteristic of the VIP: The peak 

meter of the tracks displays the level at the sound card input. 

nitoring / Software FX Monitoring 
For cards with ASIO drivers, it is also possible to use software 

from earlier Samplitu

track contents, RECORD rend
deactivated, it is left to the user to choose whether the input signal is 
shown. Use the "Force monitoring" button (small loudspeaker symbol 
beside/above the peak meter in the VIP/Mixer).  

Monitoring > Peakmete
This corresponds w

Monitoring > Software Mo

monitoring if the card does not support hardware monitoring (ASIO 
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Software FX monitoring also calculates the track effects into the 
eption of all high latency-afflicted FX 

Inserts such as FFT filters, Dehisser or Vocoder. The Amp simulator 
tude Music Studio 14 is therefore also 

usable as an effects device with which one can play live directly. 

 effects, use the conventional Live Input 
Mode, which functions without ASIO, but is afflicted with higher 

 spielen zu können. 

 the Auto DJ (on page 235) chapter. 

Direct Monitoring). 

monitoring signal with the exc

however is applicable. Sampli

If you need all of the mixer

latencies. 

Außerdem muss Software- oder Software FX-Monitoring aktiv sein, 
um VST-Instrumente live über den MIDI-IN-Port

Auto JamSession 

Read more on this in

Keyboard shortcut:  J 
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ignature 

itude Music Studio 14 offers comprehensive creation 
possibilities. 

play in the transport window serves as a visual control of the 
current tempo or time, which displays the current values when 

 can also be adjusted by placing support points at 
udio and MIDI events, e.g. 

a reference drum track (so-called Advanced Tempo Mapping). 

: 

o information can also be adopted when importing 
MIDI files into the current project. Samplitude Music Studio 14 

ired tempo markers automatically. 

be coupled with the musical grid 
and positioned precisely for tempo changes. 

marker 

irst has a single “Master” tempo which can be defined 

ited tempo changes directly in the Project 

sed to define a tempo change at a precise position, which 

Menu tempo 

Tempo/Time S

Tempo and bar changes are an important expression criteria of all 
music. Sampl

In this case the definition of tempo and time changes is done entirely 
by means of markers within the Project Window. Special tempo and 
bar markers can be defined using linear or immediate tempo or bar 
changes. The resulting tempo curves are calculated automatically. 
The dis

playing back or repositioning the current respective value. 

The musical grid
certain time positions or already available a

There are three types of markers

• Tempo 
• Time signature (musical signature) 
• Bar position 

Of course, temp

creates the requ

If required, MIDI/audio events can 

Set new tempo 

A new project f
in the Transport Control or in the project settings (Keyboard shortcut: 
“I”). 

You can define unlim
Window at anytime. The tempo marker is the most important tool as 
it can be u
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rpolated linearly to a previous tempo definition. 

 beat marker 

as a 
uniform 4/4 beat that can be defined in the Transport Control or in 

gs (Keyboard shortcut: “I”). 

 MIDI file contains bar changes, bar position markers are 
automatically generated. 

Set new beat position marker 

terial. 

ers (Advanced Tempo Mapping) 

sition, simply 
define a tempo marker, with tempo interpolation referring to the 

udio material often does not correspond with the 
project tempo, e.g. a drummer's reference track to indicate the 

ings or additionally composed material with 
many timing nuances. Instead of placing tempo makers or even 

so-called bar position 
markers. This way you can synchronize the bar grid, musical grid and 

can also be inte

Set new

The time signature marker changes the type of beat after the marker 
position, e.g. from a 4/4 beat to a 3/4 beat. A new project first h

the project settin

Bar markers can only be inserted at the beginning of a bar. If an 
imported

Beat position markers assign a specific musical position to a specific 
time position. This way, the bar frame/grid and MIDI events can be 
easily synchronized with existing audio ma

Bar position mark
The tempo of a piece of music is usually defined when it's composed. 
If you want to increase the tempo at a certain bar po

previous marker. 

However, recorded a

tempo of further record

having to adapt the reference material using time-stretching, you can 
create the musical grid at certain time positions in the linear course of 
playback of the project using support points; 

the corresponding MIDI data with available audio material. 

Example: The drummer has recorded a track using a metronome, 
but has deliberately not hit important beginnings of a bar precisely. 
The musical grid is adapted to keep the groove within this 
performance. By placing a bar position marker, the Project Beat of 
“20”, including the beginning of the chorus, is moved exactly to the 
first beat of the 20th bar played by the drummer. 
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t the bar position markers are used 
ple/time position (or SMPTE) with 

the musical bar position by means of defined support points. This 
allows for easy editing of projects with changing musical tempi when 

 is edited in the actual time course (“Bar 20 should 
begin a this point in time!”). 

A tempo marker is different in that it defines a clear command: Faster 
(or slower) from here. A bar position marker, however, defines the 

indirectly by adjusting the tempo before the marker in such a 
manner that the desired musical position (“Beat 20”) is met precisely 

isplay, the metronome and the events in the MIDI 
Editor are automatically adjusted according to the changed musical 

This practical example shows tha
to combine the audio-based sam

the musical grid

tempo 

at the marker position. 

The grid, the grid d

tempo. 

Note: Bar position markers immediately following a tempo marker 
always create a tempo run. Instead of a tempo jump, a bar position 
marker is used to set a tempo run if there is a bar position marker 
immediately before the tempo marker. As the tempo before the bar 
position marker has already been defined, the adjustment of the 
musical pos  has to be carriedition  out by decreasing or increasing the 
tempo to such an extent that the required bar position meets the 
required time position at the bar position marker. 

Working with tempo and bar markers 
Creating tempo markers 
Tempo and bar changes in Samplitude Music Studio 14 are set 

indow using project markers. 

1. Tempo/beat marker window 
he 

tempo or bar change to be. The option “Snap to grid” is very useful 
for placing the cursor directly on a bar or 1/4 bar. Click on the Snap 

Transport Control (Tempo section). 
Open the tempo/bar marker window from the Marker Menu (right-

Click on the “New Marker” button in the window. A marker is inserted 
at the current position. You can now use the marker option to set the 

directly in the Project W

So, you have to create a marker to insert a tempo change at a certain 
playback position. There are several ways to do this: 

Set the playback cursor to the position where you would like t

button in the 

click on time bar) or from the MIDI menu. 
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properties of this marker. For a new tempo marker, enter the required 
bar marker. 

list. For example, you cannot set the 
marker properties such as type or tempo after it has been created. 

e that a beat marker only makes sense at the start 
of a new beat. If the play cursor is at a different position, the marker 

2. Marker Menu 
n also be created using the marker menu 

context menu and the MIDI Menu of the program. You can of course 

3. Timestretch Mouse Mode: Click on the time border 
se Mode you can create markers directly with one 

click on the required playback position. 

Bar position marker: Alt + Click 

/bar marker window 
If a tempo marker is changed or a bar position marker is moved, this 

There are principally two possibilities: The time position either 

ker window). 

Illustration: The time position in the VIP is the absolute position within 
e musical position is flexible, which is made clear by the 

grid. Maintaining the musical position therefore means that the 
ted grid and that 

their time position in the VIP therefore changes. If the time position is 
the al position changes accordingly. 

When tempo markers are manipulated, the behavior of the markers, 
cts can be controlled separately. With each 

presetting the musical (grid) positions are maintained for MIDI Objects 
ition for markers and audio 

Objects. The time position is always maintained if the “Alt” key is 

tempo in BPM or the new bar for the 

Please observe that the settings are only valid for the markers 
currently selected in the marker 

Please also observ

position is automatically moved to the beginning of the next bar. 

Tempo and bar markers ca

assign shortcuts. 

In Timestretch Mou

Tempo-Marker: Shift + Click 

Edit marker/ tempo

influences the following markers and audio/ MIDI projects in the VIP. 

remains constant, or the musical position remains and the time 
position is adjusted (tempo/bar mar

the VIP. Th

Objects or markers are adapted to the newly crea

maintained,  music

audio and MIDI Obje

and tempo markers, as is the time pos

pressed while manipulating with the mouse. 
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his can be changed in the Tempo Marker Window. 
The time position, however, is always maintained for fixed tracks 
(preset). T

 

 

In this example the first tempo marker in the second image has been 
changed. The MIDI Object and the second tempo marker were 
moved correspondingly so that the musical positions (3:01:000 and 
4:01:000) are retained. The time position of the audio Object was not 
changed, so that its musical position has moved forwards (from 
2:2:000 to 2:01:181). 

Further options: 
Each tempo and bar position marker can be ignored using the 

cally for bar position markers if 
absurd bar positions are created while moving, e.g. if bar position 

ate 
from a previous tempo marker cannot be met by tempo interpolation. 

rkers: In the Beat Marker window there is an 
 In this case only the set project 

Manipulating the tempo marker in timestretch Mouse Mode. 

Bar position markers are created with Alt+mouse-click and can be 
moved by Alt+horizontal mouse movement (without adjusting the time 
position), e.g. to manipulate the bar grid and to adapt it to available 

“Bypass” option. This occurs automati

markers are exchanged (bar 20 before bar 19) or are moved to a 
position within the project so that these bar positions that origin

Ignore all Tempo Ma
option for ignoring all tempo markers.
tempo is used (“I”). 

The timestretch Mouse Mode simplifies working with tempo markers. 

You can easily create tempo markers using Shift+mouse-click. 
Markers are then initialized according to the tempo. You can, 
however, adapt this tempo immediately by moving the mouse 
vertically holding Shift and clicking. 
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 audio events.

Tips, examples of use 

Loading MIDI files that include tempo changes: The tempo changes 
are adopted by the current project and are accounted for during 
subsequent editing and in the MIDI Editor. 

Tempo markers can be placed when composing in the MIDI Editor 
(these then apply to all tracks). Subsequent MIDI Objects and tempo 
markers retain their musical position (advanced setting). 

The grid can be adjusted to available audio events, e.g. assigning 
beat numbers to certain time positions. You can either use the “Set 
new Bar Position Marker” menu command to create a marker at a 
position within the project and can assign the corresponding bar 
position or, for smaller changes, Alt+mouse-click on the respective 
bar grid position and immediately move it to the required time 
position, e.g. to the beginning of an Object. 

If the project includes MIDI data, this is automatically adjusted 
(preset). The newly created tempo grid is used in the MIDI Editor for 
subsequent editing or for a new composition (e.g. quantization). 

When working with MIDI files and complex tempo changes the tempo 
map can be deactivated and, if necessary, the tempo can be reduced 
before recording new MIDI files. After recording, the tempo map can 
be used again. The newly recorded MIDI data is now adapted 
automatically. 

Ignore all tempo markers, use only 
project tempo 

Metronome active 

 This function can also be 
activated via the "Click" button of the transport console. 

Ignore all tempo markers. Only the project tempo is used. 

Activates/deactivated the metronome.
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ome 

ill require soundcard with MIDI functionality 
and/or an external MIDI instrument to provide the metronome click. 

Metron

Here you can set a metronome to help keep in time with the beat 
during recordings. You w

.

 

Active during recording: This option allows you to hear the 
metronome click during recording. 

Active while playing: This option allows you to hear the metronome 
click while playing. 

Output device: Selects the device that will provide the metronome 
click (usually the soundcard). 

MIDI Channel: Sets the MIDI channel, through which MIDI commands 
are sent. 
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Tact / Tact velocity: Here you can set the various notes and 
velocities for the first beat of each tact and/or the subsequent tacts. 
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New MIDI object 

Object is created on the selected track. After choosing 
the command, you can select a prefabricated MIDI template (from the 

e Music Studio 14 as a template. If only one file is in 
the template listing, no menu appears the Object is created 

. 

This menu point opens the MIDI Editor. Here, the content of the MIDI 
yed and edited. Here, you can 
itor, Score Editor, Event List, 

and Velocity/Controller Editor. 

be asked if you wish to create 
one. If you confirm this with "YES", a MIDI object in the current track 

MIDI menu 

A new MIDI 

subdirectory “Templates” in the Samplitude Music Studio 14 
directory) from a small pop-up menu. It deals with normal standard 
MIDI files which can be copied into this directory or directly exported 
from Samplitud

immediately. 

New MIDI track 

Use this function to create a new track in MIDI mode to which you 
can add MIDI objects and edit them

MIDI Editor 

object selected in the VIP can be displa
choose from: Matrix Editor, Drum Ed

If a MIDI object is not selected, you will 

is created at the cursor position/start of the range. 

Read more about the MIDI Editor in the "MIDI Editor" chapter. 

Object Editor 

t-oriented editing. This way you can 
quickly and easily edit each selected object independent of your 

Shortcut:   Ctrl+O 

Use the Object Editor for objec

general settings. 
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Shortcut:  Ctrl + Alt + G 

bjects according to 
channels 

Glue MIDI Objects 

This command lets you glue together two or more subsequent MIDI 
Objects of a track. 

Trim MIDI objects 

This function moves the object borders of a selected object to the 
edges of the current range. For this to occur, the range must be fully 
within the object's borders. 

MIDI bouncing 

All selected MIDI objects are mixed into one object. 

Separate MIDI o

If a MIDI Object contains several channels, you can use this menu 
item to split it up into several MIDI Objects. 

Hint: Please note that the created tracks have to be allocated to the 
corresponding instrument/MIDI device. 

MIDI quantization (Start and length) 

All note on and note off events are quantized in the selected object 
according to the settings. 

Only the start positions of the Note on events are moved in the 

MIDI start quantization 

selected MIDI object. The note lengths remain. 
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e lengths in the selected MIDI object are changed according 
to the quantization settings. 

To be able to adjust the settings for MIDI data, open the track info 
dialog. Here you can set, for example, the playback device for MIDI 
data. 

MIDI length quantization 

The not

Track information 

Please also read the corresponding section in the chapter "Track 
menu". 

Shortcut:  Alt + I 

Track MIDI record 

Activates MIDI record for the selected track. 

VST Instrument Editor 

Software instruments as well as MAGIX synths (e.g. Robota Pro) can 
be integrated into a virtual project and controlled via internal MIDI 
functions and editors. All instruments are seamlessly integrated into 
all effects and routing options. 

Please also read the chapter "MIDI in Samplitude Music Studio 14" in 
the first section of the manual. 

Metronome active 

Activates/deactivated the metronome. This function can also be 
activated via the "Click" button of the transport console. 
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Metronome 

can set a metronome to help keep in time with the beat 
during recordings. You will require soundcard with MIDI functionality 

.

Here you 

and/or an external MIDI instrument to provide the metronome click. 

 

Active during recording: This option allows you to hear the 
metronome click during recording. 

Active while playing: This option allows you to hear the metronome 
click while playing. 

Output device: Selects the device that will provide the metronome 
click (usually the soundcard). 

MIDI Channel: Sets the MIDI channel, through which MIDI commands 
are sent. 
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re you can set the various notes and 
each tact and/or the subsequent tacts. 

s 

MIDI Record Modes 

The MIDI Record modes define how the newly recorded MIDI data is 

e existing Object; the new data is 
mixed with the existing data. If a recording extends over several MIDI 
Objects, then these are combined into one. 

Overdub 

th the existing data. If a recording extends over several MIDI 
Objects, then these are combined into one. 

In Multi-Overdub the new data is also mixed into the existing Objects; 

Replace 
you record over 

several objects, these are combined into a single new object. 

ing audio, existing MIDI objects on the recording 
track are also played in "Playback while recording" mode. This way, 

ssfully ended. 

s off 

DI Options for all 128 notes on all 16 
channels. Furthermore Sustain (Controller 64) is switched off and the 

Tact / Tact velocity: He
velocities for the first beat of 

MIDI Option

Here you can specify which MIDI devices (on page 443) to use in 
Samplitude Music Studio 14. 

inserted into the VIP if there are already MIDI Objects at the recording 
position. 

Normal 
The MIDI data is recorded in th

The MIDI data is recorded in the existing Object; the new data is 
mixed wi

Multi-Overdub 

however, individual Objects remain. 

Replaces the MIDI data of the existing object. If 

Unlike when record

you can choose one of the recording modes even after the recording 
was succe

MIDI Panic � All Note

This command sends a Note Off command to all MIDI devices which 
are not deactivated in the MI

pitch wheel and modulation are set to 0. In addition, an All Notes Off 
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command is sent to all VSTi's used in the project. 

If MIDI tracks or objects exist in the project, the same function is also 
accessible by clicking the stop button in the transport console or 
toolbar when the project is in STOP state. 
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Create CD" function. The options at a glance: 

Load audio CD track(s) 

See File menu (on page 263)!. 

Set Track 

Use this function to set a track marker (Index Marker) on the current 
play cursor position. All markers behind the insertion point will be 
renumbered. 

Each track on your CD needs a track marker, typically set after a 
short pause at the beginning of the next title. 

ers on object edges” to create the 
markers automatically on the borders of the sample objects! 

position. This lets the CD player switch the output to absolute silence 
while continuing playback until to the next track index/marker is 

CD menu 

The CD menu contains all special functions for audio CDs and CD 
mastering processes, e.g. setting CD tracks and subindexes as well 
as the "

Use the function “Track mark

To manage the markers or to rename them use the Marker / CD 
Track Manager in the menu ”Tools”. 

Key:  T 

Set Sub-index 

Use this function to set a sub-index marker on the current play cursor 
position. All sub-index markers behind the insertion point will be 
renumbered. 

Sub indices are not necessary for your CD but useful for selecting 
several regions in one track.. 

Set Pause 

Use this function to set a pause marker on the current play cursor 
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burn. Without the end marker, the CD you want to burn comprises 
d. 

Set Track Markers automatically 

If you are inserting a longer audio-file containing various titles (for 

in s using this function. 

Set Track Indices on Object Edges 

dex Markers) automatically to the 
beginning of each VIP object in the first VIP track. 

 that make up a single track or title, you 

en  

Remove Index 

 small rectangle below the 
number), and then activate this function to delete it! 

encountered. 

Set CD end 

Use this function for setting an end marker for the CD you want to 

the entire project to the project en

example a live-take or recordings on DAT), you can automatically 
sert track-markers between the title

This function sets track markers (In

Prior to using the function, execute Remove All Indices to delete any 
possible track markers. 

If there are multiple objects
may want to use the Bouncing function to combine the objects to 

sure proper track assignments.

Use this function to remove a previously set track or sub-index 
marker. First, click on the marker (the

Remove all Indices 

Use this function to remove all previously set track or sub-index 
markers. This can be helpful before calling the function “Set track 
markers on object edges”! 
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Make CD 

ng process. Samplitude Music Studio 
14 contains high-grade CD creation routines that are constantly 
updated. The software code is licensed from Point Software & 
Systems. 

Samplitude Music Studio 14 creates a TOC (Table of Contents) file 
prior to starting the CD creation. The name of the current VIP is used 
and the extension *.tcx is added to the file. The TOC file is located in 
the same folder as the current VIP. It is therefore important to save 
the VIP to the hard disk prior to starting the burning process. 

The "Make CD" menu in detail: 

This dialog starts the CD writi

 

Burn “On the Fly” 
Use this extremely powerful mode if you want to create the CD 
directly from within the VIP. All necessary calculations are performed 
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orama settings 
• Fades and crossfades 
• Mixing of tracks 

• Mixer Master section effects 

hethe
ed for

Play back the VIP sections s 
and/or where the most rea P 
meter (bottom left-hand). Below are the expected performances at 

• Above 90%: Real-time creation is not possible, use the second 
g) 

Generate a complete new file 
 to sustain the real-

time creation of the CD (see above). This mode calculates all WAV 

l-time processing is also part of the newly 
created audio file. Make sure that you have sufficient hard disk space 

d. This makes 
this procedure non-destructive! 

s you to print the contents information of the current CD. You 
may choose between a text style format to print the production 

rinter for more specific 
information! 

This button opens a text window, which shows the contents of the 
current TOC. The “Copy” function can be used to copy the contents 

in real-time during the burning process. The following real-time tasks 
are calculated during the process: 

• Volume and pan

• Mixer track effects 

To get a good idea w r your system is able to sustain the real-
time processing need  this functionality, try this: 

that contain the largest number of track
l-time effects are used. Watch the DS

the different DSP values: 

• Below 25%: CD creation with up to 4x mode 
• Below 50%: CD creation with up to 2x mode 
• Below 90%: CD creation with up to 1x mode 

mode (Bouncin

Use this option if your system is not fast enough

files, including fades, crossfades, and volume automation into a new 
audio file. Any other rea

prior to starting the process (approx. 700 MB for a complete CD). 

The original WAV files used in the VIP remain unchange

Print TOC 
This starts the external TOC Printer application. This convenient tool 
allow

documentation and a formatted printout for the CD jewel case. 
Please refer to the on-line help for the TOC P

Show TOC 
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ard for use with other text editing applications. 

Show CD-R Drive Information 

ation displayed is the manufacturer, drive name, 
hardware revision, cache size, and the features supported by the 

 

 pressing plants 

currently inserted CD-R 
media. The most important information is the maximum length that 

on (i.e. 74 minutes and 5 

The CD Track dialog shows all CD tracks and sub-indexes used in 

 settings such as Pre-emphasis, Copy 
Protection, and Second Generation Protection Flags can be set for 

ou to use the current 
flags to set all tracks to the chosen settings. Other settings are the 

D and is used in the TOC Printer 
application to print the CD information. 

This code is also written to the CD and can be requested by special 

to the Windows Clipbo

This dialog shows you information about the active CD-R drive(s). 
Among the inform

drive mechanism.

The feature “Disc At Once” is extremely important, since it is needed 
to produce Red Book compatible Audio CDs that are accepted as 
masters by

Show CD-R Disc Information 

This dialog shows information about the 

cannot be exceeded during the producti
seconds). 

CD Track Options 

the current VIP. Every track can be assigned with a name, which is 
also displayed in the VIP. Other

each of the tracks. The button Set All allows y

ISRC Codes for every CD track. 

CD Disc Options 

This dialog configures settings for the current CD.  

CD Title 
The title is written to the C

UPC/Ean Code 

CD players that work with this format. 



 392 CD menu  

Number of first CD Track 

 www.magix.com

Under certain circumstances, such as writing with Track-At-Once, the 

. The CD will always start with track 1 in this mode. 

ditor 

artist etc. 

number of the first track can be determined with this setting. When 
using the Disk-At-Once mode this setting does not have any 
significance

CD Text / MPEG ID3 E

This function allows you to supply data regarding a song or CD 
content – such as album, 

 

MP3 files do not only transport audio data, but also information about 
the coded music piece through so-called “ID3 tags”. These are file 
appendages into which an encoder can write standardized 

The ID3 tags are recognized by the decoders and 

Use this function to set the length of the default pause between two 
nction, which lets 

information. 
displayed as music data by the MP3 player. 

Set Pause Time 

tracks. These pause length is needed for the grid fu
the sample objects snap to the edges of other objects + this pause 
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sed. 

Use this function to set the length of the default pause before the first 
 pause time of 2 seconds is used. 

CD Arrange-Mode 

If you activate this menu feature, Samplitude Music Studio 14 will 
 a Red Book-Standard-Pause 

• Open a new VIP, with 4 tracks for example, so that you may reedit it 

Submit CD to FreeDB 

If you own a CD that’s not in the database, you may add it to the 

• Select “Add CD to FreeDB” 

• Press “OK” 

time. Normally a pause time of 2 seconds is u

Set Start Pause Time 

track. Normally a start

arrange the next objects introducing
between them.  

The following procedure highly recommended: 

later on 
• Activate the Special CD Arrange Mode in the CD Menu 
• Load wave files, audio tracks or make a recording using the 

microphone 

You will notice gaps in the VIP between the individual objects, which 
represent the inserted breaks. You can adjust the length of the 
included pauses in the dialogue ”Adjust Pause Length” if you want. 

FreeDB Options 

Get CD info (FreeDB Internet) 
Calls up FreeDB data for audio CDs. You have to register first before 
using FreeDB. 

Allows you to add a CD to the online CD database. The FreeDB™ 
project relies on user contributions to keep an updated database 
available. 

database.  

• Lay CD in the drive.. 

• Enter data in the dialog. Please double-check your data. 
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 be online after an hour or two 

Clear FreeDB cache 
o your hard disc 

containing all files that can be read online . This allows you to read 
 option allows you to delete the 

cache.  

With this function you can identify audio files. As opposed to the 
 up 

part of an album or CD, it doesn't even have to be a complete 
recording. 

Samplitude Music Studio 14 analyzes parts of a song's typical sound 
r. The 

server then compares this "acoustic fingerprint" with song information 

• Your contribution should

The FreeDB™ online database assigns a cache t

files without having to go online. This

Audio ID 

FreeDB search (on page 393), the audio file doesn't have to make

characteristics and sends this information to an Internet serve

in its database and responds with the track information. 
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Project properties 

Mixer setup 
age 462). Use this to 

set the number of tracks, AUX busses and submix busses as well as 
s. 

Playback Options 
The Play Parameter window that appears after selecting this menu 
option is designed to quickly enter playback parameters. 

Here you can open the dialog Mixer setup (on p

the routing presets for the most frequent use case

 

Sample Rate: The sample rate can be changed here as long as the 
soundcard supports the new rate (some soundcards even support 
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ple!). This is especially useful 
 in a different octave. When 

selecting half the sample rate the pitch should be the same. It would 

 card use this dialog box. 
This is necessary if playback takes place through a single sound card 
device. This is especially important if multiple output devices are 
located in the computer. 

The “Autoscroll” section will let you activate the Autoscroll feature. It 
working with long disk files. The HD Wave 
 the play cursor during playback. When 

working in “2” or “3” section display mode, the autoscroll feature will 
cause the individual sections to follow the play cursor as well. If you 
have zoomed into one of the sections, the play cursor will move 
th in more screen re-draws. 

Yo  and soft scrolling. But be careful: 
Scrolling requires CPU po phics 
ad o that the CPU may be overloaded in critical 
si ay result in playback dropouts. You should then 
de oll mode. 

 Insert key (Insert or 0 on the number 
dio 14 will switch to "Scrubbing Mode". 

This means that the playback speed can be controlled directly by the 
mouse. The further to the right the mouse goes, the faster 
Samplitude Music Studio 14 plays. 

In comparison to many HD recording systems, this even works in a 
vi l m

Use the Scrubbing Mode to find passages, crackling, etc. in material 
– the older generation of sound engineers are, no doubt, very familiar 
w this ting. 

Th g modes (in playback parameter window - key 
p)

R ative distance between the play cursor (positions bar) 
and the mouse position can be used to control the speed. The play 
cu  the mouse. 

Absolute: You can also use the absolute position of the mouse in the 

changing the rate while playing the sam
to hear notes in a sample range played

be played one octave lower. 

Device: To specify the driver of the sound

is especially useful when 
project window will follow

rough the section faster resulting 

u can choose between page
wer (depending on the processor, gra

aptor and resolution), s
tuations which m
activate autoscr

Scrubbing: If you press the
pad), Samplitude Music Stu

rtua ultitrack project. 

ith  method from analog tape edi

ere are two scrubbin
: 

elative: The rel

rsor follows the movement of



 

Options menu 397  

 

www.magix.com

window to control the speed: 

Left border = double speed backwards 

Center = no movement 

R ed forwards 

A  U rolling becomes “softer“ when using 
sm 0, 4000 samples). You may need to test your 
sy

Ti  (4000, 2000 samples) scrolling is 
"s er" this buffer size without 
an

Combined with the Soft Scroll mode, editing becomes very 
convenient on faster computers. 

Media link 

ight border = double spe

Tip sing Scrubbing: The sc
all buffer sizes (200

stem for error free playback with 

p for scrubbing: For buffer sizes
oft .  Test if your computer functions at 
y playback errors. 

 

Nearly all other media files can be linked to Sequoia projects. These 
ca e IDI songs (.MID files), video clips (AVI or MPEG 
fil r which an MCI is installed, practically all formats 
that the ayer can play back. 

“Linked” means that the linked media files are played back 
simultaneously with the Sequoia project and that no synchronization 

fied directly. Sequoia uses the 
Windows Media Player for playback, which merely starts and stops 
the selected file 

n b complete M
es), or other files fo

 Windows Media Pl

occurs. The time position is not veri
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Li ng

M a L undtracks to videos with Sequoia in real 
tim l synchronization hardware. 

In eo work with digital videos directly in the 
original resolution. However, to ensure optimum synchronization and 
a smooth workflow the following procedure is recommended: 

ce material with “MAGIX Move Edit Pro” video 
editing software (included in Sequoia) and export a pilot video of 
small size using a suitable codec which requires low 
decompression expenditure and only contains key frames if 
possible. (DiVX or MPEG are not suitabl ). MAGIX's own MXV 
format is recommended, as this format is optimized for real-time 
pro

2. Lin pply the soundtrack. 
3. Re er track bouncing. 
4. Re ed Wave Project in the video using the 

fun  then save the sound in 
the out requiring recompression 
(me xchanged). More details 
ava ound... 

File Name: Allows you to specify the file name, and source directory 
of the media file. Clicking on the folder button launches a file 
selection dialog that allows you to browse your hard disk(s) and 
specify the media file type. Once you have located the desired media 
file, simply click on OK, and Sequoia will make the link. 

Play always: This button activates synchronized playback. 

Synchronization to Audio playback: Synchronizes the new media 
link (e.g. AVI-Files) with the existing VIP. 

Always reload file before playback: This button specifies whether 
the media file should be reloaded every time before each playback. 
This can make sense, for instance, if you are still editing a MIDI song 
in a simultaneously open MIDI sequencer. You then only have to save 
the file as a MIDI file from the sequencer - Sequoia will automatically 
reload it before it is played back the next time. If the media file is not 
yet complete, this option should not be activated. The file will be 
loaded only once, which particularly makes sense with AVI files: The 
window with the video will then continue to remain open. This lets 
you check the image content that matches each marker precisely. 

nki  Sequoia projects to videos 

edi ink lets you add so
e without requiring additiona

 th ry it is possible to 

1. Digitalize your sour

e

cessing. 
 k the video to Sequoia and a
 move the link again aft
 place or store the finish

ction “Replace audio in video”. You can
 original high-resolution movie with
rely the soundtrack needs to be e
ilable from “File” menu -> Export video s
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Video Options 

io in video: This option can be opened using the 
"Export video sound" function to replace the existing soundtrack in a 
video or create a new video. 

Show current video frames: This option opens a keyframe window 
n without a loss of space in 

the VIP. 

e VIP: This is an especially strong feature of 
a video timeline ca above 

the audio tracks. A movie strip of any chosen size can be inserted, 
 current video position can be perfectly recognized. 

With range and object selections the beginning and the end are 
ely according to the frame. 

hout sound: This option makes Sequoia integrate the 
video without the sound so that the audio can be adopted by 

indow: This option opens th ndow only 
on the Sequoia main screen. This is often more practical than a 
completely independent AVI video. 

output of the graphics card): Video overlay 
 that the graphics card itself takes care of the video display 
e video picture is positioned on top actual windows 
 (overlay). 

omments 
nts to the current t 

can be displayed at each ne ect. 
ation about the project together 

io material. 

 displays various, project specific information such as 
mber of ranges as well as marker changes, and 

Play start is faster. 

Get audio from video: With this button the audio files from an AVI 
file can be extracted and converted into a wave file. This wave file can 
then be edited further in Sequoia in virtual projects. 

Replace aud

that you can freely scale on the scree ny 

Show video track in th
Sequoia. In virtual projects n be displayed 

upon which the

displayed precis

Play video wit

Sequoia. 

Video in Sequoia w e AVI wi

Video Overlay (Video 
means
and th

n
 of the 

scree

Text C
You can enter text comme
editor. This text 

 project via a simple tex
w opening of the proj

This will preserve important inform
with the aud

Project status 
This dialog
name, path, the nu
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time of creation, number of objects count and file size. 

You will also find a list of all audio files used in the project. 

yboard shortcut:  Alt 

See “Menu CD ”! 

ave Edit Mode 
estructi as virtually. Please 
escripti rst chapter of the 

t the desired g method from the list. 

e “Menu View”! 

is menu entry opens the dialog with project-dependent options and 
ormation (on page 461). 

ase refer to menu “Track”! 

n 

ens the Synchronisation dialog (on page 463). Here you can 
ecify whether Samplitude Music S ould operate as 

master or slave, which protocol to use and which interface should be 
 or receive  synchronization data. 

ngs 

VIP Mouse Mode 
s the same functions as the mouse mode bar. 

Please also read the chapter Mouse fu  (on 
). 

se Mode 
You can select between five draw mod cts (HD and 

Ke + I 

CD arrange mode 

Destructive W
Wave projects can be edited d

ding d
vely as well 

n the fialso read the correspon
handbook. You can selec

ons i
editin

Units of Measurement 
Se

Project options 

Th
inf

Track Information 

Ple

Synchronizatio

Op
sp tudio 14 sh

used to send

Program setti

This submenu feature
nctions and mouse modes

page 420

Wave Mou
es for Wave proje
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e projects): 

Please read the chapter "Mouse functions and mouse modes". 

bjects 
ume and Panoram d to the 

 them so that they ca r. This can 
exactly with 

d the object has to be moved. 

e track 
the current track are selected and 

is can be useful when the latter part of a project is 
te and a part further for ing edited. This 
art remains in the front  is moved or if 

 it. 

 works if multiple objects are selected which then have to be 
acks. 

rtcuts and menu
n the dialog for Editing keyboard shortcuts, menu 

ouse functions (on page 4

Change Toolbar style 
You can change the style of the toolbars into 3-D or a flat look. You 

litude Music Studio 14 if you changed the 
toolbar style. 

tool ba
 function can be called by right-clicking on the tool 

ars are customizable. You can customize any toolbar by 
g any command, which is available as a toolbar 

 context-sensitive pop-up help. 

reset several toolbars. 

p setup”! 

RAM Wav

Object mode 
Link curves and o

olIn this mode, V
h

a curves are attach
he

e
objects beneat
be useful if the curves are aligned 

n be moved toget
the audio material of 

the object an

Link all objects in on
In this mode, all objects following 

 together. Thmoved
already comple
way, the latter p

ward is still be
range even if it

something is added to

This also
on several tr

Editing keyboard sho s 
Here you can ope
entries and m 54). 

have to restart Samp

Edit Toolbars 
With this command you open the r editor for the according 
toolbar. The same
bar. All tool b
adding or removin
icon.  

Inside the toolbar editor there is a

Reset Toolbars 
This menu lets you 

Grid Setup 
See “Menu View>Sna
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ay the AVI frames in the VIP window, the height 
 is determined with this .Diese Auswahl ist 

auf den Video-Track zu erreichen.Font Selection 

4 will also let yo  the font used for 
s. 

 select the display font for the Time Display 
lay). 

ion on this can be foun u reference 
 System/options -> "MIDI

in the chapter nu > "Metronome 

Please read the explanations in the "View" menu 

just the foreground and background color for 
in wave projects, the colors of the volume and 
 grid, the oscillograph play. 

ows color selector has its own integrated online 
ccessed with the F1 b tton in the 

entioned function attrib of the user-
 be saved onto a file and

lector dialog to a ith all the 
palettes. With „ fined save 

urrent palette onto a new file which will then 
s in the menu. 

 be specified when P’s. A value 

Video Height 
If the option to displ
of the AVI pictures  setting
auch mit Mausklick 
Font Selection  

Font Selection 
Samplitude Music Studio 1

 object
u specify

text display in the various

Font for Time Display 
This option lets you
(Window->Time Disp

MIDI settings 
Detailed informat d in the men
under Options ->  Options". 

Metronome Options 
Please read more on this MIDI me
Options". 

Display mode 

Color Setup 
Here you can ad
displaying samples 
panorama curve, the and the time dis

Color selector 
The standard Wind
help which can be a
dialog. 

utton or the ? bu

In addition to the m utes, the sets 
defined colors can  reloaded again. 

Right-click in the color se ccess a menu w
saved user-defined color Current user-de
as...“ you can save the c
appear under Color palette

Undo Definitions 
The depth of undo can working with VI
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 last 20 changes can

initions... 
h functions sh rmitted by 

nnot be moved uni his is 
recordings to prevent inadvertent 

e beginn

: Deactivates the volume . 

System/Audio 

 opens the dialog S  
eneral project sett made for 

tudio 14. 

 Y 

of “20” means that the  be undone. 

Object Lock Def
Here you can select whic ould not be pe
locking the objects. 

The choice consists of: 

Moving: The objects ca
especially useful for m

ntentionally (default). T
ulti-track 

offset between each track from th ing. 

Volume Changes handles of the objects

This menu item ystem/Options (on page
438) where most g ings can be 
Samplitude Music S

Keyboard shortcut:
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enu 

Cascade 

anges all open windows in ade style. 

ved next to eac use of the 
whole display area. This is useful when dragging physical sample 

. 

turn/Enter 

rn the window order vious state. 

t + Return 

ns 

anged along the lower p en. 

for hiding or unhiding the Main Toolbar (on
ou will find buttons for

ds. 

e menu item indicates t le. 

ing bar on the lower portion of the 

Window m

This function arr  a casc

Tile 

All open windows are mo h other, making 

ranges into VIP’s

Keys:  Re

Untile 

This function will retu to the pre

Keys:  Shif

Arrange Ico

All icons are rearr ortion of the scre

Main Toolbar 

Please use this command 
page 426). Here y

 
 frequently used Samplitude 

Music Studio 14 comman

A check behind th hat the toolbar is visib

Position bar 

Shows or hides the position
display. 
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se Mode Toolbar 

Shows or hides the mouse mode toolbar with buttons to select 
different mouse modes in VIPs. 

 

range bar on the lower  

ar 

 hides the workspace bar at the bottom part of the screen. 

the button bar at th  screen, 
e 4 buttons Object ransport 

s or hides the status bar on the lower portion of the display. A 
ind the menu point shows that the st isible. 

cated at the bottom of t and describes 
gram. 

Opens the mixer. Please refer to the Mixer chapter! 

M 

Time display 

Shows or hides the time display window 

This lets you read the current position, for example, while externally 
g, at large distances. Font and colors of the display can 

Mou

Range bar

Shows or hides the  portion of the display.

Workspace b

Displays or

Button bar 

Shows or hides e bottom part of the
which includes th Editor, Visualization, T
and Mixer. 

Status bar 

Show
tick beh atus bar is v

The status bar is lo he screen 
the current status of the pro

Mixer 

Key:  

synchronizin
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e context menu (right m  on the time 

In the context menu of the time display the number of lines/fields that 
 can be set between 1 and 5. For each line/field 

the size that is to be displayed can be selected from the menu. 

s you edit the sizes (with the e 
ition and the current mixer value). 

The most important options: 

 Displays the current position of the current 
e beginning of the range. When moving the 

n see the starting position of the object here. Should 
number into the range when editing, the play 
 end of the range. 

Object -> "Object Len umber", 
e range, the end of th e is saved. 

 not editable 

t Mixer Value: Value of the mixer fader/dial that was just 
 or the volume or pan fader in the VIP; not editable. 

tion 

eter is a floating nables you to 
 audio in a variety o

following display options: Peakmeter, 
 correlator, Spectroscope and Spectrogram. 

ettings of the Meter can be adjusted by righ king on the 
lecting the appropriate adjustment. Use the mouse to 

click on setup. A context menu now opens in which you can set the 
value ranges, update speeds, drop times, and colors. You can also 

k values. 

be selected in th ouse-click
display). 

are to be displayed

Double-clicking let exception of th
current mouse pos

Position/Start of range:
play cursor or of th
objects you ca
you enter a negative 

et to thecursor will be s

Range length: in " gth; ne
ang

gative n
instead of the start of th e r

End of the Rang
e 

e: ->End of the Object, negative number -> Start of 
the Rang

Current Mouse Position:

Curren
changed

Visualiza

The Visualization M control which e
meter (measure) the f ways. 

You can choose between the 
Oscilloscope, Phase

The s t clic
Meter and se

reset the pea
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eter: 
Oscilloscope: 

ation: 
Spectroscope: 

ogram: 
Tuner: 

ing” guitars and other string instrum g line 
n the A0 note is played. If deviating ton  

eviation can be read on the basis of the  
umerically indicated pitch is corrected accor

rt Control 

The transport control window contains the most important 
commands for playback, recording, and positioning. 

Start / Stop / Forward / Rewind Buttons: This allows positioning 
similar to that of a tape machine. 

Right-clicking the Playback button opens the Playback Parameter 
window for the stereo master operation. This lets you determine the 
sample rate, playback device, and the Scrubbing/Varipitch options. 

Record button: Starts the recording for all active tracks. This means 
that tracks with the red REC button enabled need to be configured 
with the proper recording devices prior to starting the recording. 
Right-click on the REC button for each track to select the device. 

Right-clicking the Record button displays the Record Parameter 
window. This lets you make settings such as ‘Playback during 
recording’ and also lets you record material directly from the Record 
Parameter window. 

Time Display: This displays the current playback position of the 
project. Double-clicking on the window lets you numerically enter a 
new playback position. Clicking the green arrow lets you set various 
units of measurement. 

L/R Time Display: This displays the length of a selected range and is 
editable by double clicking the display. 

Marker Buttons 1-12: Clicking on one of the marker buttons saves 
the current playback position to the button. If it already contains a 
previously saved position (marker appears in light color), the program 
will place the playback position to the saved position. A right click 

Peakm

Phase Correl

Spectr

For “tun
appears whe

ents. A calibratin
es are played, the

d
n

calibration line and the
dingly. 

Transpo
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u to store a new position to 

utton switch Samplitude Music Studio 14 into 
punch record mode. This means that the recording process can be 
started any time during playback. This is also called ‘On-The-Fly 

repeated numerous times. Punch In and Out 
markers are set automatically. You can stop a punch in recording 

ck of the project. 

: This sets the punch in position. 

position. If the both the 
the punch recording can be 

yback button. The program will play back the 
eaches the punch in point. 

on opens the Synchronization window. 

Loop Button: The loop button activates the Loop mode, meaning 

 the peak meters. The inputs of the audio 
device(s) are directly routed to the outputs of the soundcard, if the 

with your soundcard 
manufacturer). This offers the same functionality as with real tape 
machines. 

ct continues with varying 
speed while the playback direction can be changed. This also offers a 

digital system it is more difficult to realize scrubbing as there are no 
mechanical moving parts.Turning the tape reels manually moves the 

clears the button memory and allows yo
the button. 

Marker Button: This button open the Marker Manager for more 
detailed Marker editing. 

Punch Button: This b

Recording’. This can be 

process with another click on the Record button. However, this does 
not stop the playba

Punch In Button

Punch Out Button: This sets the punch out 
punch in and punch out markers are set, 
started with the Pla
project until it r

Sync Button: This butt

that playback continues to loop through a previously selected range. 

RCMON Button: This button activates the Record Monitoring feature 
of Samplitude Music Studio 14. All tracks that have their REC buttons 
activated are monitored with

soundcard offers this functionality (check 

Scrub >>  <<: These buttons allow you to scrub through your project. 
During scrubbing the playback of the proje

convenient way of finding audio sections such as clicks or mistakes in 
the audio material. 

Jog & Shuttle Wheel: The transport control includes a Jog & Shuttle 
wheel which you can use to "scrub" over the files. The Scrubbing 
function behaves like the editing function of a tape player. The motor 
is switched off, the tape, however, remains at the sound head. With a 
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nction in 
Samplitude Music Studio 14 is similar to using a tape player as 

the mouse.  Quickly moving the 
ses the playback speed, while slowly moving it 

decreases the speed accordingly. 

ching. 

p Tempo..." opens a dialog where you can "tap in" the 
y clicking on the "Tap" button or by pressing the "T" key on 

your keyboard. 

id with the „SNAP“ button and 
switch on the metronome click with the „CLICK“ button. 

tape slowly along the tape head. Using the scrubbing fu

playback follows the movement of 
mouse increa

Tempo: In the tempo section of the transport console you can 
change the playback speed and the beat of the whole arrangement. 
All objects in the VIP are adapted to the speed of your choice with 
timestret

The item "Ta
beat b

In addition, you can fade in the bar gr

Manager 

Please also read the corresponding chapter The Managers (on page 
242). 

Close all Windows 

C
Sa
sa

loses all opened projects. Before closing a window/project, 
mplitude Music Studio 14 will ask you whether you would like to 
ve the project. 

Taste:  Taste:   h 

Iconise all waveprojects 

ill reduce all Wave projects to their icons to make 
room for the display of the virtual projects. 

This function will hide all Wave projects to make room for the display 

This function w

Hide all wave projects 
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Half Height 

The Samplitude Music Studio 14 screen is shown in the upper half of 

This is particularly useful if you want to simultaneously use a 

olution and short video explanations 
on how to perform tasks in different topics. Not only will you find 

 
tutorial video which displays solution. Entries without camera symbols 

MAGIX Online Services 

The perfect place to discuss everything to do with photography with 

of the virtual projects. 

the display. 

sequencer program so that both programs are operated 
simultaneously, without having to switch between programs with the 
Alt + Tab key. 

Jobs menu 

In this menu you will find direct s

step-by-step instructions for sound and pictures here, you also find 
quick access to lots of functions.  

If you click on an entry with a camera symbol, you will open a short

solve the problem immediately. 

@Services menu 

With MAGIX Online Services MAGIX offers a row of interesting new 
services for your photos, videos and music. Link up Samplitude 
Music Studio 14 to Services and enrich your projects with a whole 
world of multimedia. 

You can read more on this topic at the iPACE Online Services center. 

MAGIX Community 

friends and the world, the MAGIX Community. 

• Upload photos, comment on them, and have them rated by other 
users. 
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 & guestbook. 
• Create your own photo groups & make friends. 

eb! 

ews: Share your thoughts, experiences, and news 

nd enter their 
comments! 

Advantage: With MAGIX you can manage multiple blogs per account. 
A free MAGIX Online Album belongs to the MAGIX Blog Service so 
that you always have full control over your comments. 

Make podcast 

Podcast is the name for a relatively new Internet transfer form. It is 
made up of "pod" from "iPod", the name of a popular portable MP3 
player, and the term "casting" for broadcasting content to a wide 
group of listeners/viewers. 

A podcast is therefore something like an online radio station. 
"Broadcasting" webradio stations means you can only listen to and 
record the currently broadcast radio station. Podcasting is different. 
You as the listener can subscribe to the podcast and the files will be 
downloaded at a specific time and you can listen to them whenever 
you like, for example, on the move with your portable player. The 
shows are pre-produced and placed on an Internet server for 
download.  

Select the "Upload arrangement as podcast show (audio)" in the 
@Services > MAGIX Podcast Service menu and the exciting journey 
of your podcast to the pages of the largest podcast providers begins.

st stop is your personal MAGIX Online Album, the place your 
podcast will call its online home. From here it can be accessed from 

• Create your own profile

As soon as you have registered for free, you can use all the features. 
Have fun with your pictures on the w

MAGIX Blog Service 

YOU make the n
with a worldwide audience in no time with your own interactive online 
journal. With professional templates & 100% unique design, including 
photos, videos, and music – no previous design know-how required. 
Invite family, friends, and acquaintances to join in a

 

The fir

anywhere in the world. Login with your password or register.  
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Your free MAGIX Online Album with 128 MB webspace can be set up 
at any time. It will then be available to you from anywhere in the 
world.  

When uploaded via the "Make podcast" button the podcast will be 
sent to your personal MAGIX Online Album. In the MAGIX Online 
Media Manager of your MAGIX Online Album the cast can now be 
found in its new format in the newly created folder "My podcasts".  

 

Now take a look at your album website: Here you can listen to the 
cast on your own website. You will immediately notice the small 

 RSS feed" which allows any user of your MAGIX 
Online Album to automatically receive podcasts now and in future. 
button "Subscribe to

 

How is your podcast distributed? 
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eed - the technology behind a podcast - will automatically 
guarantee that your podcast will be sent from your MAGIX Online 
Album to many large podcatchers, including MAGIX Podcast Service. 
Here your podcast can now be subscribed to by a worldwide 
audience. Currently, a podcast created with Samplitude Music Studio 
14 and uploaded to MAGIX Online Album is sent to 10-20 
international podcatchers. The distribution depends on the topic of 
the podcast. 

You may even find your podcast via a search engine without knowing 
how long the journey of a cast over the web may be. 

With Make podcast you can publish your project as a track on your 
podcast. 

for y

Your RSS f

The Export podcast dialog now opens. Here the required information 
our podcast track has to be entered. 

 

Title: This is the title of your podcast. A podcast typically contains 
nd new ones are added regularly. This is not where 

he project is encoded as an MP3 and then 
uploaded to the MAGIX Online Album. You can only upload one 

several tracks, a
you enter the name of the podcast to which the track belongs. You 
can enter the name when you upload to MAGIX Online Album. A 
podcast then corresponds to an album.   

Export podcast: T
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ther listeners will find your podcast. 

that you 
can be contacted. 

contribution at a time (one file). 

Description: It is important to enter a unique name and description 
so that o

Person responsible: Here you enter your email address so 
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H

ca
by

Context Help 

p about any part of Samplitude Music 
 By pressing the Context Help button in the top tool bar 

ill become an arrow with a question mark. Then 
enu in one of the tool bars. Information about 

isplayed. 

and for getting information about the online help 

itude Music Studio 14 

Tip of the day 

 get the tip of the day and to display the start 

 required in the Samplitude Music Studio 

A window is displayed, containing information about the memory 
rameters. 

Particularly useful is the display of the free storage on all connected 

Help menu 

elp Index 

Use this command to show the index of the help. From this page you 
n jump to specific commands or read through the instructions step 
 step. 

Use this command, to get hel
Studio 14.
the mouse indicator w
click on any button or m
this topic will then be d

About Help 

Use this comm
system. 

About Sampl

Copyright notices and version numbers are displayed. 

Start selection / 

Use this command to
selection window. 

For tips, the file >tips.txt< is
14 folder. 

System Information 

status and other pa
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esources utilized by Samplitude Music 
Studio 14 and the memory usage. Make sure the parameter for 

sed by Samplitude Music Studio 14 never grows 
larger than the displayed overall system memory available (physical 

e performance of Samplitude Music Studio 
e swapping (virtual memory) done to 

compensate for the missing memory. 

Automatically searches the Internet for up-dates to Samplitude Music 
An Internet connection must first be provided for this 

er activation 

For importing (decoding) or exporting (encoding) specific audio and 
mats you require a suitable codec for importing or exporting 

not including 
them in our programs in general, MAGIX will in future also be able to 

disk drives, the used system r

system memory u

RAM). If this happens, th
14 is reduced caused by pag

MAGIX Auto-Update 

Studio 14. 
purpose. 

 Encod

Why activate? 

video for
such formats. Integrating third party de- and encoders usually incurs 
costs. By offering you such costs as an option and 

offer to you our software at good value for money. 
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Activation is fee-based and can be done online or via post/fax. The 

kes just a few minutes via 
email. The order of your activation code via post/fax takes a few 

quickest and easiest way to order an activation code is via the 
Internet. Ordering the activation code ta

days.  

 

This is how activation works: 

Order activation code online 
Click on "Order online..." (Field 1). Your web browser will open where 
you can register your Samplitude Music Studio 14 first (if you have 
not already done so). You will then be forwarded to a website where 
you can request the corresponding activation to be carried out. 

Order activation code via post/fax 

to the post/fax form. Now send the completed form as 
a print out to the address/fax no. mentioned. Once payment has 

vation code 
After receiving your personal activation code you can use the 

After clicking on "Order via post/fax" (field 2) your user code will 
appear. This automatically assigns your personal activation code to 
your PC. Click on "Continue to order form" to transfer your user code 
automatically 

been processed successfully, your activation code will be sent to you 
in the post/via fax in just a few days. Optionally it can also be sent by 
mail if an email address is stated.  

Enter acti

"...activate" option in the "Help" menu to open the activation dialog 
for the corresponding file format. Copy the activation code from your 
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The MAGIX website won't open 

l-up. 

 you may have to use manual dial-up. 

dequate text editing program is installed and 
activated (for example, MS Word). 

ation code 

that we can 
assist you as quickly and as specifically as possible. 

lp" menu) 
• Encoder/Decoder name 
Your user code (accessible via the "Activate via post/fax" dialog) 

I installed my MAGIX program onto my new computer or built a new 
hard disk (sound card, memory...) into my old computer. Now my 
activation code is no longer accepted. 

Activation is linked to a specific computer. Changes to the 
computer's hardware, for example, integrating a larger hard disk can 
lead to the computer no longer being recognized as the one for 
which the activation code has been calculated. This will most likely 
happen if you install Samplitude Music Studio 14 on a new computer. 
If this is the case, simply request a new activation code. Since you're 
already registered as a MAGIX customer, you won't have to pay for 
another activation. 

Online: When registering on the MAGIX website use your existing 

email into the input field in the dialog and click on "Activate...".  

Possible problems and their solutions 

Check your Internet connection, you may have to use manual dia

The MAGIX website won't open 

Check your Internet connection,

The form for post/fax ordering won't open 

• Check that an a

I still haven't received an email with the activ

• Check that your inbox isn't full. 
• Have a look in your spam folder. 

You can always send questions via email to our support whenever 
you like. Please have the following information at hand so 

• Complete product name 
• Exact version number (to be found in the about box in the "About" 

menu item of the "He
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 Post/Fax: Print out the order form again and send it to the 
addressee/fax number stated. 

MAGIX login details. 
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the VIP. More mouse functions 
are available for the left mouse button. 

r half of the track: 
• Stretch and move ranges (with Shift) 

cking on a range 

 objects (or group of objects.) 

ts, including all objects 
between the two clicks. 

ct, you can sketch a rectangle with the 
mouse button pressed down by dragging the mouse the right. All 

sso function). 

Objects (or a group of objects) are moved if you click into their lower 

 or object groups up or down the 
track list without changing the time position.  

Mouse functions and mouse 
modes 

Universal Mode 

Right Mouse Button: Displays context sensitive pop-up menu. 
Left Mouse Button: In universal mode a distinction is made 

between the upper and lower half of a 
track in 

 

Mouse functions for the uppe

•  Set the start position of the play cursor by clicking next to the object 
• Reduce the horizontal zoom level by double-clicking next to a range 
• Increase of the horizontal zoom level by cli

Select Objects 
Single click selects

Single click + Ctrl selects multiple single objects. 

Single click + Shift selects multiple objec

If you click left next to an obje

objects contained therein are selected (la

Moving Objects 

half and drag them to the desired position while holding the mouse 
key. 

Dragging + Shift moves objects

Dragging + key ‘k’ move the object under the mouse pointer, plus all 
objects behind on the same track. 
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jects 
Dragging + Ctrl duplicates one or more objects. To do this you also 

Object lasso: If you click left next to an object in the lower half of the 
pressed 

down by dragging the mouse the right. All included objects are 

Volume and panorama lasso: If you click left next to an object in the 

. 

P. 

t 
the volume and stereo panorama curves of the tracks. Movable 

s ar ted on the curve. 

Double-clicking on the automation curve creates a new curve event. 
Another double click on the same curve event deletes the event. 
Selected handles can also be deleted by selecting "Delete Curve 
Handles" from the Edit menu. 

A volume or panorama handle is selected simply by clicking. Several 
handles are selected by holding the Ctrl key while clicking. 

If you click right next to an object, you can sketch a rectangle with 
the mouse button pressed down by dragging the mouse the right. All 

Duplicating Ob

have to click the lower half of the object. 

Dragging + Shift + Ctrl duplicates one or more objects, while allowing 
the objects to be moved up or down the track list without changing 
the time position. 

Lasso Function 

track, you can sketch a rectangle with the mouse button 

selected. 

lower half of the track, you can sketch a rectangle with the mouse 
button pressed down by dragging the mouse the right. All contained 
volume and panorama points are selected. 

Volume and length of individual objects 
You can individually adjust the volume and length with the five object 
handles

Object Handles: The upper handle changes the object volume. The 
changed level is shown in dB in the upper left-hand corner of the VI

Side handles: Fade-in oder fade-out. The fade curves used here can 
be set in the Crossfade Editor. 

Lower handle: Adjusts the length of an object. 

Volume and Panorama Automation Curves 
The volume and panorama curves can be used to graphically adjus

handle point e crea
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contained volume and panorama points are selected (lasso function). 

Selected volume and panorama points can be moved with the 

mode 

This mode differs to the universal mode only in as much that the track 
is not split in two halves. 

er 
functions are handled by the universal mode (only, one needs to work 

The curves/object mode is less complicated to use and is therefore a 

 context sensitive pop-up menu. 

tton: Range: Selecting ranges and moving ranges 

icking and dragging the 
mouse pointer while holding the mouse button. 

The "Range mode" is a saved mode as objects or curves can not be 

Play Cursor 
 sets the play cursor anywhere in the track. 

Double click outside of a selected range (or no range) zooms out. 

 object mode, 

mouse. To move several points, you have to hold the Ctrl key while 
dragging. 

Curves/Object 

Play-cursor, fields and zooming are not set in the upper part of the 
track, but rather in the beat line above the first track. All oth

with split tracks). 

default setting. 

Range Mode (Secure Mode) 

Right Mouse Button: Displays

Left Mouse Bu
(with Shift key). Objects or automation  curves cannot be changed by 
accident (therefore called ‘Secure Mode’).  

Create ranges 
In Range mode, ranges are sketched by cl

moved accidentally. 

Single click

Zoom 

Double click inside a selected range zooms in.  

Quick switch to other mouse modes 
Using the ‘.’ (Period key) temporarily switches to the
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Volume and Panorama rubber band 
 the track near by an object, you can, by pulling 

A double click on the volume or panorama curve creates a new 
 it. Selected handles may 

also be cleared by selecting the option ”clear handles” in menu ”edit”. 

ou 
will select further handles by holding the Ctrl key while clicking. 

 track on the right besides an object, you can 
spread a rectangle with the mouse key kept depressed. This will 
select all volume and panorama points contained within (rubber band 

a handles with the 
mouse. To move several handles the Ctrl key must be kept 

C

Le

which allows moving of objects.  

Using the ‘-‘ (Minus key) temporarily switches to the curve mode, 
which allows moving and manipulating of automation curve events. 

Curve Mode 

Right Mouse Button: Context menu 

Left Mouse Button: The left mouse key offers following functions: 

When you click into
the mouse to the left or right, spread a rectangle with the mouse key 
kept depressed. This will select all volume and panorama points 
contained within. 

Volume and Panorama gradients for the whole track 
By means of the panorama and volume curves, volume and stereo 
panorama graduations can be graphically recorded. For this purpose 
sizing handles, which are moved are created on the curve. 

handle, and a further double click will clear

You may select a volume or panorama handle by a single click. Y

When you click into the

function). 

You may move selected volume and panoram

depressed while pulling. 

ut Mode 

Right Mouse Button: Context menu 

ft Mouse Button: You can use the mouse cursor like a pair of 
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sc

P

st
is t simply in a different 

U

D

R

ation curves into VIP tracks. 

dr

Draw Panorama Mode 

Righ n: Displays context sensitive pop-up menu. 

The ‘P’ button for a respective track needs to be active prior to 

Mode (only wave projects) 

Left Mouse Button: Free-hand drawing function for the wave format.  

Scrub Mouse Mode 

Right Mouse button: Context menu 

Left Mouse button: Scrub function. Click  into project: Pre-listen with 
control over play tempo. The project will be played forward and back 

issors to crop objects. 

itch-shift/Time stretch Mode 

Right Mouse Button: Context menu 

Left Mouse Button:The lower right tab allows compression or 
retching of an object. A time stretching effect is created: The object 
 not played as a loop or shorter version, bu

play tempo. 

sing the center tab, the pitch can be altered using pitch shifting. 

raw Volume Mode 

ight Mouse Button: Displays context sensitive pop-up menu. 

Left Mouse Button: Draws volume autom
The ‘V’ button for a respective track needs to be active prior to 

awing the volume curve. 

t Mouse Butto

Left Mouse Button: Draws volume automation curves into VIP tracks. 

drawing the panorama curve. 

Wave Edit 

Right Mouse Button: Context menu 
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y 
cursor position. The larger the distance the faster the play tempo. 
You can set 3 individual scrub modes in the play parameter window . 

Zoom Modus 

Right Mouse Button: Zooms out of the project 

Left Mouse Button: Zooms into the project 

controlled by the distance of the mouse pointer from the actual pla
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Button Overview 

When the program is first started, only the tools and mouse mode 
bars are opened in the upper right corner of the monitor. All further 
ones may be added via menu ”windows”. 

All toolbars may be placed on the screen at discretion, and they are 
automatically arranged in the upper part of the screen by a double 
click onto the header line. 

Tools bar (left) 

 

1 New multi-track project  
2 Oen VIP 
3 Open Audio file  
4 Export/Store project 
5 Save Project 
6 Cut 
7 Copy 
8 Insert 

Tools bar (right) 

 

1 Set Marker 
2 Set Track Index   
3 Set Sub Index  
4 Set Pause  
5 Set CD End   
6 Set indexes at object borders 
7 Make CD   
8 Play Once 
9 Play Loop 
10 Play into Range 
11 Stop 
12 Record Options  
13 Multi-I/O-Recording 
14 Mixer  
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Mouse mode bar 

 

1 Universal mode 
2 Range mode 
3 Curve mode 
4 Object and curve mode 

9 Draw wave mode (wave projects only) 
9 Scrubbing mouse mode 
10 Zoom mode 

5 Cut mode 
6 Pitchshift/Timestrech mode 
7 Draw Volume mode 
8 Draw panorama mode 

Positioning bar (left) 
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1 Cropping at start 

4 Half cropping to right 

7 Object edge left  

11 Zoom in  

14 Range as clipping 

2 Cropping to left 
3 Half cropping to left 

5 Cropping to right  
6 Cropping at end 

8 Object edge right 
9 Range to last marker  
10 Range to next marker  

12 Zoom out  
13 Zoom all 

15 1 Pixel = 1 Sample 
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Positioning Bar (right) 

 

1 Zooming range 1 sec, 10 sec, 60 sec or 10 min 
2 free definable zoom sections 
3 Zoom in vertically 
4 Zoom out vertically 
5 Zoom all vertically 
6 Range as vertical clipping 
7 Zoom in Waveform 
8 Zoom out Waveform 

Range bar 

 www.magix.com

 

1 Play cursor to start of range 
2 Play cursor to end of range 
3 Fold range to the left 
4 Fold range to the right 
5 Range start to previous zero crossing 
6 Range start to next zero crossing 
7 Range end to previous zero crossing 
8 Range end to next zero crossingg 
9 Range editor 
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shortcuts Preset keyboard 

Hint: You can create, change and remove your own keyboard 
shortcuts in the menu Options > Program settings > Edit keyboard 
shortcuts and menus. Click on the "All" button to open an overview of 
all shortcuts defined in the menu. Shortcuts in brackets (<>) cannot 
be changed. 

File menu 

New Virtual Project (VIP)... E

Open 
Virtual Project  (*.vip)... O 
HD Wave Project (*.hdp)...  Umschalt + L 

Load / Import 

Load audio file W 

Strg + S 

 

C / Ctrl + C / Ctrl + Ins
Paste from clip V / Ctrl + V / Shift + 

 

Audio importieren... Ctrl + I 
MIDI (*.mid)... Umschalt + M 

Speichern 
Speichern unter... Umschalt + S 
Export audio (WAV) Ctrl + E

 

Edit menu 

Undo Ctrl + Z 
Redo Ctrl + Y 
Cut X 
Delete Del 
Copy 

Ins 
More 
Set Silence Alt + Del 
Copy + Silence Ctrl + Alt + C  
Copy as... Shift + C 
Overwrite with Clip Alt + V / Ins 
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View menu 

1 Shift + B 
Page down 

ion Page up 

Ctrl + ´ 

VIP Display mode > Definition Shift + Tab 
Modus 1/2 Umschalten Tab 

1 Ctrl + Numeric '1' 
'2' 

3 Ctrl + Numeric '3' 

Ctrl + Numeric '4' 
2 Ctrl + Numeric '5' 
3 Ctrl + Numeric '6' 

Get position and zoom factor 
1 Numeric '1' 
2 Numeric '2' 
3 Numeric '3' 

Get zoom factor 
1 Numeric '4 
'2 Numeric '5' 
3 Numeric '6' 

Horizontal 
Half section left Ctrl + Alt + Cursor left 
Half section right Ctrl + Alt + Cursor right 
Section to play cursor Ctrl + Alt +  ,  
Section to range start Alt + Home,  

Cursor up,  

Sections 

Activate next section 
Activate previous sect

Grid ´ 
Snap to grid 

Store position and zoom factor 

2 Ctrl + Numeric 

Store zoom factor 
1 

Ctrl + Shift + Page up 
Section to range end Alt + End,  

Ctrl + Shift + Page down 
Zoom in 

Ctrl + Cursor right 
Zoom out Cursor down,  

Ctrl + Cursor left 
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tion up Shift + Cursor up 

 

Ctrl + Alt + M 

Edit Pan Ctrl + Shift + P 

Object menu 

T 

rl + Alt + G 

Ctrl + 1 

Show all Ctrl + Alt + Cursor up 
Zoom to range Ctrl + Alt + Cursor down 

Vertical 
Half sec

Half section down Shift + Cursor down 
Zoom out wave Ctrl + Cursor down 
Zoom in wave Ctrl + Cursor up 

Track menu 

Track properties 
Mute Alt + M 
Mute / Inactive 
Solo Alt + S 
Solo exclusive Ctrl + Alt + S 
Record Alt + R 
Monitoring Ctrl + Alt + Shift + F 
Lock Alt + L 
Volume curve active Alt + K 
Pan curve active Alt + P 
Edit volume Ctrl + Shift + K 

 

Cut objects 
Duplicate and move Ctrl + D 
Separate with alternative crossfade Shift + T 
Separate objects 
Trim objects Ctrl + T 
Undo object split Ctrl + Alt + T 
Glue objects Ct

Move/edit objects/crossfade 
Object step size 1 
(left) Object to left 
Right object to left Alt + 1 
(left) Object to right Ctrl + 2 
right Object to right Alt + 2 
Object(s) to left Ctrl + Alt + 1 
Object(s) to right Ctrl + Alt + 2 
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 to left Ctrl + 3 
Object start to right Ctrl + 4 

Ctrl + Alt + 3 

ffset to right Ctrl + 6 

Ctrl + 7 

right volume Alt + 7 
Increase volume Ctrl + Alt + 8 

nt to right Ctrl + 0 
right object content to left Alt + 9 

(left) Object to left Ctrl + Shift + 1 

ht Alt + Shift + 2 

Ctrl + Shift + 4 

t Ctrl + Shift + 6 
Object end offset to left Alt + Shift + 5 

Object start

Object end to left Alt + 3 
Object end to right Alt + 4 
Crossfade to left 
Crossfade to right Ctrl + Alt + 4 
Object start offset to left Ctrl + 5 
Object start o
Object end offset to left Alt + 5 
Object end offset to right Alt + 6 
Increase left volume Ctrl + 8 
Reduce left volume 
Increase right volume Alt + 8 
Reduce 

Reduce volume Ctrl + Alt + 7 
(left) object content to left Ctrl + 9 
(left) object conte

right object content to right Alt + 0 
Object content to left Ctrl + Alt + 9 
Object content to right Ctrl + Alt + 0 

Object step size 2 

Right object to left Alt + Shift + 1 
(left) Object to right Ctrl + Shift + 2 
right Object to rig
Object(s) to left Ctrl + Alt + Shift + 1 
Object(s) to right Ctrl + Alt + Shift + 2 
Object start to left Ctrl + Shift + 3 
Object start to right 
Object end to left Alt + Shift + 3 
Object end to right Alt + Shift + 4 
Crossfade to left Ctrl + Alt + Shift + 3 
Crossfade to right Ctrl + Alt + Shift + 4 
Object start offset to left Ctrl + Shift + 5 
Object start offset to righ

Object end offset to right Alt + Shift + 6 
Increase left volume Ctrl + Shift + 8 
Reduce left volume Ctrl + Shift + 7 
Increase right volume Alt + Shift + 8 
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Ctrl + Alt + Shift + 7 

Ctrl + Alt + Shift + 9 
nt t Ctrl + Alt + Shift + 0 
sition o  marker Ctrl + Alt + P 

Object to original position Ctrl + Alt + O 
Ctrl + Alt + Shift + A 

Mute objects Ctrl + M 
Create looped object Ctrl + L 

Select all objects Ctrl + A 

bject < / Ctrl + Alt + Q 
Object lasso Ctrl + Alt + L 

anager Ctrl + Shift + O 

s menu 

Reduce right volume Alt + Shift + 7 
Increase volume Ctrl + Alt + Shift + 8 
Reduce volume 
(left) object content to left Ctrl + Shift + 9 
(left) object content to right Ctrl + Shift + 0 
right object content to left Alt + Shift + 9 
right object content to right Alt + Shift + 0 
Object content to left 
Object conte to righ
Object to po f play

Arrange objects 

Select objects 

Unselect all objects Ctrl + Shift + A 
Select next object > / Ctrl + Alt +W 
Select previous o

Build group Ctrl + G 
Ungroup Ctrl + U 
Object name Ctrl + N 
Object editor Ctrl + O 
Object m
Take Manager Ctrl + Alt + Shift + T 

 

Realtime effect

Elastic Audio  Ctrl+Shift+E 

 

Offline effects menu 

Normalize... Shift+N 
Normalize (quick access) N 
Manual declicker Ctrl + Shift + D 
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Range menu 

Arrow right 
Move right in scroll mode Alt + arrow right 

F 2 / Alt + Q 
Marker right F 3 / Alt + W 

Range start to right Alt + '*' 
Range end to left Shift + arrow left / Alt + '-' 
Range end to right Alt + '+' / Shift + Arrow right 

d -> 0 Ctrl + Page Up 

B 

Ctrl + F2-F10 

Set marker to record position Alt + ? 

ad 1 
Box 2 Alt + Numpad 2 

Select all as range A 

Move play markers 
Marker at start Home 
Set marker at end End 
Move left in side mode Arrow left 
Move left in scroll mode Alt + arrow left 
Move right in side mode 

Object edge left Ctrl + Q 
Object edge right Ctrl + W 
Track marker left 

Manipulate range 
Range start to left Alt + '/' 

Fold range to left Ctrl + Shift + Arrow right 
Fold range to right Ctrl + Shift + Arrow right 
Range start -> 0 Ctrl + Page Up 
Range start <- 0 Shift + Page Up 
Range en
Range end <- 0 Shift + Page Down 
Set range start to left marker Shift+F2 
Set range start to right marker Shift+F3 
Split range 
Remember range Alt + F2 - F10 (exception: Alt 

+ F4 and F9) 
Other... Alt + F11 
Get range 
Get range length Ctrl + Shift + F2-F10 
Save marker Shift + 0-9 
Marker with name... ? 
Marker with automatic numbering Shift + # 

Get marker 1 - 9, 0 
Restore previous range Shift + Backspace 
Box 1 Alt + Nump
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Alt + Numpad 4 
Box 5 Alt + Numpad 5 

CD/DVD menu 

ll indexes Ctrl + Alt + Shift + I 
CD Index Manager Ctrl + Alt + Shift + D 

Manager 

Ctrl + Shift + O 

d objects Ctrl + Space 

eft 

Scrubbing right Alt + Shift + Arrow right 

Recording R 

Box 3 Alt + Numpad 3 
Box 4 

 

Set track index Ctrl + Alt +I 
Remove a

 

Tools menu 

File Browser Ctrl + Shift + B 
Object manager 
Track manager Ctrl + Shift + S 
Marker manager Ctrl + Alt + Shift + M 
Range manager Ctrl + Alt + Shift + B 
Take Manager Ctrl + Alt + Shift + T 

 

Playback menu 

Play Space bar 
Replay Space bar 
Play with preload Shift + Space 
Play in range/loop Shift + P 
Only play selecte

Stop and jump to  
current position Number block ',' 
Playback parameters P 

Playback mode 
Auto scroll Scroll Lock 
Soft autoscroll Shift + Scroll 
Scrubbin activated Alt + Shift + Arrow down 

Scrubbing left Alt + Shift + Arrow l
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.. Shift + R 
Alt + Shift + M 

 

MIDI menu 

O
Glue MIDI objects Ctrl + Alt + G 
Track information Alt + I 
MIDI Controllers Ctrl + Alt + A 
 

Options menu 

Project properties 
M
P
P
Project options Ctrl + Shift + #/I 
Track information... Alt + I 
Synchronization active 
S
D
S
 

Window menu 

Tiled Return 
Restore Shift 
Mixer M 
Time display Ctrl + Shift + Z 
V
T
C

 

H

Help F1 
C

 

M

Middle-click Play 

Record options.
Input monitoring 

bject editor Ctrl + O 

ixer setup... Ctrl + Shift + M 
layback parameters P 
roject status Shift + I 

G 
ynchronization settings... Shift + G 
isplay options Shift + Tab 
ystem Y 

(Enter) 
+ Backspace 

isualization Ctrl + Alt + Shift + V 
ransport console Ctrl + Shift + T 
lose all windows Ctrl + H 

elp menu 

ontext help Shift+F 1 

ouse 

Start/Stop 
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Wheel Horizontal 

S

+

+

 

+

 

scrolling 

hift+Wheel You can fine-adjust 
active buttons/faders 

 Ctrl Horizontal zooming 

 Shift: Vertical zooming 

(Increase/reduce wave 
shape size) 

 Ctrl+Shift vertical scrolling in 
VIPs (tracks) 
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G

Y
s

K

System/Audio 

I
M

I

•
•
•
•
•
•
•

eneral settings 

ou can access the project-independent Samplitude Music Studio 14 
ettings this way. These settings are also global. 

eyboard shortcut: Y 

n the “System” menu, you have options to fine-tune Samplitude 
usic Studio 14.  

n detail this is: 

 Audio playback settings (Playback Devices) 
 Audio record settings (Record Devices) 
 Program Options 
 Paths/Skins 
 View options 
 Color setup (colors) 
 Metronome settings (MIDI options) 

Most of the dialogs can also be activated separately via the different 
menus and are explained at a the corresponding position. In the 
following you can find the explanations on system settings directly via 
the "System/Audio" dialog. 
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Playback Devices (audio playback settings) 

 

Device Resolution / Device Communication 

H
a
i
r
a
I
(
p

ere you can specify the bit resolution for communicating with the 
udio driver for recording and playback. Usually, resolution selection 

s automatic. If the output device is not able to display at the desired 
esolution (e.g. 24 bit), an appropriate lower solution will be dithered 
utomatically by Samplitude Music Studio 14 and sent to the driver. 

n certain circumstances, e.g. if the driver triggers error messages 
because it registers certain resolutions but can not actually 
lay/record them), you can force 16 bit driver address here. 

Driver system 

You have the choice between MME, multi-channel MME, and ASIO. 
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M
s
p
d

ME is the standard Windows multimedia driver system. If your 
ound card supports 24/32-bit audio playback, but still experiences 
roblems when playing high-resolution audio files, try using these 
rivers. 

ASIO 

H
s

owever, if your sound card model uses ASIO drivers, you have 
ome distinct advantages over MME: 

MAGIX LoLa is supplied with the program. This is a universal ASIO 
driver that can be used for many sound cards that do not have their 
own ASIO drivers.. 

•

•

•

•

A

A
s
s
i

ASIO software monitoring with track effects: With this option you 
can use Samplitude Music Studio 14 as an external effects device. 
This requires that an ASIO driver is installed for the sound card. 

B

 Lower latency of the driver system. This results in considerably lower 
response times for real-time editing. This enables software 
monitoring of the inputs (and VST instruments). The CPU load of the 
system drops, more high-quality effects are possible without 
intermediate bouncing. 

 Driver-side synchronization between recording and playback is 
available. This ensures that overdub recordings are 100 % stable 
regarding timing. This also allows for mechanisms for compensating 
latency for effects permitting software FX monitoring. 

 ASIO also offers a general method for treating multi-channel audio. 
All bit-resolution and multi-channel problems which may appear with 
WDM drivers under Win2K/XP are avoided from the outset. 

 Advanced hardware monitoring options via use of ASIO direct 
monitoring (flexible routing including Pan & Volume, irrespective of 
the sound card). 

SIO settings 

SIO driver: The drivers of each ASIO device currently available in the 
ystem are listed here. "Settings" opens the settings dialog of the 
ound card driver. Please refer to the sound card manual for more 

nformation. 

uffer settings 
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P
r

I
s
t
C
r

W
b

R
R
f
p

H
t
a
a
q
e

V
(
m
a
u
p
t
s

Realtime Buffer: Values of 8000 are set as default. This buffer is only 
used for realtime previewing the effects from the effects menu. 

B
d
a
l
b

H
a
w

lay/Record buffer: Specifies the buffer sizes for playback or 
ecording of audio data. 

n principle, the larger the buffer, the safer playback will operate on 
lower systems or at full load. The number of simultaneously playable 
racks also increases. However, this reducese the reaction time of the 
PU, which can particularly disturb realtime effects. We therefore 

ecommend searching for an optimum compromise for your system. 

hen recording and playing simultaneously, the record and play 
uffer have to be the same size. 

AM Buffer: This parameter allows you to control the size of the 
AM Buffer. The RAM Buffer is used to record and playback audio 

rom RAM Projects. The default size is 4000 and will generally 
erform well, but you can try smaller sizes for quicker response time. 

D /Scrubb Buffer: This parameter allows you to control the size of 
he HD (hard disk) / Scrubb Buffer. This Buffer is used to playback 
udio from Hard Disk Projects (HD Wave). The default size is 8000 
nd will generally perform well. However, you can try smaller sizes for 
uicker response time, or larger sizes if you experience drop-outs or 
rrors. T 

IP Buffer: This parameter allows you to control the size of the VIP 
Virtual Project) Buffer. The VIP Buffer is used to playback and 

anipulate audio when in the VIP window. The default size is 16000 
nd will generally perform well. VIP Buffer: As error-free playback is 
sually more important than fast reaction times, this value should be 
ossible be increased from 16000 to 32000 when playing many 

racks. When playing virtual projects or using the mixer only these 
ettings are relevant. 

uffer Number: Here you can specify how many of the buffers 
escribed above should be used. More buffers increase reliability, but 
lso increase the memory requirements. Reaction times become 

onger. You can check the current buffer usage levels in the status 
ar to the bottom right. 

D record buffer: 16000 samples are set as a buffer, however, they 
re used for audio recording and indicate how much data should be 
ritten on a block of the hard drive. 
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D
a

R
T
t
y
w

eactivating non-reachable menus and buttons: If this option is 
ctivated, many menus only appear if projects are opened. 

ecord Devices 
he installed sound cards are listed in the large window at the top of 
he dialog. With the Device Info you can open the small dialog. There 
ou will find information on the sound card activated in the adjacent 
indow (supported sample rates, manufacturer, etc.). 
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MIDI 

 

P
S

G
S
d
p

G
S
d

Y
b
M
a

R
u

Audio/MIDI synchronisation: If this box is checked you can specify 
the intensity of Audio/MIDI synchronization coupling. 

layback devices: Here you can define which devices are available in 
amplitude Music Studio 14 and which are not. 

lobal Play/Record Devices: Here you can specify the driver that 
amplitude Music Studio 14 should use to playback MIDI tracks by 
efault.  Of course an individual driver or one of the installed VST 
lug-ins can be selected for any VIP track (only in the VIP track). 

lobal Play/Record Devices: Here you can specify the driver that 
amplitude Music Studio 14 should use to playback MIDI tracks by 
efault.  

ou can also disable all MIDI functions for troubleshooting purposes 
y checking the option “Deactivate all MIDI functions”. Samplitude 
usic Studio 14 will then refrain from reproducing any MIDI data in 

ny of its project windows. 

ecording Offset: Here you can enter the delay in milliseconds to be 
sed when starting recording. 
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0% Very low 

50% Medium 

100% Very high 

Hardware Controller 
S
c
c
s
n

A
e
t

I
O
Y
s

T
u
f

amplitude Music Studio 14 lets you use external hardware 
ontrollers to conveniently control the software. Several presets for 
ommon controllers are included (.cps files). The number of 
upported devices is continuously being increased and adapted to 
ew devices available on the market. 

 MIDI interface is required for using a hardware controller. Please 
nsure that the MIDI functions of the program are not deactivated as 
hey are necessary for addressing the MIDI controllers. 

nstalling a hardware controller 
pen the Hardware controller setup dialog by pressing the "Y" key. 
ou are now in the System/Options dialog. Now open the 
ubcategory Hardware controllers. 

he Hardware controller setup contains two tabs. The first one is 
sed for general settings while the second one is used for learning 

unctions. 

 

1. Press the button Select controller. Then select your controller or 
a compatible model from the list. With Delete or the Delete key 
you can remove selected controllers again. You can use the 
mouse to change the order of the controllers and their internal 
assignment.  A controller that is indented corresponds to an 
expansion module. You can use the checkbox above the 
controller or the button Activate controller to temporary 
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deactivate a controller. 
. On the right you can select the MIDI parts that are connected to 

your controller. 
. Your controller is ready for action after you have closed the dialog. 

rack number 
pecifies the number of tracks in a bank available to the controller. 
hese are usually 8 tracks. Mackie Control and HUI Protocol can only 
ccess 8 channels per bank. However, there are also controllers that 
ave a native mode letting you learn several channels. Here you can 
et this value to 16 or 24 (max. 64). The value is set to "1" for single-
rack controllers. 

gnore SysEx input data 
sEx data sent by the contro

usic Studio 14. 

nternal mode 
he internal modes are used to adapt Samplitude Music Studio 14 to 
ifferent hardware controllers that have a different concept. 
epending on the mode the controller display is addressed differently 
nd the controller information is interpreted differently by Samplitude 
usic Studio 14. 

Hint: If you are using a controller different to the one listed here you 
should select one from the list that is similar to yours in concept and 
design. 
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nternal mode description: 

ackie Multitrack 

rack mode (Standard) 
ctivation: Assignment Track 

ctive Control Mode 
ctivation: 2 x Assignment Track 
unction: Changes the value of the selected element in the mixer 
ith the 1st fader. 

anorama mode 
ctivation: Assignment Pan 
unction: Panorama values are shown in the display. 
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Frontier AlphaTrack 
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hatChannel AUX mode 
ctivation: Assignment AUX 
unction: Controls all AUX sends in the selected channel. 

UX track mode 
ctivation: 2 x Assignment AUX 
unction: Controls AUX sends of the different tracks in the selected 
lot. 
he active slot can be selected with the used keys for "Mixer track 8 
p" or "Mixer track 8 down". 

hatChannel EQ mode 
ctivation: EQ assignment 
unction: Controls the EQ of the selected track using VPots. 
he display page is toggled with the keys "Mixer track 8 up/down". 

hatChannel EQ mode band type 
ctivation: 2 x Assignment EQ 
unction: Controls the EQ of the selected track using VPots in a 
ifferent order. 

lug-in mode 
ctivation: EQ assignment 
reset: 
 Select the plug-in by pressing the corresponding VPot, e.g. 2nd 
plug-in with 2nd VPot. ("Push VPot" can also be assigned to a 
different key). 

 Now you can control all parameters of the corresponding plug-ins 
with the vpots. The display page is toggled with the keys "Mixer 
track 8 up/down". 

anorama mode 
ctivation: Assignment Track 
eatures: 
 Panorama control 
 Navigate to markers 
 Move selected track 

ctive Control Mode 
ctivation: 2 x Assignment Track 
unction: Changes the value of the selected element in the mixer 
ith the fader. 
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Activation: EQ assignment 
Function: Controlling the input volume, frequency and quality bands 
of the selected EQs. 
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UX mode 
ctivation: Assignment AUX 
eatures: 
 Select other track 
 Select other slot 
 Change AUX send of the selected track/selected slot 

Q mode 

he bands are selected with "Mixer track up/down". 
lug-in mode 
ctivation: EQ assignment 
eatures: 
 Select track 
 Select plug-in slot in the track with "Mixer track up/down" key 
 Now you can control 3 parameters of the corresponding plug-ins 
with the vpots. The display page is toggled with the keys "Mixer 
track   up/down". 

rontier Tranzport 

unctions: For transport only 

LCooper (MCS) 

rack mode (Standard) 
ctivation: Assignment Track 

ctive Control Mode 
ctivation: 2 x Assignment Track 
unction: Changes the value of the selected element in the mixer 
ith the 1st fader. 

UX mode 
ctivation: Assignment AUX 
unction: Controls all AUX sends in the selected channel. 

Q mode 
ctivation: EQ assignment 
unction: Controls the EQ of the selected track using VPots. 

utput 
eactivate: If your PC does not have a motor fader, you can use this 
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Send Echo: The MIDI controller data is received and processed and 
forwarded straight back to the controller. Controllers need this for 
their displays (lamps, LEDs). Program data (e.g. fade changes in the 
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ption to deactivate the transmission of controller data. 

ormal send: The MIDI controller data is received and processed. 
rogram data (e.g. fade changes in the Mixer) are sent to the 

ixer) are sent to the controller. If your controller has difficulties with 
his (e.g. .Logic Control), activate "Normal Send". 

end Echo (without Fadertouch): The MIDI controller data is 
eceived, processed and returned to the controller. However, the 
ader values are not sent back while it is moved (activated fader 
ouch). Only the last value is released to prevent increased data 
olumes. Program data (e.g. fade changes in the Mixer) are sent to 
he controller. If your controller has difficulties with this (e.g. Logic 
ontrol), activate "Normal Send". 

djusting the hardware controller/creating your own set 
ost devices available on the market understand protocols such as 
ackie Control or HUI. If your device is not included in the list simply 

elect the nearest compatible device. 

f you can't find your device in the list or want to change the default 
ettings, you should proceed as follows: 

efore adapting an existing template to your controller you should 
ave it under a new name using the Save as... option. 

ow go to the tab "Adapt controller". The following dialog will appear: 
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se Mackie Control if your controller can emulate this mode. In this 
ase 7-bit values are transmitted. You can see this in the MIDI Input 
onitor. Pressing a key displays a new line, another line is displayed 

pon key release. HUI receives 14-bit messages, i.e. two lines 
espectively. 

n the parallel opened Mixer you can now select the element you want 
o program on your controller. The saved function is displayed in the 
ection Program function, e.g. Fader Master for the fader in the 
amplitude Music Studio 14 mixer. Alternatively you can open the 
ontext menu. It contains a list of all remotely controllable functions in 
amplitude Music Studio 14. You can now assign them to your 
ontroller one after another. The upper commands are Mixer-only 
unctions and intended only for connecting the controller. The lower 
nes represent the entire menu structure of Samplitude Music Studio 
4. This allows you to assign any menu command to a controller key. 
lease note that the test LED of the controller is not active for menu 
ommands. 

ow move the fader or press the corresponding key on your 
ontroller. The MIDI data of this element is displayed in the section 
ast MIDI data. Press the Learn button to allocate the new data to 
he function. 

N e: Hardware controllers with touch-sensitive faders transmit data ot
to Samplitude Music Studio 14 when released again, so that the 
"learn" button has to be pressed after moving and before releasing a 
fader! 

I u want to use a key/fader for multiple tracks, e.g. learn mute, 
select Mixer/Tracks/Track Mute" in "Samplitude Music Studio 14 
f
s
t
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unctions". Now activate the check for "Track "Auto Increment" and 
tart programming the first track. After pressing Learn the value of 
he track is automatically increased by "1". All you have to do is to 
ctuate the next element on your controller and press Learn again. 

ou can use the "Delete" button to unselect a function assignment. 
owever, you can also simply overwrite the data by relearning.  

f a controller should move in the wrong direction after programming, 
lease repeat the programming sequence and activate Invert Vpot 
irection upon button release. 

f you want to know which functions have been assigned to a key of 
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our controller, simply actuate this key. The data appears in the list of 
ssigned functions. 

his way you can let Samplitude Music Studio 14 learn individual 
ontrol elements of your hardware controller. 

Hint: If "Object Mode" is activated, you can jump to the next object 
with the Rewind/FastForward keys of the transport control of your 
hardware controller. The same applies to Marker Mode, where you 
can jump to the previous or next controller in the project. 

Metronome Options 

Please also read the section "Menu Options > Program settings > 
Metronome options". 
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Playback parameters 
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eyboard shortcut:  P 

he playback rate can be adjusted with Samplerate, as far as the 
ound card permits this. Use the varipitch feature to adjust the speed 
uring playback or for non-supported sample rates. 

evice:This allows you to define the device used for playback of if 
layback is to occur via a card. This is particularly important if you 
ave several sound cards installed on your computer. 

se Autoscroll to activate a feature which is especially useful when 
orking with long HD Wave Projects: The graphical display always 
hanges when the Play Cursor (position line) leaves the visible 
ection. This way you always have a good overview of the settings, 
hereby it has proven most sensible to display the current project in 

wo sections (Setup > 2 sections), one displaying the entire project 
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nd one in a useful zoom depth with Autoscrolling. 

ou can choose between page and soft scrolling. But be careful: 
crolling requires CPU power (depending on the processor, graphics 
daptor and resolution), so that the CPU may be overloaded in critical 
ituations which may result in playback dropouts. You should then 
eactivate autoscroll mode. 

crubbing: If you press the Insert key (Insert or 0 on the number 
ad), Samplitude Music Studio 14 will switch  to "Scrubbing Mode". 
his means that the playback speed can be controlled directly by the 
ouse. The further to the right the mouse goes, the faster 
amplitude Music Studio 14 plays. 

n comparison to many HD recording systems, this even works in a 
irtual multitrack project. 

se the Scrubbing Mode to find passages, crackling, etc. in material 
 the older generation of sound engineers are, no doubt, very familiar 
ith this method from analog tape editing. 

here are 2 scrubbing modes available (in the playback parameter 
indow - Key P): 

elative: The relative distance between the play cursor (position bar) 
nd the mouse position can be used to control the speed. The play 
ursor follows the movement of the mouse. 

bsolute: You can also use the absolute position of the mouse in the 
indow to control the speed: 

 Left border double speed backwards, 
 Center = no movement, 
 Right border = double speed forwards. 

ip for scrubbing: For buffer sizes (4000, 2000 samples) scrolling is 
softer". Test if your computer functions at this buffer size without any 
layback errors. Using Soft Scroll Mode guarantees that working on 
our computer is easy and fast. 

aripitch / Practice mode 
amplitude Music Studio 14 supports smooth changes of the pitch 
hile playback, even in multi track projects (vertical slider in playback 
arameter window - key p). Activate the Varispeed mode with the 
active” button, and then you can change the playback speed in 
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useful for digital playback to DAT with 44.1 KHz samples and vice 
versa. 

B
a

arious kinds: 

ractice mode: When the Practice mode is activated the pitch 
emains regardless of the playing speed. This mode is suitable 
articularly for pieces that have to be played more slowly, for 
ractice, e.g. a guitar accompaniment, because otherwise excessive 
emands might be made on the player. 

ertical slider: Changes the playback speed from -200% to +200% 

itch Factor: Lets you specify a certain pitch factor manually 

alftones: Lets you specify a value of halftones. The playback will be 
ransposed the number of halftones. 

nternal Rate: Here you can set a sample rate for the Varipitch 
alculation. If you want to play a WAV file with a sample rate of 48 
Hz but your sound card can only play rates up to 44.1 KHz simply 
et the internal rate to 48 and activate Varispeed. You hear the same 
esult as playing back with real 48 KHz! This function is also very 

PM: Here you can type in the original bpm value of your material 
nd a destination bpm value, which is reached using the Varipitch. 

Important: Varipitch works also while recording! So you can set the 
pitch to -2 halftones, sing a song into the computer, then switch off 
the Varipitch –  your track is transposed two halftones higher! 

Then deactivate Varispeed and your voice will reach unknown highs. 
But be careful: You'll sound like Micky Mouse if you apply to much! 

Key:  P 
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diting keyboard shortcuts and menus 

n this dialog, you can freely choose the keyboard shortcuts for every 
enu function in the main menu or for the Auto Jam Session of 
amplitude Music Studio 14. This way, it’s possible to set the 
ommands you use most often to a special key combination so they 
an be opened quickly. 

 

W
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The display of the entire menu tree is the key function of Samplitude 
Music Studio 14. 

H
s
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hen you close Samplitude Music Studio 14, the shortcut settings 
re saved in the Windows folder file MusStu40.ini, so that they are 
utomatically made available the next time the program is opened. 

t is, however, also possible to export sets of shortcut keys or menu 
efinitions in files. 

ere, you can select which menu point you want to create a new 
hortcut or if the menu point should appear in the main menu of 
amplitude Music Studio 14. 

hortcut list 
xport list: You can use this to export the shortcut as a list in a text 

ile in different formats. A window will open in the Shortcut Editor 
hich displays a complete list of the current shortcuts. The included 
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Load/Save: Previously saved shortcuts are loaded and activated or 
the current shortcuts are saved under a file name. 
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Delete: Deletes the selected shortcut. 

A
a
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opy button can be used to copy this list to the Windows clipboard 
nd then edit and print it using a text editor. 

eset: Activates all preset shortcuts again. 

hortcut 
o add a new shortcut, click on the desired menu item and then on 
he input box at the bottom. Then click on the shortcut key. 

ou can also use combinations of any key with Shift, Alt or Control. 
lease do not use the space bar, ESC or Insert key (0 in the number 
lock), as the functions of these keys are permanently set in 
amplitude Music Studio 14 and cannot be changed. 

ssign shortcut: This button can be used to activate the key 
equence on the left as a shortcut. A warning will be displayed if this 
ommand should already have been assigned. However, you can 
lso check in advance whether the key combination has already been 
ssigned. To do this, click on the Search button (binoculars) once the 
ey sequence has been entered. An assigned menu command will 
hen be displayed in the top list.  

ssigned: Shows all the shortcuts assigned to menu points. You can 
ssign menu commands to multiple shortcuts. 

uto JamSession 
diting this is basically identical to editing the main menu. However, 
ou cannot set any keyboard shortcuts, but rather MIDI commands 
r joystick actions. 

The commands listed here don’t exist in any menu. For this reason, 
the buttons “Show/Hide menu point” and “Reset” (from show/hide 
menu command) are greyed out. Similarly, the list cannot be exported 
or saved. 

Reset: Activates all preset shortcuts again. 
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Note: The MIDI input device can be set in the metronome options. 

T
t

o assign a new shortcut to a command, enter the type of shortcut in 
he flip menu “Status”. 

Note: MIDI commands can also be learned. If you should use control 
change events for remote controlling, you can choose between 
“CtrlUpDn” and “CtrlChg” in the “Status” menu. 

•

•

• CtrlChg: Control Change events are transmitted to the MIDI device. 
he MIDI device can also be programmed so that pressing a key will 

transmit such a Control Change event. Please refer to the 

•
change in the sound generator. 

• tchWheel: The Pitch Wheel normally serves to modulate the pitch 
of the sound played. When using it, a quick movement is all that’s 

• Joystick1/2: Use the buttons 1-4 of your joystick to control the Auto 
am Session. In the field beside it, “Button”, enter the corresponding 

number of the desired button. Here, you cannot set the channel as 

•
MIDI device transmits to a different MIDI channel, you can set it here. 

• Assign: With this button you can activate the specified MIDI event or 
set the joystick button as a new shortcut. A warning will be displayed 
if this command should already have been assigned. 

• Delete: Deletes the selected shortcut. 
• Assigned: Shows all the functions of shortcuts assigned to menu 

points. You can assign menu functions to multiple shortcuts. 

Learning MIDI commands 

1. Select the function you want to remotely control via MIDI from the 

 CtrlUpDn: This is a special adaptation for use with a sustain pedal 
from the MIDI keyboard. A command is activated only when the 
pedal is “tapped”lightly, because, when playing, the sustain pedal is 
typically held longer than it takes to actually activate an assigned 
command. 

 NoteOn: Note On events are always transmitted when a key on the 
MIDI keyboard is pressed. It’s also possible for other keys of the 
MIDI keyboard to transmit Note On events. Please refer to the 
instructions of your MIDI device. 

T

instructions of your MIDI device. 
 PrgChg: Program Change events are actually there to effect a sound 

 Pi

necessary to execute an assigned command. 

J

joysticks don’t have anything to do with MIDI devices. 
 Channel: MIDI Channel 1 is always set as the default. In case your 
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list at the top. 
2. Click on the “Learn” button. This now turns red. 
3. From the MIDI device, activate the MIDI command to start the 

function. 
4. In the dialog, click on the “Assign” button to complete the learning 

process. 

Definition 

This dialog can be used to change and select both alternative display 
formats for objects in virtual projects. 

Here the properties of the display for both formats can be selected. 

 

Draw mode 1/2 
Switching between the two modes is possible by pressing the Tab-
key. You can also toggle between Mode 1 and Mode 2 by selecting 
the appropriate mode from the Menu item.  

Waveform Display 
Draw Samples: The audio sample representation is switched on. 
Usually you will leave this on, but it can be advantageous to 
deactivate sample representation if you want to see the volume and 
pan curves more clearly.  
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Scale with Fades/Curves: In this default representation mode the 
Waveform drawing is scaled according to the settings of the Fade 
In/Out or Volume curves. This way the decay of the sound during a 
Fade Out, or volume changes caused by a volume curve, are more 
obviously visible. 

  

Halve: The graphical representation of the audio material can be 
displayed as a whole Waveform or half the form for higher definition. 
Checking this box will display the Waveform with half its information. 
This mode is recommended, because the Grid function (key #) and 
the vertical Zoom functions (Ctrl + cursor up/down) are perfectly 
adapted to this draw mode. Volume Curves results also display better 
in this mode. 

 

Separate Stereo: If this option is active, stereo tracks in VIP Projects 
are displayed with a two-channel Waveform. This allows you to 
expand the display to both channels rather than displaying just one 
composite channel display. Please keep in mind that this will also 
affect the Wave Project display for stereo Wave Projects. 
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Envelope only: When this radio button is selected only the Waveform 
outline (envelope) is drawn. This can be useful when constructing 
crossfades, allowing for easier view of the overlapped Waveforms. 

 

Transparent: When this radio button is selected the colors of both 
crossfade Waveforms are overlapped. This works best in front of a 
dark background (default). We recommend that you combine this 
mode and the Draw Mode option Waveform Colors > Red/Blue 
alternation to display the crossfade areas optimally. 

 

Interleaved: When this radio button is selected a sample of the left 
Object and a sample of the right Object is drawn alternately within a 
crossfade. You can then visually assess the fade area, especially if 
the adjacent Objects have different colors. 

 

VIP 
Various VIP components (Buttons/Slider, Peak Meters, Show Border, 
Arrangement Text, and Vertical Auto Zoom) can be activated and 
deactivated here. 

Objekte 
Background: Each Object in the VIP Track can be assigned it’s own 
color. The color is displayed if this option is checked.  

Object Name: Objects in VIP windows can have their own name. If 
this option is checked, the Object name is displayed.  

Large Object Handles: When selected, larger handles for Objects 
and volume / panorama curves will be displayed.  
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Project Name: Samplitude Music Studio 14 also allows you to display 
the audio file name in each Object. This is especially useful if you 
quickly want to identify the Wave Project used in an Object.  

Object Properties: This shows you which Object related effects are 
applied to the Object, e.g. EQ for equalizers, DYN for dynamics etc... 

Group Number: Objects in VIP windows can be grouped together. 
When grouping Objects it is helpful if the group number is displayed 
in the Object. This option allows you to display that information in the 
Object. 

Object Lock Button: When locked an Object cannot be moved. 
Setting this option will let you comfortably change the lock/unlock 
status of an Object by clicking on the key in the lower region of the 
Object. 

Waveform Colors 
Red/Blue alternation: This representation mode colours the 
Waveforms of adjacent Objects alternately red and blue, to improve 
the visibility of crossfades in the Transparent and Interleaved drawing 
modes. 
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Project settings 

Here you will find all information regarding settings that are 
dependent of a WAVE project (.HDP) or Virtual Project (.VIP). 

Project Options 

 

This will show you information on the current project. This includes 
creation date, memory size, path and file names. For virtual projects, 
a list of all included physical files is displayed.  

Virtual projects also display a list of linked Wave projects. 

Volume Reduction in Virtual Projects: In Project Information for 
virtual projects you can reduce the level in 6 dB steps. This volume 
reduction is necessary for multi-track virtual projects as the sum of all 
tracks in this case must not exceed 16 bit (0 dB) in this case. 
Theoretically, each Track of a 4 Track stereo Project must be 
reduced by 2 bit's (12 dB). In the real world application, Tracks are 
often not recorded or played back at the maximum level so that the 
reduction can be adjusted accordingly. However, raising the volume 
reduction setting may result in clipping. 

Please keep in mind that Samplitude Music Studio 14 reduces the 
volume of Wave Projects to the setting in the Virtual Project that uses 
the Wave Project. This allows you to switch between the VIP and the 
Wave Project without the usual encounter of volume differences 
between the Project types. If a Wave Project is opened by itself 
(without using the Wave Project in a VIP), Samplitude Music Studio 



 

 462 Project settings  

www.magix.com

14 automatically uses the maximum volume playback. 

Key:  I 

Mixer Setup 

Opens the mixer setup dialog where you adjust the general settings 
for the mixer routing design.  

 

Project and Mixer configuration: Here you can set the number of VIP 
and Mixer tracks as well as the submix and AUX busses. 

Device Setup: Here you can set the various routings. 
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Synchronization / Synchronization 
settings 

 

Master synchronization: Samplitude Music Studio 14 will slave to 
SMPTE/MTC/MC and can act as the master for MIDI Clock and MIDI 
Time Code. 

Sync output is directly linked to audio playback so that no delays 
occur between Samplitude Music Studio 14 and external devices, 
even with long tracks. This new synchronization technology was 
specially developed for connecting Samplitude Music Studio 14 with 
MIDI sequencers such as Cakewalk, Cubase, Logic, Evolution Audio, 
MIDI Connections, etc, that can run on the same PC in multitasking 
mode. 

In this case you should use a virtual MIDI router for internally linking 
the programs, such as "Hubis MIDI Loopback" from the Samplitude 
Music Studio 14 studio CD-ROM. 

Wherever possible please use MTC -25 frames/sec. as, unlike with 
MIDI clock, no tempo changes have to be taken into account. 

If Samplitude Music Studio 14 is running as Master, please set the FX 
factor to 1.0. 

Slave synchronization with real "chase lock": Samplitude Music 
Studio 14 supports real "Chase Lock" synchronization, i.e. audio 
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playback can be controlled precisely by a received timecode signal 
(MC or MTC). In this case not only the starting point of audio 
playback is controlled externally, but sync also controls playback 
speed if "Chase Lock" is activated. This way Samplitude Music 
Studio 14 can follow the sync of analog tape machines or VCRs for 
quite some time, which always have a certain slip, without delay. 

This is a very powerful feature which many "professional" systems 
only offer at a high price! 

By entering the "Sync Velocity" you can influence the speed of the 
tempo adjustment. The greater the sync velocity, the faster 
Samplitude Music Studio 14 will follow a tempo change of the sync 
master; however, this also means that the pitch fluctution in the audio 
material is greater. 

Only use values greater than 100 if Samplitude Music Studio 14 does 
not synchronize precisely in standard cases. 

The "Chase lock" synchronization uses a realtime resampling routine 
requiring a certain CPU power. Anything as fast as a Pentium 90 
processor should suffice. 

When using the hardware pitching feature, the Chase Lock 
synchronization uses direct access to the sample rate of the sound 
card in 1 Hz steps. This achieves particularly precise synchronization 
without additional CPU load. However, the sound card has to support 
this feature, as is currently the case with the ARC44 and ARC88 4 or 
8 channel. 

MIDI Clock Input Device: Here the driver must be selected from 
which Samplitude Music Studio 14 will receive MIDI Clocks for the 
synchronization. 

BPM: Here you have to enter the tempo at which you want to receive 
MIDI clocks. 

MIDI Clock Output Device: Here you have to select the driver via 
which Samplitude Music Studio 14 should send MIDI clocks for 
synchronization. 

BPM: Here you have to enter the tempo you want to send MIDI 
clocks. 

SMPTE/MTC Input Device: Here you have to select the driver via 
which Samplitude Music Studio 14 should receive MIDI timecode for 
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synchronization. 

Sync velocity: The greater the sync velocity, the faster Samplitude 
Music Studio 14 will follow a tempo change of the sync master; 
however, this also means that the pitch fluctution in the audio 
material is greater. Only use values greater than 100 if Samplitude 
Music Studio 14 does not synchronize precisely in standard cases. 

MTC Output Device: Here you have to select the driver via which 
Samplitude Music Studio 14 should send MIDI timecode for 
synchronization. 

Type: Select the proper frame rate. Use 24 frames for cinematic 
synchronization, 25 frames for PAL video, and audio synchronization, 
30 frames for NTSC video. 

Pre-roll-Frames: You can specify, how many frames Samplitude 
Music Studio 14 is to ignore before the synchronization starts. Here 
you can account for the fact, that certain analog instruments need 
time to reach the correct speed. In order to have Samplitude Music 
Studio 14 link up to the proper time values, a certain pre-roll frame 
count can be specified. 

SMPTE-Offset: The SMPTE offset is indicated in milliseconds and in 
SMPTE frames. The offset is removed from the incoming SMPTE time 
code signal to line up differences between tape material and 
recorded samples in Samplitude Music Studio 14. With an offset of 
“60:00:00” milliseconds (1 hour) a tape that was previously stripped 
can be synchronized, if the start point for the recording/playback 
starts at 1 hour. Samplitude Music Studio 14 will, however, start at 
the correct beginning position. 

FX: With this parameter, possible inaccuracies during the positioning 
of long samples can be equalized. Requirement is a flawless 
synchronization at the sample beginning. Follow the instructions in 
the chapter “Problem Solutions”. 

Key:  G 
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Recording options 

 

Keyboard shortcut:  R 

Record mode: Here you can choose between stereo and mono, 
recording into the RAM via RAM Wave projects, or onto hard drive via 
WAVE projects. 

Preload: The recording is prepared, all buffers will be loaded. A 
requester will appear enabling you to instantly start recording when 
the Record button is clicked. If disabled, there will be a short pause 
(depending on the size of the Buffers) before recording actually 
begins. 

Sample rate: This option allows you to select the sample rate of the 
recording. Your audio card must support the selected sample rate or 
recording will not work. 

Resample to 44100 Hz: With this button you can specify whether it 
should be recorded at 48 kHz or 32 kHz or even be converted into 
44.1 kHz while recording. This is useful when recording from DAT 
recorders via a digital sound card if the material is to be used on CDs 
with 44.1 kHz. 

Rec. dev: Here you can select the sound card driver that should be 
used for recording. If there is no entry here, or  a wrong one, then 
your card is not installed on Windows correctly. Try to do this via 
System/Options > Driver. 

Info: Here you can access a dialog that provides information on the 
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sound card properties. If your sound card supports 24-bit recording, 
you can activate this record mode via the Info dialog. 

Playback: Playback while recording with record offset: Here 
simultaneous recording and playback can be activated if supported 
by the sound card(s). If you record and play through multiple sound 
cards, small differences may come about during playback of longer 
passages. This is as a result of sample rates of cards which are not 
100% synchronous. Ideally you should use the same card for 
recording as you do for playback. Should your card have a delay 
between the start of recording and the start of playback, you can 
balance it out in the Record Offset field. 

To do so, play a sample with a noticeable impulse at the beginning 
and record it using a loop from the sound card's output to the input. 
Then zoom into the VIP to such a depth that you can precisely 
pinpoint the delay and gauge it. 

File name/file path: The name of the audio file that is to be created 
and the preset directory path are displayed in the bottom record 
window. Both can be changed by clicking on the folder button. 

Set CD Track marker: While recording you can set track markers by 
clicking on "Set CD Track Marker" in the record dialog. 

Automatic record stop: If this button is activated recording will cease 
automatically after approx. 16 seconds of silence. This means that 
you can record without having to stop when the recording comes to 
an end. 

Automatic CD track recognition: If this button is activated track 
markers are automatically placed at the end of the pauses after a 
track. 

Create VIP project: With this mode you can specify whether all 
recordings should be automatically integrated into a virtual project or 
not. 

Monitor: Here the LED control displays can be activated. Please note 
that the correct recording device must be selected prior to beginning 
this. While recording, the LED control displays move slower, do, 
however, show each maximum level. 

Visual: Indicates whether the level of the signal that is to be digitized 
is adjusted correctly. To set the level, play the loudest part of the 
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material you want to record and monitor the display. 

Too low level settings result in lower sound quality, too high settings 
in so-called "clipping". 

You can adjust the record level either on the sound source or with the 
mixer of your sound card. 

Osci./Correl: Here you can open the oscillograph or phase correlator. 
The oscillograph displays the wave form at the input in a scaleable 
window. 

The phase correlator displays the phase level of a stereo signal. A 
vertical line corresponds to a mono signal, and a horizontal line 
corresponds to a 180° phase-inverted signal which usually indicates 
an incorrect cable connection. 

Reset peak parameter: Here you can reset the LED peak meter 
(Peak Hold Display). 

Tuner: This option allows you to tune guitars and other string 
instruments (tune). The visualization will display a calibration line at 
note A0. If different tones are played, the deviation is indicated by the 
calibration line, and the tone pitch is displayed numerically and can 
be corrected accordingly. 

Record offset: Here you can enter the offset in sample values. which 
may develop in "Record-while-play" mode between playback and 
record start of the sound card. This allows you to balance the delay 
between record and play start of some cards. Typical values are 
between 20 and 1000 samples. You can determine this value by 
playing a project with a distinct start in a multitrack VIP and recording 
it simultaneously. You can then measure the offset precisely using the 
zoom functions. 

Set Marker 1: While recording you have the option of selecting a 
marker at the current position of the play cursor (position line), in 
order to, for example, correct an erroneous passage later. 

Record: Click this button to start recording. Please note that with 
active external synchronization as a "Slave", the recording does not 
start immediately, but rather at the start of each master. 

Stop: Ends a recording process. Should the computer be 
overloaded, for example, as a result of swapping or disk access, the 
recording can be cancelled by pressing the right mouse button. 

OK: Closes the record window. 
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